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BIENVENUE

Bienvenue

Bienvenue sur I'aide Adobe FrameMaker. Plongez dans les points de départ suivants pour vous familiar-
iser avec tous les détails de FrameMaker :

. Prise en main

. Concepts de base de FrameMaker

. Mise en page et modeéles

. Modification de contenu

. Tableaux

J Graphiques et objets

. Projets, livres et documents longs

. Contenu de source unique

. Révision et collaboration

. Création de contenu structuré

. Création de contenu structuré a I'aide de DITA
J Imprimer et publier

. Traduction

J Systémes de gestion de contenu

. Création de scripts dans FrameMaker
. Annexe

. Informations juridiques




PRISE EN MAIN

Prise en main

Lancez-vous avec FrameMaker et apprenez-en davantage sur les puissantes possibilités que vous offre
FrameMaker pour la rédaction et la publication de contenu.

Adobe FrameMaker est une solution compléte de rédaction de contenu congue pour prendre en charge
les environnements de rédaction complexes et les besoins en termes de publication.

Avant de commencer a vous servir de FrameMaker, prenez le temps de lire la présentation relative a
I'activation et aux nombreuses ressources a votre disposition. En plus des informations données dans ce
guide, vous avez acces en ligne a des vidéos d’explication, des modules externes, des modéles, des
communautés d’utilisateurs, des séminaires, des didacticiels, des flux RSS et bien plus encore.

Pour accéder a un large éventail de ressources FrameMaker, visitez la Page de ressources d’aide
FrameMaker.



http://www.adobe.com/go/learn_fm_help_resources_fr
http://www.adobe.com/go/learn_fm_help_resources_fr

PRESENTATION DE FRAMEMAKER

Présentation de FrameMaker

FrameMaker est une solution polyvalente qui vous permet de créer des documents structurés ou basés
sur des modeles, d’examiner et de collaborer avec plusieurs systémes de gestion de contenu et de
publier sur une multitude d’appareils.

Dans ce sujet

Introduction

Création et enrichissement de contenu
Gestion et collaboration

Publication dans plusieurs canaux
Logiciel pris en charge

Introduction

Si vous cherchez un outil polyvalent qui prend en charge tous vos besoins en termes de création de
contenu et de publication, FrameMaker est la solution :

Sivous souhaitez créer un document qui appligue une structure étroite ou que vous envisagez une
approche se basant sur un modele, FrameMaker offre des outils puissants et les rend les plus acces-
sibles possibles aux particuliers et aux équipes.

Avec les capacités avancées de révision et de collaboration que propose FrameMaker, vous pouvez
intégrer et envoyer des commentaires de révision en toute simplicité.

FrameMaker vous permet d’associer vos fichiers a Adobe Experience Manager, OpenText Docu-
mentum, Microsoft SharePoint, DitaExchange et a tout systeme de gestion de contenu de votre
choix sans effort.

Un ensemble important d’options de publication vous permet de personnaliser et de livrer du
contenu a plusieurs périphériques.
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Création et enrichissement de contenu

Alors que la nature de certains documents nécessite une création de contenu structuré, vous pouvez
utiliser le mode libre pour la création de contenus de documents différents. Les graphiques, les tableaux
et les objets au contenu multimédia enrichi ne constituent que quelques exemples des manieres dont
vous pouvez enrichir du contenu. FrameMaker vous donne la flexibilité pour choisir votre mode de créa-
tion de contenu, ainsi que plusieurs options d’amélioration de contenu.

fm | .book | .mif
Unstructured Unstructured

FrameMaker

ructure
m FrameMaker

Authoring

Structured

xml
Fm Structured
- Create Structed applications FrameMaker

- Manage Templates
- Publish

Gestion et collaboration

La vitesse et la précision sont d’'une importance primordiale pour que votre contenu reste actuel et perti-
nent. Vous disposez de plusieurs options pour effectuer des révisions de contenu et assurer une collab-
oration étroite avec les membres de I'équipe. Utilisez les barres de modification, activez le suivi des
modifications de texte ou définissez les révisions de fichiers PDF partagés selon vos besoins. Vous pouvez
également utiliser FrameMaker pour accéder directement a un systeme de gestion de contenu et y trans-
férer des actifs.
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Pour plus de détails, reportez-vous a la section Création de contenu structuré.

Publication dans plusieurs canaux

Les demandes actuelles de publication de contenu nécessitent la prise en charge d’un nombre sans cesse
croissant de formats et de périphériques. FrameMaker répond a vos besoins de publication complexe de
la facon la plus facile d’utilisation et la plus efficace. Vous pouvez générer des formats de sortie tels que
PDF, Responsive HTML5 ou des sorties pour périphériques Kindle, entre autres. La modification des
styles et des thémes, le paramétrage de modeles, I'activation du codage, ou la définition d’options de
recherche de contenu vous permettent de personnaliser votre sortie. Génération d’un format de sortie
unique ou de formats multiples en une seule fois
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Pour plus de détails, reportez-vous a la section Publication multicanaux.

Logiciel pris en charge

FrameMaker prend en charge les logiciels suivants dans ses processus :

. Microsoft® Word 2013, 2010 ou Office 365 (uniquement les documents téléchargés depuis
Office 365)

. Acrobat Desktop Application versions XI, Pro (2017 release), derniéere version
. OpenText EMC Documentum

] Microsoft® SharePoint Online ou 2013

. Microsoft SharePoint Online

o Adobe Experience Manager 6.5, 6.4 ou 6.3

. Adobe XML Documentation for Adobe Experience Manager
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Modes de création de contenu

Découvrez les différents environnements de création de contenu dans Adobe FrameMaker pour le
contenu non structuré et structuré et I'édition (XML), et comment choisir entre ces options.

Dans ce sujet

. Introduction

. Choix d’un mode de création de contenu

. Mode FrameMaker

. Mode FrameMaker structuré

Introduction

Adobe FrameMaker offre les modes de création suivants :
. Mode FrameMaker

. Mode FrameMaker structuré

J Editeur de code source XML

Selon que vous adoptez I'approche structurée ou non structurée de la création de contenu ou si vous
souhaitez modifier du code source XML, vous pouvez choisir un mode de création approprié pour votre
contenu.

Choix d’un mode de création de contenu

La premiere fois que vous ouvrez FrameMaker, le mode de création par défaut est défini sur FrameMaker
structuré. Vous pouvez changer le mode dans la boite de dialogue Préférences :

1)  Sélectionnez Edition > Préférences pour ouvrir la boite de dialogue Préférences.
2) Dans la boite de dialogue Préférences, sélectionnez Global > Général.
3) Dans laliste déroulante Interface du produit, sélectionnez le mode FrameMaker et cliquez sur OK.

Vous étes invité a redémarrer FrameMaker pour que les modifications prennent effet.

L'interface utilisateur de FrameMaker fournit une transition en tout simplicité entre une création de
contenu FrameMaker structuré et non structuré. Les options du menu et les autres éléments de l'inter-
face sont cohérents entre les deux modes. Toutefois, les options sont spécifiques au mode choisi pour la
création de contenu.
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Le mode FrameMaker est idéal pour la création de contenu qui ne doit pas étre associé a une structure
rigide. La création a base de style s’appuie sur un modéle pour définir la présentation du contenu. Les
styles de paragraphe, de caractere, de tableau et d’objet sont souvent basés sur des guides de style et
des regles pour I’écriture de contenu spécifiés par des éditeurs. En tant qu’auteur, vous pouvez décider
du flux et du formatage du contenu. Par exemple, vous pouvez inclure des intitulés suivis soit de para-
graphes soit de graphiques, selon la nature du contenu. Cela signifie que dans un flux de production de
création de contenu non structuré, il est possible de créer des documents basés sur une narration rela-
tivement libre.

Une procédure typique de création de contenu standard dans FrameMaker comprend les taches
suivantes :

. Créer des documents uniques.

. Compiler plusieurs documents dans un livre.

. Spécifier comment le contenu est présenté en définissant les styles de paragraphe, de caractere,
de tableau et d’objet.

] Créer des modeles fournissant des styles prédéfinis, pouvant étre échangés avec plusieurs auteurs.
. Utiliser la fenétre Document pour créer le contenu.

] Travailler dans I'un des formats pris en charge : documents standard (. £m), documents Maker
Interchange Format (.mif), et livres (.book).

REMARQUE : En mode FrameMaker, vous ne pouvez pas ouvrir de documents XML et structurés.
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Mode FrameMaker structuré
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Utilisez le mode FrameMaker structuré pour les documents qui doivent adhérer a une structure. La
structure est définie par les éléments et les attributs qui sont disponibles ainsi que I'emplacement valide
de ces éléments dans la structure.

Tout objet d’un document, par exemple un paragraphe, une section, une rubrique ou un tableau,
s’exprime sous la forme d’un élément. Lorsque vous créez un document structuré, vous devez vous
assurer que chaque élément est présent a un emplacement structurellement valide. La création de

contenu assure la cohérence d’une structure pour plusieurs éléments de contenu.

Voici quelques exemples de régles structurelles :

. Une liste a puces doit contenir au moins trois éléments.

o Une section doit commencer par un titre.

. Un intitulé doit étre suivi d’un paragraphe.

. Un tableau doit avoir une ligne d’intitulé.

] Un graphique doit avoir une légende.

Une procédure typique de création de contenu structuré dans FrameMaker comprend les taches

suivantes :

. Créer des documents structurés individuels ou inclure plusieurs documents dans un mappage DITA

ou dans un livre.

] Utilisez les exemples structurés existant ou créez une structure personnalisée a partir des EDD et

DTD.

10
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. Inclure les éléments de droite pour définir le flux de contenu. Certains éléments comprennent aussi
les informations de formatage que vous pouvez utiliser pour spécifier des styles.

. La structure sous-jacente assure la cohérence pour un contenu dans un environnement multi
auteurs.

. Utilisez le catalogue Eléments ou les raccourcis clavier pour insérer de nouveaux éléments pour des
textes, des images, des tableaux et autres objets.

. Utilisez la Vue de la structure pour naviguer dans votre structure et déplacer des éléments a
I'intérieur. La Vue de la structure indique également la validité de votre document par rapport a la
structure sous-jacente.

] Créer dans I'un des formats pris en charge : documents structurés (. £m), documents XML (. xm1,
.dita) et des livres (.book, .ditamap).

Voir une vidéo sur Introduction a FrameMaker structuré.

REMARQUE : Vous pouvez également choisir d’utiliser des éléments non structurés dans le mode Struc-
turé. Toutes les fonctionnalités du mode FrameMaker sont disponibles en mode Structuré.

11


https://my.adobeconnect.com/structuredframemaker17/

NOUVELLES FONCTIONS D’ADOBE FRAMEMAKER

Nouvelles fonctions d’Adobe FrameMaker

Découvrez les nouveautés d’Adobe FrameMaker (version été 2020).

Adobe FrameMaker fournit un certain nombre de nouvelles fonctionnalités, de mises a jour et d’amélio-
rations. Cette rubrique vous offre un apergu de tout ce qui a changé dans la version principale de
FrameMaker. Dans I'ensemble, cette version de FrameMaker contient de nouvelles fonctionnalités et
des améliorations de presque tous les domaines principaux, comme la plate-forme, la création, la migra-
tion de contenu, la création de contenu multimédia enrichi, la révision en ligne, la traduction et la publi-
cation.

CoNSsEIL : Regardez cette vidéo d’introduction http://www.adobe.com/go/learn_fm_16 intro_en sur
FrameMaker.

Jetons un ceil a ce qui a changé dans la version principale de FrameMaker :
Bibliothéques mises a jour pour une plus grande stabilité

La version principale d’Adobe FrameMaker prend en charge Windows 10 sur un systeme 64 bits. Les
bibliotheques de base de FrameMaker ont été améliorées grace aux derniéeres bibliotheques Adobe et
open-source. Grace a cette amélioration, vous obtenez des performances nettement améliorées lors de
la création et de la publication de vos documents volumineux. Cette amélioration vous offre aussi une
meilleure stabilité, avec moins de défaillances et une protection contre les vulnérabilités courantes.

Figure 1: FrameMaker prend en charge Windows 10 sur un systeme 64 bits
Nouvelle vue Navigation pour les documents FrameMaker

Lors de la création, il est trés utile de connaitre la structure globale du document sur lequel vous
travaillez. Faire défiler un long document permet d’obtenir cette information, mais ce n’est pas un
processus fluide.

FrameMaker offre une vue unifiée unique des intitulés ou de la structure de votre document actuel.
Ouvrez la nouvelle Vue Navigation. La structure de votre document actuel s'affiche dans le panneau Vue
Navigation. Cette fonctionnalité n’est actuellement prise en charge que pour les documents
FrameMaker basés sur le style. La logique utilisée dans cette fonctionnalité vous donne une liste de tous
les en-tétes et sous-intitulés de votre document.

Pour lancer la vue Navigation, accédez a Affichage > Panneau > Vue Navigation ou utilisez les touches
de raccourci échap nv.
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EDITING CONTENT
TEXT AND SPECIAL CHARACTERS

oy
Editing content
Navigation View =
\ L Search by Headings < |
KEYWORDS: EDIT CONTENT IN FRAMEMAKER t
DESCRIPTION: LEARN HOW TO EDIT CONTENT IN FRAMEMAKER 4

Editing content

c

FrameMaker provides you with a yarietucd TS AT T SOl Text and special characters
add graphics, images, tables, and i Expand All
equations and QR codes. Collapse All

« Add text and special characters

= Copy, move, and delete text
Select Heading And Content

« Drag and drop text
Delete J P

rTeXt and SpEClaI chara Importing and linking files

Equations
Markers

KEYWORDS: ADD TEXT, ADD SPECIAL CHARACTERS, DISPLAY PARAGRAPH SYMBOL

DESCRIPTION: KNOW HOW TO ADD TEXT AND SPECIAL CHARACTERS TO THE DOCUMEN

As an authoring environment, FrameMaker provides you will the |t Hypertext commands

special characters) to a document. While text includes the standar Multiple Undo/Redo
numbers, you can also enter characters such as tab, bullet symbols Search

Add text and special characters |

Figure 2:  Vue Navigation avec menu contextuel

Sivous cliquez sur un titre dans la vue Navigation, vous accédez au contenu de l'intitulé. Utilisez le menu
contextuel pour naviguer rapidement et développer ou réduire les rubriques, ou méme supprimer un
intitulé entier (ou une rubrique) de votre document.

Pour plus d’informations, voir Vue Navigation.
Voir une vidéo sur la fonctionnalité Vue Navigation.
Insertion de vidéos YouTube

YouTube est I'une des plateformes les plus utilisées pour stocker et partager des vidéos. Si vous avez une
chaine YouTube ou vous conservez toutes vos vidéos de produits, vous pouvez facilement ajouter ces
vidéos dans votre contenu.

La fonctionnalité Insertion de vidéos en ligne vous permet d’insérer des vidéos YouTube dans un docu-
ment FrameMaker, un fichier DITA ou un document LwDITA. Pour insérer une vidéo YouTube, accédez a
Insérer > Multimédia > Vidéo en ligne et fournissez I’'URL de votre vidéo YouTube.

B ' Online Video X

URL or Embed HTML.:

https:/fwww.youtube.com/watch?v=6QvGCz_EAsU

Insert Cancel

Figure 3: Intégrer une vidéo YouTube

13


https://video.tv.adobe.com/v/32421t1

NOUVELLES FONCTIONS D’ADOBE FRAMEMAKER

Lorsque vous générez une sortie PDF ou Responsive HTML5, un lien vers la vidéo YouTube est ajouté a la
sortie. En cliquant sur le lien, la vidéo est lue dans la sortie HTMLS5, et dans le cas de la sortie PDF, la vidéo
est lue dans le navigateur par défaut.

Pour plus d’informations, voir Insertion de vidéos Youtube.
Voir une vidéo sur Intégrer des vidéos YouTube.
Guillemets intelligents spécifiques a chaque langue

FrameMaker est une solution de création et de publication multilingue. Il est trés fréquent de voir un
méme document rédigé et publié dans plusieurs langues. Chaque langue a ses propres systémes de
syntaxe, de sémantique et d’alphabet. Pour vous donner un meilleur contréle lors de la création,
FrameMaker vous permet de spécifier des guillemets ouvrants/fermants spécifiques a la langue.

Vous pouvez définir les guillemets simples et doubles que FrameMaker doit utiliser lors de la création.
Un nouvel ensemble de parameétres Guillemets ouvrants/fermants a été introduit dans la boite de
dialogue Préférences de FrameMaker pour vous permettre de spécifier les guillemets en fonction de
votre langue. Pour accéder aux parameétres Guillemets ouvrants/fermants, accédez a Edition >
Préférences > Orthographes > Guillemets ouvrants/fermants. Une fois cela défini, FrameMaker utilise
dans votre document les guillemets que vous avez définis pour votre langue dans les parameétres Guille-
mets ouvrants/fermants ou la langue définie dans le style de paragraphe.

Preferences X
= Global Smart Quotes Settings
General — Arabic N
Graphics Single Quote o
~Interface Double Quote «»
- Alerts —| Bulgarian
Launch Single Quote N
Dropbox Double Quote -
—| Catalan
CMS_ Single Quote ¢
~ Spelling Double Quote o
- Dictionary —| Chinese (Simplified)
Single Quote b
Spelling Options Double Quote
XML —| Chinese (Traditional)
MathML Single Quote
Double Quote “
—| Croatian
Single Quote “
Double Quote -
—| Czech
Single Quote )
Double Quote . v
OK Cancel

Figure 4: Paramétres Guillemets intelligents dans la boite de dialogue Préférences
Pour plus d’informations, voir Guillemets ouvrants/fermants.

Voir une vidéo sur Utilisation de guillemets intelligents spécifiques a la langue.
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Mise en forme des phrases

Par défaut, FrameMaker fournit de nombreuses fonctionnalités de mise en forme du texte qui vous
aident a créer rapidement vos documents FrameMaker.

TTTI%TT}abAbABAb

Figure 5:  Option Casse de la phrase dans la barre d’outils Formatage de texte

Vous pouvez simplement sélectionner le texte et appliquer les formats de votre choix en un seul clic. Des
formats comme gras, italique, augmentation ou diminution de la taille de la police, modification de la
casse en minuscules, en majuscules et autres sont disponibles dans la barre d’outils Formatage de texte.

Avec la version principale de FrameMaker, vous pouvez facilement appliquer Casse de la phrase a des
phrases ou des paragraphes sélectionnés. Casse de la phrase et d’autres options de mise en forme du
texte sont disponibles dans la barre d’outils Formatage de texte. Pour ouvrir la barre d’outils Formatage
de texte, sélectionnez Affichage > Barres d’outils > Formatage de texte.

Gestion plus intelligente des notes de bas de page

Sivous utilisez beaucoup de notes, vous apprécierez les améliorations apportées a la derniére version de
FrameMaker. Si votre document contient une série de notes, FrameMaker utilise intelligemment
I’espace disponible sur la page pour accueillir autant de notes de bas de page que possible. S’il n’y a plus
d’espace sur la page, FrameMaker déplace automatiquement la note de bas de page sur la page suivante
et réinitialise la numérotation de la note de bas de page pour fournir une référence correcte. Que vous
travailliez sur un document a une seule colonne ou a plusieurs colonnes, vos notes de bas de page
s’affichent correctement dans leur colonne respective. Les notes et leurs références source apparaitront
désormais dans la méme colonne.
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WelcomeScreen X GeneralDescription.fm X

Tip: Click any of the formatted Animations: Show Animatior

terms to see the component:

Major Components: Rear Wall, Propeller, Cylinder, Crankcase,

highlighted in theillustration= F - —13]
i A Cylinder Head, Spinner, Intake, Cam Housing?

Views: Default, Left, Right, Front, Back, Bottom*

1. Footnote in colufmn 1 )
2. Sample footnote two |
3. Sample footnote three
| 4. Sample footnote four

4/23/20 83-3844-8 |5 |

Figure 6: Gestion intelligente des notes de bas de page

Pour plus d’informations, voir Création et modification de notes.
Voir une vidéo sur Gestion intelligente des notes de bas de page.
Fractionner les documents en chapitres

Chaque fois que vous migrez du contenu d’une plateforme a une autre, le premier défi apres I'importa-
tion est de diviser le contenu migré en blocs. Le fait de diviser en blocs des documents volumineux peut
prendre beaucoup de temps. Avec la version principale de FrameMaker, vous pouvez effectuer cette
tache complexe en quelgues minutes.

Une fois que votre contenu a été importé dans FrameMaker, lancez la fonctionnalité de fractionnement
de document a partir de Fichier > Utilitaires > Diviser le document actif pour fractionner facilement vos
documents volumineux. Cette fonctionnalité vous permet de travailler sur un fichier a la fois, ce qui vous
donne plus de contréle sur le fonctionnement du processus de fractionnement. Vous pouvez choisir de
fractionner votre document sur la base de marqueurs ou de formats de paragraphes.

Il existe aussi une fonction de prévisualisation qui vous montre comment la sortie finale sera générée. Si
vous de la structure proposée ne vous convient pas, vous avez également la possibilité de fusionner ou
de fractionner les rubriques. Cela vous donne un meilleur contréle sur la création de vos chapitres et de
votre livre finaux.
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Split a document X Split a document X
Seurce document | GeneralDescription.fm = GeneralDescription.book
S1fm
Create a new book =) History of flight.fm
Create in folder C:\Kuldip\Data\Work\temp\Fm-2020\sample-docs\Unstructure | .. | ~Overview
*Vehicle structure.fm
Characters in file names Split a document
Whitespaces in file names
Select a custom marker | Split
) : « - AND --
Special characters in file names (e.g. *,\, etc.)
Selected paragraph formats
DT_DefinitionTerm
FC_FigureCaption
FF_FigureFrame
Next FN_Footnote Remove from file-list
H2_Heading2 [ Vehicle structure | [fm Rename document
H3_Heading3
HB_HeadingBook Back Start the split

L1_ListLevel01_Begin
L1_ListLevel01_Continue
L2_ListLevel02
NC_Caution -

Back Analyse

Figure 7:  Configurer les options de fractionnement des documents
Pour plus d’informations, voir Diviser les grands documents.
Voir une vidéo sur Fractionner les documents en chapitres.
Correction améliorée de I'orthographe et de la ponctuation

FrameMaker vous donne le controle de toutes les fonctionnalités d’utilisation, comme la facon dont les
espaces sont introduits avant ou apreés la ponctuation ou des caractéres spéciaux. Avec une meilleure
gestion des espaces et de la ponctuation, la vérification orthographique est plus précise que jamais. La

vérification orthographique prend en compte la ponctuation, qui autrement signalerait un mot comme
incorrect.

Figure 8:  Vérification orthographique améliorée
Pour plus d’informations, voir vérificateur orthographique.
Acceés rapide aux mappages et aux fichiers de livres

La fenétre du livre affiche la liste des fichiers qui font partie du livre. Vous pouvez ouvrir plusieurs livres
(.book) et mappages DITA (. ditamap) dans la méme session. Lorsque vous ouvrez trois fichiers de

livres ou plus, les onglets de livre commencent a se chevaucher. Lorsque les onglets se chevauchent, les
livres ayant des caractéeres de départ similaire ne vous permettent pas d’accéder facilement au bon livre.
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FrameMaker vous offre un moyen facile d’accéder au bon livre en un seul clic. Cliquez sur I'icbne =

dans la fenétre du livre et vous obtenez la liste de tous les livres ou fichiers de mappage ouverts dans la
session en cours. Sélectionnez le fichier de livre ou mappage dans la liste pour le mettre en avant.

File Edit View XSLT CMS Window Help

% WelcomeScreen X | t adiust the <ea

| UserGuide.d m generald4 mfoperatind m_systems.ditamap UserGuide7!| = Close e
E‘i Eﬁ @ D-[g 1 3 ?‘C p Close Tab Group 3 |'
o5 systems UserGuide.book

= systems xmil m_generaldescription.ditamap
SHEc_escape_system.xml m_operatinglimitations.ditamap te
Bc_launch_pad_escape.xml ¥ m_systems.ditamap
e cabin_escape.xml UserGuide_master.ditamap )
c_landing_escape.xml _—
=Hd c_crew_and_passenger_system.xml Current ve
' Bc_hygiene xml
“l@ic_sleep.xml RECENT FILES Produc
=i c_landing_system.xml .
- c_landing_gear.xml UserGuide book Click to fill
- c_braking xml using-framemaker-201...
L D I S [N Create

Figure 9: Menu de groupe d’onglets de fenétre Livre
Vue simultanée d’un document et d’un livre pour les mappages DITA

Chaque fois que vous passiez a la vue Document de votre fichier de mappage, la vue du livre ou la vue
des fichiers de mappage DITA n’était plus visible. Ainsi, vous ne disposiez pas des informations sur les
fichiers dans votre mappage DITA. Beaucoup d’entre vous aimeraient faire des mises a jour dans un
fichier de mappage DITA a l'aide de la vue du document et souhaitent également que la liste des fichiers
de votre mappage soit disponible en méme temps.

FrameMaker vous permet de travailler dans la vue Document tout en conservant la vue du livre ou du
mappage DITA. Cela signifie que vous pouvez désormais travailler en méme temps sur toutes les vues
(WYSIWYG, Document, XML), sans perdre la vue du livre.

18



NOUVELLES FONCTIONS D’ADOBE FRAMEMAKER

B File Edit View XSLT Window Help QUNE  XMuStuctured » L= =] X
UserGuide master.ditamap % r_launch and landing site.xml X | #
m ide_master.ditamap -
EBRBRIR%BER e % ) L E2
=@ Personal Spaceship Operations Manual ';"”‘
[ Cover\personal_spaceship_operations_manual.xml - 9|
i Legailegalxm Personal Spaceship Ope
[ Contacts\contacts.xml oo
(1 GeneralDescription\m_generaldescription.ditamap * (Cover/personal_spaceship, A
(3 Systems\m_systems ditamap LaunCh and Iandlni i
[2 OperatingLimitations\m_operatinglimitations.ditamap » (Legalllegal.xml) f%;
* (Contacts/contacts.xml) Ensure the launch site meets minimun Ill
Structure View | = * (GeneralDescription/m_gene ¢ The launch site must meet physit
il .
O search by Element Name, Attribute or Content @ « (Systems/m_systems.ditamz —  atleast5 miles” long;
4 task z SR L t_adjust_the seat temperature.xml x
_ * (OperatingLimitations/m_op¢ | o= e Te—r—
- title : N
A 1 < i2d
2 <IDOCTYPE task PUBLIC "-//OASIS//DTD DI
« shortdesc 3 <task id="id_jw4fU6E6dEI5">
; 4 ctitle>Adjust the seat temperaturec,
s 5 <shortdesc>Everyone likes to have a
4 taskbody 3 comfortable to them and the sea
7 ctaskbody>
4 context 8 <context)
« indext 9 <indexterm>seat temperature
neexienmy 1e <p>There is a minimum and m:
11 your administrator to el
g 12 </contexty
13 <steps>
d U 14 <step>
ctonc vl
Line:lg | Column:[18 |} [DITA_1.3_task v -EE -+

Figure 10: Vues Document, WYSIWYG et XML simultanées
Voir une vidéo sur Vue de document et vue de livre simultanées pour les mappages DITA.
Basculement instantané entre les vues

Dans un environnement de création standard, vous pouvez travailler sur différents types de documents
simultanément. Vous pouvez avoir un document FrameMaker ouvert, ainsi qu’un document structuré,
et dans des vues différentes : WYSIWYG ou XML. La vue WYSIWYG est disponible pour tous les types de
documents, mais la vue XML est spécifique aux documents DITA/XML. Si vous passez a la vue XML, tous
les documents non XML sont retirés de l'interface. Pour travailler sur ces documents, vous devez revenir
a la vue WYSIWYG. Ce basculement d’une vue a I'autre prend quelques secondes sur votre temps de
création.

Avec la nouvelle version de FrameMaker, vous pouvez travailler de fagon fluide sur différents formats de
documents dans des vues différentes sans jamais perdre un document de vue. Cela signifie que vous
pouvez avoir la vue XML ouverte pour votre document structuré et basculer vers un document
FrameMaker sans avoir a changer la vue dans la barre d’outils. FrameMaker conserve désormais la vue
Document au niveau du document. Vous pouvez travailler sur la vue XML ou sur la vue WYSIWYG simul-
tanément pour des documents structurés ou FrameMaker.

Voir une vidéo sur Basculement instantané entre les vues.
Meilleure prise en charge du style CSS3

Pour toute application FrameMaker, un document de définition des éléments ou EDD contient des défi-
nitions d’éléments, des définitions d’attributs, des régles de formatage et d’autres informations régis-
sant le I'insertion d’éléments.

Les feuilles de style en cascade (CSS) stockent les informations de formatage des éléments. La plupart
des utilisateurs avancés sont a I'aise avec le format CSS pour définir le style et le formatage des informa-
tions pour leur contenu. FrameMaker vous offre une fonctionnalité d’importation CSS améliorée qui
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vous permet d’'importer des informations de style directement a partir de CSS. Avec la prise en charge
des dernieres normes CSS 3, vous avez un meilleur controle sur le style et la présentation de votre
contenu. De plus, vous pouvez importer ces formats CSS 3 directement dans I'EDD de votre document
structuré afin de créer des documents plus présentables et plus harmonieux.

The CSS File

ph{

font—-family: "Franklin Gothic Demi Cond", "Arial Black", serif;

forit=aize:rx=large; Before Importing the CSS
color:Maroon; o I Cpe
background-color:rgb (254, 254, 216); Fonts tab example

font-style:oblique;

Thisis the short desaription After Importing the CSS

font=stretch:280;

n example of the €S53 import.
Thisis s <p>element wih <ph> element withi - Fonts tab example
Thisisan list.
The <ph> elem hin the <ul> ele

font-variant:small-caps;

font-weight:bold;

vertical-align: super; This is the short description.
NOTE: This is a<p> element within <note >, whi

font-kerning: normal; le of the CS53 import
xample of the CS$3 impor

--fm-letter-spacing:10.32126849878325; Thisis a <p> element with <ph> element within it.
o Thisis anunordered list.
--fm-font-variation:Wide; . The
. ELEMENT 1S WITHIN THE
text-decoration=line:line-through,overline,underline; <ph> <ul>

element

text-decoration-style:double; woTE: This is a<p> element within <note, which as

} L”,E,,<ph>7£',t EMENT IN I T

Figure 11: Fichier CSS avant et apres l'importation dans I'EDD

Pour plus d’informations, voir HTML avec feuilles de style en cascade.
Voir une vidéo sur Prise en charge du style CSS3.

Toute nouvelle vue Structure

La vue Structure est I'une des fonctionnalités les plus utilisées dans un document FrameMaker structuré.
Dans la version principale de FrameMaker, cette fonctionnalité a été encore améliorée et rendue beau-
coup plus puissante. La nouvellevue Structure est maintenant également disponible lorsque vous utilisez
la Vue XML. Cela signifie que la fonctionnalité Arborescence est maintenant remplacée par la nouvelle
Vue Structure.

Avec la nouvelle vue Structure améliorée, vous pouvez effectuer les taches suivantes (dans la vue XML
d’un document) :

. Effectuer une recherche par élément, attribut ou contenu.

. Naviguer dans le code XML en cliquant sur n’importe quel élément de la vue de la structure.

. Utiliser le menu contextuel pour couper, copier, coller et supprimer des éléments.

. Insérez un élément avant ou apres tout élément a I'aide du menu contextuel.

. Afficher et modifier les attributs directement a partir de la vue de la structure proprement dite.
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QUHE  XMUStructured ~ = B X

WelcomeScreen X t_adjust_the seat temperature.xml X |
task » taskbody » context » indexterm StouctureView =

B <« ?> \,O Search by Element Name, Attribute or Content & |

2 <!DOCTYPE task PUBLIC "-//OASIS//DTD DITA Composite 4 ek

3 <task id="id_jw4fUGE6dEJIS">

4 <title>Adjust the seat temperature</title> - title L |

5 <shortdesc>Everyone likes to have a seat at a s P o

6 comfortable to them and the seat coolness o USRS SERS SRR

Z <Easkbody> » shortdesc —

8 kcontext> | e S Y

3 T Everyone likes to have c at a se

9 <indexterm>seat temperature</indexterm>|

18 <p>There is a minimum and maximum defin| 4 taskbody —

31 your administrator to ensure seats

= | </context>| 4__context

13 (steps> Undo Ctri+Z T [

14 <step> Redo Shift+Z

15 <cmd>Launch your at temperature

16 </step> Cut Ctrl+X

a7 Sstep> Copy Ctrl+C o

18 <cmd>Select ere Hgagn

19 <uicontrol>s: Insert Before

28 </cmd> Insert After

21 </step> Pasts Ctrl+\ t

22 <step>

23 <cmd>Tap Paste Before

24 <uicontrol>L Paste After

25 </cmd>

" <Jsteps Delete Del

27 <step>

28 <cmd>Tap

29 <uicontrol>Temperature</uicontn|

3e </cmd>

31 </step>

32 <step>

33 <cmd>Adjust the temperature up or d

34 <info>

35 <p>

36 <image href="../media/Warmc|

37 </p> T

Figure 12: Nouvelle vue de la structure dans la vue XML d'un document
Pour plus d’informations, voir Vue XML.
Vue WYSIWYG (XML) améliorée

Dans une version antérieure de FrameMaker, la fonctionnalité Vue XML simplifiée a été introduite pour
vous aider a créer facilement des documents DITA. Maintenant, la Vue XML simplifiée a été fusionnée
avec la Vue WYSIWYG. Suite a ce changement, toutes les fonctionnalités de la Vue XML simplifiée sont
maintenant disponibles dans la Vue WYSIWYG. Vous pouvez utiliser les mémes touches de raccourci,
disponibles dans la Vue XML simplifiée, pour appliquer I'attribut Gras (Ctrl+b), Italique (Ctrl+i), ou
Souligné (Ctrl+u). D’autres fonctionnalités qui étaient disponibles que dans la Vue XML simplifiée sont
maintenant disponibles dans la Vue WYSIWYG de vos documents DITA.

Pour plus d’informations, voir La vue WYSIWYG.
Voir une vidéo sur la Vue WYSIWYG améliorée.
Prise en charge instantanée de LWDITA

LwDITA (Lightweight DITA) est une version simplifiée de DITA. Elle se compose d’un ensemble beaucoup
plus petit d’éléments, d’attributs, de modeéles de contenu et de fonctionnalités. Il s’agit d’une future
norme pour la création d’'une documentation structurée. FrameMaker prend directement en charge
LwDITA. Vous pouvez créer directement un mappage ou une rubrique LwDITA a partir du menu Fichier
> Nouveau.
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Un modeéle de mappage et de rubrique permet de créer facilement des mappages et des rubriques
LwDITA. En plus des modeles de création, les modeles de publication préts a I'emploi vous aident a
générer une sortie pour votre mappage/rubrique LwWDITA.

Pour commencer a utiliser I'application LWDITA, passeza LW DITA Applications dansles
parameétres Options DITA :

DITA Options X
DITA Version: General Options:
Use DITA Version: 1.3 ) Auto-Load Topicrefs On File Open
Auto-Load Conrefs On File Open
Use Application Mapping: [LW_DITA_Applications i Auto-Load Xrefs On File Open

DITA_1.3_Applications
DITA_1.3_Learning_Applications|

[] Auto-Load Graphics (Documentum Only)

Defaults: LW DITA Applications [[] Cenditionalize Proleg On File Open
‘New' Type: "xml M [T Conditionalize Comments On File Open
Auto-Add IDs If Required By Element
ID Prefix: (id Always Update Navtile While Updating TopicRef

Always Display Navtile On File Open
Indexterm To Index Marker Conversion
URI notation for paths

Application Mappings... Save Cancel

Figure 13: Passez a I'application LwDITA dans les options DITA

Aprés avoir modifié les parametres, vous pouvez créer un mappage ou une rubrique LwDITA dans le
menu Fichier :

File | Edit Insert View Element Structure Review Window Help
New > Document... Ctrl+N
abc
Open... Ctrl+O Book Esc fN 2 [
Open Recent > DITA > <topic> EscNT1 ‘en X
— p P _L
— Close Ctrl+W XML... Esc f X <map> Esc N M 1
E Save Ditamap Ctrl+S Project Escprn m Adobe |:
@« Save Ditamap As... Escfa New EDD EscfDN
=g Save As PDF... Escfwp
Save As Review PDF > Recent ltems
l Revert to Saved Escfr
PROJECTS
Import >
Package... EscFlp |
. Publish Escph
Utilities >
S , rexml RECENT FILES
o wure_display.xml .
Print Ditamap... Ctrl+P UserGuide_mast...
Print Setup... .
rint Setup - «ml Ch1_Overview#2...
File Info... Escfil ml
CMS > frm_text_tx.fm
Exit frm_text_txxml

Figure 14: Le menu Fichier change pour afficher les documents LwDITA pris en charge
Voir une vidéo sur la Prise en charge instantanée de LwDITA.
Pour plus d'informations, voir Utilisation de LwDITA dans FrameMaker.

Référencement d’acronyme avec <abbreviated-form>
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Dans vos documents DITA, vous pouvez désormais utiliser I’élément pour référencer un terme d’entrée
de glossaire contenant la forme longue et courte du terme. Le moteur de publication de FrameMaker lit
le contexte dans lequel I’élément est référencé, et utilise la forme longue ou courte du terme.

< di%1 3

ABBREVIATED FORM

Figure 15: Prise en charge de <abbreviated-form>
Insérer du contenu multimédia enrichi a I'aide d’éléments DITA

FrameMaker vous permet d’insérer facilement des fichiers au contenu multimédia enrichi dans vos docu-
ments. Que vous travailliez dans un document FrameMaker, DITA (XML) ou LwDITA, vous pouvez facile-
ment importer des fichiers vidéo et audio. Pour les documents structurés, FrameMaker insére les fichiers
vidéo/audio a I'aide des éléments valides. Vous n’avez pas besoin d’aller dans le code source de votre
document structuré pour modifier ou appliquer I’élément valide.

Utilisez le menu Insérer > Multimédia et suivez le processus d’insertion de fichier. FrameMaker s’occupe
d’ajouter vos fichiers multimédias. Ces fichiers multimédias sont également publiés tels quels dans les
sorties PDF et Responsive HTMLS5.

File Edit | Insert | Format View Graphics Table Element Structure Review

o i it Image... Escfili —nE__ A S obe ui
12 = B 7 = Multimedia > Audio... Escfia £
Anchored Frame... Escsa Video... Escfiv
r Cross-Reference... Escsc : Online Video...l Escfio VI ¢ history.
m_generaldescr External Reference... EsclER
E‘i E.‘ﬁ ﬁ m Conref... EsclC
~Bgeneral_desc  Element ctrl+1 ube video:
= gener;l des MathML Equation... Escnml
Zic_history Conditional Tags... EscsC
=@c_overviev Marker... Escsm
j r_space:  \Variables... Escsv
@r_launch Hypertext... Escsh

Figure 16: Menu Insérer Multimédia

Pour plus d’informations, voir Importation d'objets audio, vidéo et 3D.
Voir une vidéo sur Insérer du contenu multimédia enrichi avec DITA.
Convertir du contenu Word et Markdown dans DITA

FrameMaker est livré avec une fonctionnalité d’importation Word puissante. Avec cette fonctionnalité,
vous pouvez facilement convertir vos documents Word en fichiers FrameMaker (. £m). Avec la version
principale de FrameMaker, vous pouvez maintenant également convertir vos documents Word en docu-
ments DITA. Le processus est extrémement simple. Il vous suffit de spécifier les emplacements des
dossiers d’entrée et de sortie ainsi que le fichier de mappage de conversion pour convertir le document
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en documents DITA. Le processus de conversion vous fournit un ensemble de fichiers . dita ainsi qu’un
fichier .ditamap.

Pour pouvoir convertir un document Word avec succes, votre document doit étre bien structuré. Par
exemple, votre document doit avoir un titre, suivi de l'intitulé 1, de l'intitulé 2, et ainsi de suite. Chacun
des intitulés doit inclure certains contenus.

Vous pouvez également introduire votre contenu Markdown dans FrameMaker. La conversion Mark-
down utilise une logique de mappage intégrée. Vous n'avez pas besoin de spécifier de fichier de mappage
lors de la conversion de vos documents Markdown. Il suffit de spécifier le mappage DITA d’entrée conte-
nant votre fichier Markdown en tant que <topicref> et |’'emplacement de sortie pour convertir fichier
Mardown en DITA.

Convertir Word (.docx) en DITA

Document Ward (docx) d'entrée

Fichier:

[C:\word todita.docx Parcourr...

Map Style de balisage

Fichier
[rame Maker\16\X2DITA\Ward2DITA'styletagMap i Parcourr

Fichiers DITAde sgitie - | ¢onertir Markdown en DITA

Réperigire
[Chowps | Mappage de conversion arkgonn d enirée en DITA (dtamap)
Fichier:

[:\Users 1\Deskiop'remotelighting ditamap| | Parcou..

[] Joumalisation verbe

Fichiers DITA de sortie -

Réperigire
[\Release\2020\Reserach\markdowno-dita\converted| [ Parcoumr

[ Joumalisation yerbeuse

Convertir Annuler

Figure 17: Convertir vos documents Word et Markdown en DITA

Pour de plus amples informations, voir Convertir des documents Word en DITA et Convertir des docu-
ments Markdown en DITA.

Voir les vidéos sur Importer du contenu Word dans DITA et Importer Markdown dans DITA.
Ajouter des documents de référence dans la sortie PDF

Tres souvent, vous avez besoin de lier des documents de référence supplémentaires dans votre fichier
PDF source. Pour ce faire, vous créez d’abord un PDF, puis utilisez Adobe Acrobat pour ajouter le docu-
ment de référence comme piéce jointe. FrameMaker vous offre une fonctionnalité pour ajouter des
documents de référence au moment méme de la création. Lorsque vous générez votre PDF final, le docu-
ment de référence est ajouté dans le PDF sans avoir a effectuer de tache supplémentaire dans Acrobat.

Pour ajouter un document de référence, accédez a Insérer > Intégrer un fichier dans le PDF ou Joindre
un fichier au PDF. Selon la valeur prédéfinie de publication de PDF que vous utilisez, vous devrez choisir
entre I'option d’intégrer ou I'option de joindre un fichier.
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WelcomeScreen X | GeneralDescription.fm X |

1.3.3 Thermal protection

Heat protection against burnup and cold protection against the
oid of space is provided by materials applied to the outer skin of
the vehicle to maintain acceptable temperatures.

The outside of the vehicle is made of aluminum and epoxy.
Reentry temperatures can exceed 3000° F'. Outside tem peratures
can plummet to minus 250° F2.

Materials are usedin a preferred order and include:

1. Reinforced carbon fiber.
High temperature reusable surface insulation.

Low temperature reusable surface insulation.

> W N

Specialized materials for other exposed internal surfaces.
a) Flexible surface insulation over standard shapes

b)_Insulating blankets strapped to non-standard shapes
Embedded PDF:

Attached PDF: i

1] q M 14 (120f12)* E

Figure 18: PDF intégré et joint dans le document source

Pour plus d’informations, voir Joindre ou intégrer des fichiers.
Voir une vidéo sur Ajout de PDF de référence au sein d’un PDF.
Générer des fichiers PDF conformes PDF/A et PDF/X

Il existe plusieurs normes sectorielles pour la création de fichiers PDF. Ces normes définissent I'objet et

I"utilisation d’un fichier PDF. Par exemple, les normes PDF/X s’appliquent a I’échange de contenu

graphique, les normes PDF a I’échange interactif de documents d’ingénierie et les normes PDF/A a

I'archivage long-terme des documents électroniques.

. Les normes PDF/X s'appliquent a I'échange de contenu graphique et aux exigences liées a l'impres-
sion.

J Les normes PDF/E s'appliquent a I'échange interactif de documents d'ingénierie.

. Les normes PDF/A s'appliquent a I'archivage a long terme des documents électroniques.

Selon les exigences de votre organisation, vous pouvez définir une norme personnalisée pour créer des
fichiers PDF. Ces normes sont créées sous forme de fichier . joboptions.
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Figure 19: Fichiers PDF conformes PDF/A et PDF/X

FrameMaker vous permet d’utiliser votre propre norme personnalisée ou les normes prédéfinies pour
créer des fichiers PDF conformes PDF/A ou PDF/X. Tout le processus consiste a copier votre fichier

. joboptions dans un emplacement spécifique. FrameMaker s’occupe ensuite de publier votre docu-
ment en utilisant les parametres définis dans le fichier . joboptions.

Pour plus d’informations, voir Parametres PDF.
Voir une vidéo sur Création de fichiers PDF conformes PDF/A et PDF/X
Nouveau moteur HTML

Tirez parti du nouveau moteur HTML de pointe, entierement repensé, pour générer une sortie
Responsive HTML5 rapidement et de maniéere fluide. Capturez plus d’informations de style avec des
améliorations CSS3 comme la numérotation automatique, la génération pseudo-classe, et plus encore.

Figure 20: Nouveau moteur HTML puissant

Voici quelques-unes des principales améliorations apportées au moteur HTML :

. Exportation de graphiques dans votre contenu au format SVG avec un meilleur contréle de la spéci-
fication des parametres de la fenétre d'affichage et de la zone d'affichage.

. Contrdblez la mise en forme des en-tétes et des lignes de votre table a I'aide de votre CSS person-
nalisé.
. Logique nettement améliorée pour créer le TOC.

. Les noms de classes des formats de paragraphes, de caractéres et de tables utilisent désormais le
méme nom que celui défini dans leurs catalogues respectifs.

Pour plus d’informations, voir Publication multicanaux.

Voir une vidéo surTout nouveau moteur PDF.
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Meilleure accessibilité au contenu pour les PDF

FrameMaker prenait déja en charge la création d’une sortie PDF et Responsive HTML5 conforme a la
norme 508. La version principale FrameMaker présente une meilleure conformité aux normes PDF 2.0.
Vos fichiers PDF seront désormais rendus en toute fluidité sur la version mobile d’Adobe Acrobat Reader.
Cette fonctionnalité s'ajoute au balisage existant permettant de générer un fichier PDF dans
FrameMaker.

Voir une vidéo sur Meilleure accessibilité au contenu pour les PDF.

Figure 21: Plus grande accessibilité du contenu

Pour plus d’informations, voir Signets et étiquettes.

Voir une vidéo sur Meilleure accessibilité au contenu pour les PDF.
Collaboration sans souci a I'aide d’Adobe Acrobat

La révision d’un document fait partie intégrante du processus de création de documents. Générer un PDF
et créer une révision partagée est un flux de travail trés courant adopté par de nombreuses organisations
a travers le monde. Vous pouvez facilement créer un PDF de révision directement a partir de
FrameMaker et le partager avec vos réviseurs.

Sivous étes un utilisateur abonné a Adobe Technical Communication Suite, la création de fichiers PDF de
révision est maintenant encore plus simple. La version principale de FrameMaker s’intégre a Adobe
Document Cloud. Vous pouvez créer un PDF de révision, I'héberger dans votre compte Document Cloud,
et le partager avec vos experts internes ou externes pour révision. Il leur suffit d’avoir leurs identifiants
pour étre en mesure d’accéder au PDF de révision a partir de Document Cloud d’Adobe.

Une fois la révision terminée, vous pouvez importer les commentaires de révision directement dans le
document source. Le nouveau panneau Révision vous permet de parcourir les commentaires et de
prendre des mesures en conséquence.
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Fichier Edition Insérer Format Affichage Graphiques Tableau Elément  Structure |[Réisien| Fenétre Aide

™ L Envoyer pour révision en ligne...

Enregistrer en tant que PDF de révision M

Body

M
g Importer les commentaires >

Gérer les révisions en ligne... 4

= p | Afficher le panneau de révision
|
Envayer pour révision en ligne X Gérer les révisions en ligne X
Documert & réviser Rechercher des réviseurs
\Genera\-Desmmmn pif |
Modfier la révision Supprimer la révision Importer les commentaires ]
Hom de la révision
[review | Nom de la réuision  Document Brat Dstededébitd  Fchéance  Re
—— review GenerabDescription pef ACTIVE 20200522 0200609
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< >
Supprimer < 5
Définir I schéance
[p6.05.2020 B Modier Fermer
Aonder

Figure 22: Processus de révision en ligne

Pour plus d’informations, voir Configurer une révision de PDF en ligne.
Voir une vidéo sur Collaboration sans souci a 'aide d’Adobe Acrobat.
Support de 2FA/SSO dans le connecteur Adobe Experience Manager

Adobe Experience Manager est une solution compléte de gestion de contenu pour la création de sites
Web, d’applications mobiles et de formulaires. Adobe FrameMaker est livré avec I'intégration native a
I'aide d'Adobe Experience Manager. Avec le connecteur CMS de FrameMaker, vous pouvez facilement
vous connecter a Adobe Experience Manager pour créer et fournir votre contenu technique et
marketing.

Avec des fonctionnalités telles que I'archivage automatique des fichiers lors de leur fermeture ou leur
extraction automatique lors de leur ouverture, Adobe Experience Manager n’aurait pas pu étre plus
convivial pour les utilisateurs de FrameMaker. D’autres commandes telles que l'archivage et I'extraction
de plusieurs fichiers et I'annulation de |'extraction vous facilitent le travail en toute transparence avec
Adobe Experience Manager.

Si votre organisation utilise I'authentification a deux facteurs (2FA) ou I'authentification unique (SSO),
utilisez I'option SSO dans le gestionnaire de connexion pour démarrer votre serveur AEM.
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Connection Manager X

Connectto a Favorite: Choose Connection:

|Adobe Experience Manager v ‘

Connection Details:

Name: |AEM Server

Server: |hnp:!!lccalhost:4502 ‘

(e.g. protocol://server:port)

[_] Use single sign-on (SSO)

User Name: |u5ername

Password:

Save password

Workspace: |crx.default ‘

Local Folder: |C:\Temp ‘ B

Remove Clear

Connect Cancel

Figure 23: Parametres de connexion Adobe Experience Manager avec I'option SSO

Pour plus d’informations, voir Configuration du connecteur Adobe Experience Manager.
Voir une vidéo sur Intégration native avec Adobe Experience Manager.

Tirer parti des personnalisations a I’'aide de modules externes partenaires Adobe

Le réseau de partenaires Adobe Technical Communication regroupe des experts individuels et des entre-
prises qui peuvent vous aider a obtenir des modules externes ou des solutions personnalisés selon vos
besoins. Vous pouvez accéder directement a notre réseau de partenaires a partir de FrameMaker en
accédant a Aide > Partenaires de formation/de conseil.
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Type solution partner

Tap into our global network of Adobe Technical Communication Partners to receive local sales and technical
expertise in your region. Partners provide a range of services, from tools training and support in local languages to

Filters Clear all

Choose Product
Adobe FrameMaker - 109 Results

Adobe FrameMaker Publishing
Server

Adobe RoboHelp
Adobe RoboHelp Server

Adobe Technical Communication
Suite >

Choose services

Choose country

Choose language

@®ADG

Absolute Data Group

plugins and fulfilment of custom requirements.

4XScripts - Ute Mitschke

—- Order By -- v

4XScripts unterstiitzt technische Redaktionen mit Automatisierungslosungen fiir
Adobe FrameMaker, Entwicklung von XML-Strukturen, Schulung, Training und

Consulting.

Absolute Data Group Pty Ltd

ADG is an award-winning technology company that specializes in creating,

across a variety of industries....

Figure 24: Page des partenaires Adobe Technical Communication

managing and leveraging technical data and maintenance information for clients

En plus du réseau des partenaires, vous pouvez également accéder a certains des modules externes les
plus couramment utilisés créés par nos partenaires en accédant a Aide > Plugins/modules complémen-

taires tiers.

F4X| Technical

- Partner Portal
Adode | Communication

Type solution partner Q

Home Products ~ Customer success stories

4 Back to Home Page

FrameMaker.dk

intelligant <ontant ralutions

Templates Plugins | Paid

3
& 80 active installs < 0 active installs

Eclipse iSpec CMM/SB

The plug-in leverages the
printing capability of Adobe
FrameMaker to...

Tahona - An A4
FrameMaker 2019
template
We made the "Tahona - Tequila
driven, FrameMaker 2019
Template"...

Figure 25: Page Modules externes tierces

Customer support Contact us

TXTAOMEDIA

Plugins  Paid

& 66 active installs

Live Action Video

The Animated Videos can be
transformed into Live Action
Videos...

TXTOMEDIA

Plugins Paid

& 65 active installs

Sample Animated Video

Text, illustrations, and images
used in the written manuals
and...

Voir une vidéo sur Accéder a la page des modules externes et des partenaires Adobe Technical Commu-

nication.
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Prise en charge instantanée de la traduction

La version principale de FrameMaker est livré avec une prise en charge préte a I'utilisation pour le cadre
de traduction. Convertissez facilement votre livre FrameMaker ou un mappage DITA en XLIFF (Format de
fichier d’échange de localisation XML) et partagez-le avec votre fournisseur de localisation pour un trait-
ement facile. Lorsque les fichiers traduits vous sont renvoyés, utilisez la fonctionnalité d’importation
pour récupérer le contenu converti dans FrameMaker. Avec un large éventail d’options de controle de
ce que contient votre package de traduction, vous contrélez mieux votre contenu.

[ Parametres d'exportation XLIFF

Languesource  Frangals

©
H
g
!
i
g
i

Appliuer les régles de segmentation XLIFF

Options FrameMaker structuré

0] Exposerfesrégles e préfixelufioe

Envegistrerles paramétie

Figure 26: Parametres d'exportation XLIFF

Pour plus d’informations, voir Traduction.

Voir des vidéos sur Prise en charge instantanée de la traduction etXLIFF pré-segmenté pour une traduc-
tion plus facile.
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Nouvelles fonctions de la mise a jour 1 d’Adobe FrameMaker

Découvrez les nouveautés de la version mise a jour 1 d’Adobe FrameMaker.

La mise a jour 1 de FrameMaker (version été 2020) comporte de nombreuses améliorations et résolu-
tions de bogues concernant la création, la publication, le marqueur d’index DITA, la table des matieres
et I'index HTML, l'identification des titres PDF balisés, etc.

REMARQUE : Pour plus de détails sur les problemes corrigés dans cette version, consultez I'article sur les
problémes corrigés.

32


https://helpx.adobe.com/framemaker/kb/fixed-issues.html
https://helpx.adobe.com/framemaker/kb/fixed-issues.html

NOUVELLES FONCTIONS DE LA MISE A JOUR 2 D’ ADOBE FRAMEMAKER

Nouvelles fonctions de la mise a jour 2 d’Adobe FrameMaker

Découvrez les nouveautés de la version mise a jour 2 d’Adobe FrameMaker.

La mise a jour 2 de FrameMaker (version été 2020) comporte de nombreuses améliorations et résolu-
tions de bogues concernant la création, la publication et la gestion du contenu. Des fonctionnalités pour
vous aider a travailler efficacement avec des images, des projets LwWDITA ; des améliorations de la publi-
cation aux formats PDF et Kindle ; la gestion du contenu dans AEM, SharePoint, et bien plus encore.

REMARQUE : Pour plus de détails sur les problémes corrigés dans cette version, consultez I'article sur les
problemes corrigés.

Jetons un ceil aux fonctionnalités nouvelles et améliorées dans la mise a jour 2 de FrameMaker :
Conservation des DPI des images lors de la mise a I’échelle ou du redimensionnement

Les images font partie intégrante d’un document. Converser la qualité de vos images lorsque vous modi-
fiez leur taille dans un document est essentiel. Adobe FrameMaker intégre de nombreuses fonctionnal-
ités pour vous aider a insérer et a aligner des images. Cette version intégre une nouvelle fonctionnalité
permettant de conserver la qualité de vos images méme lorsqu’elles sont redimensionnées ou mises a
I’échelle.

Lorsque vous importez une image et que vous la mettez a I’échelle ou que vous utilisez la fonctionnalité
Adapter au cadre (proportionnellement), la résolution et la qualité de I'image changent. Avec la mise a
jour 2, FrameMaker conserve la résolution de I'image a la meilleure valeur ppp (points par pouce)
possible lors du redimensionnement de I'image, ce qui permet de garder le format original. On retrouve
également cette valeur dans le panneau Caractéristiques de I'objet.

Pour lancer le panneau Caractéristiques de I’'objet, sélectionnez Graphiques > Caractéristiques de I’objet.
Pour plus d’informations, consultez Importation de graphiques.

La mise a jour 2 de FrameMaker conserve la qualité de I'image lorsque vous insérez des images dans
différents emplacements que ce soit dans des documents structurés ou non. Supposons que vous
insériez une image plus grande que la zone de texte parent ou que la cellule du tableau. Dans ce cas,
I'image dépasse la taille du cadre ancré. Lorsque vous redimensionnez I'image pour qu’elle rentre dans
le cadre ancré, I'image perd de sa valeur ppp. Avec la mise a jour 2, FrameMaker conserve la qualité de
I'image et met I'image a I’échelle de maniere proportionnelle pour qu’elle rentre dans le cadre ancré
parent tout en gardant la meilleure valeur ppp possible.

Pour mettre I'image a I’échelle automatiquement, sélectionnez Edition > Préférences > Graphiques puis
choisissez Mise a I’échelle automatique de I'image sur la largeur (a l'insertion).
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Préférences >

obal Paramétres par défaut
. Général Importer l'image

Position d'ancrage | En gessous de la ligne cou
Interface Type d'al =
€ d aligneme:

Atetes e dte

Lancer FFP 72 -
i i Dropbox
- CMS Mise & I'échelle automatigue de I'image sur la largeur (& l'insertion)
‘f‘ - Orthographe Exporter Iimage
L XML
L MathML PPP des images pixelisees 300 -

dans la sortie HTML

Anuler

Figure 1:  Option Mise a I'échelle automatique des images dans la boite de dialogue Préférences
Pour plus d’informations, consultez Mise a I’échelle automatique d’une image dans un cadre graphique.
L’attribut xml:lang est pris en charge lors de la création de contenu XML ou DITA

FrameMaker prend en charge la création et la publication dans plusieurs langues, dans les documents
structurés et non structurés. Avec la nouvelle amélioration pour le contenu structuré, vous pouvez créer
et réviser votre contenu dans différentes langues.

Vous pouvez sélectionner une des 46 langues intégrées a FrameMaker et I'ajouter en tant que valeur
d’attribut pour @xml : 1ang pour votre contenu structuré.

Pour prendre en charge cette fonctionnalité, la modele de création de contenu structuré (DITA 1.2,
DITA 1.3 et LWDITA) a été mis a jour. Dans ce modéle, FrameMaker défini les propriétés de Configuration
de paragraphes en se basant sur le parametre de langue dans I'attribut @xm1 : 1ang dans votre

fichier XML.

Les propriétés de Configuration de paragraphes, configurées automatiquement lors de la spécification
de la valeur d’attribut pour @xml : 1angsont :

o Langue

] Sens du texte

. Famille de polices

. Crénage par paire

. Utiliser le compositeur asiatique
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Paramétres configurés dans Configuration de paragraphes pour prendre en charge I'attribut

Figure 2:
@xml:lang
Configuration de paragraphes | » | =
Style |Cnurant w |
Elémentaire Police Pagination Mumérotation
Avancées Asigtique | Cellule de tableau Sens
Famille : Taille :
[M3 Gothic v||[1200 v
Couleur : Armiéreplan :
M Noir ~ . Aucune ~
Graisse : Angle : Wariation :
Regular ~ | | Regular ~ | Regular ~
[ |Souligné | [] Surligné [ Bame
Espacement des lettres :  Etirement Langue
[00% | [1000% | Japanese v
[ | Exposant ~| [ |Petites capitales ~
Crénage par paire |[_| Bame de modf. [ ] Tsume
Q = |  Benommer | Mettre & jour le style Appliquer
Configuration de paragraphes | Variables » | = e i Variables »| =
Style : [Courart v] Style * [Courant ]
Elémentaire Police Pagination | Numératation Elémentaire Police Pagination | Numérotation
Avancées | Asidique | Cellde detableau | Sens Mvancées | Asatique | Cellule de tableau
Espacement caractéres occid./asiat. (% taille de poli Sens :
iHeriter P

[oo " ls0.0% " tes0n ]

caractéres asiat. (% taille de police)

Espacement
[oox " hoow oo

Comprimer autant que nécessaire

onais, |e coréen et les

langues similaires)

£t~ [ | Eevommer | [Metre ajourle style | [ Aopliguer

£+ || | Benommer | | Mettre & jour e style | [ Appliquer

Pour plus d’informations, consultez Parametres de langue et de police dans les documents structurés.

Mappage de métadonnées de FrameMaker a PDF

Avec la nouvelle amélioration, vous profitez d’'une expérience unifiée pour la publication d’un PDF. Les
métadonnées pouvant étre ajoutées par un utilisateur a document FrameMaker dans la boite de

dialogue

Infos sur le fichier
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Nouvelles fonctions de la mise a jour 3 d’Adobe FrameMaker

Découvrez les nouveautés de la version mise a jour 3 d’Adobe FrameMaker.

La mise a jour 3 de FrameMaker (version été 2020) comporte de nombreuses améliorations concernant
la gestion des images dans la sortie HTMLS5.

REMARQUE : Pour plus de détails sur les problémes corrigés dans cette version, consultez I’article sur les
problémes corrigés.

Jetons un ceil aux fonctionnalités nouvelles et améliorées dans la mise a jour 3 de FrameMaker :

Améliorations de la sortie HTML5

La sortie HTMLS5 est un format de publication clé pour la documentation FrameMaker et la publication
d’images fait partie intégrante de ce processus de génération de sortie. De nombreuses améliorations
ont été apportées a la mise a jour 3 pour la publication d’images dans la sortie HTMLS5.

FrameMaker améliore encore la fonction de référencement des images dans vos documents non struc-
turés lorsque vous générez la sortie HTMLS5 correspondante. FrameMaker conserve également la qualité
des images dans la sortie HTML5 de vos documents.

Référencement des images originales

Il est important de conserver les noms de fichier corrects des images lors de la génération de la

sortie HTML5 de vos documents. Maintenant, la convention de dénomination suivante est suivie pour les
différentes images importées dans vos documents non structurés, lorsque vous générez la sortie HTML5
pour ceux-ci :

. Les noms originaux des images, référencées dans le document, sont conservés tels quels.

. S’il y a plusieurs images référencées avec les mémes noms (fichiers avec le méme nom existant a
différents emplacements), alors leur ID d’image est ajouté comme suffixe pour maintenir I'unicité
des images. Par exemple, ImageName imageID.

] Pour les images qui ont été copiées dans le document, un nouveau nom avec la
convention DocumentName imagelID est attribué. Par exemple, si vous copiez deux
images .png dans votre document « mydoc. fm », elles recevront de nouveaux noms comme
«mydoc 1.png»et«mydoc 2.png».

REMARQUE : Pour une conversion correcte des images, évitez d’utiliser des caractéres spéciaux dans les
noms d’images comme le hashtag (#), 'apostrophe (') et I'esperluette (&).

Formats d’image pris en charge sur les pages Web

Dans les versions précédentes de FrameMaker, les images étaient soumises a un processus de conver-
sion pendant leur publication dans la sortie HMTL5. Lors de ce processus de conversion, les images ont
été redimensionnées et leur qualité a été réduite. De plus, les images .gif ont été publiées en tant
gu’images statiques.

Dans lamise a jour 3 de FrameMaker, tous les formats d’image pris en charge sur les pages Web (tels que
.png, .svg, .jpg ou .gif) sont importés dans vos documents non structurés, conservés tels quels dans la
sortie HTMLS5 et ne sont pas soumis au processus de conversion. La mise a I’échelle des images est
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rendue par le navigateur, et la qualité et la taille spécifiée des images sont maintenues. Avec la mise a
jour 3, vous pouvez également jouer des animations .gif dans votre sortie HTML5 et rendre votre
contenu plus attrayant.

Autres formats d’images

Dans les versions précédentes de FrameMaker, d’autres formats d’image non pris en charge par les
pages Web, tels que .bmp et .tiff, étaient soumis a un processus de conversion lors de leur publication
dans la sortie HMTL5. Dans le processus de conversion, ils ont été convertis en .gifs, ce qui a entrainé une
perte de qualité.

Dans la mise a jour 3 de FrameMaker, les autres formats d’image sont convertis en .jpg. Au cours de ce
processus de conversion, la qualité des images est améliorée par rapport aux versions précédentes.

Pour en savoir plus sur les parametres de publication vers une sortie HTML5, consultez Parametres de
sortie.

Figure 1: Sortie HTML5 d’une image (.png) exemple  Figure 2:  Sortie HTML5 d’une image (.png) exemple
dans la Mise a jour 2 dans la Mise a jour 3

Fonctionnalité désapprouvée

La fonctionnalité suivante a été désapprouvée dans FrameMaker :
PDF protégé par mot de passe

La fonctionnalité permettant de protéger votre fichier PDF par un mot de passe a été désapprouvée a
partir de la mise a jour 2 de FrameMaker version été 2020. Comme le mot de passe était stocké dans le
fichier .sts, cela pouvait entrainer un probléme de sécurité. Toutefois, vous pouvez générer la sortie PDF
a partir de FrameMaker, I'ouvrir dans Adobe Acrobat, puis définir un mot de passe. Dans Acrobat, vous
pouvez choisir Fichier > Protéger a I’aide d’un mot de passe ou Outils > Protéger > Protéger a I’aide
d’un mot de passe. Pour plus d’informations, consultez le site Web Sécuriser les PDF avec des mots de
passe dans la documentation Adobe Acrobat.

REMARQUE : Si vous publiez un document enregistré avec I'ancien fichier de paramétrage (.sts) (antérieur
a la mise a jour 3 de FrameMaker) et disposant du mot de passe de sécurité, vous verrez apparaitre une
erreur de journalisation de la console. Vous devez effectuer une mise a niveau vers le dernier fichier de
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configuration (.sts) par le biais de 'invite de mise a niveau qui s’affiche. L'erreur de journalisation de la
console ne se produira pas apres la mise a niveau du fichier de parametres (.sts). Pour plus d’informa-
tions sur les paramétres PDF, consultez Paramétres PDF
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Nouvelles fonctions de la mise a jour 4 d’Adobe FrameMaker

Découvrez les nouveautés de la version mise a jour 4 d’Adobe FrameMaker.

La mise a jour 4 de FrameMaker (version été 2020) comporte de nombreuses améliorations telles que la
prise en charge de la création de contenu a I'aide du systeme de référencement de fichiers basé sur
I"UUID, I'ajout d’étiquettes pendant le processus d’archivage et la fourniture de FDK sous forme de
fichier ZIP téléchargeable.

REMARQUE : Pour plus d’informations sur les problémes corrigés dans cette version, consultez I'article sur
les problémes corrigés.

Jetons un ceil aux fonctionnalités nouvelles et améliorées dans la mise a jour 4 de FrameMaker :

Support des fichiers UUID pour XML Documentation for Adobe Experience Manager as
a Cloud Service

Dans la derniére version de FrameMaker, le connecteur AEM a été amélioré afin de prendre en charge
la création et la publication de contenu qui utilise le systéme de référencement de fichiers basé sur UUID
dans FrameMaker. Cette fonctionnalité est disponible pour XML Documentation for
Adobe Experience Manager as a Cloud Service (a partir de la version de janvier 2022). Les fichiers UUID
sont téléchargés sous forme de fichiers plats sans structure de dossier hiérarchique.

Chaque fichier possede un UUID unique, qui permet de I'identifier dans le systeme de fichiers. Une fois
gue vous avez téléchargé les fichiers AEM sur votre systeme, vous pouvez les modifier et les publier dans
FrameMaker. La hiérarchie des fichiers plats permet d’enregistrer tous les sujets et fichiers multimédias
référencés dans un seul dossier. Comme toutes les références dans la solution XML Documentation sont
basées sur 'UUID, la hiérarchie plate aide a maintenir les références. Ces références restent inchangées
lorsque vous transférez le fichier d’'un emplacement a un autre.

Les captures d’écran suivantes montrent des fichiers UUID ouverts dans FrameMaker pour étre modifiés.
La fenétre du livre affiche la liste des fichiers qui font partie du mappage DITA. Lorsque vous ouvrez un
fichier, 'UUID est affiché comme titre de la fenétre du document.

T View Grphics Table [ement Structre Review Windew licks
£ OB fdFRAY L EEE =
ieo RHE I )

eference » title
i« »

<!DOCTYPE reference PUBLIC "-//OASIS//DTD DITA Compesite//EN" "technicalContent/dtd/ditabase.dtd">

<reference id="id_CZi5X12NoM
<titlesTakeofs¢/titles
<shortdescyThe maximum airsoeed for the vehicle is 492 knots equivalent airspeed (KEAS) where

topic

E IS

<image |href="GUID-64ba2718-3023-401b-bc69- 94528180405, gif" /> (see figure below).

7 </shortdescs

8 <refbody>

9 <section 1d="1721332">

16 <>

1 <indexterm>takeoff</indexterm>There is no official minimum airspeed

12 for ascent.

13 <fig id="i721322">

14 <image |href="GUID-e598a60d-c0d2-42080-b28c-22723a90568F . png” | scale="5¢" />
</figr

iGeneraI description

“The section pro

16 </pr
17 ¢/section>
18 </refbody>

18 </reference>

Figure 1:  Hiérarchie plate de 'UUID Figure 2:  Références dans un fichier basé sur UUID
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La création de fichiers UUID est une fonctionnalité améliorée de FrameMaker, qui prend en charge
diverses opérations sur les fichiers, telles que I'extraction, I'archivage, I'actualisation, etc. Pour plus
d’informations sur les opérations sur les fichiers, reportez-vous a Utilisation de fichiers.

Pour plus d’informations sur I'activation du référencement des fichiers basé sur 'UUID, reportez-vous a
Activer le support des fichiers UUID

Ajouter des étiquettes en vérifiant des fichiers dans AEM

Avec la derniére version, FrameMaker offre une fonction permettant d’utiliser les étiquettes (métadon-
nées) définies dans la solution XML Documentation lors de I’archivage de vos fichiers.

Les étiquettes définies dans la solution XML Documentation apparaissent sous la forme d’une liste
déroulante, et vos utilisateurs peuvent sélectionner plusieurs étiquettes dans la liste. Cela permet de
créer un ensemble cohérent d’étiquettes. Par exemple, vos experts en la matiére peuvent définir des
étiquettes telles que « révision technique », « révision éditoriale » et « révision de la qualité » dans la
solution XML Documentation, et les utilisateurs peuvent utiliser ces étiquettes dans FrameMaker pour
définir les versions lors de I’archivage de leurs fichiers. Une fois que vous avez archivé vos fichiers, les
étiquettes d’archivage sont affichées dans I’historique des versions du document dans I'interface utilisa-
teur de la solution XML Documentation.

La capture d’écran suivante affiche la liste déroulante des étiquettes qui ont été définies dans la solution
XML Documentation et qui apparaissent lorsque vous enregistrez vos fichiers dans FrameMaker.

Checkin *
atopichi
Cument Version: Latest
Version Label: TesiLabel1 TestLabel2 V|
Checkin Comment [v| Testlabel?
[ | Testlabel3
Cancel

Si vos étiquettes ne sont pas définies dans la solution XML Documentation, vous pouvez ajouter de
nouvelles étiquettes dans FrameMaker, séparées par des virgules.

Pour plus d’informations, référez-vous a Ajouter des étiquettes lors de la vérification des fichiers dans
AEM.

Testé et certifié sur le dernier systeme d’exploitation Windows 11.

A partir de la mise a jour 4, Adobe FrameMaker 2020 est testé et certifié sur le dernier systéme
d’exploitation Windows 11. Toutes les fonctionnalités de FrameMaker Update 4 fonctionneront égale-
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ment sans probleme avec Windows 11 et Windows 10. La mise a jour 3 et les versions antérieures de
FrameMaker 2020 continueront a fonctionner sur Windows 10.

FDK partagé en tant que fichier ZIP

Le kit de développement Adobe FrameMaker (FDK, FrameMaker Developer Kit) vous permet de créer
des modules externes pour répondre a vos besoins de production de contenu. Désormais, avec la mise a
jour 4 de FrameMaker 2020, le FDK sera partagé sous forme de fichier ZIP. Vous pouvez télécharger et
décompresser le fichier pour commencer. Ce nouveau processus résout le probléme de I'écrasement du
dossier de la version existante du FDK lorsqu’une nouvelle version du FDK est installée.

Téléchargez le fichier ZIP FDK sur le site Web Adobe.io.
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Autres fonctionnalités de la version FrameMaker (été 2019)

Découvrez d'autres fonctionnalités de la version de FrameMaker (version 2019) qui vous aideront a créer
et a publier facilement vos documents.

Performances de fichier plus rapides

Grace aux améliorations apportées aux opérations sur les fichiers et au moteur de publication, vous
bénéficiez d’'une meilleure expérience lorsque vous exécutez une opération de fichier ou une tache
de publication. Des opérations telles que I'ouverture et I'enregistrement d’un fichier sont beau-
coup plus rapides et plus fluides. Le temps nécessaire pour ouvrir ou publier des fichiers au format
PDF ou HTML5 est beaucoup plus rapide.

Voir une vidéo sur Performances de fichier plus rapides.

Barre de progression interactive en temps réel

Avec la présentation des barres de progression informatives, vous saurez toujours ou en est une
mise a jour du livre ou un processus de publication. Par exemple, lorsque vous mettez a jour un
livre, la barre de progression affiche I’état comme ouvrir un fichier, traiter un fichier, générer des
fichiers d’index, etc. De méme, lorsque vous exécutez une tache de publication, la barre de progres-
sion vous indique le traitement effectué sur les fichiers, tel que I'ouverture du fichier, le processus
de conversion, I'application de certaines transformations, etc.

Les captures d’écran suivantes sont capturées a différentes étapes des taches de mise a jour et de
publication du livre.
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Saving as PDF

Converting Legal fm

Preparing document ...

Updating book

Saving as book with Fm components
Scanning contacts fm
Cipening m_systems ditamap -
_ - Traversing document ...
Saving as PDF

Creating composite document of ditamap...

Cpening m_systems ditamap

Voir une vidéo sur Barre de progression interactive en temps réel.

Amélioration de la gestion des images

L'insertion de plusieurs images a la fois a été une tache difficile dans FrameMaker. Cependant, avec
cette version, vous serez en mesure d’importer des centaines d’'images dans votre document sans
aucun retard. Avec le nouveau processus de traitement d’image, le défilement de votre document
lourd se passera de maniére fluide.

Voir une vidéo sur Amélioration de la gestion des images.

Prise en charge clé en main de Microsoft SharePoint 2016

Le gestionnaire de connexion prend désormais en charge les serveurs Microsoft SharePoint Online
et Microsoft SharePoint 2016. Accédez a vos fichiers a partir de la derniére version du serveur
SharePoint sans avoir a utiliser un module externe tiers.

Voir une vidéo sur Prise en charge clé en main de Microsoft SharePoint 2016.

Acces rapide a I’écran d’accueil

L’écran d’accueil (ou écran de démarrage) est désormais accessible depuis le menu déroulant de
I’espace de travail L’écran d’accueil fournit un acces rapide a vos documents récemment ouverts,
aux modeles de documents, aux connexions au référentiel et bien plus encore. L’écran d’accueil
peut également étre personnalisé en fonction de vos besoins en matiere de création et de publica-
tion. Par exemple, vous pouvez ajouter des liens aux modeles de document les plus couramment
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utilisés ou fournir des instructions pour créer un type de document particulier. Vous pouvez main-
tenant accéder a I’écran d’accueil a tout moment et sans fermer vos documents ouverts.

[ XML/Structured ~ ]l —|[®] x |

Authoring
Blank
Design
Manage Graphics
Review
v XML/Structured

Save workspace
Manage workspace

Reset workspace

Show Welcome Screen

Pour plus d’informations, voir Ecran d'accueil.

Prise en charge du nouveau dictionnaire Duden

La prise en charge des dictionnaires allemands a été completement revue. Depuis le dictionnaire
Hunspell précédent, FrameMaker prend désormais en charge le dictionnaire Duden pour les utili-
sateurs allemands. Le dictionnaire Duden est régulierement mis a jour et est I'un des plus utilisés
par les utilisateurs allemands.

Preferences X
E Global Dictionary Provider Settings
~General —| German - Austria (2006 Reform) ~
Graphics [Speling 00} -
~Interface Hyphenation

Alerts — German - Germany (1901 ({Duden: Konservativ
Spelling Duden: Presse

~Launch Duden: Tolerant

Dropbox Hyphenation T P
— German - Germany (1996 Reform)
#=CMS .
. Spelling Duden
I Spelling Hyphenation Duden All
~Dictionary —| German - Germany (2006 Reform)
Smart Quotes Spelling Duden
~Spelling Options Hyphenation Duden All
XML Thesaurus Proximity
‘MathML = Gem_'\an - Swiss (1901 Old rules)
Spelling Hunspell
Hyphenation Hunspell
Thesaurus Proximity
— German - Swiss (1996 Reform)
Spelling Duden
Hyphenation Duden All
— German - Swiss (2006 Reform) v

OK Cancel

Voir une vidéo sur Prise en charge du nouveau dictionnaire Duden.

44


https://video.tv.adobe.com/v/22873t1/

AUTRES FONCTIONNALITES DE LA VERSION FRAMEMAKER (ETE 2019)

Boites de dialogue HTML5 interactives pour les modules externes

FrameMaker prend désormais en charge les boites de dialogue HTML5 enrichies. En utilisant
HTMLS5, CSS3 et JavaScript, vous pouvez créer des boites de dialogue HTMLS interactives pour les
modules externes que vous créez pour vos utilisateurs. La prise en charge des boites de dialogue
HTMLS5 interactives réduit considérablement les efforts requis pour créer des boites de dialogue a
I'aide de fichiers DRE.

Nouvelle boite de dialogue Ouvrir le fichier basée sur Windows

La boite de dialogue Fichier ouvert existante est améliorée pour offrir une expérience de travail
plus fluide. La boite de dialogue Fichier ouvert est basée sur la technologie de boite de dialogue
native de Windows, qui est puissante et offre une variété d’options de personnalisation.

Prise en charge d’'images WebP et ICO

FrameMaker prend désormais en charge I'importation des images \WebP et ICO (icone) dans vos
documents. Le format d’image WebP est développé par Google et prend en charge la compression
avec et sans perte. Il est considéré comme une alternative aux formats de fichiers PNG et JPEG en
raison de sa plus petite taille de fichier et d’'une meilleure qualité d’image. Lors de I'insertion d’'une
image, choisissez le format WEBP (* .webp) ou ICO (* .ico) dans la liste déroulante Fichiers de type
pour ajouter une image WebP ou une image d’icone a votre document.

Plus de contrdle sur les fichiers PDF

La nouvelle génération de PDF propose des parameétres de publication complets. Les parametres
de publication PDF sont divisés en cinq catégories : Général, Repéres et fonds perdus, Modele DITA
et Options DITA.

Les parameétres généraux vous permettent de configurer le préréglage de sortie, la norme PDF, la
compatibilité, les options d’affichage, etc. Le parameétre Repéres et fonds perdus peut étre utilisé
pour définir les paramétres de recadrage, de fond perdu, de repéres de montage et de ligne-bloc.
Les parameétres des modeles DITA sont utilisés pour configurer les modeéles que vous voulez utiliser
pour publier le document. Enfin, si vous souhaitez enregistrer le PDF via l'itinéraire Livre, vous
pouvez choisir ce que vous souhaitez inclure ou exclure du PDF publié dans les paramétres Options
DITA.

Pour plus d’informations, voir Sortie PDF.

Sortie couleur WYSIWYG

Lorsque vous générez une sortie PDF, vous n’avez plus besoin de sélectionner les parametres de
couleur RVB ou CMIJN. La nouvelle technologie de génération de PDF publie les mémes couleurs de
texte et d’images que celles que vous voyez lors de la création. Cela vous donne une apparence
cohérente de votre document, que vous soyez en train de créer ou de visualiser la sortie publiée.

Gestion plus rapide des fichiers XML

FrameMaker utilise un nouveau moteur d’analyse basé sur Java qui réduit considérablement le
temps nécessaire pour analyser les fichiers XML. Avec le nouveau moteur d’analyse, ouvrir, éditer,
enregistrer ou méme intégrer vos fichiers XML dans des packages est beaucoup plus rapide.

Voir une vidéo sur Gestion plus rapide des fichiers XML.
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Création d’EDD sans effort

La création d’EDD peut étre un processus long et complexe. FrameMaker vous offre maintenant
une interface facile a utiliser pour créer des EDD rapidement et facilement. Cette nouvelle fonction
de création d’EDD prend en charge les types de document Lightweight DITA et DITA 1.3.

Le nouveau module externe Personnaliser DITA utilise le schéma RELAXNG. Actuellement, les
spécifications DITA 1.3 et Lightweight DITA ont été utilisées dans ce module externe. Vous pouvez
personnaliser les shells DITA existants en incluant ou en excluant des modules, domaines ou
éléments dans un shell. Le module externe vous permet également d’appliquer facilement un
fichier CSS pour donner une nouvelle apparence au sujet DITA. Une fois vos personnalisations en
place, un nouveau document peut étre créé en choisissant simplement le menu Fichier > Nouveau
> DITA.

Pour plus d’informations, voir la rubrique Personnalisation de DITA a I'aide du module externe dans
le guide Personnalisation de DITA pour Adobe FrameMaker.

Edition Saxon Enterprise

FrameMaker est livré avec I’édition Saxon Enterprise. Vous pouvez créer une variété de scénarios
pré-traitement et post-traitement ou exécuter la transformation XSLT sur les fichiers XML. Vous
pouvez définir I'’étendue des taches de transformation a exécuter sur un fichier, sur tous les fichiers
d’un dossier, sur un mappage DITA ou sur toutes les rubriques enfants d’un livre et utiliser les
capacités de XPATH 3.0 et de XSLT 3.0, ainsi que la puissance de I'édition SAXON Enterprise.

Prise en charge de XPATH 3.0

FrameMaker prend en charge XPATH 3.0 via I’édition SAXON Enterprise. Utilisez les requétes
XPath pour rechercher rapidement des éléments et des attributs dans un long document XML. Le
Query Builder vous permet de créer facilement des requétes XPath personnalisées, d’obtenir des
suggestions, de définir la portée des requétes, d’utiliser le menu déroulant Historique et d’enreg-
istrer les résultats de la recherche pour une utilisation ultérieure.

Prise en charge de XSLT 3.0

FrameMaker prend en charge XSLT 3.0 via le processeur Edition Saxon Enterprise. Vous pouvez
créer divers scénarios de transformation en appliquant XSLT prédéfini ou personnalisé sur des fich-
iers XML et les exécuter a I'aide d’'une gamme de processeurs compatibles JAXP. Vous pouvez
définir I’étendue des taches de transformation a exécuter sur un fichier, sur tous les fichiers d’un
dossier, sur un mappage DITA ou sur toutes les rubriques enfants d’un livre.

Outil de création de package amélioré

Le gestionnaire de packages a été amélioré pour créer rapidement des packages avec |'aide du
nouveau moteur d’analyse. Vous pouvez facilement créer un package autonome de vos docu-
ments, livres ou mappages DITA, en incluant tous les fichiers, images et configurations référencés.

Pour plus d’informations, voir Créer des packages.

Voir une vidéo sur Outil de création de package amélioré.
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CONFIGURATION REQUISE

Configuration requise

En savoir plus sur la configuration systéme requise pour l'installation d’Adobe FrameMaker.

Avant d’installer FrameMaker, assurez-vous que vous disposez du matériel et des logiciels requis :
. Processeur Core i5 ou plus rapide

. Version 64 bits uniquement (32 bits non pris en charge)

. Microsoft® Windows® 10

. 4 Go de RAM ou plus (recommandé)

. 64 Go d’espace disque disponible pour l'installation ; espace libre supplémentaire requis pendant
I'installation (installation impossible sur un volume qui utilise un systeme de fichiers sensible a la
casse ou sur des périphériques de stockage Flash amovibles).

) JRE 8 (est nécessaire pour le processus de publication)

REMARQUE : Résolution d’écran maximale prise en charge : 4K (3 480 x 2 160, 8,3 mégapixels, format
16:9)

Ce logiciel ne fonctionne pas sans activation. Il est nécessaire de disposer d’une connexion Internet et de
s’enregistrer pour activer les logiciels, valider les souscriptions et accéder aux services en ligne.
REMARQUE : L’activation par téléphone n’est pas possible.

Langues d’interface utilisateur disponibles

FrameMaker est disponible dans les langues suivantes :
. English

. Francais

. Allemand

o Japonais

RELATED LINKS:
https://www.adobe.com/go/learn_fm_sys req_fr

Configuration systéme requise détaillée
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INSTALLATION ET ENREGISTREMENT

Installation et enregistrement

Suivez les instructions suivantes pour vous familiariser avec FrameMaker sur votre ordinateur.

Le programme d’installation FrameMaker est basé sur la toute derniere technologie d’installation
d’Adobe. L'installateur a besoin de moins d’espace et est rapide.
Pour installer FrameMaker :

1) Téléchargez le programme d’installation de FrameMaker a partir du site du produit
https://www.adobe.com/fr/products/framemaker/download-trial/try.html.

2)  Fermer toutes les applications Adobe et Microsoft.

3) Dans le dossier de téléchargement, localisez le fichier Set-up . exe et double-cliquez dessus pour
démarrer le processus d’installation.

Suivez les instructions qui s’affichent a I’écran pour terminer l'installation.
4)  Aprés avoir terminé le processus d’installation, lancez FrameMaker.

Lors du processus d’installation, votre logiciel Adobe contacte un serveur Adobe afin d’achever le
processus d’activation de la licence. Aucune donnée personnelle n’est transmise.

Pour plus d’informations sur I'activation du produit, visitez le site Web d’Adobe a
https://helpx.adobe.com/fr/download-install/kb/activate-deactivate-products.html

REMARQUE : Si vous souhaitez désactiver votre instance FrameMaker pour une raison quelconque, cliquez
sur Aide > Déconnexion
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RESSOURCES D’ APPRENTISSAGE

Ressources d’apprentissage

Accédez aux derniéres ressources d’apprentissage d’Adobe FrameMaker.

Ressource URL

Guide de I'utilisateur Adobe FrameMaker http://www.adobe.com/go/learn_fm16_ug_fr

(PDF)

Guide de démarrage Adobe FrameMaker http://www.adobe.com/go/learn_fm_16_gsg_fr

Introduction a Adobe FrameMaker http://www.adobe.com/go/learn_fm_16_intro_fr

Didacticiels vidéo https://helpx.adobe.com/fr/framemaker/video-hub.ht
ml

Foire aux questions http://www.adobe.com/go/learn_fm_faq_fr

Configuration requise http://www.adobe.com/go/learn_fm_sys_req_fr

Forum des utilisateurs d'Adobe https://community.adobe.com/t5/framemaker/bd-p/f

FrameMaker ramemaker

Blog Adobe TechComm http://blogs.adobe.com/techcomm/

Adobe TechComm sur Twitter https://twitter.com/adobetcs

Adobe TechComm sur Facebook https://www.facebook.com/adobetcs/

Adobe TechComm sur YouTube https://www.youtube.com/user/AdobeTCS/

Groupe LinkedIn Adobe TechComm https://www.linkedin.com/groups/2381149/

Groupe LinkedIn Adobe FrameMaker https://www.linkedin.com/groups/2204291/

Partenaires de formation et de conseils https://partners.adobetechcomm.com

Adobe

Plugins/modules complémentaires tiers https://partners.adobetechcomm.com//view_all_dow
nloads
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CONCEPTS DE BASE DE FRAMEMAKER

Concepts de base de FrameMaker

Prise en main avec introduction aux concepts de base d’Adobe FrameMaker.

Adobe FrameMaker dispose d’une interface utilisateur étendue qui vous permet d’effectuer toutes les
taches de création et de publication en toute simplicité.

Découvrez les différents éléments de I'interface utilisateur de FrameMaker, comment débuter en créant
un document et comment utiliser du contenu bidirectionnel.
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INTERFACE UTILISATEUR

Interface utilisateur

Découvrez comment travailler avec I'interface utilisateur d’Adobe FrameMaker

Plus d’informations sur l'interface utilisateur dans les sous-rubriques.
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Ecran d'accueil

Comprendre I’écran d'accueil dans FrameMaker, connaitre les taches qui peuvent étre effectuées selon
I’option correspondante choisie sur I’écran de bienvenue.

FrameMaker affiche un écran d’accueil en fonction du mode actuel.

L’écran d’accueil fournit des options permettant d’effectuer un ensemble de taches communément
requises en fonction du mode actuel de FrameMaker.

Ouvrir un projet ou un document récent
Dans le mode FrameMaker : création d'un projet, documents, livres

Dans le mode FrameMaker structuré : création de mappages DITA, fichiers DITA, fichiers XML,
version DITA de modification

Rechercher et ouvrir des fichiers

Créer une connexion CMS, ouvrir une connexion récente, parcourir des fichiers sur des sites
distants a I'aide de leur URL

Acces aux modeles FrameMaker
Acces aux ressources de formation FrameMaker

Acces a I'assistance technique, aux mises a jour des produits, au pole de développement, aux
forums et au contenu marketing

Restauration de la derniére session

Vous pouvez également personnaliser I’écran d’accueil en réorganisant ou en ajoutant des informations
sur cet écran. La personnalisation de I’écran d’accueil se fait en mettant a jour le fichier welcome . html
qui est disponible a I'adresse suivante :

$appdata%\Adobe\FrameMaker\16\resources\welcomeScreen\

L'écran d’accueil, comme le montre l'illustration ci-apreés, s’affiche lors du lancement de FrameMaker en
mode structuré.
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Figure 1:  Ecran de bienvenue

REMARQUE : Pour tirer le meilleur parti du nouvelécran d’accueil, il est recommandé d’utiliser Internet
Explorer 11 ou version ultérieure. Si vous utilisez une version antérieure d’Internet Explorer,
I’écrand’accueil peut sembler déformé.

Acces a I’écran d’accueil

Par défaut, I’écran d’accueil s’affiche au démarrage de FrameMaker. Lorsque vous créez un document
ou ouvrez un document existant, le document s’affiche dans une fenétre a onglets. A ce moment, I’écran
D’accueil est également remplacé par une fenétre a onglets. Vous pouvez accéder a I’écrand’accueil avec
I'onglet de I’écran d’accueil.

Lorsque vous travaillez, vous risquez de fermer I’écran d’accueil. Pour relancer I'écran d'accueil, sélec-
tionnez Afficher I’écran d’accueil dans le menu sélecteur Espace de travail.

RELATED LINKS:
Espaces de travail
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Espaces de travail

Comprendre I'agencement des éléments et des panneaux dans FrameMaker, connaitre les types
d’espaces de travail et leurs fonctionnalités.

Dans ce sujet

. Introduction

] Espaces de travail standard

. Enregistrement d’un espace de travail personnalisé

. Changement d'espace de travail

J Réinitialisation d’un espace de travail

. Changement de nom d'un espace de travail personnalisé

o Suppression d’un espace de travail personnalisé

Introduction

On désigne par I'expression espace de travail un arrangement particulier d’éléments tels que les
panneaux que vous utilisez fréquemment lorsque vous travaillez sur vos documents. Vous pouvez ancrer
ces éléments, les empiler, les réduire ou les rendre flottants a I'intérieur de votre espace de travail. Vous
pouvez sélectionner I'un des espaces de travail prédéfinis ou en créer un. Une fois les panneaux organ-
isés, vous pouvez enregistrer les parametres de I'espace de travail pour un usage ultérieur.

L'interface FrameMaker présente les composants suivants.

J La barre d’application occupe la partie supérieure et contient un sélecteur permettant de basculer
vers un autre espace de travail, des menus, ainsi que d’autres commandes d’application.

. La fenétre de document affiche le fichier sur lequel vous travaillez. Les fenétres de document
peuvent présenter un onglet et, dans certains cas, étre regroupées et ancrées.

. Les panneaux vous permettent de contréler et de modifier votre travail. Il existe par exemple des
panneaux pour la configuration de paragraphes, de caractéres ou de tableaux, ainsi que pour les
marqueurs, les variables et les références croisées. Vous pouvez les réduire, les regrouper, les
empiler ou les ancrer.

. La barre d’état affiche les informations de formatage de texte et de pagination du document actif.
Dans les documents structurés, la barre d’état affiche également le chemin de navigation exact de
I’élément actuellement sélectionné.

Espaces de travail standard

Vous pouvez choisir I'un des espaces de travail standard ou créer des espaces de travail personnalisés et
passer de I'un a I'autre. Les espaces de travail standard sont congus pour vous permettre de passer
rapidement d’un espace de travail a I'autre selon I'opération que vous souhaitez accomplir. Par exemple,
I'espace de travail Révision possede des barres d'outils de révision, des panneaux couramment utilisés
ainsi que des panneaux préarrangés qui facilitent la révision rapide d'un document.

. Création

. Vierge

. Conception
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. Gestion des graphiques
. Révision
. XML/structuré (uniquement disponible sur FrameMaker structuré)

Enregistrement d’un espace de travail personnalisé

1) Configurez I'espace de travail comme vous le souhaitez et sélectionnez Enregistrer I’espace de
travail au moyen du sélecteur dans la barre d’application.

2)  Saisissez un nom pour |'espace de travail. Cliquez sur OK.

D'une session a l'autre, FrameMaker garde en mémoire le dernier espace de travail utilisé. Si vous
travailliez dans I'espace de travail Révision et que vous fermez et relancez FrameMaker, cet espace de
travail Révision est chargé.

Changement d'espace de travail

Pour changer d’espace de travail, sélectionnez un espace de travail dans le sélecteur d’espace de travail
de la barre d’application.

Authering - L= (<3 2
Authoring
Elank
Design
Manage Graphics
Review

KML/Structured

Save workspace
Manage workspace

Reset workspace

Show Welcome Screen

Figure 1:  Utilisez le sélecteur pour basculer entre les différents espaces de travail congus pour votre flux de
production..

Réinitialisation d’un espace de travail

En enregistrant la configuration actuelle des panneaux comme espace de travail nommé, vous gardez la
possibilité de restaurer cet espace par la suite et ce, méme si vous avez déplacé ou fermé un panneau.

Les noms des espaces de travail enregistrés sont visibles dans le sélecteur d’espace de travail de la barre
d’application.

Sélectionnez I'option Rétablir I’espace de travail a I'aide du sélecteur d'espace de travail dans la barre

d'application.

Changement de nom d'un espace de travail personnalisé

1) Sélectionnez I'option Gérer I’espace de travail via le sélecteur d’espace de travail de la barre
d’application.
2)  Sélectionnez I'espace de travail. Cliquez sur Renommer.
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3)  Entrez un nouveau nom. Cliquez deux fois sur OK.

Suppression d’un espace de travail personnalisé

Sélectionnez Gérer l'espace de travail dans le sélecteur de I'espace de travail de la barre d'application,
sélectionnez I'espace de travail, puis cliquez sur Supprimer.
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Fenétre de document

Familiarisez-vous avec la fenétre de document et les documents onglets dans Adobe FrameMaker.

Une fenétre de document s'affiche lorsque vous ouvrez un document structuré ou FrameMaker. Elle
contient le document avec le texte mis en forme, ses dessins et autres éléments, le tout sous la forme
d’une page. Si plusieurs documents sont ouverts, une fenétre de document s'affiche pour chacun d'eux.

La fenétre de document est la seule fenétre disponible dans I'espace de travail FrameMaker standard.
Dans I'espace de travail FrameMaker structuré, vous pouvez également voir les limites d'éléments dans
la fenétre de document.

Documents en onglets

Les fenétres de document comportent des onglets lorsque plusieurs fichiers sont ouverts. Vous pouvez
ouvrir des documents sous forme de fenétres flottantes en supprimant I'option Ouvrir les documents
sous forme d’onglets dans Préférences > Interface > Générale.

Untitledl.fm x | Untitled2fm x | Untitled3.fm x |
lo_. 1 . [1 1 . 2, 1 . 3, 1
i EUIL} AT T AT
N Zip Code
5] Dear Sir:
) Ridebis, et licet rideas. Ego ille «
fmmam s Bl e U Gam oman mim b ol emmdi o

Figure 1: Les documents apparaissent sous forme d’onglets dans la Vue de document

Toutefois, lorsque vous ajoutez un fichier généré, comme une Table des matieres, le fichier généré
s’affiche sous forme réduite en bas a gauche de votre espace de travail. Vous pouvez organiser les
fenétres de documents flottantes et a onglets de plusieurs facons.

. Pour ancrer une fenétre de document a un groupe de fenétres de document, faites glisser cette
fenétre dans le groupe.

. Pour modifier I'ordre des onglets de la fenétre de document, faites glisser un onglet de la fenétre
a 'emplacement voulu dans le groupe.

. Pour annuler I'ancrage d’une fenétre de document a un groupe de fenétres, faites glisser I'onglet
de cette fenétre hors du groupe.

REMARQUE : lorsque vous réduisez une fenétre de document flottante, celle-ci recouvre une partie
de la barre d'état de FrameMaker. Vous ne pouvez pas déplacer la fenétre réduite a un nouvel
emplacement.

Vous pouvez effectuer diverses autres taches a partir du menu contextuel d’'un document a onglets.
Cliguez avec le bouton droit sur la fenétre du document a onglets pour effectuer les taches suivantes :

. Consolidation de toutes les fenétres de document

. Fermeture de I'onglet sélectionné ou de tous les documents ouverts
. Déplacement de I'onglet sélectionné dans une nouvelle fenétre

. Ouvrir I'Explorateur Windows ou le fichier est stocké
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Créer un document
Ouverture d'un document
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Panneaux

Découvrez les panneaux Adobe FrameMaker livres et les dispositions possibles dans un espace de travail.
Les panneaux sont des panneaux flottants avec une interface congue pour simplifier votre travail.

FrameMaker fournit les panneaux clés suivants :
. Panneau de balises conditionnelles

. Panneau Références croisées

. Panneau de marqueurs

. Panneau de polices

L Panneau Encarts

. Panneau de variables

. Panneaux de références

J Panneau Ouvrir les fichiers

. Réviser les commentaires

B F 7 W ul RS C
']

Search tesd |

D Marker Text Mar... Docum... = Page Element Tag &)
13357 HZ2_Heading2: 1.3.1 ... Cross-Ref General-Des... 13 <lUnstructured:
20034: H2_Heading?: 1.3.2 ... Cross-Ref Geneml-Des... 18 <Unstructured:
21943 H1_Heading1: 1.1 Hi... Cross-Ref General-Des... 8 <Unstructured >
22811: H1_Heading1: 1.20... Cross-Ref Geneml-Des... 11 <Unstructured:
24113: H2_Heading2: 133 .. Cros§ Marker Text: 22811: H1_Headingl: 1.2 Overview
68397 H1_Heading1: 1.3 P... Cros§ Marker Type: Cross-Ref
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drink dispenser Indes| Fage 11
ight overviewhistory of fight  Ind Elernent Tag: <Unstructured >
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_E:tnDbjedld 2 9996382 Hypernexd General-Des... 7 <Unstructured >
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Figure 1: Interface de panneau

A. Entrées dans le panneau Recherche : a mesure que vous tapez, FrameMaker recherche des correspon-
dances dans toutes les colonnes et les affiche. B. Boutons de la barre d’outils spécifique au panneau. C.
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Filtre pour choisir le document actif, tous les documents ouverts ou un document spécifique. D. Les
fleches sur les en-tétes de colonnes indiquent I'ordre de tri E. Zone de liste du panneau F. Info-bulle G.
Les détails de chaque occurrence incluent I'emplacement. Vous pouvez personnaliser I’'emplacement a
I'aide de la boite de dialogue Critéres d’emplacement des panneaux.

REMARQUE : Par défaut, les panneaux s’ouvrent dans la zone de liste du panneau dans le volet de droite.
Si vous déplacez les panneaux, FrameMaker mémorise I’emplacement des panneaux. La prochaine fois
gue vous lancez le panneau, il s’affiche au dernier emplacement mémorisé.

Fermer les panneaux et les groupes d'onglets

Les panneaux disposent d’'un bouton a droite de la barre de titre sur lequel vous pouvez cliquer pour
fermer un panneau ou un groupe d’onglets (groupe de panneaux).

Document

g Close
search text Close Tab erp
Untitled 1 fm

Untitled 1 fm £
Unttled 1 fm
Untithed 1 fm
Untitled 1 fm
Untitled 1 fm

Figure 2: Fermer les panneaux et le groupe d'onglets
. Fermer : ferme uniqguement le panneau actif (le panneau Marqueurs dans ce cas)
] Fermer le groupe d'onglets : ferme tous les panneaux dans le groupe d'onglets

En outre, en cliquant deux fois sur le titre d’'un panneau, vous pouvez réduire ou agrandir ce panneau
ainsi que le groupe d’onglets dont il fait partie.

Zone de liste du panneau

Le menu déroulant Sélectionner affiche la liste de tous les documents ouverts, notamment les livres et
les mappages DITA.

Sivous sélectionnez Tous les documents ouverts, la zone de liste du panneau affiche toutes les variables
de tous les documents ouverts. Si vous sélectionnez un document ouvert spécifique, la zone de liste du
panneau affiche les variables du document sélectionné, méme si vous passez a un autre document
ouvert. La zone de liste du panneau continue d'afficher les occurrences correspondant au document
sélectionné.

Si vous sélectionnez I'option En cours, la zone de liste du panneau affiche la liste de toutes les occur-
rences du document sélectionné. Lorsque vous passez d'un document ouvert a I'autre, la zone de liste
est actualisée. Cependant, lorsque vous passez d'un panneau a l'autre, vous devrez peut-étre cliquer sur
Actualiser.

Si vous sélectionnez un document ouvert (<filename>) :
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. Cliquez sur une occurrence dans le panneau pour afficher I'occurrence correspondante dans le
document. Par exemple, si vous sélectionnez une occurrence d'image dans le panneau Encarts,
I'image correspondante est également sélectionnée dans la vue de document.

. Cliquez deux fois sur une occurrence pour effectuer les opérations suivantes pour chaque
panneau :

Les panneaux suivants sont disponibles :

Panneau de balises conditionnelles
Affiche le panneau Ajouter/modifier une balise conditionnelle pour la condition sélectionnée.

Panneau de références croisées

Affiche le panneau Référence croisée pour la modification de la référence croisée sélectionnée.

Panneau de marqueurs
Affiche le panneau Marqueurs afin que vous puissiez modifier la définition de marqueur sélec-
tionnée.

Panneau de polices
Affiche le panneau Remplacer la police pour sélectionner une police de remplacement.

Panneau Encarts

Affiche le panneau Caractéristiques de I'objet pour I'encart sélectionné.

Panneau de variables

Ajoute la variable sélectionnée au point d'insertion dans le document en cours.

Panneau de zones réactives

Affiche le panneau des Zones réactives pour la modification de la zone réactive sélectionnée.

Ouvrir les fichiers
Vous permet de gérer et de naviguer a travers un grand nombre de fichiers ouverts.
REMARQUE : Cliquez sur le nom d'une colonne pour trier les données de la zone de liste dans I'ordre crois-
sant ou décroissant.
Panneau de console

Affiche le panneau Console qui dresse la liste des avertissements et des messages d’erreur.

Panneau de références
Affiche les résultats de la recherche pour les emplacements ol un élément particulier est
référencé. Ce panneau concerne uniquement les documents DITA.

Réviser les commentaires

Affiche et vous permet de gérer les commentaires de révision recus des réviseurs.
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Barres d’outils

Découvrir les types de barres d’outils, les icones de barres d’outils, les préférences et la personnalisation
des barres d’outils dans Adobe FrameMaker.

Dans ce sujet

o Introduction

J Icones de la barre d’outils

. Définition des préférences d’icénes de barres d'outils
. Personnalisation des icénes de barre d’outils

Introduction

Vous pouvez accéder a toutes les commandes souvent utilisées dans les barres d’outils suivantes, pour
vous en servir dans les documents structurés ou non structurés : Vous pouvez afficher une barre d’outils
a partir du menu Afficher > Barres d’outils.

barre d’outils Graphiques
Fournit des raccourcis de création et d’édition graphique.

Barre d'acces rapide
Fournit des commandes permettant d’ouvrir et d’enregistrer les documents et de modifier le texte,
les graphiques et les tableaux.

Barre d’outils Interface structurée
Fournit des commandes pour I'utilisation de document structuré, telles que Ajouter un document
XML, Ouvrir le catalogue d’éléments, Modifier les attributs, etc.

Formatage de texte
Fournit des commandes de formatage de texte, comme les styles de police.

Formatage de tableau
Fournit des commandes de manipulation de tableau : insertion de lignes et de colonnes, fusion de
cellules et options d’alignement de texte pour les cellules de tableau.

Formatage de paragraphe
Fournit des commandes de formatage de paragraphes : taquets de tabulation, alignement du texte,
espacement et listes des styles de paragraphes.

barre d'outils d'insertion rapide
Fournit des commandes d’insertion et d’enchainement d’éléments structurés courants de docu-
ment.

Alignement d'objets

Fournit des commandes permettant de modifier la séquence, I'alignement et I'orientation des
objets.
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Caractéristiques de I'objet
Fournit des commandes permettant de grouper les objets, de modifier I'ordre des calques, de
modifier la forme et |’échelle des objets et de les accrocher sur la grille.

Suivi des modifications du texte

Fournit des commandes de suivi, d’acceptation et de refus des modifications de texte.

Barre d’outils de direction

Fournit des commandes pour |'utilisation des documents bidirectionnels.

Vous disposez également de raccourcis clavier pour toutes les commandes présentes dans les barres
d’outils et les menus.

Icones de la barre d’outils

FrameMaker vous propose un ensemble prédéfini d’icbnes en niveaux de gris et de couleur. Ces icones
sont redimensionnées en fonction de la résolution de votre périphérique d’affichage. Par défaut,
FrameMaker utilise des icones en niveaux de gris. Vous pouvez passer aux icones de couleur en modifiant
le parameétre Icones dans la boite de dialogue Préférences.

Définition des préférences d’icones de barres d'outils

Définissez vos préférences d’icones de barres d'outils pour choisir des icones de couleur ou en niveaux
de gris :

1) Choisissez Edition > Préférences.

2) Danslaboite de dialogue Préférences, sélectionnez Interface et choisissez les préférences relatives
aux Icones - Niveaux de gris ou De couleur.

3) Redémarrez FrameMaker pour appliquer les préférences des icones.

Personnalisation des icones de barre d’outils

Vous pouvez également ajouter vos propres icones personnalisées dans FrameMaker. Vous devez mettre
ajour le fichier . xm1 de la barre d’outils. Ce fichier est disponible a deux emplacements : dans I’'emplace-
ment d’installation de FrameMaker et dans le dossier $appdata%. Si vous souhaitez enregistrer défini-
tivement votre barre d’outils personnalisée, vous devez mettre a jour le fichier de la barre d’outils situé
dans I'emplacement d’installation de FrameMaker. Sinon, vous pouvez également mettre a jour les fich-
iers de la barre d’ outils disponibles dans le dossier ¢ AppData%.

Par exemple, si vous voulez mettre a jour la barre d’outils Elément rapide dans la vue WYSIWYG, vous
pouvez mettre a jour le fichier quick element.xml situé a cet emplacement :

<Fm install location>\fminit\WorkSpaces\Structured\WYSIWYGView\toolbars

La méthode préférée est de mettre a jour les fichier de la barre d’outils dans le dossier de préférences
de l'utilisateur (¥appdata%):

C:\Users\<username>\AppData\Roaming\Adobe\FrameMaker\<version>\Work-
Spaces\Structured\WYSIWYGView\toolbars
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De méme, vous devez spécifier le chemin du référentiel image de I'icbne dans le fichier maker.ini.
Dans le fichier maker. ini, utilisez la propriété ToolbarCustomImageDir pour spécifier le chemin
de base de votre répertoire d’icones. Encore une fois, le fichiermaker. ini est disponible a 'emplace-
ment d’installation de FrameMaker et dans votre dossier Sappdata%. Si vous spécifiez le chemin de
base aux deux emplacements, FrameMaker donne la priorité a I'emplacement spécifieé dans le fichier
%appdata%$\Adobe\FrameMaker\<version>\maker.ini.

Effectuez les étapes suivantes pour personnaliser les icOnes de la barre d’outils dans FrameMaker :
1) Créez et placez tous les fichiers d’icone dans votre systéme. Vous pouvez stocker des icones dans
n‘importe quel emplacement, y compris le dossier $appdata%.

2) Indiquez le chemin de base du répertoire d’icones dans la propriété ToolbarCustomImageDir
dans le fichiermaker. ini. Par exemple, si vos icones sont stockées dans la structure de dossiers
suivante :

v custom
v icons
v structured
v toolbar
Feature-A
Feature-B

Feature-C

Figure 1: Exemple de structure de dossier pour stocker les icOnes personnalisées
Vous devez alors spécifier le chemin de base suivant : C: \custom\icons\structured\tool-
bar.

3) Recherchez le fichier . xm1 de la barre d’outils correspondant a votre affichage et a votre mode et
ouvrez-le pour le modifier.

4)  Recherchez I'élément <ACTION> correspondant a I'icone que vous souhaitez personnaliser. Un
échantillon du code d’élément<ACTION> est indiqué ci-dessous :
<ACTION command="CenterPara">
<images base="Feature-B/P TextAlignCenter Md"/>

5) Ajoutez le nom de base de I'icone dans I'attribut de @base de I'élément d’images.

REMARQUE : Dans notre exemple, les icOnes sont situées dans les sous-répertoires, nous devons
donc spécifier le chemin relatif.

6) Créez au moins six images d’icone pour différents niveaux de zoom du moniteur. Les niveaux de
zoom pris en charge sont 100 %, 150 % et 200 %. Pour chaque niveau de zoom, vous devez avoir
deux images : une pour le mode activé et I'autre pour le mode désactivé.

Le tableau suivant répertorie les noms et les dimensions des icénes pour I'utilisation d’icénes en
niveaux de gris personnalisées. Par exemple, si le nom de base de votre ic6ne est xyz, vous pouvez
avoir six fichiers image pour les combinaisons possibles de niveaux de zoom suivantes :
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Noms d’icone
Niveau de Taille d’icone recommandée
zoom Activé Désactivé en pixels
100 % XyZ.png xyz D.png 18x18
150% xyz 3TO2X.png xyz D 3TO2X.png 27x27
200% xyz 2X.png xyz D 2X.png 36x36

Notez que pour les icbnes désactivées, D doit étre spécifié dans le nom de fichier comme indiqué
dans le tableau ci-dessus. De méme, pour un niveau de zoom de 150 %, 3TOZ2X est spécifié dans le
nom de fichier et 2X est spécifié pour les icbnes a utiliser au niveau de zoom de 200 %.

Sivous souhaitez utiliser des ic6nes de couleur, nommez les fichiers en utilisant la syntaxe suivante :
<base-name> C <zoom-level>.png

La syntaxe mentionnée ci-dessus est destinée aux icones Activé. Pour créer des icones Désactivé, uti-
lisez la syntaxe d’attribution de nom de fichier suivante :

<base-name> C D <zoom-level>.png

RELATED LINKS:
Raccourcis clavier
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Catalogues dynamiques

Découvrez comment utiliser un catalogue dynamique dans Adobe FrameMaker.

Vous pouvez utiliser le Catalogue dynamique comme raccourci pratique vers les catalogues disponibles
dans FrameMaker. Par exemple, pour définir un style de paragraphe dans un document, vous utilisez le
Catalogue dynamique pour rechercher et sélectionner le style de paragraphe nécessaire. Dans les docu-
ments structurés, vous pouvez facilement retrouver les éléments et les attributs requis a insérer dans le
document.

Voir la vidéo Catalogues dynamiques.

Pour utiliser le catalogue dynamique:
1)  Placez le curseur a I'emplacement souhaité dans le document.

Par exemple, pour les styles de caractéres et de paragraphes, placez le curseur a l'intérieur d'un
paragraphe. Pour des éléments et des attributs dans un document structuré, placez le pointeur a
I’'emplacement d’insertion d’un élément dans la Vue de la structure.

2)  Appuyez sur la touche de raccourci du catalogue dynamique. Voir les touches de raccourci du cata-
logue dynamique définies ci-dessous.

La boite de dialogue du catalogue dynamique s’affiche.

<TEXT=> »
abbreviated-form {(Abbreviated Form)

apiname (APl Name)

b (Bold)

boolean (deprecated)

cite (Citation—bibliographic source)
cmdname (Command Name)

codeblock (Code Block)

codeph (Code Phrase)

data (Data element) v

T e T T T

Figure 1:  Catalogue dynamique « Insérer un élément » dans Adobe FrameMaker
Le pointeur se trouve maintenant dans la zone de texte située en haut de la boite de dialogue.

3)  Pourrechercher un élément dans le catalogue actuel, saisissez le nom ou la description de
I’élément. Au cours de la saisie, le contenu de la liste dans la boite de dialogue s'affine.

Par exemple, si vous souhaitez insérer un élément de liste dans un document structuré, vous pouvez
saisir le nom de I'élément de la liste :<ul><ol>ou<dl>. Cependant, vous pouvez également saisir
la description de I’'élément et la liste est réduite dans la boite de dialogue a tous les éléments de liste
disponibles dans le Catalogue d’éléments.
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list

dl {Definition List)

ol {Ordered List)
parml (Parameter List)
sl (Simple List)

ul (Unordered List)

L.

Figure 2: Filtrage d'éléments dans le catalogue dynamique « Insérer un élément »

REMARQUE : La liste d'éléments affichés dans la boite de dialogue est limitée a dix. Si la liste dépasse dix,

vous pouvez utiliser la barre de défilement pour parcourir la totalité de la liste.

Table 1: Touches de raccourci du catalogue dynamique

Raccourci boite de dialogue Catalogue dynamique S’applique a...
F8, ctrl+8 Catalogue de caractéres Structuré et non structuré
F9, ctrl+9 Catalogue de paragraphes Structuré et non structuré
Ctrl+1 Catalogue d'éléments Structuré
Ctrl+2 Enchainer un élément Structuré
Ctrl+3 Modifier un élément Structuré
ctrl+4 Appliquer la condition Structuré et non structuré
ctrl+5 Supprimer la condition Structuré et non structuré
ctrl+7 Attributs Structuré
échap+qg+o Catalogue de styles d’objet Structuré et non structuré
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recherche de commande

Découvrez comment utiliser la fonctionnalité Recherche de commande dans Adobe FrameMaker.

Il'y a des centaines de commandes dans FrameMaker et chaqgue commande exécute une tache
spécifique. Parfois, il est difficile de trouver la tache souhaitée a partir du menu principal. FrameMaker
vous permet de trouver plus facilement une tache a 'aide de la fonctionnalité Fonctionnalité Recherche
de commande. Cliquez sur I'icone en forme de loupe dans la barre d’application pour ouvrir la fonction
Recherche de commande. Vous pouvez également utiliser la touche de raccourci F7 :

1 |
Merge with last element (Esc EM) Element > Merge Into Last
Merge elements (Esc Em) Element > Merge
SiD_CustomizeDitaHtml Structure > DITA > Customize DITA > Customize DITA shell
Insert image (Escfii) Insert > Image..
SiD_BackupUserDir Structure = DITA » Customize DITA > Backup Customizations
SiD_RestoreUserDir Structure > DITA » Customize DITA > Restore Customizations
Create a new DITA glossary group (Esc N T &) File > New > DITA > <glossgroup>
Open graphic runaround Properties (Esc g R) Graphics » Runaround Properties..,
Create a new DITA glossary entry (Esc N T5) File » New > DITA > <glossentry>
Open Character palette  Insert > Character » Character Palette...

Figure 1: Recherche de commande dans FrameMaker

Lorsque vous commencez a taper le nom de la tache que vous voulez exécuter, les commandes
disponibles sont filtrées. Par exemple, si vous saisissez un paragraphe, seules les commandes qui vous
permettent de travailler avec un paragraphe sont affichées dans les panneaux Recherche de commande.

:| paragrapﬂ
Apply 1.5 line spacing in paragraph (Esc)
Apply custom spacing between paragraphs (Escjw)
Apply custom line spacing in paragraph (Esc ju)
Update paragraph format (Esc o p u)
Create a new paragraph format (Escopn)
Add list of paragraphs (Esclo p) Insert = List Of > Elements Paragraphs..
Add alphabetical paragraph list {Esclo P} Insert = List Of = Elements Paragraphs (Alphabetical)...
Left align paragraph (Escj )
Center align paragraph (Escjc)
FocusinParagraphDesigner (Esc Fi p) View = Focus = Focus In Paragraph Designer

Figure 2: Exemple de recherche de commande : Recherchez le paragraphe

Vous pouvez choisir une commande dans la liste et appuyer sur Entrée pour exécuter la commande sélec-
tionnée. Le panneau Recherche de commandes montre également la séquence de touche Echap et le
chemin du menu de I'exécution de la commande.
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Barre d’état

Découvrez comment utiliser la barre d’état dans Adobe FrameMaker.

Dans ce sujet

. Introduction

. Zoom avant et arriére

. Passage d’une page a I'autre et définition du défilement
. Navigation dans les pages d'un document

Introduction

La barre d'état d'Adobe FrameMaker fournit les contrdles de navigation, les informations de pagination
et les contrdles de zoom.

A BCD EF G H I

Fow: A E: concept > conbody > p 4 4|2 » M Zof30" 32 PO = 100% “ -l-‘

Figure 1:  Controles de navigation de la barre d'état

A Enchainement de page et chemin de navigation des éléments (structuré) ou style de paragraphe (non
structuré) B Premiere page C Précédent D Aller a la page numéro E Suivant F Derniere page G Aller a la
ligne numéror H Aller au point d'insertion | Controles de zoom

Zoom avant et arriére

. Pour augmenter ou diminuer I'agrandissement du texte et des objets, cliquez sur les boutons +
(Augmenter le zoom) ou — (Diminuer le zoom) de la barre d’état. FrameMaker effectue un zoom
avant ou arriére sur la zone de la page contenant le point d'insertion ou la sélection. S'il n'y pas de
point d'insertion ni de sélection, FrameMaker effectue un zoom avant sur le centre de la page.

] Pour afficher du texte et des objets avec un agrandissement précis, sélectionnez un pourcentage
dans la liste déroulante Zoom.

. Pour afficher toute la page dans la fenétre en cours, sélectionnez Adapter la page a la fenétre dans
la liste déroulante Zoom.

. Pour adapter la page ou la zone de texte a la fenétre, sélectionnez Adapter la fenétre a la page ou
Adapter la fenétre a la zone de texte dans la liste déroulante Zoom. Si les options d'affichage sont
définies pour afficher deux pages en regard, la fenétre est redimensionnée pour contenir deux
pages cOte a cote.

. Pour modifier les parameétres de zoom disponibles, cliquez sur Définir dans la liste déroulante
Zoom, sélectionnez le pourcentage a modifier et entrez le nouveau pourcentage. Entrez une valeur
entre 25 et 1 600 %. Cliquez sur Définir. Pour revenir aux pourcentages par défaut, cliquez sur
Rétablir défaut.

REMARQUE : Le niveau de zoom par défaut est défini en fonction de la résolution de votre périphérique
d’affichage.
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Passage d’une page a I'autre et définition du défilement

Vous pouvez définir comment FrameMaker affichera les pages que vous faites défiler de haut en bas, de
gauche a droite, ou par deux.

1)

2)
3)

4)

Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

Sélectionnez Options > d’affichage.
Choisissez I'une des options suivantes dans la liste déroulante Défilement :

- Pour afficher des pages du haut vers le bas (par exemple, la page 2 au-dessous de la page 1),
sélectionnez Vertical.

- Pour afficher des pages de gauche a droite (par exemple, la page 2 a droite de la page 1),
sélectionnez Horizontal.

- Pour afficher deux pages a la fois cote a cote, sélectionnez Pages en regard.

- Pour afficher autant de pages que possible dans la fenétre de la gauche vers la droite, sélec-
tionnez Variable.

Cliquez sur Définir-

Navigation dans les pages d'un document

Pour naviguer dans une fenétre de document, utilisez les contréles de la barre d’état.

Procédez de I'une des facons suivantes :

Pour accéder a la page suivante, cliquez sur le bouton Page suivante.

Pour accéder a la page précédente, cliquez sur le bouton Page précédente.

Pour accéder a la premiere page du document, cliquez sur le bouton Premiére page.
Pour accéder a la derniere page du document, cliquez sur le bouton Derniére page.

Pour accéder a une page spécifique, cliquez dans la zone Numéro de page et tapez le numéro de la
page a afficher.

Pour accéder a un numéro de ligne spécifique, cliquez dans la zone Numéro de ligne et tapez le
numéro de la ligne a afficher.

Pour accéder a la page contenant le point d'insertion, cliquez sur le bouton Point d'insertion.
Pour vous déplacer rapidement d'une page a l'autre, faites défiler verticalement.

Si le document que vous parcourez fait partie d'un livre ouvert, FrameMaker affiche parfois un message
d'alerte vous invitant a ouvrir le document suivant ou précédent du livre. Si, par exemple, vous cliquez
sur Page précédente sur la premiére page d'un document, en cliquant sur Oui vous ouvrez le document
précédent du livre. FrameMaker affiche alors la derniére page de ce document.

CoNSsEIL : Dans le cas de documents structurés, sélectionnez un élément dans la Vue de la structure pour
afficher la page correspondante dans la fenétre du document.
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Options d'affichage

En savoir plus sur les différentes options de visualisation et d’affichage dans Adobe FrameMaker.

Dans ce sujet

. Options d'affichage

. Unités

. Unités de polices

. Régles et grille

. Numéros de ligne

] Guides visuels

o Symboles de texte

. Sous-ensemble de commandes de menu
. Espace de travail a contraste élevé
. Affichage plus rapide des pages

Options d'affichage

REMARQUE : Les regles, les grilles, la bordure des objets, les symboles de texte et les graphiques sont des
propriétés de session et non des propriétés de documents. lls ont un impact sur tous les documents
ouverts pendant la session en cours.

Dans Adobe FrameMaker, certaines zones de texte de boites de dialogue requierent une unité de mesure
(telle que des points ou des pouces) pour la valeur que vous entrez.

Vous pouvez spécifier les unités par défaut pour la taille de la police et I'espacement des lignes (unités
de taille de la police) et pour les autres mesures (unités d'affichage) dans la boite de dialogue Options
d’affichage.

Les unités de mesure par défaut s’affichent aprés les valeurs dans les zones de texte des boites de
dialogue.

Vous pouvez saisir des formes courtes et longues d’unités dans des zones de texte des boites de
dialogue :

. pc, pi or pica pour les picas

. pt ou point pour les points

. px pour les pixels

. dd pour les didots

. cc ou cicéro pour les cicéros

J Q pour les unités Q (se réfere a la taille de police et a I'interligne pour la langue japonaise
seulement).

Si vous entrez une valeur sans unité de mesure dans ces zones de texte, FrameMaker utilise 'unité par
défaut.

Si vous saisissez une valeur avec une unité différente de I'unité par défaut définie dans les Options d’affi-
chage, FrameMaker recalcule automatiquement la valeur par défaut. Par exemple, si les unités d’affi-
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chage de votre document sont des picas et que vous souhaitez définir un retrait de paragraphe de
1 pouce, saisissez 1" dans la boite de dialogue Premier retrait de la Configuration de paragraphe.

Lorsque vous cliquez sur Appliquer, la mesure se modifie pour refléter le nombre de picas correspondant
a 1 pouce.

Sélectionnez Affichage > Options... pour ouvrir la boite de dialogue Options d’affichage.

Figure 1:

Unités

Sélectionnez les valeurs pour Unités. Vous pouvez choisir entre les unités par défaut suivantes :

cm (centimetres)
mm (millimetres)
Pouce

Pica

Point

Didot

Cicéro

Pixel

Cliquez sur Définir-

View Options
Page Scrolling:
Units:
Display Units:
Font Units:
Snap:
[_] Grid Spacing:
Rotation:
Display:
[_|Rulers:
[ ] Grid Lines:
Borders on Objects
Text Symbols
Graphics

Set

X
Variable v
Inch »
Point ~

0,125"

0,25 g

1/8" v

172" »
Cancel

Boite de dialogue Options d'affichage
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Unités de polices

Choisissez les valeurs pour les Unités de polices. Vous pouvez choisir entre les unités par défaut
suivantes :

. Point
. Q (pour le japonais seulement)

Cliquez sur Définir-

Regles et grille

Sélectionnez un parametre dans la liste déroulante Régles et dans la liste déroulante du Grille.
Cliguez sur Définir-

Numéros de ligne

Sélectionnez Affichage > Numéros de ligne pour afficher/masquer les numéros de ligne.

Les numéros de ligne dans les fichiers FrameMaker vous aident a identifier les lignes particuliéres de
contenu. Les numéros de ligne sont définis au niveau du document (pour un fichier. fm) et apparaissent
avant chaque ligne insérée dans un document FrameMaker.

>:Line numbers in FrameMaker file
:set at a document level (for a .fm 1
siument.

Figure 2: Numéros de ligne et barres de modification tels qu’affichés dans un document FrameMaker

Remarques concernant les numéros de ligne

. Prise en charge des formats a colonnes et enchainements multiples : pour les fichiers avec des
formats a colonnes multiples, les numéros de ligne s'affichent pour le texte dans chacune des
colonnes. Pour les documents a enchainements multiples, les numéros de ligne sont calculés en
fonction des enchainements du texte et continuent en conséquence.

. Adaptation du calcul : lorsque vous insérez du texte dans un paragraphe et que les numéros de
ligne sont activés, les numéros de ligne sont recalculés afin de prendre en compte le nouveau texte.

. Propriété au niveau du document : les numéros de ligne sont une propriété au niveau du docu-
ment, vous pouvez donc activer/désactiver cette fonctionnalité pour un document (fichier . £m).
Les numéros de ligne peuvent étre configurés au niveau d’un document pour continuer dans la
suite de la page précédente ou redémarrer a chaque page.

] Enchainements de texte : pour les documents a enchainements multiples, les numéros de ligne
suivent les enchainements de texte et sont calculés en conséquence.

. Documents XML : les numéros de ligne ne sont pas conservés dans les documents XML. Vous
pouvez toutefois activer les numéros de ligne dans le modele de I'application.
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. Impression : les numéros de ligne sont visibles dans le document imprimé et dans le document PDF

créé a l'aide de I'option Enregistrer au format PDF.

Lors de I'utilisation des numéros de ligne et des barres de modification, assurez-vous qu’ils ne se
chevauchent pas.

Pour afficher les numéros de ligne, procédez comme suit :

1) Choisissez Format > Document > Numéros de ligne. La boite de dialogue Propriétés de numéros de

ligne est affichée :

Line Number Properties X
Width:  [UER ‘
Font:  Segoe Ul Symbol ~
Size: ‘7,0 pt v ‘
Color: Dark Grey w7

[ | Restart at Each Page

[ ]Show line humbers

Set Cancel

Figure 3: Boite de dialogue de propriétés de numéros de ligne

2) Dans la boite de dialogue Propriétés de numéros de ligne, sélectionnez Afficher les numéros de
ligne et spécifiez les parametres suivants :

Largeur : distance entre les numéros de ligne et la colonne. La distance dépend des colonnes qui
contiennent du texte.

Police : police des numéros de ligne.
Taille : taille des numéros de ligne.
Couleur : couleur des numéros de ligne.

Redémarrer a chaque page : I'activation de cette option fait redémarrer la série de numéros de
ligne a chaque page.
Afficher les numéros de ligne : sélectionnez cette option pour afficher les numéros de ligne.

3)  Cliquez sur Définir-

Guides visuels

Vous pouvez afficher plusieurs guides visuels dans une fenétre de document :

. Bordures autour des zones de texte, des cadres graphiques et des objets importés
] Marqueurs, marque de paragraphe (1)) et autres symboles dans le texte en cours
. Reégles sur les cotés supérieur et latéral gauche de la fenétre
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Vous pouvez en outre afficher une grille composée de lignes verticales et horizontales pour dessiner,
redimensionner et aligner des graphiques. Les guides visuels n’apparaissent pas a I'impression. Il est
donc inutile de les masquer lorsque vous imprimez. Activez la fenétre de document ou de livre qui vous
intéresse.

Procédez comme suit :

. Pour afficher ou masquer les bordures, sélectionnez Affichage > Bordures.

. Pour afficher ou masquer les régles, sélectionnez Affichage > Régles.

. Pour afficher ou masquer les grilles, sélectionnez Affichage > Grilles.

o Pour afficher les limites d’éléments, sélectionnez Affichage > Limites d’éléments ou Limites
d’éléments (comme étiquettes) dans FrameMaker structuré. FrameMaker bascule automatique-
ment entre ces deux options.

IMPORTANT : Les guides visuels affectent tous les documents ouverts de la session en cours. Dans les
versions précédentes de FrameMaker, les guides visuels s’appliquaient uniquement au document sélec-
tionné.

Symboles de texte

Pour afficher ou masquer les symboles de texte, sélectionnez Affichage > Symboles de texte.

Symbole de texte Signification
9 Fin de paragraphe
§ Fin d'enchainement et fin de cellule de tableau
) Tabulation
L Cadre ancré et ancre de tableau
T Marqueur
[ Retour forcé
| Point d'alignement manuel d'équation
u Espace insécable
—_ Tiret de césure facultative
— Césure insécable

Sous-ensemble de commandes de menu

Vous pouvez afficher des sous-ensembles de commandes de menu appelés menus courts. Ces derniers
ne comportent pas de commandes permettant de formater du texte, de modifier certains aspects des
graphiques, ni d’'insérer des objets tels que des marqueurs et des variables.

Si une partie de I'ensemble des commandes de menu n’est pas visible, les menus courts sont probable-
ment affichés.
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REMARQUE : si vous utilisez un document structuré, le développeur de I'application a la possibilité de
modifier les commandes disponibles dans les menus longs.

. Pour afficher les menus rapides, sélectionnez Affichage > Menus > Rapide.
] Pour restaurer le menu complet, sélectionnez Affichage > Menus > Complet.

. Pour personnaliser les menus, ajoutez, déplacez ou supprimez des menus et commandes comme
indiqué dans le manuel en ligne Personnalisation de FrameMaker sur le site Web d’Adobe,
www.adobe.com/go/Ir_FrameMaker_support_fr.

Espace de travail a contraste élevé

Adobe FrameMaker utilise les couleurs systéme pour tracer les arriere-plans de fenétres, le texte et
autres éléments graphiques. Les utilisateurs qui éprouvent des difficultés a discerner les couleurs et vari-
ations de contraste ou qui possédent une faible acuité visuelle peuvent définir des schémas de couleurs
a contraste élevé ou personnaliser les couleurs du texte et de 'arriére-plan pour faciliter la visualisation
des informations dans I'interface.

Pour configurer les options d’accessibilité dans Windows, définissez les options d’accessibilité dans le
panneau de configuration de Windows.

REMARQUE : FrameMaker ne peut pas régler les couleurs de tous les éléments. Il s’agit notamment de la
couleur d’arriére-plan et de la couleur de remplissage des objets graphiques.

Affichage plus rapide des pages

Pour afficher des pages plus rapidement :

. Ouvrez le document en ignorant la mise a jour des graphiques importés, des références croisées et
des encarts de texte. L'ouverture d’'un document sans mettre a jour les références est plus rapide,
mais peut ralentir I'affichage individuel des pages.

. Désactivez I’affichage des graphiques en sélectionnant Affichage > Options. Supprimez la sélection
de I'option Graphiques. Cliquez sur Définir-

IMPORTANT : Si vous désactivez I'option Graphiques et que vous générez un PDF, les graphiques
n'apparaissent pas dans le fichier PDF.

. Affichez le texte de petite taille sous forme de barres grises en choisissant Fichier > Préférences >
Général. Entrez une taille de point dans la zone Simuler texte plus petit. Cliquez sur Définir.
Lorsque votre document comporte du texte dont la taille en points est plus petite que celle que
vous avez définie dans cette zone, les caracteres s'affichent sous la forme d'une barre grisée.
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Préférences de FrameMaker

Apprenez a utiliser la boite de dialogue la boite de dialogue Préférences pour modifier différents
parameétres Adobe FrameMaker.

Utilisez la boite de dialogue Préférences (Edition > Préférences) pour modifier les paramétres de
FrameMaker. Les parameétres sont classés dans les sections suivantes :

. Global : cette section vous permet de configurer des parameétres pour l'interface du produit,
I'importation de graphiques, les info-bulles, les messages d'avertissement et d'alerte, les panneaux,
les scripts de démarrage et |'intégration de Dropbox.

. CMS (Systéme de gestion de contenu) : cette section vous permet de configurer les parametres
pour travailler avec les CMS pris en charge.

] Orthographe : cette section vous permet de configurer des parameétres pour les dictionnaires pris
en charge, les guillemets ouvrants/fermants et les options de vérification de I'orthographe.

. XML : cette section vous permet de configurer I'apparence de la vue XML.

J MathML : cette section vous permet de configurer le chemin d’installation de MathML, les infor-
mations de licence et d’autres options connexes.

Preferences X
= Global Product Interface: Compatibility
General
" |Structured FrameMaker i ] Save Framelmage with Imported
Graphics Graphics
~Interface ;
Aot Automatic Backup on Save Lock File on Network
5 Minutes
Launch Ll Auto Save Every Remember Missing Font Names
Dropbox
P Show File Translation Errors
= CMS Embed in PDF
~Documentum Greek Screen Text Smaller Than
) ) Adobe Flash Files
~Microsoft SharePoint
DitaExchange ! 3-D Objects
. . Checkout HTTP Files on Open
Adobe Experience Mani Multimedia Objects
= Spelling Upload HTTP Files on Save
- Dictionary Image Padding Cursor Movement
Smart Quotes . -
Spelling Options Import Image by Reference @ Logical O Visual
XML Show Tabbed Welcome Screen
MathML
[] Do not check for Updated Images &
Multimedia
< >

OK Cancel

Figure 1:  Boite de dialogue Préférences FrameMaker
Les paramétres de la boite de dialogue Préférences sont expliqués ci-dessous.

Dans ce sujet
J Global > Général
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. Global > Graphiques

. Global > Interface

. Global > Alertes

. Global > Lancer

J Global > Dropbox

o CMS > Documentum

] CMS > Microsoft SharePoint
. CMS > DitaExchange

J CMS > Adobe Experience Manager

. Orthographe > Dictionnaire

. Orthographe > Guillemets ouvrants/fermants

J Orthographe > Options d’orthographe

. XML
. MathML

Global > Général

Les paramétres suivants sont disponibles dans cette section:

Parametre

Description

Interface du produit

Par défaut, FrameMaker s’ouvre en mode de création
FrameMaker structuré. Si vous souhaitez passer en mode de
création non structuré, choisissez FrameMaker dans la liste des
options et redémarrez FrameMaker.

Pour plus d’informations, voir Modes de création de contenu.

Enregistrement avec copie de
sécurité automatique

A chaque fois que vous enregistrez un document, sélectionnez
cette option pour créer une copie de sauvegarde.

Pour plus d’informations, voir Copies de sauvegarde et
enregistrement automatique.

Enregistrement automatique
toutes les

Sélectionnez cette option et spécifiez le temps en minutes pour
enregistrer automatiquement le fichier aux intervalles spécifiés.
Pour plus d’informations, voir Copies de sauvegarde et
enregistrement automatique.

Afficher les erreurs de conversion
du fichier

Sélectionnez cette option pour afficher les messages d’erreur
lors de I'importation d’un document a partir d’un autre format
tel que Word.

Simuler texte plus petit que

Sélectionnez cette option pour afficher un petit texte sous
forme de barres grises. Lorsque le texte dont la taille en points
est plus petite que celle que vous avez définie, le texte s’affiche
sous la forme d’une barre grisée.

Pour plus d’informations, voir Affichage plus rapide des pages.
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Parametre

Description

Extraire les fichiers HTTP a
I'ouverture

Sélectionnez cette option si vous souhaitez extraire un fichier
d’un serveur WebDAV lors de son ouverture.

Télécharger les fichiers HTTP a
I'enregistrement

Sélectionnez cette option si vous souhaitez archiver un fichier
une seule fois lors de sa fermeture.

Remplissage d'image

Spécifiez la valeur de remplissage (espace) par défaut pour une
image et son cadre ancré contenant. Lorsque vous insérez une
image, FrameMaker ajoute un espace (remplissage) entre
I'image et le cadre ancré.

La valeur par défaut est 6,0 pt.

Importer I'image par référence

Sélectionnez cette option pour définir I'importation d’'images
par référence comme méthode par défaut d'importation
d’images.

Afficher I'’écran d’accueil a onglets

Sélectionnez cette option pour afficher I'écran d’accueil en tant
gue document a onglets. Si vous ne sélectionnez pas cette
option, vous verrez I’écran d’accueil au lancement de
FrameMaker. Cependant, lorsque vous ouvrez ou créez un
document, I’écran d’accueil est fermé.

Vous pouvez alors ouvrir I’écran d’accueil dans le menu du
sélecteur d’espace de travail.

Ne pas vérifier la présence
d'images et de contenu
multimédia mis a jour

Si vous travaillez sur un lecteur réseau, sélectionnez cette
option pour empécher FrameMaker de rechercher des images
et des fichiers multimédias mis a jour sur le lecteur réseau. Vous
devez désélectionner cette option avant de publier, sinon vous
risquez d'avoir des fichiers multimédias obsoletes dans votre
sortie publiée.

Compatibilité

Enregistrement de Framelmage
avec des graphiques importés

Lorsque vous copiez un graphique dans un document
FrameMaker, le document FrameMaker stocke les données
graphiques dans une ou plusieurs facettes. Chaque facette
contient des données dans un format graphique spécifique.
FrameMaker utilise des facettes pour afficher et imprimer des
graphiques.

Sélectionnez cette option pour enregistrer les données d’une
image sous la forme d’une facette avec le graphique importé.

Verrouiller des fichiers sur le
réseau

Sélectionnez cette option pour verrouiller un fichier lorsqu’il est
ouvert. Cela empéche les autres utilisateurs de modifier le
fichier.

Pour plus d’informations, voir Ouverture d'un document en
cours d'utilisation.
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Parameétre

Description

Mémoriser les noms de polices
manquantes

Lorsque vous sélectionnez cette option, FrameMaker conserve
les noms des polices indisponibles utilisées dans le document.
Méme si vous enregistrez le document avec des polices de
substitution, les polices d’origine s’affichent de nouveau si vous
ouvrez le document sur un ordinateur ou les polices appropriées
sont installées.

Pour plus d’informations, voir Dépannage de polices non
disponibles.

Incorporer dans le PDF

Fichier Adobe Flash

Sélectionnez cette option pour générer le fichier PDF avec les
fichiers Adobe Flash intégrés utilisés dans le document.

Objets en 3D

Sélectionnez cette option pour générer le fichier PDF avec les
fichiers d’objet en 3D intégrés utilisés dans le document.

Objets multimédia

Sélectionnez cette option pour générer le fichier PDF avec les
fichiers objet multimédia (comme MP3, MP4, AVI) intégrés
utilisés dans le document.

Déplacement du curseur

Logique/Visuel

Sélectionnez le mouvement du curseur pour gu’il soit logique
ou visuel lorsque vous travaillez dans un document activé de
droite a gauche.

Pour plus d’informations, voir Emplacement et mouvement du
caret.

Global > Graphiques

Les parametres suivants sont disponibles dans cette section.

Parameétre

Description

Importer l'image

Position d'ancrage

Sélectionnez la position d’ancrage par défaut a utiliser lors de
I'importation d’'une image. Par défaut, toutes les images sont
importées dans un cadre ancré placé sous la ligne actuelle.

Type d’alignement

Sélectionnez I'alignement par défaut pour le cadre ancré. Par
défaut, le cadre ancré est centré.

PPP

Spécifiez le paramétre PPP par défaut pour importer une image.
Par défaut, 72 PPP sont utilisés pour importer une image.
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Parametre

Description

Mise a I’échelle automatique de
I'image sur la largeur (a I'insertion)

Sélectionnez cette option lors de I'insertion d’'une image dans
une zone de texte, une cellule de tableau, un en-téte, un titre de
marge ou un colonne. L'image est mise a I'échelle et s'adapte
automatiquement.

Par exemple, si l'image est plus grande que la zone de texte, elle
sera automatiquement mise a |I'échelle proportionnellement, en
conservant le meilleur PPP possible, et s'adaptera a la zone de
texte.

Exporter une image

PPP des images pixellisées dans la
sortie HTML

Pour les images raster utilisées dans vos documents, vous
pouvez spécifier les PPP pour convertir ces images. Ce
parametre n’est applicable que lorsque vous générez une sortie
en Responsive HTMLS5.

Global > Interface

Les parameétres suivants sont disponibles dans cette section.

Parametre

Description

Aspect des info-bulles

Conserver I'aspect de I'info-bulle. Les options
possibles sont Normal, Rapide et Caché.

Panneaux

Réduire automatiquement les panneaux pilotés Sélectionnez cette option pour réduire

par icone

automatiquement un panneau en icone, lorsque
le focus se décale du panneau.

Masquer les panneaux a la fermeture

Sélectionnez cette option pour masquer les
panneaux lorsqu’ils sont fermés. De cette fagon,
les panneaux restent masqués de I'interface,
mais ils restent actifs dans la mémoire du
systéeme. Lorsque cette option n’est pas
sélectionnée, le panneau est fermé et supprimé
de la mémoire du systéme.

Afficher le chemin d’accés au menu d
recherche de commande

ans la Sélectionnez cette option pour afficher le chemin
de menu d’'une commande dans Recherche de
commande. Pour plus d’informations, voir
recherche de commande.

Boites de dialogue
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Parametre

Description

Utiliser I'Explorateur de fichiers de Windows

Sélectionnez cette option pour utiliser la boite de
dialogue native de I'Explorateur de fichiers de
Windows lors de I'ouverture ou de
I’enregistrement de fichiers.

Documents

Ouvrir les documents sous forme d’onglets

Sélectionnez cette option pour afficher les
documents ouverts dans des onglets distincts. Si
cette option n’est pas sélectionnée, les
documents sont ouverts dans des fenétres
séparées.

Masquer les onglets isolés dans les documents

Lorsque les documents sont affichés dans une
fenétre séparée, le nom de fichier n’est pas
affiché dans un onglet.

Interdire la mise en onglets des documents lors
du déplacement par glissement

Sélectionnez cette option pour empécher la mise
en onglets des documents lors du déplacement
par glissement.

Ouvrir les documents composites sous forme
d’onglets

Sélectionnez cette option pour ouvrir les
documents composites sous forme d’onglets.

Ouvrir les documents par glisser-déposer

Sélectionnez cette option pour ouvrir les
documents lorsqu’ils sont glissés et déposés dans
la fenétre du document.

IcOnes

Niveaux de gris/De couleur

Sélectionnez I'option Niveaux de gris si vous
voulez utiliser des icOnes de niveaux de gris dans
I'interface utilisateur de FrameMaker, sinon
choisissez De couleur.

vue Structure

Développement automatique correspondant a
I’emplacement du curseur dans la fenétre du
document

Sélectionnez cette option pour synchroniser
I’emplacement du curseur dans la fenétre du
document avec la sélection de I'élément dans la
vue Structure. Par exemple, si vous placez votre
curseur n‘importe ol dans la fenétre de
document, I’élément correspondant dans la vue
Structure est automatiquement mis en
surbrillance. De méme, si vous sélectionnez un
élément dans la vue Structure, le texte
correspondant dans la fenétre de document est
sélectionné.
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Global > Alertes

Les parametres suivants sont disponibles dans cette section.

Parameétre

Description

Afficher les avertissements lors du nettoyage de
I’historique

Sélectionnez cette option pour afficher un
message d’avertissement lors de toute opération
d’effacement de I’historique. Vous pouvez en
outre limiter I'apparition de ce message
d’avertissement a une seule fois pour chaque
type d’opération ou pour toutes les opérations.

Le fichier contient des références croisées non
résolues

Sélectionnez cette option si vous souhaitez
afficher des alertes lorsque des références
croisées non résolues sont découvertes dans le
document.

Ouverture d’'un document issu d’une version
antérieure

Sélectionnez cette option si vous souhaitez
afficher des alertes lors de I'ouverture d’un
document a partir d’'une ancienne version de
FrameMaker.

Ouverture d’un livre issu d’une version antérieure

Sélectionnez cette option si vous souhaitez
afficher des alertes lors de I'ouverture d’un fichier
livre a partir d’'une ancienne version de
FrameMaker.

Fichier contenant des polices non disponibles

Sélectionnez cette option si vous souhaitez
afficher des alertes lorsque les polices utilisées
dans le document ne sont pas disponibles sur le
systeme ol le document est ouvert.

Non correspondance du fournisseur de
dictionnaire

Sélectionnez cette option si vous souhaitez
afficher des alertes lorsque le fournisseur de
service de dictionnaire dans le document ne
correspond pas au systeme ol le document est
ouvert.

REMARQUE : Le fournisseur de service de
dictionnaire peut étre défini a partir de
Préférences > Orthographe > Dictionnaire.

Fichier non pris en charge dans ce mode

Sélectionnez cette option si vous souhaitez
afficher des alertes lorsqu’un fichier structuré est
ouvert en mode non structuré.

Fichier non pris en charge dans cette vue

Sélectionnez cette option si vous souhaitez
afficher des alertes lorsqu’un fichier est ouvert en
mode non structuré.
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Parameétre

Description

Passer automatiquement au compositeur
asiatique

Sélectionnez cette option pour passer
automatiquement en mode Compositeur
asiatique.

Pour plus d’informations, voir Prise en charge des
langues asiatiques.

Afficher les alertes dans la restauration de
session

Sélectionnez cette option si vous souhaitez
afficher des alertes sur la restauration d’'une
session antérieure. Cela peut se produire lorsque
vous relancez FrameMaker aprés un incident.

Afficher les conseils contextuels

Sélectionnez cette option pour afficher les
conseils contextuels relatifs a I'opération que
vous effectuez dans FrameMaker.

Pour plus d’informations, voir Conseils
contextuels.

Global > Lancer

Les parametres suivants sont disponibles dans cette section.

Parameétre

Description

Charger les polices Adobe au démarrage

Cette option charge les polices Adobe au
démarrage de FrameMaker. Les polices Adobe
sont stockées dans le dossier

<emplacement installation Fm>\fmin
it\fonts. Sivous désélectionnez cette option,
aucune des polices Adobe ne sera disponible.

Retarder le chargement des clients

Lorsque vous sélectionnez cette option, aucun
des clients comme MathFlow et Importation de
commentaires PDF ne sont chargés au
démarrage. Cette option améliore le temps de
lancement de FrameMaker, mais certaines
applications client ne sont pas disponibles
immédiatement apres le lancement de
FrameMaker.
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Parametre

Description

Retarder le chargement des fournisseurs
linguistiques

Sélectionnez cette option pour retarder le
lancement de tous les fournisseurs de services
linguistiques jusqu’a ce que FrameMaker soit
lancé. Lorsqu’elle est sélectionnée, cette option
ne charge que les services de dictionnaire de
langue anglaise au démarrage. Les autres
fournisseurs de services de dictionnaire sont
chargés apres le lancement de FrameMaker.

Ne pas charger les scripts de démarrage

Spécifiez une liste de scripts que vous ne voulez
pas que FrameMaker lance au démarrage. Par
exemple, par défaut, les utilitaires S1000D et les
scripts de menu sont spécifiés dans cette liste. Si
vous supprimez les scripts S1000D de cette liste,
ils sont exécutés et vous verrez I'option de menu
S1000D.

Global > Dropbox

Les parametres suivants sont disponibles dans cette section.

Parameétre

Description

Dossier Dropbox actuellement sélectionné

Spécifiez un emplacement de dossier a définir
comme emplacement par défaut pour stocker
des fichiers a partir de Dropbox.

Supprimer les fichiers de Dropbox apreés les avoir
copiés en local

Sélectionnez cette option pour supprimer les
fichiers du disque apreés le téléchargement des
fichiers dans le dossier Dropbox.

Créez une structure de dossier pour les fichiers
dépendants lors du téléchargement

Sélectionnez cette option pour définir une
structure de dossiers pour transférer tous les
fichiers dépendants dans le dossier Dropbox.

CMS > Documentum

Les parameétres suivants sont disponibles dans cette section.

Parametre

Description

Lors du téléchargement de fichier
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Parametre

Description

Ecraser I'objet existant et enregistrer sous

Sélectionnez cette option pour spécifier le
mécanisme de version. Vous pouvez choisir
d’écraser une version existante du fichier et
définir son numéro de version pour qu’il soit
identique, ou la version mineure ou majeure
suivante.

Afficher les objets masqués

Sélectionnez cette option pour afficher les
fichiers marqués comme masqués dans le
référentiel Documentum. Les fichiers masqués
sont également affichés dans la fenétre du
Gestionnaire de référentiel.

Afficher les cabinets privés

Sélectionnez cette option pour afficher les
cabinets privés contenus dans le référentiel
Documentum. Les cabinets privés s’affichent
dans la fenétre du Gestionnaire de référentiel.

Chemin d’accés du kit de développement DFS

Recherchez et sélectionnez le chemin d’acceés au
kit de développement Documentum Foundation
Services (DFS) sur votre systéeme.

Attributs personnalisés

Spécifiez tout attribut personnalisé que vous
souhaitez utiliser a partir de Documentum.
Pour plus d’informations, voir Ajout d’attributs
CMS personnalisés.

CMS > Microsoft SharePoint

Les parameétres suivants sont disponibles dans cette section.

Parametre

Description

Lors du téléchargement de fichier

Ecraser 'objet existant et enregistrer sous

Sélectionnez cette option pour spécifier le
mécanisme de version. Vous pouvez choisir
d’écraser une version existante du fichier et
définir son numéro de version sur la version
mineure ou majeure suivante.

Attributs personnalisés

Spécifiez tout attribut personnalisé que vous
souhaitez utiliser a partir de Microsoft
SharePoint.

Pour plus d’informations, voir Ajout d’attributs
CMS personnalisés.
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Parameétre

Description

Extraire les fichiers dépendants par défaut

Si votre document principal possede des fichiers
dépendants, sélectionnez cette option pour
extraire le principal document ainsi que les
dépendances. Cette option se synchronise avec
I'option Extraire tous les fichiers dépendants
dans la boite de dialogue de confirmation. La
boite de dialogue apparait lorsque vous extrayez
les fichiers du serveur SharePoint.

CMS > DitaExchange

Les parameétres suivants sont disponibles dans cette section.

Parametre

Description

Lors du téléchargement de fichier

Ecraser I'objet existant et enregistrer sous

Sélectionnez cette option pour spécifier le
mécanisme de version. Vous pouvez choisir
d’écraser une version existante du fichier et
définir son numéro de version sur la version
mineure ou majeure suivante.

CMS > Adobe Experience Manager

Les parameétres suivants sont disponibles dans cette section.

Parametre

Description

SGC

Fermer le fichier aprés I'archivage | Sélectionnez cette option pour fermer un fichier lorsqu’il est

réintégré dans AEM.

Utiliser un référencement basé sur | Sélectionnez cette option pour télécharger des fichiers utilisant
uuIiD le systéme de référencement de fichier basé sur un

identificateur unique universel (UUID)/identificateur unique a
I’échelle mondiale (GUID). Vous pouvez publier ces fichiers dans
FrameMaker pour générer la sortie requise.

Ouvrir le fichier aprés I'extraction | Sélectionnez cette option pour ouvrir un fichier lorsqu’il est

extrait d’AEM.

Extraction automatique
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Parametre Description

Activer I’extraction automatique Sélectionnez cette option pour extraire automatiquement le
fichier lors de son ouverture ou de son enregistrement. Lorsque
vous sélectionnez cette option, les options Lors de
I'enregistrement du fichier et Lors de I'ouverture du fichier
sont activées. L'option Afficher I'invite peut étre combinée avec
les options Lors de I’enregistrement du fichier ou Lors de
I'ouverture du fichier.

Si vous utilisez une combinaison d'extraire Lors de I'ouverture
du fichier et d'Afficher I'invite, vous voyez une invite lors de
I'ouverture d’un fichier a partir du référentiel AEM. Si vous
choisissez d’extraire le fichier, vous obtenez un verrou exclusif
sur le fichier et vous pouvez le modifier. Si vous choisissez de ne
pas extraire le fichier, le fichier est ouvert en mode lecture
seule.

Si vous utilisez une combinaison d’extraction Lors de
I’enregistrement du fichier et d'Afficher I'invite, vous voyez une
invite pour extraire le fichier lors de I'enregistrement. Si le
fichier n’est pas extrait et que vous essayez de I'enregistrer, vous
étes invité a l'extraire. Si vous choisissez de ne pas extraire le
fichier, les mises a jour ne sont pas enregistrées.

Proxy

Type de proxy Si vous étes derriére un serveur proxy, vous devez spécifier les
détails de ce serveur ici pour vous connecter a votre serveur
AEM. Sélectionnez le protocole de serveur utilisé par votre
serveur AEM. Les options possibles sont HTTP et HTTPS.

Serveur/Port Indiquez I'adresse IP ou le nom de domaine de votre serveur
proxy et le port sur lequel il est en écoute.

Infos de débogage

Journalisation complete Sélectionnez cette option pour stocker les journaux détaillés qui

peuvent étre utilisés pour déboguer n’importe quel probleme.

Orthographe > Dictionnaire

Utilisez ces préférences afin de définir les dictionnaires Proximity ou Hunspell pour I'orthographe, la
césure et le dictionnaire des synonymes (thésaurus) pour plusieurs langues. Pour les variantes de langue
allemande, vous pouvez choisir d’utiliser le dictionnaire Duden.

Orthographe > Guillemets ouvrants/fermants

Utilisez les parametres Guillemets ouvrants/fermants pour spécifier les guillemets simples ou doubles a
utiliser pour les langues prises en charge. Les guillemets que vous spécifiez ici sont automatiquement
récupérés lorsque vous les utilisez dans votre document.
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Orthographe > Options d’orthographe

Les parametres suivants sont disponibles dans cette section.

Parameétre

Description

Vérification automatique de |'orthographe

Vérifie I'orthographe dans le document en cours
de frappe. Si un mot est mal orthographié, un
soulignement rouge ondulé apparait sous le mot.

Rechercher

Mot répété

Sélectionnez cette option si vous souhaitez que le
vérificateur orthographique trouve les mots
répétés dans votre document.

Césure inhabituelle

Sélectionnez cette option si vous souhaitez que le
vérificateur orthographique trouve les césures
inhabituelles dans votre document.

Casse inhabituelle

Sélectionnez cette option si vous souhaitez que le
vérificateur orthographique trouve les casses
inhabituelles (comme VErt) dans votre
document.

Deux a la suite

Sélectionnez cette option et spécifiez les
caractéres qui doivent étre marqués par le
vérificateur orthographique s’ils se trouvent a la
suite.

Guillemets droits

Sélectionnez cette option si vous souhaitez que le
vérificateur orthographique trouve les guillemets
droits dans votre document.

Espaces superflus

Sélectionnez cette option si vous souhaitez que le
vérificateur orthographique trouve les espaces
superflus entre deux mots.

Espace avant

Sélectionnez cette option et spécifiez les
caracteres qui doivent étre marqués par le
vérificateur orthographique s’ils sont précédés
d’un espace.

Espace apres

Sélectionnez cette option et spécifiez les
caractéres qui doivent étre marqués par le
vérificateur orthographique s’ils sont suivis d’'un
espace.

Rétablir défaut

Cliquez sur ce bouton pour rétablir les options
d’orthographe par défaut.
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Parameétre

Description

Ignorer

Mots a un seul caractere

Sélectionnez cette option pour que le vérificateur
orthographique ignore tout mot a un seul
caractere.

Mots en majuscules

Sélectionnez cette option pour que le vérificateur
orthographique ignore tout mot en majuscules.

Mot contenant

Sélectionnez cette option et spécifiez les
caractéres qui, s’ils se trouvent dans un mot, ne
doivent pas étre marqués par le vérificateur
orthographique.

Chiffres romains (ND pour Hunspell)

Sélectionnez cette option pour que le vérificateur
orthographique ignore tous les chiffres romains.

Mots incluant des chiffres

Sélectionnez cette option pour que le vérificateur
orthographique ignore tous les mots contenant
des chiffres.

Guillemets ouvrants/fermants dans l'espace
avant et apres

Sélectionnez cette option pour inclure les
guillemets ouvrants/fermants spécifiés sous les
parameétres Guillemets ouvrants/fermants a
inclure dans I'espace avant et apres la regle.

XML

Les parametres suivants sont disponibles dans cette section.

Parameétre

Description

Couleurs de la syntaxe

Sélectionnez les couleurs pour afficher les
attributs, commentaires, entités, noms
d’éléments et autres objets dans la vue XML.

Afficher les numéros de ligne

Sélectionnez cette option pour afficher les
numeéros de ligne en vue XML.

Renvoi a la ligne

Sélectionnez cette option pour enchainer des
mots dans la vue XML.

Famille de polices

Sélectionnez la famille de polices a utiliser pour
afficher le code XML dans la vue XML.

MathML

Les parameétres suivants sont disponibles dans cette section.
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Parametre

Description

MathFlow

Chemin d’installation

Recherchez et sélectionnez le chemin
d’installation de MathFlow sur votre systeme.

Chemin du fichier de licence

Recherchez et sélectionnez le chemin du fichier
de licence MathFlow sur votre systéeme.

Type d’éditeur

Sélectionnez le type d’éditeur MathFlow que
vous souhaitez utiliser. Les options possibles sont
I’éditeur de style et I’éditeur de structure.

Pour plus d’informations, voir Création
d’équations a I'aide de MathML.

Parametres de MathFlow

PPP

Les équations MathML sont insérées dans votre
document sous la forme d’une image. Spécifiez
les DPI pour les images d’équation MathML.

Incorporer une insertion

Sélectionnez cette option pour incorporer
I'image de I'’équation en ligne avec le paragraphe
encadrant.

Appliquer le style de paragraphe

Sélectionnez cette option pour appliquer le
formatage du paragraphe encadrant dans
I’équation MathML.

Exporter au format PNG

Sélectionnez cette option pour exporter les
équations MathML en tant qu’images PNG dans
la sortie PDF.

Taille des polices

Spécifiez la taille de la police en pixels pour
I’éguation MathML. La taille de la police par
défaut est 14 px.

Alerte

Afficher le nombre de jours d’évaluation restants

Sélectionnez cette option pour afficher une
alerte si vous utilisez une licence d’évaluation de
MathFlow.
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Conseils contextuels

Découvrez comment des conseils contextuels vous aident a trouver les nouvelles fonctionnalités intro-
duites dans Adobe FrameMaker.

Les conseils contextuels vous permettent de trouver les nouvelles fonctionnalités de FrameMaker ou de
trouver une autre méthode pour effectuer une tache ordinaire. Si une fonction est associée a la tache en
cours d’exécution, la fonctionnalité de conseils contextuels vous présente les informations relatives a
cette fonctionnalité sous forme de conseil. Ces conseils utiles vous aident a réaliser vos taches de
maniére simple et efficace.

Par exemple, la premiére fois que vous ouvrez un document, un conseil s’affiche dans le coin inférieur
droit de I'espace de travail FrameMaker.

Tips (7) (x)

*ou can also use the multi-device publizhing feature to publish your

content to @ vanety of output formats other than POF. such as
Respansive HTMLS, EPUE. and \WebHelp.

Showhie Details

Figure 1:  Conseils contextuels dans Adobe FrameMaker

La boite de dialogue Conseils inclut les boutons suivants :

. ? : survolez ce bouton avec la souris pour savoir comment activer ou désactiver ces conseils.

. Montrez-moi : ce bouton s'affiche pour certains conseils seulement. En cliquant sur ce bouton,
vous ouvrez le panneau mentionné dans le conseil.

. Détails : ce bouton vous améne a la rubrique d'aide pertinente.

] X : ce bouton ferme le conseil. Pour ne plus afficher ces messages, consultez Préférences relatives
aux conseils contextuels.

Chaque conseil n'est affiché qu'une seule fois pour une tache spécifique. Par exemple, la seconde fois
gue vous ouvrirez un document, le conseil ne s'affichera pas. Le but est de vous fournir une information
pratique sans vous géner. Voila pourquoi, lorsque vous effectuez une tache, FrameMaker suppose que
vous avez soit utilisé pris en compte le conseil, soit que vous n'en aviez pas besoin.

Préférences relatives aux conseils contextuels

Pour personnaliser les préférences de conseils contextuels, sélectionnez Modifier > Préférences > Global
> Alertes. Les options suivantes liées aux conseils contextuels sont disponibles au bas de la boite de
dialogue :

Afficher les conseils contextuels

Désélectionnez cette option pour annuler I'affichage des messages. Cela implique que lorsque vous
effectuerez une tache pour la premiére fois, aucun conseil ou message ne s'affichera.
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Réinitialiser les conseils contextuels
Cliquez sur le bouton Réinitialiser les conseils contextuels pour afficher a nouveau les conseils, y
compris pour les flux de travail antérieurs. Par exemple, si un conseil s’affiche lors de I’enregis-
trement d’'un document, vous pouvez réinitialiser les conseils contextuels en cliquant sur ce
bouton. Le méme message s’affichera au prochain enregistrement.
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Gestion de fichiers ouverts

Découvrez comment utiliser des fichiers ouverts dans FrameMaker avec le panneau Panneau Ouvrir les
fichiers.

Le panneau Fichiers ouverts vous permet de gérer et de naviguer dans un grand nombre de fichiers
ouverts.

Utilisez le panneau Ouvrir les fichiers, vous pouvez :

1)  Consulter et enregistrer les fichiers avec des modifications non enregistrées.

2)  Rechercher unfichier avec un nom spécifique ou des fichiers enregistrés dans un dossier spécifique.
3)  Accéder a différents fichiers.

4)  Vérifier le chemin des différents fichiers ouverts.

5)  Fermer des fichiers spécifiques aprés I'enregistrement ou sans enregistrer.

- e s

0 2en Fi es E_

A A x v &

|Search texd | €

[] Mame = Path

General-Descri...  Ktemp'2018'wserguide’Sample-unstructuredGeneral-Description fm
H [ Operating-Limit... K:\temp'2018\user-guide‘\Sample-unstructured \Operating-Limitations fm

[T Personal Spac... K:‘temp'2018‘user-guide".Sample-unstructured*Personal Spaceship ...

[ Systems fm K:temp"2018'\user-guide’Sample-unstructured*.Systems fm

Figure 1: Le panneau Fichiers ouverts

A. Enregistrez les fichiers et les gardez-les ouverts. B. Enregistrer les fichiers sélectionnés et fermez-les.
C. Fermez les fichiers sélectionnés — s’il y a des modifications non enregistrées dans les fichiers que vous
essayez de fermer, la boite de dialogue Enregistrer les fichiers apparait D. Rechercher — A mesure que
vous tapez, le panneau correspond aux criteres de recherche avec des entrées dans toutes les colonnes.
Utilisez I'icbne en forme de croix en regard de la zone de texte de recherche pour effacer le texte de
recherche saisi E. Sélectionner Tous, Non enregistré ou Enregistré pour filtrer F. Actualiser la liste des
fichiers G. Sélectionner tous les fichiers dans la liste H. Liste des fichiers actuellement ouverts

Vous pouvez afficher le panneau Ouvrir les fichiers en choisissant Affichage > Panneaux > Ouvrir les fich-
iers ou Affichage > Ouvrir les fichiers.

Voir la vidéo : Panneau Ouvrir les fichiers.
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Enregistrer les fichiers lors de la fermeture des fichiers et de la sortie

FrameMaker affiche la boite de dialogue Enregistrer les fichiers lorsque vous tentez I'une des actions
suivantes :

Quitter FrameMaker en

- Cliquant sur le bouton Fermer
- Sélectionner Fichier > Sortie
- Utilisant Alt+F4 sur le clavier

Vous sélectionnez Maj+Fichier et sélectionnez I'une des options suivantes :
- Fermer tous les fichiers ouverts

- Fermer tous les fichiers du livre

- Fermer tous les fichiers du fichier ditamap

Essayer de fermer les fichiers sans les enregistrer dans le panneau Fichiers ouverts

Save Files *

Do you want to save your changes to the selected files?

[] Mame = Path
Operating Limitations fm* K \Kuldip Wordd\FM\Release' 2017 UserGuide \Operating Limitati
Systems fm™ K- Kuldip'Work\FM"Release’ 201 7 UserGuide’ Systems fm

< >

Save Don't Save Cancel

Figure 2: Boite de dialogue Enregistrer les fichiers

Dans la boite de dialogue Enregistrer les fichiers, vous pouvez réviser et enregistrer les modifications non

enregistrées apportées aux fichiers. Vous pouvez également ignorer les modifications en désélection-
nant les fichiers et en cliquant sur Enregistrer.

Enregistrement et fermeture des fichiers ouverts

Vous pouvez afficher une liste des documents actuellement ouverts dans le panneau Fichiers ouverts. A

I'aide du panneau Fichiers ouverts, vous pouvez sélectionner les fichiers et les modifications a enregistrer

et ignorer.

1)

Sélectionnez Affichage > Panneaux > Ouvrir les fichiers.

FrameMaker affiche le panneau Fichiers ouverts. Les fichiers non enregistrés et les fichiers avec des
modifications non enregistrées sont signalés par un astérisque (*). Pour rechercher des fichiers dans
une longue liste, tapez du texte dans la zone Recherche. FrameMaker recherche le texte dans le nom

du fichier ainsi que dans le chemin.
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2)  Sélectionnez les fichiers a enregistrer et effectuez I'une des opérations suivantes :

Cliquez sur Enregistrer.

FrameMaker enregistre les fichiers sélectionnés. FrameMaker vous invite a spécifier le nom et
le chemin des fichiers qui ne sont pas encore enregistrés sur le disque.

Cliquez sur Enregistrer et fermer.
FrameMaker enregistre et ferme les fichiers sélectionnés.
Fermez les fichiers.

FrameMaker ferme les fichiers sélectionnés. Si vous choisissez de fermer des fichiers avec des
modifications non enregistrées, la boite de dialogue Enregistrer les fichiers s’affiche.
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Restauration de la derniéere session

Découvrez comment FrameMaker vous permet de restaurer la derniére session, les étapes et les
préférences.

Dans ce sujet

. Introduction

] Conditions de restauration de la derniere session

. Etapes de restauration de la derniére session

. Préférences pour les alertes lors de la restauration

Introduction

FrameMaker vous permet de restaurer la derniére session sur laquelle vous avez travaillé la derniéere fois
gue vous avez quitté FrameMaker ou qu’il s’est bloqué. En cas de plantage, lorsque vous relancez
FrameMaker, le programme affiche une alerte permettant de choisir de restaurer la session précédente.
En restaurant la derniére session, vous pouvez rétablir les éléments suivants tels que vous les utilisiez lors
de la derniére session :

. Vue : Code XML, WYSIWYG ou Auteur
. Espace de travail
. Document affiché

. Fichiers ouverts lors de la derniére session (a I'exception des fichiers ouverts via le connecteur de
CMS lors de la session précédente)

. Numeéros de page affichés pour différents documents

. Espace de défilement pour les maquettes, pages courantes et pages de référence
] Ordre de tabulation des documents

. Palettes (comme le navigateur d’équations, de modéles et de thésaurus)

J Fichier stuctapps.fm : le dernier fichier structapps.fm lu (en cas de restauration, le dernier fichier
structapps. fmest de nouveau lu)

Voir la vidéo : Restauration de session en un clic.

Conditions de restauration de la derniére session

Si toutes les conditions suivantes sont remplies, vous pouvez restaurer la derniere session :

1) Desfichiers étaient ouverts lorsque vous avez quitté FrameMaker ou qu’il s’est bloqué. En d’autres
termes, il existe des éléments a restaurer de la derniére session. Si vous quittez FrameMaker manu-
ellement aprées la fermeture de fichiers, il n'y a rien a restaurer.

2) Il n’y aaucun fichier ouvert lorsque vous tentez de restaurer la derniére session.

3) Le mode actuel de FrameMaker (structuré ou non structuré) est identique au mode de
FrameMaker la derniére fois que vous I'avez quitté.
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Etapes de restauration de la derniére session

Pour restaurer la derniére session de FrameMaker, lancez FrameMaker et effectuez I'une des opérations
suivantes :

. Cliquez sur Restaurer la derniére session sur /’écran de bienvenue.

ou

. Sélectionnez Fichier > Ouvrir récent > Restaurer la derniére session.
ou

. Utilisez le raccourci clavier esc+r+s.

J Au cas ou FrameMaker se bloque, lorsque vous relancez FrameMaker, FrameMaker affiche un
message d'alerte ou vous pouvez cliquer sur Oui pour restaurer la derniéere session.

FrameMaker restaure la derniére session. Si certains fichiers n’ont pas pu étre restaurés, FrameMaker
affiche un message d’erreur et répertorie les fichiers dans le panneau Console.

REMARQUE : Pour lancer le panneau Console, sélectionnez Affichage > Panneaux > Console ou appuyez
sur échap+c+P.

Préférences pour les alertes lors de la restauration

Dans la boite de dialogue Préférences, vous pouvez choisir d’afficher ou non les messages d’alerte
(polices manquantes et références croisées non résolues par exemple) lors de la restauration d’une
session. Les alertes qui nécessitent une action de I'utilisateur (graphiques manquants par exemple) appa-
raissent méme si vous avez désactivé les alertes.
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Restauration des dimensions de vues RM

Comprenez comment FrameMaker conserve les dimensions des vues du gestionnaire de ressources lors
de la sortie et de la relance.

FrameMaker conserve les dimensions des vues suivantes du Gestionnaire de ressources lors de la sortie
et de larelance :

. Vue du Gestionnaire de ressources pour le Livre

. Vue du Gestionnaire de ressources pour le Navigateur de référentiel CMS

] Vue du Gestionnaire de ressources pour le mappage DITA

FrameMaker conserve les dimensions des vues du Gestionnaire de ressources et les utilise comme des
dimensions par défaut de ces vues lorsque vous les fermez et les ouvrez de nouveau.

. Pour les vues du Gestionnaire de ressources qui ne sont pas ancrées, FrameMaker conserve la
largeur et la hauteur.

] Pour les vues du Gestionnaire de ressources ancrées, FrameMaker conserve uniquement la largeur.
La largeur qui est conservée pour les vues Gestionnaire de ressources ancrées et non ancrées est

différente. Les dimensions conservées pour les différentes vues du Gestionnaire de ressources, telles que
Livre et Mappage DITA, sont identiques.
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Conseils sur l'utilisation de l’interface

Découvrez des conseils et des raccourcis pour utiliser l'interface utilisateur, la luminosité, les fenétres de
documents, les panneaux et les icones dans Adobe FrameMaker.

Associer des fenétres de document

Pour regrouper toutes les fenétres de documents (flottantes, réduites ou ancrées), cliquez avec le
bouton droit de la souris sur la barre d'onglets de la fenétre de document ancrée, puis sélectionnez
Tout combiner ici dans le menu.

Ouvrir le fichier dans I'Explorateur Windows

Pour ouvrir I'emplacement d'un fichier dans I'Explorateur Windows, cliquez avec le bouton droit de
la souris sur la barre d'onglets de la fenétre de document ancrée et sélectionnez Ouvrir le dossier
de contenu dans le menu. Le fichier du document est sélectionné automatiquement dans
I’"Explorateur Windows.

Afficher dans des fenétres de document flottantes

Cliquez sur l'icone Organiser les documents dans la barre supérieure Application et sélectionnez
Faire flotter tout dans les fenétres. Cela permet d’organiser toutes les fenétres de document en
panneaux flottants disposés en cascade.

Disposer des documents en mosaique

Utilisez I'icone Organiser les documents pour disposer des fenétres de document a la verticale ou
al’horizontale. Cela est particulierement utile pour une comparaison manuelle de documents, ainsi
que leur disposition cote a cote.

Placer des panneaux masqués au premier plan
Parfois, lorsque vous travaillez sur des fenétres de document flottantes ou lorsque vous changez
d’espaces de travail, les panneaux peuvent sembler difficiles a placer au premier plan.

. Annulez I'ancrage des panneaux en les faisant glisser hors de la barre des titres des panneaux.

. Ancrez toutes les fenétres de document flottantes. Cliquez avec le bouton droit de la souris sur la
barre d'onglets ancrée, puis sélectionnez Tout combiner ici ou faites glisser et ancrez les fenétres
de document flottantes.

Réduire les panneaux a des icones
Cliquez avec le bouton droit de la souris sur la barre d'onglets des panneaux et sélectionnez Réduire
a des icones. Cette option est uniquement disponible si les panneaux sont flottants et non ancrés.
Pour réduire des panneaux ancrés, cliquez n’'importe ou sur la barre d’onglets.

Rouvrir les panneaux
Sélectionnez Affichage > Panneaux et cliquez sur un nom de panneau. Le groupe complet de
panneaux s'ouvre en bas de I'espace de travail.

Rouvrir un panneau

Sélectionnez Fenétres > Panneaux, puis le panneau que vous souhaitez rouvrir.
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Réduire tous les groupes de panneaux ouverts en icones
Cliquez avec le bouton droit sur la barre d’onglets du groupe de panneaux, puis sélectionnez
Réduire a des icones.

Quitter le mode plein écran

Cliquez avec le bouton droit en dehors de la zone de texte dans la fenétre de document, puis sélec-
tionnez Changer de mode d'écran.

RELATED LINKS:
Modes d’affichage de I’'écran
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ACCESSIBILITE

Accessibilité

Connaitre les fonctionnalités offertes par FrameMaker pour améliorer I'accés aux utilisateurs ayant une
déficience visuelle.

Le logiciel FrameMaker propose plusieurs fonctionnalités susceptibles d'améliorer |'accés aux docu-
ments pour les malvoyants. Le logiciel Adobe FrameMaker :
. assure |'affichage a contraste élevé pour les utilisateurs a faible acuité visuelle ;

o crée des fichiers Adobe PDF balisés lors de la conversion des fichiers FrameMaker en PDF balisé,
afin de permettre aux utilisateurs de logiciels de lecteurs d’écran de suivre aisément I'ordre de
lecture des documents. Pour plus de détails sur la conversion de vos documents FrameMaker en
fichiers Adobe PDF balisés, voir .

] Prend en charge les technologies d'assistance, telles que le logiciel de lecteur d'écran pour la

plate-forme Windows' .

Les lecteurs d'écran permettent aux utilisateurs malvoyants d'interagir avec I'ordinateur en interprétant
ce qui se produit a I'écran et en envoyant cette information aux périphériques de synthéese vocale. Le
lecteur d'écran suit la structure logique du document. Les lecteurs d’écran peuvent lire les documents
FrameMaker affichés dans FrameMaker, ou encore les documents PDF balisés affichés dans Adobe

Acrobat’ ou Adobe Reader". Reportez-vous a la documentation de votre lecteur d’écran pour plus
d’informations sur son installation et son utilisation avec des documents affichés dans FrameMaker ou
Acrobat.

Pour plus de détails sur I'accessibilité des documents Adobe Acrobat et Adobe PDF, consultez I'aide en
ligne d’Acrobat et le site Web d’Adobe.

Démarrage du clavier visuel

1)  Dans le menu Démarrer, sélectionnez Programmes > Accessoires > Accessibilité > Clavier visuel.
2) Cliguez sur OK. Vous pouvez alors utiliser le clavier visuel.

RELATED LINKS:
Espace de travail a contraste élevé
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DOCUMENTS

Documents

Comprendre les différentes méthodes pour créer des documents dans FrameMaker. Utilisez les modéles
intégrés pour créer vos documents.

En savoir plus sur le travail avec des documents sur ces sous-sujets.
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Créer un document

Découvrez comment créer un document dans Adobe FrameMaker a partir d’'un document vierge ou d’un
modele. Apprenez a définir le sens de lecture du document (de gauche a droite/de droite a gauche).

FrameMaker fournit plusieurs modeles a partir desquels vous pouvez adapter vos documents. Vous
pouvez également choisir d’utiliser un modéle défini par votre entreprise, ou créer un document vierge.

Par défaut, les documents FrameMaker ont une extension en . fm.
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Création d’un document vierge

Découvrez comment créer un document vierge avec le modéle par défaut dans Adobe FrameMaker.
Si vous définissez un modele pour votre entreprise ou pour votre équipe, vous pouvez commencer par
un document FrameMaker vierge.
1)  Sélectionnez Fichier > Nouveau > Document.
2)  Spécifiez la mise en page de base :
- Pour créer un document standard a une colonne, cliquez sur Portraitou sur Paysage.

- Pour créer un document avec un format de page, des marges de colonnes et des paramétres
de pagination personnalisés, cliquez sur Personnalisé et spécifiez les valeurs requises. Cliquez
sur Créer.

Vous pouvez également sélectionner une unité de mesure pour le document. FrameMaker af-
fiche les mesures dans des boites de dialogue et dans la barre d’état de la fenétre du document
de l'unité sélectionnée.

3)  Ajouter du contenu au document.

105



Utiliser un modéle pour créer un document

Découvrez comment créer un document FrameMaker basé sur un modéle.

Dans ce sujet

. Introduction

o Modeéles standard,

. Modéles structurés

. Modeéles personnalisés

J Modeéle de droite a gauche

Introduction

Vous pouvez créer un document a I'aide d’un modéle. Il se peut que votre entreprise dispose de modeéles
prédéfinis pour différents types de documents. Pour créer un document, cliquez sur Fichier > Nouveau
> Document.

Procédez comme suit pour créer un document basé sur un modele prédéfini.

Modeéles standard,

Pour créer un document FrameMaker a partir d’un modéle standard :
1) Cliquez sur Explorer les modeéles standard.

2)  Sélectionnez un modeéle dans la boite de dialogue Modeéles standard. Par exemple, Guides de I’util-
isateur—Légaux.

3)  Cliquez sur Créer pour créer un document basé sur le modéle sélectionné.

REMARQUE : Vous pouvez également cliquer surAfficher un échantillon pour afficher un apergu du
document dans un nouvel onglet de documents. Cette option ferme la boite de dialogue Modéles
standard. Pour revenir a la boite de dialogue aprés avoir visualisé I'exemple, sélectionnez de
nouveau Fichier > Nouveau > Document > Explorer les modeéles standard.

4)  Ajouter du contenu au document.

Modeéles structurés

Pour créer un document structuré a partir d’'un modele structuré :
1)  Cliquez sur Explorer les modeéles structurés

2)  Sélectionnez un modele dans la boite de dialogue Modéles structurés. Par exemple, Profes-
sionnel—Mémo.
3)  Cliquez sur Créer pour créer un document basé sur le modele sélectionné.

REMARQUE : Vous pouvez également cliquer surAfficher un échantillon pour afficher un apergu du
document dans un nouvel onglet de documents. Cette option ferme la boite de dialogue Modéles
structurés. Pour revenir a la boite de dialogue aprés avoir visualisé I'exemple, sélectionnez de
nouveau Fichier > Nouveau > Document > Explorer les modéles structurés.

4)  Ajouter du contenu au document.
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Modéles personnalisés

Choisir un modele personnalisé:
1)  Accédez au document que vous souhaitez utiliser comme modéle pour le nouveau document.
2) Cliguez sur Nouveau.

Modéle de droite a gauche

Pour créer un document de droite a gauche a partir d’'un modeéle de droite a gauche :
1)  Accédez au dossier Modeéles (SFMHOME \ Templates).

2) Cliguez sur le fichier RTLTemplate. fm.

3) Cliguez sur Nouveau.

4)  Ajouter du contenu au document.

REMARQUE : Cette opération crée un document vide avec une direction définie de droite a gauche.
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Ouverture d'un document

Découvrez comment ouvrir différents fichiers et documents dans FrameMaker. Comprendre comment
résoudre les problemes de polices indisponibles.

Outre les documents FrameMaker, vous pouvez également ouvrir les fichiers texte, les fichiers MIF
(Maker Interchange Format), les fichiers MML (Maker Markup Language), ainsi que les documents XML
et SGML. Si le filtre requis est installé, vous pouvez également ouvrir des fichiers créés dans d’autres

applications, Microsoft” Word par exemple. Le formatage du fichier est en grande partie conservé lors
de I'ouverture du fichier.

REMARQUE : Pour ouvrir des fichiers créés a I'aide de FrameMaker 7 ou d’une version précédente de
FrameMaker, enregistrez-les en tant que fichiers MIF.

Ouverture d’un fichier

1) Choisissez Fichier > Ouvrir.

B open x
U c« 2018 » user-guide » Sample-unstructured v & Search Sample-unstructured 0
Organize + MNew folder =z~ M 0
~
v Adobe FrameMaker 2018 # Name Date modified Type ~
AMT media File folder
APCZO output File folder
clipart Settings File folder
CustomHooks a Backpagefm Adobe Fran
dict a Contacts.fm Adobe Frarr
a Contents.fm Adobe Frarr
Documents
a Cover.fm Adobe Frarr
us
en- a General-Description.fm Adobe Frarr
ExtendScriptResources a Index fm Adobe Frar
Features a Legal fm Adobe Frarr
filters a Operating-Limitations.fm Adobe Frarr
frinit "Fn| Personal Spaceship User Guide - EN-US.b... & Adobe Frarr ,
Fantdir i = 2
File name: | v| All FrameMaker Documents ("4 ~

Figure 1: Boite de dialogue Fichier ouvert

Les boites de dialogue Ouvrir et Enregistrer le document sont basées sur les boites de dialogue na-
tives Ouvrir le fichier/Enregistrer de Windows, ce qui donne un accés facile aux fichiers sur votre sys-
teme.

REMARQUE : Si vous voulez utiliser I'ancienne boite de dialogue Ouvrir, désactivez le parameétre
Utiliser les Explorateurs de fichiers de Windows dans la boite de dialogue Edition > Préférences >
Global > Interface.

2) Localisez le document. Cliquez sur Ouvrir.
En général, lorsque vous ouvrez un document, les graphiques importés par référence, les encarts de

texte, les références croisées et les variables systéme (le cas échéant) sont automatiquement mis a jour.
Les fichiers récemment ouverts sont répertoriés au bas du menu Fichier.
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Des messages signalant des problémes potentiels liés au fichier s’affichent parfois. Vous pouvez cliquez
sur OK et résoudre les problemes plus tard.

REMARQUE : Vous pouvez également glisser-déposer des fichiers de I'Explorateur Windows vers la fenétre
de document, les zones vides de 'interface utilisateur, les barres d’outils, les barres de menus ou les
panneaux pour ouvrir les fichiers.

Ouverture d'un fichier texte

Les fichiers texte seulement ne contiennent ni graphiques ni informations de formatage. Lors de I'ouver-
ture d'un fichier texte seulement, vous devez confirmer qu'il s'agit d'un fichier texte.

1)  Sélectionnez Fichier > Ouvrir, et ouvrez un fichier .txt. La boite de dialogue Type de fichier indéter-
miné s’affiche.

2)  Sélectionnez I'option Texte.

3) Cliquez sur le bouton Convertir.

4)  Sélectionnez I'une des options suivantes :

- Pour séparer le texte en paragraphes uniquement au niveau des lignes vides, sélectionnez
Fusionner les lignes en paragraphes. Utilisez cette option pour un fichier texte comportant
des paragraphes, par exemple un fichier contenant un texte de document.

- Pour séparer le texte en paragraphes a la fin de chaque ligne, sélectionnez Considérer chaque
ligne comme un paragraphe. Utilisez cette option pour un fichier texte comportant des
lignes, tel gu’un fichier contenant du code informatique.

- Pour convertir le texte en tableau, sélectionnez Convertir texte en tableau. Utilisez cette
option si le contenu du fichier source est séparé par des tabulations.

Sélectionnez d’autres options dans la boite de dialogue Convertir en tableau, par exemple le
nombre de colonnes, les marques de séparation des cellules et les lignes d’intitulé, afin d’af-
ficher les données au format de tableau adéquat.

5)  Sélectionnez un schéma de codage. Le schéma de codage ANSI (Windows) est sélectionné par
défaut.

6) Cliquez sur Lecture. Le texte s'affiche dans un document créé a partir d'un modeéle spécial. Vous
pouvez personnaliser le modele afin que les documents créés a partir de fichiers texte soient
formatés différemment.

Ouverture d'un document en cours d'utilisation

Un fichier de verrouillage (* . 1ck) est créé chaque fois que vous ouvrez un document. Ce fichier de
verrouillage empéche les autres utilisateurs de modifier le fichier lorsque vous I'utilisez. Le fichier de
verrouillage se trouve dans le méme dossier que le document d'origine et est supprimé a la fermeture
du document. Vous pouvez désactiver le verrouillage de fichier.

Si vous tentez d'ouvrir un document déja ouvert et sur lequel vous possédez les droits d'écriture, une
boite de dialogue affiche le nom du document, le nom du dernier utilisateur a I'avoir ouvert et la
date/heure, ainsi que I'ordinateur sur lequel il a été ouvert. Cette boite de dialogue s'affiche parfois aprées
un blocage du systéme, lorsque vous ouvrez un document que vous étes le dernier a avoir utilisé.

Ouvrez le fichier, puis effectuez I'une des opérations suivantes :
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. Pour consulter le fichier sans le modifier, cliquez sur Ouvrir pour consultation seulement, puis sur
Continuer. Le document s'affiche au format Consultation seulement.

. Pour modifier une copie du fichier, cliquez sur Ouvrir une copie pour modification, puis sur
Continuer. Une copie du fichier s'ouvre et, lorsque vous enregistrez ce fichier, vous étes invité a
spécifier un nouveau nom de fichier.

. Pour modifier le fichier, si vous savez que personne d'autre ne l'utilise, cliquez sur Déverrouiller et
ouvrir, puis sur Continuer. Utilisez cette option aprés un blocage du systeme, pour modifier un
document ouvert au moment du blocage.

Ouverture d’'un document sans mise a jour des références

Un document met plus de temps a s’ouvrir s’il contient de nombreuses références croisées vers d’autres
fichiers, des graphiques importés volumineux ou plusieurs encarts de texte. Vous pouvez ouvrir un docu-
ment plus rapidement en ignorant la mise a jour des graphiques importés, des références croisées et des
encarts de texte. Cependant, si vous ouvrez des documents a |'aide de cette méthode, FrameMaker
n‘indique pas qu’il mangue des éléments ou que des références croisées ne sont pas résolues, le cas
échéant. C'est pourquoi il est conseillé d'ouvrir de temps en temps un document selon la méthode habi-
tuelle.

1) Choisissez Fichier > Ouvrir et sélectionnez le fichier souhaité.
2)  Tout en maintenant la touche Ctrl enfoncée, cliquez sur Ouvrir.

Une fois le fichier ouvert, FrameMaker importe et affiche les graphiques nécessaires page par page. Vous
pouvez mettre a jour manuellement les références croisées et les encarts de texte a I'aide de la
commande Edition > Mettre a jour les références. Si |'affichage de la page est trop lent, ouvrez a
nouveau le document de la maniere habituelle.

SGML, MIF et MML sont des formats texte. Vous pouvez donc les ouvrir en tant que fichiers texte en
mode non structuré.

Dans le cas des fichiers . xm1 ou .mif dans FrameMaker structuré, il suffit de cliquer sur le bouton
Ouvrir en maintenant la touche Ctrl enfoncée pour les ouvrir en tant que fichiers texte. Vous étes invité
a spécifier les options de lecture de texte dans la boite de dialogue Lecture de fichier texte en cours.
Lorsque ces fichiers sont ouverts au format texte, vous pouvez afficher et modifier le balisage.

<chapter draftversion = "Alpha Draft"><title><clj
</chapnumber>
<chapname>Doors</chapname ></title>
<reviewinfo></reviewinfo>
<chapintro><autohead></autohead>
<chapoverview><autohead></autohead>
<section><head>Procedures in This Chapter</hg
<para>This chapter describes maintenance procq
doors on the AstroLiner T440B and T442 light rai
safety guidelines, an overview of door componer|

Figure 2:  Balisage dans un fichier SGML
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Réouverture d'un fichier aprés un blocage du systéme

En cas de blocage du systéme, le fichier est automatiquement enregistré dans les situations suivantes :

. Si vous avez sélectionné I'option Enregistrement automatique dans la boite de dialogue
Préférences, les fichiers d’enregistrement automatique (dont le nom contient I'extension .auto)
sont créés selon l'intervalle de temps spécifié. Ce fichier est supprimé lorsque vous enregistrez et
fermez un fichier.

. Si votre systeme devient instable, FrameMaker tente de créer un fichier de récupération (d'exten-
sion . recover) avec les modifications les plus récentes.

Une copie du fichier enregistrée automatiquement contient les modifications apportées récemment au
fichier.

1)  Ouvrez le fichier sur lequel vous travailliez avant le blocage.
2)  Procédez de I'une des fagons suivantes :

- Si un fichier de récupération existe, ouvrez-le a l'invite et vérifiez que vos dernieres modifi-
cations y figurent. Dans I'affirmative, enregistrez le fichier récupéré sous le méme nom que
celui du document d'origine puis supprimez le fichier de récupération.

- S'il n'existe pas de fichier de récupération, ouvrez le fichier de sauvegarde auto a l'invite et
enregistrez-le sous le méme nom que celui du document d'origine. Ce fichier contient toutes
les modifications effectuées jusqu'au dernier enregistrement automatique. La quantité de
travail perdue est fonction de l'intervalle défini entre chaque enregistrement et le moment
ou le systéme s'est bloqué.

Dépannage de polices non disponibles

Parfois, un message d’alerte indique que le document en cours d’ouverture utilise des polices non
disponibles. Plusieurs raisons peuvent expliquer I'indisponibilité des polices :

. Le document a été modifié sur un autre systéme, a lI'aide de polices non installées sur le systeme
actuel.

. Une police a été supprimée ou est endommagée.
. L'imprimante par défaut du systéme a changé.

Si vous avez sélectionné I'option Mémoriser le nom des polices manquantes dans la boite de dialogue
Préférences, FrameMaker conserve le nom de ces polices. Dans ce cas, méme si vous enregistrez le docu-
ment avec des polices de substitution, les polices d’origine s’affichent de nouveau si vous ouvrez le docu-
ment sur un ordinateur ou les polices appropriées sont installées.

Pour résoudre le probleme des polices manquantes, plusieurs possibilités s’offrent a vous :

Vérifier si des polices sont endommagées

Déterminez si les polices non disponibles dans FrameMaker sont installées sur votre systéme et
disponibles dans une autre application. Si c'est le cas, alors que FrameMaker ne peut pas les utiliser,
il est possible qu'elles soient endommagées. Réinstallez-les a I'aide du support d'origine. Pour plus
de détails sur le dépannage des problemes liés aux polices, I'identification de polices endom-
magées ou d’un dossier de polices endommagées ou la réinstallation des polices PostScript,
consultez le site Web d’Adobe.
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Rétablir les correspondances des polices non disponibles

Si vous ne pouvez pas installer ou réinstaller les polices non disponibles, vous pouvez tenter de
rétablir les correspondances entre les polices non disponibles et les polices disponibles de sorte
qgue le message d'alerte ne s'affiche plus a I'ouverture du document. Pour ce faire, désélectionnez
I’option Mémoriser les noms de polices manquantes dans la boite de dialogue Préférences avant
d’ouvrir le fichier. Toutefois, vous perdrez alors les informations sur les polices d'origine
référencées dans le document.

Changer d'imprimante

FrameMaker lit les informations de polices enregistrées dans le pilote de lI'imprimante afin de
pouvoir utiliser ces polices. Parfois, il suffit de changer d'imprimante par défaut pour rendre
certaines polices disponibles dans FrameMaker.

Obtenir et installer les polices manquantes

Par exemple, sivous et un collegue modifiez les mémes documents et que vous souhaiteriez utiliser
les mémes polices que celui-ci, envisagez d’acheter et d’installer les copies des polices.
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Enregistrer le document ou le livre

Découvrez les différentes méthodes pour enregistrer un document dans FrameMaker. Comprendre les
extensions et les formats du nom de fichier utilisés dans FrameMaker.

Dans ce sujet

. Introduction

o Enregistrement d'un livre

. Enregistrement de tous les documents ouverts

. Retour a la version enregistrée de votre document

L Copies de sauvegarde et enregistrement automatique

Introduction

Vous pouvez enregistrer un document a I'aide de son nom et de son emplacement actuels ou enregistrer
une copie du document en utilisant un nom ou un emplacement différent. Vous pouvez enregistrer un
document sous différents formats, notamment HTML (Hypertext Markup Language), XML (Extensible
Markup Language), RTF (Rich Text Format) ou PDF (Portable Document Format).

Lorsqu’un document ou un livre a été modifié et que ces modifications n’ont pas été enregistrées, un
astérisque (*) s’affiche dans la zone Etat de la page de la barre d’état.

Flow: & T:#5_Mumbersection I 4 M| 3qord> M| = 100% v+

Figure 1:  Un astérisque signale des modifications non enregistrées.

Pour enregistrer un document, procédez de I'une des fagons suivantes :
. Pour enregistrer les modifications apportées au fichier actif, choisissez Fichier > Enregistrer.

. Pour enregistrer le fichier dans un autre dossier ou sous un autre nom, choisissez Fichier > Enreg-
istrer sous.

Sivous choisissez Fichier > Enregistrer sous, ou si le fichier n’a jamais été enregistré, spécifiez le nouveau
nom de fichier et 'emplacement. Pour enregistrer le fichier sous un autre format, choisissez le format
dans la liste déroulante.

Cliquez sur Enregistrer. Si vous sélectionnez le format Texte seulement, spécifiez comment traiter le
texte et les tableaux du document.

Enregistrement d'un livre

1)  Procédez de I'une des fagons suivantes :
- Pour écraser la version actuelle figurant sur le disque, choisissez Fichier > Enregistrer le livre.

- Pour enregistrer le fichier dans un autre dossier ou sous un nom différent, choisissez Fichier
> Enregistrer le livre sous.

2) Sivous choisissez la commande Fichier > Enregistrer le livre sous ou si le fichier n’a jamais été
enregistré auparavant, spécifiez son nouveau nom et son emplacement.
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Enregistrement de tous les documents ouverts

Maintenez la touche Maj enfoncée et sélectionnez Fichier > Enregistrer tous les fichiers ouverts.

Retour a la version enregistrée de votre document

Sélectionnez Fichier > Version précédente. Cliquez sur OK.

Copies de sauvegarde et enregistrement automatique

FrameMaker peut sauvegarder et enregistrer votre travail automatiquement.
1) Choisissez Edition > Préférences.
2) Dans les préférences générales, effectuez les opérations suivantes :

- Pour créer une copie de sauvegarde a chaque fois que vous enregistrez, sélectionnez
Sauvegarde avec copie de sécurité automatique. Ainsi, une copie du fichier est créée avant
gue vos dernieres modifications ne soient enregistrées. S'il existe une copie de sauvegarde,
elle est remplacée par la nouvelle copie. Les noms de fichier des copies de sauvegarde portent
I’extension .backup.

- Pour créer un fichier de sauvegarde auto a intervalles réguliers, sélectionnez Enregistrement
automatique toutes les et entrez un intervalle (en minutes) dans la zone. Ainsi, le fichier est
régulierement enregistré, sans que vous ayez a sélectionner Fichier > Enregistrer. Les noms
des fichiers d’enregistrement automatique portent I'extension . auto. Lorsque vous
effectuez un enregistrement manuel ou que vous revenez a la derniére version enregistrée
avec la commande Revenir a la version enregistrée, le fichier de sauvegarde auto est
supprimé.

3) Cliquez sur OK.

RELATED LINKS:
Enregistrer au format PDF

Importation de caractéristiques a partir d'un modele
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Vue Navigation

Apprenez a utiliser la vue de navigation pour obtenir un apercu rapide de votre structure de documents.

Dans ce sujet
. Introduction
. Utiliser la vue de navigation

Introduction

Lorsque vous travaillez dans un long document, vous pouvez utiliser le panneau Navigation View pour
voir I’'ensemble de la structure du document. La vue de navigation utilise un algorithme intelligent pour
comprendre les titres de votre document pour afficher la structure de votre document.

Utiliser la vue de navigation

Pour vérifier la structure de votre document, lancez la vue de navigation depuis le menu principal Affi-
chage > Panneaux > Vue Navigation ou utilisez le raccourci clavier Echapnv.

EDITING CONTENT
TEXT AND SPECIAL CHARACTERS

g
Editing content
Navigation View =
[ 2O search by Headings & |
KEYWORDS: EDIT CONTENT IN FRAMEMAKER 1
DESCRIPTION: LEARN HOW TO EDIT CONTENT IN FRAMEMAKER 4 Editing content
FrameMaker provides you with a yarietv-at-astionsand-tootistoral 4 Text and special characters
add gttaphlcs, images, tables, and |i Boandill - Add text and special characters
equations and QR codes. Collapse All

= Copy, move, and delete text
Select Heading And Content

= Drag and drop text

Delete

’Text and special charat ____

Importing and linking files
Equations
Markers

KEYWORDS: ADD TEXT, ADD SPECIAL CHARACTERS, DISPLAY PARAGRAPH SYMBOL

DESCRIPTION: KNOW HOW TO ADD TEXT AND SPECIAL CHARACTERS TO THE DOCUMEN

As an authoring environment, FrameMaker provides you will the [t Hypertext commands

special characters) to a document. While text includes the standar Multiple Undo/Redo
numbers, you can also enter characters such as tab, bullet symbaols Search

Add text and special characters

Figure 1: Panneau De vue de navigation et son menu contextuelle

Les fonctions suivantes sont disponibles dans le panneau Navigation View :

. Recherchez un titre en entrant quelques mots clés dans la boite de texte Search by Heading.
. Passez a un titre dans le contenu principal en cliquant sur le texte de titre.

. Sautez en haut du document en cliquant sur la barre haute fleche.

La zone de fonctions suivante est disponible dans le menu contextuelle du panneau Navigation View :
] Elargirtous : Elargissez et montrez tous les titres d’enfants du titre actuellement sélectionné.
. CollapseAll : Effondrez et cachez tous les titres d’enfant du titre actuellement sélectionné.
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Sélectionnez Letitre et le contenu : Sélectionnez le titre et le contenu qui fait partie du titre sélec-
tionné. Dans le cas ou le titre choisi a des titres d’enfant, alors tout ce contenu est également sélec-

tionné.
Supprimer: Supprimer le titre actuellement sélectionné et son contenu.
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Formats de fichiers disponibles pour I'enregistrement

Découvrez les formats de fichiers que FrameMaker peut enregistrer et la facon d'échanger des docu-
ments FrameMaker entre les versions.

Dans ce sujet

J Introduction

J Formats de fichiers FrameMaker

. Formats de fichiers d’un mappage DITA

. Echange de documents avec FrameMaker 8 et versions ultérieures

J Documents d’échange avec FrameMaker 7.2 ou versions antérieures

. Autres formats de fichiers (Texte seulement, SGML, HTML, XML, RTF)

Introduction

Vous pouvez utiliser lacommande Fichier > Enregistrer sous pour enregistrer un document FrameMaker
dans les différents formats de fichiers. Vous pouvez enregistrer en tant que fichier FrameMaker pouvant
étre ouvert dans la version précédente de FrameMaker, Enregistrer au format Maker Interchange
Format (MIF) pour les anciennes versions FrameMaker, ou aux formats Texte seulement, SGML, HTML,
XML et RTF.

Formats de fichiers FrameMaker

Livre 2020 (* .book)
Enregistre le livre FrameMaker en tant que livre accessible et modifiable dans la derniére version
de FrameMaker.

Livre 2019 (* .book)
Enregistre le livre FrameMaker en tant que livre accessible et modifiable dans FrameMaker (version
2019).

Document 2020 (* . £m)
Enregistre le document FrameMaker en tant que document accessible et modifiable dans la
derniere version de FrameMaker.

Document 2019 (* . £m)
Enregistre le document FrameMaker en tant que document accessible et modifiable dans
FrameMaker (version 2019).

MIF 2020 (* .mif)

Crée un fichier texte contenant des instructions FrameMaker décrivant le texte et les graphiques.
Pour éviter d'écraser le document d'origine, enregistrez le fichier MIF sous un nom différent. Vous
pouvez par exemple ajouter une extension .mif au nom.

Pour plus de détails sur le format MIF, consultez le guide de référence MIF.
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Consultation seulement 2020

Enregistre le livre ou le document FrameMaker en tant que livre ou document en lecture seule
accessible et modifiable dans la derniére version de FrameMaker.

Formats de fichiers d’'un mappage DITA

XML (*.xml, .ditamap)

Enregistre le fichier de mappage en tant que fichier . xm1 ou . ditamap accessible dans n'importe
quel éditeur XML.

Document composite 2020 (* . £m)

Enregistre le fichier de mappage et toutes les rubriques incluses sous forme de document
FrameMaker unique. Vous pouvez ouvrir et modifier ce document dans la derniére version de
FrameMaker.

Livre 2020 avec des composants Fm (* . book)

Enregistre le fichier de mappage en tant que fichier . book et toutes les rubriques incluses en tant
que documents FrameMaker (. fm). Vous pouvez ouvrir et modifier ces documents dans la derniére
version de FrameMaker. Cela génére aussi d'autres composants du livre, comme la liste des figures,
ds tableaux et un index.

Echange de documents avec FrameMaker 8 et versions ultérieures

Pour échanger des fichiers FrameMaker avec des versions plus anciennes de FrameMaker, enregistrez le
livre ou le document au format Maker Interchange Format (MIF) de la version actuelle. Ouvrez ce fichier
dans I'ancienne version de FrameMaker et enregistrez-le au format natif de cette version.

Pour plus de détails sur le format MIF, consultez le manuel en lighe Référence MIF.

Documents d’échange avec FrameMaker 7.2 ou versions antérieures

Pour échanger des fichiers FrameMaker avec des versions FrameMaker antérieures a la version 7.2,
enregistrez le livre ou le document au format MIF 7.0 (* .mi£). Ouvrez ce fichier dans FrameMaker 7.2
ou une version antérieure et enregistrez-le au format natif de cette version.

Pour plus de détails sur le format MIF, consultez le manuel en ligne Référence MIF.

WARNING: Le format de fichier MIF 7.0 ne prend pas en charge Unicode. Tous les caractéres non pris en
charge dans FrameMaker 7.2 ou versions antérieures apparaitront sous forme de points d’interrogation
(« ? ») ou disparaitront. L'enregistrement de documents FrameMaker 8 ou de versions plus récentes
sous la version MIF 7.0 n’est pas recommandé en raison de I'absence de prise en charge d'Unicode dans
les versions FrameMaker antérieures a 7.2.

Autres formats de fichiers (Texte seulement, SGML, HTML, XML, RTF)

Texte seulement

Crée un fichier texte simple sans graphiques ni informations de formatage. Pour éviter d'écraser le
document d'origine, enregistrez le fichier texte sous un nom différent. Vous pouvez par exemple
ajouter une extension . txt au nom.
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SGML
Crée un fichier SGML avec le contenu, les éléments et les attributs du document.

HTML

Crée un document HTML (Hypertext Markup Language) pouvant étre consulté sur Internet. Pour
plus de détails sur la mise en correspondance des styles de paragraphes et de caractéres avec des
éléments HTML prédéfinis, consultez Définition et réglage des mises en correspondance HTMIL

REMARQUE : lorsqu’un document FrameMaker structuré est enregistré au format HTML, tous les attributs
de nom identique sont mis en correspondance avec la méme valeur, méme si les valeurs des attributs ne
sont pas les mémes pour tous les éléments. Pour donner a ces attributs des valeurs différentes apres
exportation, il vous faudra utiliser un éditeur de texte pour modifier directement les fichiers résultants.
XML

Crée un document XML pouvant étre utilisé pour échanger des données ou les présenter sur le

Web.

Pour plus de détails sur XML, consultez https://www.w3.org/standards/xml/.

Microsoft RTF

Crée des fichiers au format RTF (Rich Text Format) 1.9 pris en charge par de nombreuses applica-
tions de traitement de texte, ce qui permet de les lire dans d’autres applications. Les formats étant
généralement convertis en styles de traitement de texte, la plupart des éléments de formatage
sont conservés.

Pour plus de détails sur RTF, consultez laspécification RTF (Microsoft Rich Text Format) .

RELATED LINKS:
Enregistrer des documents FrameMaker au format texte seulement

Enregistrer des documents FrameMaker Standard au format XML
Enregistrer des documents FrameMaker structurés aux formats SGML ou XML

Définition et réglage des mises en correspondance HTML
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Enregistrer des documents FrameMaker au format texte seulement

Découvrez comment enregistrer un document FrameMaker en tant que fichier texte seulement, sélec-
tionner le bon codage, et les limites de ce format.

IMPORTANT : Seul le texte ordinaire (texte dans les zones de texte et les tableaux) est enregistré ; les
graphiques, les légendes, les notes de bas de page et les informations de formatage sont perdus. Refor-
matez la césure et les longueurs de ligne selon vos besoins avant d'enregistrer le fichier.

Vous pouvez enregistrer un document FrameMaker en tant que fichier texte seulement. L'enregis-
trement d'un document au format texte seulement crée un fichier texte avec le codage de texte de votre
choix.

Si certains caractéeres ne sont pas disponibles dans le codage choisi, ils sont remplacés dans le fichier
texte. Par exemple, lorsque vous enregistrez un document au format Texte seulement avec le codage
ANSI (Windows) ou ASCII, tous les espaces (cadratins, demi-cadratins, fins et numériques) sont convertis
en espaces Normaux.

1)  Sélectionnez Fichier > Enregistrer au format.
2)  Spécifiez le nom du fichier et I'emplacement et sélectionnez le format Texte seulement.
3) Cliquez sur Enregistrer. La boite de dialogue Enregistrer en tant que texte s’affiche :

Save As Text X
Put a Carriage Return:

(O At the End of Each Line
@ Only between Paragraphs

Include Text from Table Cells:

(® Row by Row
(O Column by Column

Separate Each Table Cell With: EE
Separate Each Row/Column With: E

Encoding: UTF-8 v

Save Cancel

Figure 1: boite de dialogue FrameMaker Enregistrer en tant que texte

4)  Procédez de I'une des fagons suivantes :

- Pour faire de chaque ligne un paragraphe séparé, cliquez sur A la fin de chaque ligne. Cette
option permet de conserver les sauts de ligne et les lignes vides d’origine. Utilisez cette option
pour un fichier comportant des lignes tel qu’un fichier de code informatique.

- Pour fusionner des lignes adjacentes en paragraphes et insérer un retour chariot unique-
ment a la fin des lignes vides, cliquez sur Entre les paragraphes uniquement. Utilisez cette
option pour les fichiers composés de paragraphes tels que les fichiers contenant un texte de
document.
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5)

6)

Pour enregistrer le texte d’un tableau, sélectionnez Inclure le texte des cellules de tableaux.
Continuez comme suit :

- Spécifiez I'ordre dans lequel enregistrer les cellules de tableaux (ligne par ligne ou colonne
par colonne).

- Précisez si vous souhaitez séparer les cellules par des tabulations (\ t) ou par des retours de
chariot (\ r’en choisissant des éléments dans les listes déroulantes.

Si le fichier texte doit étre utilisé sur une plate-forme dont le codage est différent, choisissez un
codage approprié dans la liste déroulante Encodage de texte, puis cliquez sur Enregistrer.

Vous pouvez choisir entre les encodages suivants :
- UTF-8

- Latin-1 I1SO (Unix)

- ASCII

- ANSI (Windows)

- Macintosh

- Japonais (JIS)

- Japonais (Shift-JIS)

- Japonais (EUC)

- Chinois traditionnel (Big5)

- Chinois traditionnel (EUC-CNS)
—  Chinois simplifi\x8e (GB)

- Chinois simplifi\x8e (HZ)

- Coréen

- UTF-16 (Big Endian)

- UTF-16 (Little Endian)

- UTF-32 (Big Endian)

- UTF-32 (Big Endian)

RELATED LINKS:

Formats de fichiers disponibles pour I'enregistrement
Enregistrer des documents FrameMaker Standard au format XML

Enregistrer des documents FrameMaker structurés aux formats SGML ou XML
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Enregistrer des documents FrameMaker Standard au format XML

Découvrez comment enregistrer un document FrameMaker standard au format XML.
Il est possible d’exporter des fichiers structurés et non structurés au format XML.

Pour les documents structurés (fichiers FrameMaker avec une structure intégrée), I'application struc-
turée est utilisée pour enregistrer au format XML.

Pour les documents non structurés (fichiers FrameMaker sans structure intégrée), le mappage utilisé
pour spécifier I'élément a créer pour chaque paragraphe, caractére, révérence croisée, etc. dans le
fichier FrameMaker source est défini sur la page de référence « XML » dans la « table de mappage XML ».

La fonction d'exportation crée un fichier XML et la feuille de style en cascade (CSS, Cascading Style Sheet)
correspondante, qui peut étre utilisée avec le document.
1) Procédez de I'une des fagons suivantes :

- Sélectionnez Fichier > Enregistrer au format XML ou appuyez sur Echap+f+w+x.

- Sélectionnez Fichier > Enregistrer sous, puis sélectionnez XML dans la liste déroulante Enreg-
istrer sous.

Attribuez I'extension . xm1 au fichier.

2) Spécifiez I'emplacement du fichier.

3) Cliquez sur Enregistrer.

RELATED LINKS:
Formats de fichiers disponibles pour I'enregistrement
Enregistrer des documents FrameMaker au format texte seulement
Formats de fichiers disponibles pour I'enregistrement

Enregistrer des documents FrameMaker structurés aux formats SGML ou XML
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Enregistrer des documents FrameMaker structurés aux formats SGML ou XML

Découvrez comment enregistrer un document structuré en format SGML ou XML dans FrameMaker.

Vous pouvez enregistrer tout document FrameMaker structuré au format SGML ou XML. Le contenu, les
éléments et les attributs du document seront conservés, mais pas le formatage. Vous pouvez I'enregis-
trer sous un type de document structuré différent de I'original (du format SGML au format XML par
exemple), mais certaines erreurs risquent de se produire en raison de différences dans les DTD.

Lorsque vous enregistrez un contenu Unicode sous forme de fichier XML, FrameMaker spécifie automa-
tiguement le codage. Par défaut, FrameMaker utilise le format de codage UTF-8.

Avant d’enregistrer un document au format SGML ou XML, vous devez le valider et corriger les erreurs
dans les éléments et les attributs (voir « Validation des documents »). A défaut, le balisage risque d’étre
non valide.

Lors de I'enregistrement de documents XML structurés, vous devez vérifier que les noms des éléments
XML commencent par une lettre et ne contiennent que des caractéres alphanumériques, des points ou
des tirets. Les espaces, traits de soulignement et autres caractéres figurant dans des noms d’éléments

XML sont des caracteres non valides et sont convertis en tirets (-) ou génerent une erreur.

Les titres, les tables et les pages de référence ne sont pas utilisés lors de I'exportation XML, et les noms
par défaut des éléments sont simplement les noms de style.

Les parametres de codage par défaut pour I'exportation de documents structurés sont ISO-8859-1 pour
SGML et UTF-8 pour XML. Si le document structuré est un fichier SGML ou XML importé, FrameMaker
utilise le codage du fichier d’origine plutot que le codage par défaut.

1)  Sélectionnez Fichier > Enregistrer au format.

2)  Spécifiez un nom de fichier et un emplacement. Il peut étre utile d’ajouter I’extension appropriée
(comme .sgmou .xml) au nom du fichier.

3)  Sélectionnez SGML ou XML dans la liste déroulante. Cliquez sur Enregistrer. Si une application est
associée au document, ce dernier est enregistré.

4) Sila boite de dialogue Définir I'application structurée apparait, sélectionnez un nom d'application
dans la liste déroulante Définir I’application structurée. Cliquez sur Continuer. Procédez ensuite de
I"'une des facons suivantes :

- Pour associer une application au document, sélectionnez le nom d’une application.

- Pour utiliser le mappage par défaut et pas des regles de lecture/d'écriture, sélectionnez
<Aucune application>.

En cas d’erreur de structure lors de I'enregistrement d’un document dans FrameMaker, les messages
d’erreur sont répertoriés dans un journal des erreurs en consultation seulement. Si un message fait
référence a une erreur figurant dans le document FrameMaker, le message est lié au document. Dans la
plupart des cas, vous pouvez cliquer sur le message et accéder directement a I'emplacement de I'erreur.

Lorsque vous ouvrez les documents structurés, importez-y les définitions d’éléments. Vous devrez vrais-
emblablement apporter quelques corrections a leur structure.

RELATED LINKS:
Importation de définitions d’éléments dans un livre structuré
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Ajouter des métadonnées a un document

Savoir comment FrameMaker prend en charge Extensible Metadata Platform (XMP)
FrameMaker inclut un support intégré pour Extensible Metadata Platform (XMP).

Les métadonnées (ou informations sur les fichiers) sont des données descriptives pouvant étre
consultées et traitées par ordinateur. Utilisez ces données pour fournir des informations sur le contenu
d’un document et pour conserver des informations sur un document destiné a étre ouvert dans d’autres
applications Adobe. Si vous exportez le fichier concerné au format PDF, la plupart des métadonnées
s’affichent dans Acrobat.

Les balises de métadonnées accompagnent le document et décrivent son contenu. Si vous choisissez
d’incorporer des métadonnées a vos documents, ces derniers sont plus faciles a suivre, a gérer et a
récupérer.

REMARQUE : les métadonnées d’un fichier livre peuvent parfois remplacer les métadonnées d’un fichier
document. Si votre document fait partie d’un fichier livre, ouvrez le fichier livre et sélectionnez le docu-
ment avant d’ajouter les métadonnées.

1)  Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

2)  Cliquez sur Fichier > Informations.
3) Entrezles informations requises dans la zone en regard d’une ou de toutes les catégories.

4)  Pour Marqué, sélectionnez Oui si le document est protégé par les droits d'auteur, ou Non si le
document est explicitement du domaine public. Sélectionnez Indéterminé si vous n'étes pas
certain.

5)  Cliquez sur Définir-
Vous pouvez voir les informations de la boite de dialogue Informations dans les métadonnées de la sortie

PDF lors de sa publication. Par exemple, entrez les informations dans les champs donnés, et vous pouvez
les voir dans les métadonnées de la sortie PDF.

Table 1: Informations mappées en métadonnées

Titres mappés dans les métadonnées du
Informations dans FrameMaker PDF
Auteur Auteur
Title Titre du document
Sujet Description
Mots-cl\x8es Mots-cl\x8es
Copyright Déclaration concernant les droits d’auteur
Instructions Web URL d’information concernant les droits
d’auteur
Marqu\x8e Etat du copyright
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Pour afficher les métadonnées d’un PDF, ouvrez-le dans Adobe Acrobat et procédez comme suit :
1) Sélectionnez Propriétés du fichier.

2) Dans l'onglet Description, vous trouverez un résumé des métadonnées.

3)  Pour afficher l'intégralité des métadonnées, cliquez sur Métadonnées supplémentaires.
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Extensions de fichiers FrameMaker

Connaitre les extensions de fichiers FrameMaker . fm, .mif, .book, .xml, .dita, .ditamap.

Lorsque vous enregistrez un fichier pour la premiere fois dans Windows, FrameMaker ajoute automa-
tiguement ces extensions :

J . fm pour les documents FrameMaker

. .mif pour les documents FrameMaker MIF (Maker Interchange Format)

. .book pour les documents de livres FrameMaker

. .xml/.dita pour les documents XML

] .ditamap pour les fichiers de mappage DITA et les fichiers de plan d’ouvrage

Grace a ces extensions, le systeme d’exploitation Windows reconnaft toujours les fichiers comme étant
des fichiers FrameMaker.

Pour éviter que ces extensions spéciales soient ajoutées aux noms de fichier que vous attribuez, il suffit
de placer les noms de fichier entre guillemets doubles. En I'absence d’une de ces extensions, Windows
ne reconnait pas les fichiers comme étant des fichiers FrameMaker, mais vous pouvez toujours les ouvrir
a partir de FrameMaker.

Si vous attribuez a un fichier une extension enregistrée par une autre application, par exemple . doc ou
.docx, celle-ci n’est pas remplacée par I’extension FrameMaker et vous pouvez toujours ouvrir le fichier
dans FrameMaker.
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DIRECTION D'UN DOCUMENT

Direction d'un document

Familiarisez-vous avec la facon dont Adobe FrameMaker vous permet de créer des documents avec un
sens de lecture de gauche a droite (« LTR » pour « Left-To-Right ») ou de droite a gauche (« RTL » pour
« Right-To-Left"), par exemple pour I'arabe, I'hébreu ou le farsi.

Dans ce sujet

J Modlifier la direction du document actuel
J Conception héritée

. Emplacement et mouvement du caret

Introduction

FrameMaker vous permet de créer des documents avec un sens de lecture de gauche a droite (« LTR »
pour « Left To Right ») ou de droite a gauche (« RTL » pour « Right To Left »), par exemple pour I'arabe,
I’'hébreu ou le farsi. Vous pouvez également choisir de créer des documents multi-directionnels, c’est a
dire des documents avec une direction spécifique mais dont certaines parties se lisent dans I'autre direc-
tion. Par exemple, vous pouvez créer un document dans un script LTR, comme I'anglais, mais incluant des
paragraphes et des tableaux (voir ) créés dans un script RTL, comme I'arabe, I’'hébreu ou le farsi. Vous
pouvez créer un document a enchainements multiples contenant un enchainement (zone de texte) dans
une langue LTR et un autre enchainement dans une langue RTL.

E_-"md a table authored in Hebrew ]

Emsaa Luwramn

Figure 1: Document avec scripts LTR (anglais) et RTL (arabe, hébreu et farsi)

En plus du texte dans un document, vous pouvez également changer |'orientation des images d’un docu-
ment en fonction de son sens de lecture (voir Changer le sens d'un document contenant des objets). Vous
pouvez ajouter des lignes de texte multidirectionnelles aux images dans vos documents (voir Ajout d’une
ligne de texte a un graphique).

Vous pouvez définir une mini table des matieres dans un document FrameMaker dans lequel la direction
est de gauche a droite ou de droite a gauche. Utilisez les repéres directionnels dans le document (Insérer
> Repéres directionnels) pour insérer des repéres de type incorporation LRT/RTL, repéere ou remplace-
ment.
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DIRECTION D'UN DOCUMENT

Vous pouvez également copier et coller ce texte depuis et vers des documents FrameMaker (voir Impor-
tation de fichiers Microsoft Word).

REMARQUE : Lorsque vous importez ou copiez un texte avec une direction spécifique dans un document
FrameMaker, assurez-vous que la direction du texte dans I'emplacement de destination (document,
tableau ou paragraphe) est la méme.

FrameMaker fournit un support de direction des documents prét a I'emploi pour les documents non
structurés et les rubriques DITA. Toutefois, pour les documents structurés basés sur d'autres applications
structurées, le développeur de I'application devra définir la propriété dir dans I'EDD. Pour plus de
détails, voir le Guide de référence du développeur d'applications structurées.

Modifier la direction du document actuel

Pour modifier le sens de lecture du document actuel, procédez comme suit :

1)  Pour faire passer le sens de lecture du document de gauche a droite, sélectionnez Format > Docu-
ment > Direction > De gauche a droite.

2)  Pour faire passer le sens de lecture du document de Droite a gauche, sélectionnez Format > Docu-
ment > Direction > Droite a gauche.

La position du point d'insertion dépend du sens de lecture défini pour le document.

Conception héritée

Dans FrameMaker, la prise en charge de la direction d'un contenu est basée sur la conception héritée.
Par défaut, les objets contenus dans un document hériteront la direction de ce document. Par exemple,
la direction des paragraphes et tableaux insérés dans un document RTL sera RTL. FrameMaker utilise
cette conception héritée pour vous permettre de créer des documents multi-directionnels.

Emplacement et mouvement du caret

Par défaut, le curseur dans un document activé dans le sens RTL se déplace de droite a gauche a mesure
gue vous tapez. FrameMaker a désormais un systéme de caret fort (principal) et de caret faible (secon-
daire). Le caret fort indique ol un caractére inséré sera affiché lorsque la direction de ce caractére est
identique au sens de base du texte. Un caret faible indique ol un caractere inséré sera affiché lorsque la
direction du caractere est l'inverse du sens de base du texte.

Pour modifier le comportement de mouvement du caret :

1)  Choisissez Edition > Préférences.

2) Dans le groupe Mouvement du caret, sélectionnez Logiquepour vous assurer que le mouvement
de la touche reste identique a l'ordre logique des caracteres insérés.

Sélectionnez Visuel pour vous assurer que le mouvement du curseur est dans le sens des touches.
Par exemple, la fleche gauche déplace le curseur vers la gauche.

RELATED LINKS:
Global > Général
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DIRECTION D'UN DOCUMENT

Modeéle de droite a gauche

Définir la direction d’enchainement

Modification du sens du texte dans des documents structurés
Modification du sens du texte dans un tableau

Configuration de paragraphes

Changer le sens d'un document contenant des objets
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PRISE EN CHARGE DES LANGUES ASIATIQUES

Prise en charge des langues asiatiques

FrameMaker fournit un support avancé pour I’édition et la publication des langues asiatiques. Le moteur
de mise en page peut étre spécifié au niveau du paragraphe en spécifiant le compositeur de paragraphe
asiatique.

Lorsque vous sélectionnez une police codée sur deux octets ou une police en langue CJK dans la config-
uration de paragraphes (pour le chinois, le japonais, le coréen), cochez I'option Utiliser le compositeur
asiatique dans Configuration de paragraphes.

Lorsqu'un document hérité est ouvert, cette propriété est activée dans tous les paragraphes contenant
une police sur deux octets ou du texte Rubi pour que le moteur de mise en page asiatique y soit utilisé.

Puisque les deux moteurs de mise en page ont différentes capacités, il se peut parfois qu'aucun ne puisse
gérer le texte correctement. Par exemple, si un paragraphe contient a la fois du texte Rubi et du texte
arabe, aucun des deux moteurs ne pourra le gérer correctement.

Vous pouvez aussi choisir de ne pas afficher cet avertissement et indiquer a FrameMaker de passer
automatiquement au mode de prise en charge des langues asiatiques.

1)  Sélectionnez Edition > Préférences pour ouvrir la boite de dialogue Préférences.

2) Accédez a I'onglet Global > Alertes.

3) Cochez la case Passer automatiquement au compositeur asiatique.
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MISE EN PAGE ET MODELES

Mise en page et modeles

Un modele FrameMaker est constitué de plusieurs composants. Il s’agit notamment des styles de para-
graphes et de caracteres, des mises en page de maquette, des pages de référence et des références
croisées.

Les modeles non structurés, comme les modeéles structurés, nécessitent une planification minutieuse et
une conception en amont lors de la création de modeéles.
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FORMATS

Formats

En savoir plus sur le formatage de paragraphe dans FrameMaker, créer le style paragraphe.
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Styles de paragraphes

Découvrez les styles de paragraphes et comment créer un style de paragraphe dans Adobe FrameMaker.

Dans ce sujet

. Introduction

. Configuration de paragraphes

. Catalogue de paragraphes

. Création d'un style de paragraphe

. Mise a jour d'un style de paragraphe existant

J Mise a jour d'un style de paragraphe existant

J Ajout de graphiques a des styles de paragraphes

Introduction

Dans Adobe FrameMaker, les styles de paragraphes contiennent des parametres permettant de définir
I'aspect du texte et la facon dont le formatage est appliqué a la totalité du paragraphe.

Les styles de paragraphes constituent la base du formatage des documents dans I'application
FrameMaker non structurée, méme s’ils peuvent également étre utilisés comme base du formatage dans
les documents FrameMaker structurés.

Configuration de paragraphes

La Configuration de paragraphes permet de créer des styles de paragraphes et de gérer le format des
paragraphes.

Sélectionnez Format > Paragraphes > Configuration de paragraphes... ou Affichage > Panneaux >
Configuration de paragraphes... ou appuyez sur ctrl+m pour ouvrir la Configuration de paragraphes.

133



Paragraph Designer

Style: ‘BBiBodyBegininew v ‘
Basic Font Pagination Numbering
Advanced Asian Table Cell Direction
Indent
First: Left: Right:
oo | [oor | oo ‘
Spacing
Above Paragraph: Below Paragraph:
lsopt v] [sopt ~|
Others
Alignment: [JTab Stops:
Justified v | (NETREES]
Line Space:
16.0 pt > | [/ Eixed
Next Paragraph Tag:
‘BCiBodyConlent v ‘ Edit...
-ﬁ v c Rename Create Style Apply

Figure 1:  Configuration de paragraphes

Réglages de base

Propriétés de paragraphe telles que le retrait, 'espacement, I'alignement, les taquets de tabula-
tion, l'interligne et le syle de paragraphe suivant a utiliser.

Police

Propriétés de police telles que la famille de polices, la taille, I'angle, I'épaisseur, la couleur
d’arriére-plan et la langue. La liste déroulante Langue vous permet de sélectionner les langues lues
de gauche a droite comme, I'Anglais, I'Allemand ou le Thai, et de droite a gauche comme I'arabe,
I'hébreu et le Farsi.

Pagination

Propriétés de pagination telles que Conserver avec et propriétés de formatage telles que Dans la
colonne, Dans toutes les colonnes.

Numérotation
Utilisez les composants fonctionnels disponibles pour définir un format de numérotation.

Avancé
Propriétés telles que la césure automatique et I'espacement entre les mots.

Asiatique
Appliquez les parametres de langue asiatique tels que I'espacement des caracteres asiatiques.
Inclut la case a cocher Utiliser le compositeur asiatique pour sélectionner le moteur de mise en
page de FrameMaker (voir Prise en charge des langues asiatiques).
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Cellule de tableau
Propriétés de paragraphe appliquées a une cellule de tableau.

Sens
Définissez le sens du paragraphe sur Hériter (par défaut), Gauche a droite ou Droite a gauche.

Catalogue de paragraphes

Le Catalogue de paragraphes répertorie tous les styles de paragraphes disponibles pour un document.

Sélectionnez Format > Paragraphes > Catalogue de paragraphes... ou Affichage > Panneaux > Catalogue
de paragraphes... pour ouvrir le Catalogue de paragraphes.

Pour appliquer un style de paragraphes, sélectionnez le texte et choisissez le style a partir du Catalogue
de paragraphes.

Vous pouvez entrer des parties d’'un nom de style dans la boite de recherche pour réduire la liste des
styles a ceux dont le nom contient

Paragraph Catalog
~u S
L= ﬂ
| a

v Body
Bulleted

v CellBody

v CellHeading

+ Footnote
Heading1
Heading2
HeadingRunlin
Indented
Numbered
Numbered1

v TableFootnote

v TableTitle
Title

Figure 2: Catalogue de paragraphes

Création d'un style de paragraphe

Pour créer un style de paragraphe, procédez comme suit :

1) Sélectionnez Format > Paragraphes > Configuration de paragraphes... ou Affichage > Panneaux >
Configuration de paragraphes... pour ouvrir la Configuration de paragraphes.

2)  Cliquez sur un paragraphe dont le format est similaire a celui que vous souhaitez créer.
Assurez-vous de ne pas sélectionner plusieurs paragraphes.

3) Ouvrez la fenétre Configuration de paragraphes et entrez le nom du nouveau format dans la zone
de texte Style.

4)  Cliquez sur Créer un style.
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Le nouveau style de paragraphe est créé et ajouté au Catalogue de paragraphes.

REMARQUE : Le bouton Mettre a jour le style remplace le bouton Créer un style. Tous les nouveaux styles
de paragraphes sont automatiquement stockés dans le Catalogue de paragraphes.

Mise a jour d'un style de paragraphe existant

Pour mettre a jour un style de paragraphe existant, procédez comme suit :

1)  Sélectionnez Format > Paragraphes > Configuration de paragraphes... ou Affichage > Panneaux >
Configuration de paragraphes... pour ouvrir la Configuration de paragraphes.

2) Cliguez sur un paragraphe dont vous souhaitez mettre a jour le style.
3) Dans la fenétre Configuration de paragraphes, modifiez les caractéristiques de votre choix.
4)  Cliquez sur Mettre a jour le style.

Définition du style du paragraphe suivant

Les modeles bien congus relient souvent les styles entre eux de sorte que FrameMaker applique automa-
tiguement un style au paragraphe suivant le paragraphe en cours.

Pour définir le style du paragraphe qui suit le paragraphe actuel, procédez comme suit :

1) Cliquez sur le paragraphe.

2) Affichez les caractéristiques de Bases dans la fenétre Configuration de paragraphes, puis sélec-
tionnez un style dans la liste déroulante Style du paragraphe suivant. FrameMaker applique ce
style au nouveau paragraphe lorsque vous appuyez sur la touche Entrée pour créer un paragraphe.

3) Cliquez sur Appliquer.

Ajout de graphiques a des styles de paragraphes

Un style de paragraphe peut inclure une ligne ou un graphique qui s’affiche au-dessus ou au-dessous
d’un paragraphe. Par exemple, tous les intitulés de niveau supérieur d’'un document peuvent reposer sur
une longue ligne fine.

Pour ajouter des graphiques a un style de paragraphe, procédez comme suit :

1)  Surlapage de référence, dessinez ou importez le graphique dans un cadre de référence ou repérez
un graphique que vous souhaitez utiliser.

2)  Cliguez sur le paragraphe a modifier. Pour placer une ligne au-dessus ou au-dessous de plusieurs
paragraphes adjacents, sélectionnez tous les paragraphes.

3)  Affichez les caractéristiques Avancées de la fenétre Configuration de paragraphes, et sélectionnez
le nom d’un cadre de référence dans la Isite déroulante Cadre dessus ou Cadre dessous. Tous les
cadres de référence s’affichent dans les listes déroulantes.

4)  Cliquez sur Appliquer.
CONSEIL : Les options Cadre dessus et Cadre dessous ne permettant pas de placer des graphiques a

gauche ou a droite d’un paragraphe, vous ne pouvez pas les utiliser pour encadrer du texte. Vous pouvez
encadrer du texte en utilisant un tableau a une seule cellule avec un trait d’encadrement extérieur.
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Styles de caractéeres

Découvrez les styles de caracteres et comment créer un style de caractéres dans Adobe FrameMaker.

Dans ce sujet

. Introduction

. Configuration de caracteres
. du modele

. Créer un style de caracteres

Introduction

Les styles de caracteres vous permettent de formater un ou plusieurs caractéres ou mots a l'intérieur
d’un paragraphe.

Grace a l'application d'un style de caractéres, vous pouvez formater rapidement du texte sans remplacer
les caractéristiques de tout un paragraphe.

La création de styles de caracteres permet de conserver la cohérence du format et d’appliquer globale-
ment des modifications.

Les styles de caracteres servent également de composantes pour d’autres fonctionnalités de
FrameMaker, telles que les formats de références croisées ou les variables.

Configuration de caractéres

La Configuration de caracteéres est utilisée pour créer et gérer les styles de caracteres. Tous les styles de
caracteres sont répertoriés dans le Catalogue de caractéres.

Character Designer

Style: ‘DBiDialogBoxComponenL v ‘
Family: Size:
‘Myriad Pro v ‘ v
Color: Background:

M CorporateColor_Secondar Asls e
Weight: Angle: Variation:

Regular v halic v Asls e
[m] Underline v | [m]Overline [m] Strikethrough
Letter Spacing: Stretch: Language:
| | | N -
[m] Superscript ~ | [m] Small Caps v
[m] Pair Kern [m] Change Bar [m] Tsume

ﬁ v c Rename Create Style Apply

Figure 1:  Configuration de caracteres
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La Configuration de caracteéres vous permet de créer un nouveau style de caractére ou de mettre a jour
un style de caractére existant. Un large éventail d’options de mise en forme des caracteres sont a votre

disposition pour créer des styles de caractéres en fonction de vos besoins.

du modele

Le Catalogue de caractéres répertorie tous les styles de caractéres disponibles pour un document. Pour

appliquer un style de caractere, sélectionnez le texte, puis le style dans le Catalogue de caractéres.

Figure 2: Catalogue de caracteres

Créer un style de caractéres

1) Cliquez sur une plage de texte dont le style est similaire a celui que vous souhaitez créer.

Character Catalog

< 1

[ oemitirom

DE_DialoaBexComponent
" DT_DialogTitle
 EH_EmphasisHeawy
+ El_Emphasistalic
o LT_Link Text
W MO _MenuCption
PMN_PageMNumber
W SN_StepMumber
i WD_Wingdings

Assurez-vous de ne pas sélectionner plusieurs paragraphes.

2)  Ouvrez la Configuration de caractéres et saisissez le nom du nouveau style dans le zone de texte

Style.

REMARQUE : Le bouton Créer un style remplace le bouton Mettre style a jour. Tous les nouveaux

styles de caractéres sont automatiquement stockés dans le Catalogue de caractéres.
3)  Modifiez les caractéristiques a inclure dans le nouveau style de caractéres.

4)  Cliquez sur Créer un style.
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Gérer les styles

Découvrez comment Adobe FrameMaker fournit des fonctionnalités permettant de gérer divers para-
graphes, caracteres et styles de tableaux.

Dans ce sujet

. Application des styles

J Mise a jour des styles

. Mettre a jour un style de paragraphe

. Mettre a jour un style de caracteres

J Mise a jour de caractéristiques de styles spécifiques ou d’un groupe de caractéristiques
. Reformatage de tous les paragraphes avec un nouveau style

o Suppression d'un style de paragraphe du catalogue de styles de documents

J Suppression d'un style de caractere du catalogue de styles de documents

] Modification du nom d’un style

. Conseils pour la création de styles

Application des styles

Les styles de paragraphes s’appliquent au niveau d'un paragraphe, les styles de caractéres au niveau d'un
caractere ou d'un mot, et les styles de tableaux s’appliquent a des tableaux entiers.

. Styles de paragraphes et de tableaux : placez le curseur dans le paragraphe ou le tableau, puis
sélectionnez un style dans le catalogue.

] Styles de caracteres : sélectionnez le texte et cliquez sur un style dans le catalogue.

Mise a jour des styles

Vous pouvez modifier les caractéristiques de style et les utiliser pour redéfinir ou mettre a jour les styles
enregistrés et tout le texte portant leur étiquette dans le document.

Lors de la mise a jour d’un style, vous pouvez redéfinir toutes les caractéristiques ou uniquement un
groupe de caractéristiques. Par exemple, vous pouvez modifier la famille de polices par défaut de tous
les styles d’'un document sans modifier aucune autre caractéristique.

. Pour mettre a jour un ou tous les styles de paragraphes dans le document avec un groupe de
caractéristiques d’un paragraphe, cliquez sur ce paragraphe ou sélectionnez des paragraphes
consécutifs.

. Pour mettre a jour plusieurs styles de paragraphes mais pas tous, sélectionnez des paragraphes
consécutifs qui utilisent les styles a mettre a jour.

L'importations de définitions de paragraphe ou de police de caractere est également possible en sélec-
tionnant la commande Fichier > Importer > Formats.
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Mettre a jour un style de paragraphe

Pour mettre a jour un style de paragraphe dans Adobe FrameMaker, procédez comme suit :

1)  Sélectionnez Format > Paragraphes > Configuration de paragraphes pour ouvrir la Configuration
de paragraphes.

2)  Pour afficher les caractéristiques d’un style, y compris le style personnalisé, sélectionnez le texte a
analyser.
Pour afficher les caractéristiques du style telles que définies pour le style, choisissez a nouveau le
style dans la liste déroulante Style.

3) Moadifiez les caractéristiques souhaitées, puis cliquez sur Mettre a jour le style. FrameMaker
demande si vous souhaitez supprimer les personnalisations.

ConsElL : Si vous modifiez les caractéristiques de la fenétre de configuration, puis décidez de ne pas
mettre a jour le style, vous pouvez annuler I'opération et rétablir les caractéristiques en cliquant dans le
texte.

Mettre a jour un style de caractéres

Pour mettre a jour un style de caractéres dans Adobe FrameMaker, procédez comme suit :

1)  Sélectionnez Format > Paragraphes > Configuration de paragraphes pour ouvrir la Configuration
de paragraphes.

2)  Pour afficher les caractéristiques d’un style, y compris le style personnalisé, sélectionnez le texte a
analyser.

Pour afficher les caractéristiques du style telles que définies pour le style, choisissez a nouveau le
style dans la liste déroulante Style.

3) Moaodifiez les caractéristiques souhaitées, puis cliquez sur Mettre a jour le style. FrameMaker
demande si vous souhaitez supprimer les personnalisations.

ConsElL : Si vous modifiez les caractéristiques de la fenétre de configuration, puis décidez de ne pas
mettre a jour le style, vous pouvez annuler I'opération et rétablir les caractéristiques en cliquant dans le
texte.

Mise a jour de caractéristiques de styles spécifiques ou d’un groupe de caractéristiques

Pour mettre a jour une caractéristique spécifique d'un style de paragraphe ou de caractere dans Adobe
FrameMaker, procédez comme suit :

1)  Pour mettre a jour une caractéristique spécifique d'un style de paragraphe, choisissez Format >
Paragraphes > Configuration de paragraphes pour ouvrir la Configuration de paragraphes.

Pour mettre a jour une caractéristique spécifique d'un style de caractéere, choisissez Format > Car-
actéres > Configuration de caracteres pour ouvrir la Configuration de caracteres.

2)  Pour mettre a jour des caractéristiques spécifiques d'un style, ne modifiez que la caractéristique a
mettre a jour.

Pour mettre a jour un groupe spécifique de caractéristiques d'un style, sélectionnez Définir tel que
pour tous les paramétres dans la liste déroulante Commandes de la boite de dialogue de configu-
ration pour définir toutes les définitions de formatage sur Tel quel. Modifiez les caractéristiques ap-
propriées.
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3) Choisissez Options de mise a jour globale dans la liste déroulante Commandes.

4)  Pour mettre a jour un style de paragraphe, indiquez si vous souhaitez mettre a jour la définition du
style avec toutes les caractéristiques de tous les groupes de caractéristiques (Toutes caractéris-
tiques) ou uniquement les modifications effectuées dans le groupe de caractéristiques courant
(<Nom du groupe de caractéristiques> seulement).

Le champ Options de mise a jour globale de la Configuration de caractéres n’affiche pas cette op-
tion car la Configuration de caractéres ne contient qu’un groupe de caractéristiques.

5) Dans la section Mise a jour des styles de paragraphes / Mise a jour des styles de caractéres :

- Sélectionnez Tous les parag. et les entrées du catalogue ou Tous les caractéres et entrées de
catalogue pour appliquer le style sélectionné a tous les paragraphes/caractéres du document
courant.

- Sélectionnez Toutes étiquettes correspondantes dans la sélection pour appliquer la défini-
tion de style modifiée a tous les paragraphes ou caracteres du document courant qui
affichent les mémes styles que les paragraphes/caractéres sélectionnés.

- Sélectionnez Formats étiquetés pour remplacer le style actuel de tous les para-
graphes/caracteres du document par un nouveau style. Voir la section Reformatage de tous
les paragraphes avec un nouveau style pour plus de détails.

6) Cliquez sur Mettre style a jour dans la boite de dialogue Configuration.

Reformatage de tous les paragraphes avec un nouveau style

Dans Adobe FrameMaker, vous pouvez remplacer le style de paragraphe de tous les paragraphes du
document par un nouveau style. Par exemple, vous pouvez remplacer tous les paragraphes du document
formaté avec le style « Normal » par « Body ».

Pour appliquer un style différent a tous les paragraphes du document, procédez comme suit :

1) Sélectionnez un paragraphe affichant le nouveau style que vous voulez appliquer a tous les para-
graphes.

2) Sélectionnez Format > Paragraphes > Configuration de paragraphes pour ouvrir la Configuration
de paragraphes.

3) Sélectionnez Options de mise a jour globale dans la liste déroulante Commandes dans la Configu-
ration de paragraphes.

4)  Sélectionnez le style cible dans la liste déroulante Formats étiquetés.
5) Cliquez sur Mettre a jour.

6) Répondezalaquestion « Changer toutes les étiquettes <Nom du style actuel>en <Nom du nouveau
style> ? » en sélectionnant OK.

FrameMaker reformate tous les paragraphes du document actuel formaté en remplagant <Nom du style
actuel> par <Nom du nouveau style>.

Suppression d'un style de paragraphe du catalogue de styles de documents

NOTICE: La suppression d’un style du catalogue de styles de documents n’affecte pas le contenu auquel
ce style a été appliqué. Le contenu affiche simplement un style qui ne figure pas dans le catalogue.
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Pour supprimer un style de paragraphe du catalogue de styles de documents, procédez comme suit :

1) Sélectionnez Format > Paragraphes > Catalogue de paragraphes. Le Catalogue de paragraphes
s’affiche.

2) Cliguez sur le bouton Supprimer. La boite de dialogue Supprimer des formats du catalogue
s’affiche.

3) Sélectionnez le style de paragraphe que vous voulez supprimer.
4)  Cliquez sur Supprimer.
5) Cliquez sur OK pour fermer la boite de dialogue.

Suppression d'un style de caractére du catalogue de styles de documents

NOTICE: La suppression d’un style du catalogue de styles de documents n’affecte pas le contenu auquel
ce style a été appliqué. Le contenu affiche simplement un style qui ne figure pas dans le catalogue.
Pour supprimer un style de caractére du catalogue de styles de documents, procédez comme suit :

1) Sélectionnez Format > Caractéres > Catalogue de caractéres. Le Catalogue de caracteéres s’affiche.

2) Cliguez sur le bouton Supprimer. La boite de dialogue Supprimer des formats du catalogue
s’affiche.

3) Sélectionnez le style de caractére que vous voulez supprimer.
4)  Cliquez sur Supprimer.
5)  Cliquez sur OK pour fermer la boite de dialogue.

Modification du nom d’un style

Pour renommer un paragraphe ou un style de caractere dans un document Adobe FrameMaker,
procédez comme suit :

1)  Pour renommer un style de paragraphe, choisissez Format > Paragraphes > Catalogue de para-
graphes pour ouvrir le Catalogue de paragraphes.

Pour renommer un style de caractére, choisissez Format > Caractéres > Catalogue de caractéres
pour ouvrir le Catalogue de caracteéres.

2) Choisissez le style a renommer dans la liste déroulante Style.
3) Saisissez le nouveau nom dans la liste déroulante Style, puis cliquez sur Renommer.

Ajout de styles manquants dans le catalogue de styles

La suppression d’un style du catalogue de styles de documents n’affecte pas le contenu auquel ce style
a été appliqué. Le contenu affiche simplement un style qui ne figure pas dans le catalogue.

Pour ajouter des styles de paragraphes ou de caractéres appliqués a des paragraphes ou caractéres, mais
qui ne figurent pas dans les catalogues de styles, procédez comme suit :

Choisissez Fichier > Utilitaires > Créer et appliquer des formats, puis cliques sur Continuer. FrameMaker
replace dans le catalogue tout paragraphe ou style de caractére utilisé dans le document.

REMARQUE : FrameMaker crée également de nouveaux styles et les ajoute au catalogue de styles pour
tout style de paragraphe ou de caractére personnalisé. Par exemple, si vous avez plusieurs paragraphes
avec le style « Body », et que chacun d'eux affiche un formatage personnalisé, FrameMaker crée de
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nouveaux styles sous la forme « Bodyl », « Body2 », « Body3 » pour chaque personnalisation.
FrameMaker applique également les nouveaux styles a ces paragraphes et ajoute les nouveaux styles au
catalogue de styles de documents.

Conseils pour la création de styles

Si vous concevez un nouveau modeéle ou si celui que vous utilisez est incomplet, vous pouvez étre amené
a créer de nouveaux styles. La méthode la plus simple pour créer un style consiste a modifier les
caractéristiques d’un style existant.

Lorsque vous créez des styles, prenez en compte les points suivants :

Utilisez des conventions de nom cohérentes pour des paragraphes ou des éléments de texte de
méme type au sein d’un paragraphe, tel que « Intitulél » et « Intitulé2 ».

Pour appliquer des styles en utilisant le clavier, nommez ces styles de sorte que les plus utilisés
soient uniques ou classés dans les premiers de leur groupe de lettre (par ordre alphabétique), par
exemple « 11-Intitulél » ou « 11-Intitulé2 ».

Attribuez a chaque style un nom sémantique facile a mémoriser, a reconnaitre et a saisir. De plus,
si vous attribuez une style sur la base de son utilisation et non de son aspect, vous pourrez modifier
les caractéristiques du style sans devoir modifier son nom. Par exemple, si vous souhaitez créer un
style de caractere pour afficher un terme en gras, nommez le style de caractere « terme » au lieu
de « gras ». Vous pouvez définir la graisse de police « Gras » pour ce style de caractére. Si vous
souhaitez formater plus tard tous les termes en jtalique au lieu de gras, il vous suffit de remplacer
les définitions de graisse et d'angle de police du style de caractére « terme ». Cette convention de
dénomination évite de devoir renommer et redéfinir le style tout en conservant sa signification
sémantique.

Soyez attentif a Iutilisation de la casse. Les noms de styles sont sensibles a la casse. De plus, vous
pouvez souhaiter que des styles associés s’affichent ensemble dans le catalogue, par exemple
« Courant » et « Courant-Retrait ».

Lors de la création de styles pour des modeéles structurés, la maintenance du modeéle devient
souvent plus simple si vous attribuez a un style le nom de I'élément qui utilise ce style. Par exemple,
pour un élément comme <shortdesc>, vous pouvez également nommer le style de paragraphe
shortdesc.
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Catalogues de styles

Découvrez les catalogues de styles dans Adobe FrameMaker.

Dans ce sujet

] Introduction

. Configuration des styles affichés dans un catalogue de styles
. Supprimer des styles

Introduction

Adobe FrameMaker offre des fonctionnalités avancées pour gérer et appliquer les styles de paragraphe,
de caractere et de tableau. Cela est possible avec les catalogues respectifs. Par défaut, un catalogue
affiche tous les styles dans le document actif. Vous pouvez définir les styles que vous souhaitez voir dans
le catalogue. Les catalogues sont également utiles pour appliquer et gérer les styles.

FrameMaker marque les styles utilisés dans un catalogue. Les styles inutilisés ne sont pas marqués. Ces
informations d’utilisation ne sont pas mises a jour dés que vous appliquez les styles dans le document.
Cliguer sur Actualiser le catalogue dans le catalogue met a jour les informations d’utilisation. Les infor-
mations d’utilisation les plus récentes sont également mises a jour lors de I'ouverture d’'un document.

Configuration des styles affichés dans un catalogue de styles

Pour configurer les styles visibles dans un catalogue de styles et modifier leur ordre, procédez comme
suit :
1) Ouvrez un catalogue (paragraphe, caractére ou tableau) et cliquez sur Options. La boite de
dialogue Définir les formats disponibles s’affiche.
2)  Sélectionnez I'une des options ci-dessous.
- Sélectionnez Tout afficher pour voir tous les styles disponibles.

- Sélectionnez Afficher les formats utilisés avant les formats inutilisés pour voir les styles util-
isés avant les styles inutilisés dans le catalogue.

- Sélectionnez Afficher uniquement les formats utilisés pour masquer les styles inutilisés du
catalogue, mais les conserver dans le document.

- Sélectionnez Afficher uniquement les formats inutilisés pour masquer les styles utilisés du
catalogue, mais les conserver dans le document.

- Sélectionnez Supprimer tous les formats inutilisés pour supprimer tous les styles inutilisés du
document actif, sans avertissement ou confirmation.

- Sélectionnez Liste personnalisée, puis cliquez sur Modifier pour personnaliser les formats qui
s'affichent dans le Catalogue et dans quel ordre.

3)  Les styles utilisés dans le document actif sont signalés dans le catalogue. Lorsque le document est
modifié, I’état d’utilisation n’est pas mis a jour automatiquement. Pour actualiser la liste, cliquez
sur Actualiser le catalogue.

REMARQUE : les options d’affichage que vous définissez sont des propriétés de I’espace de travail applica-
bles aux documents FrameMaker ouverts sur votre ordinateur.
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Supprimer des styles

Pour supprimer les styles d’un catalogue de document, procédez comme suit :
. Ouvrez le catalogue en question s’il n’est pas déja ouvert.

- Sélectionnez Affichage > Panneaux > Catalogue de paragraphes pour ouvrir le Catalogue de
paragraphes.

- Sélectionnez Affichage > Panneaux > Catalogue de caractéres pour ouvrir le Catalogue de
caracteres.

- Sélectionnez Affichage > Panneaux > Catalogue de tableaux pour ouvrir le Catalogue de
tableaux.

. Cliquez sur Supprimer.
. Dans la fenétre Supprimer des formats du catalogue, sélectionnez un format et supprimez-le.

. Cliquez sur OK pour supprimer les styles du document ou pour fermer la fenétre et annuler I'opéra-
tion.
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Polices

Familiarisez-vous avec les polices de FrameMaker, les barres de modifications, le crénage de paire, et les
polices japonaises et occidentales.

Dans ce sujet

J Remplacement des polices a I'aide du panneau Polices

] Modification manuelle des polices

. Modification des polices a I'aide des fenétres de configuration

. Réglage de la mise en indice, en exposant et en petites capitales

J Réglage de la mise en indice, en exposant et en petites capitales

. Concentration et étirement des caractéres

J Création ou modification de polices de caractéres occidentaux et japonais

Remplacement des polices a I’aide du panneau Polices

Vous pouvez utiliser le panneau Polices pour identifier toutes les polices utilisées dans un ou tous les
documents ouverts. La zone de liste du panneau répertorie toutes les polices utilisées dans un document.
Vous pouvez remplacer toutes les polices utilisées dans un document, y compris les polices manquantes,
a 'aide du panneau Polices. Les polices manquantes sont signalées par une croix rouge.

A B cC D
B
= Y O
Font = Document
E—+Gisha Legal fm

Figure 1: La zone de liste du panneau Polices répertorie toutes les polices utilisées dans un document.

A. Affichez uniquement les polices manquantes ou toutes les polices utilisées dans un document. B.
Remplacez la police pour afficher le panneau Remplacer la police. C. Sélectionnez tous les documents
ouverts ou seul le document ouvert actuellement. D. Actualisez la liste des polices affichées dans la zone
de liste du panneau. E. Les polices manquantes sont signalées par une croix rouge.
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Pour remplacer une police manquante :
1) Sélectionnez une police de la liste, puis cliquez sur I'icone Remplacer.

2) Dans le panneau Remplacer la police, sélectionnez la nouvelle police dans la zone de liste
Remplacer par, puis cliquez sur Appliquer.

Replace Font L. ade ] = — =
A - FontName: Gisha
B il Replace With. Adobe Arabic
C- Document Legalfm Apply
Locations
Page Size Angle Weight Vanation
D == 3 120pt Regular Regular Regular
3 240 pt Regular Bold Regular
4 120pt Regular Regular Regular
Left 8.0 pt Regular Regular Regular
Left 120pt Regular Regular Regular
Left 180pt Regular Bold Regular
Right 180pt Regular Bold Regular
Right 8.0 pt Regular Regular Regular
Right 120pt Regular Regular Regular
HTML 6.0 pt Regular Regular Regular
HTAM 19 N nd Doamslar Bnlid Boamidar

Figure 2: Le panneau Remplacer la police répertorie tous les paragraphes d’un document qui utilisent une
police sélectionnée.
A. Nom de la police sélectionnée. B. La zone de liste Remplacer par répertorie toutes les polices in-
stallées sur un systéme. C. La liste Emplacements affiche tous les paragraphes du document qui uti-
lisent la police sélectionnée. D. Cliquez deux fois sur n’importe quel élément de la liste permet
d’accéder a I'emplacement du document qui utilise la police sélectionnée.

Modification manuelle des polices

Les modifications de format effectuées a I'aide des commandes du menu Format prennent effet immédi-
atement.

Lorsque vous modifiez les caractéristiques de police, tenez compte des points suivants :

o Pour supprimer les autres caractéristiques de format, choisissez Format > Styme > Normal.

) Si vous modifiez les caractéristiques de police d’un texte sélectionné, elles sont conservées lors de
la mise a jour ultérieure des caractéristiques du paragraphe entier.

. Vous pouvez modifier les caractéristiques de police d’un texte créé a I'aide de I'outil Ligne de texte
ainsi que du texte de paragraphe.

J Si une police posséde plusieurs graisses (par exemple, Helvetica® Condensed Bold et Helvetica
Condensed Black), le sous-menu Format > Style n’affiche que Bold. Pour choisir d’autres poids,
utilisez les caractéristiques de police de la fenétre Configuration de paragraphes ou de la fenétre
Configuration de caractéres.

Modification des polices a I’aide des fenétres de configuration

Pour modifier les caractéristiques de la police par défaut d’un paragraphe entier, utilisez la fenétre
Configuration de paragraphes. Les familles de polices et les styles disponibles sont fonction des polices
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installées. Pour modifier un texte spécifique dans un paragraphe, sélectionnez le texte et utilisez la
fenétre Configuration de caracteéres.

Vous avez déja probablement rencontré plusieurs de ces paramétres dans d’autres traitements de texte,
mais il se peut que certains soient nouveaux pour vous.

Souligné numérique
Pour utiliser un décalage et une épaisseur uniques pour un souligné, quelle que soit la police ou la
taille des caracteres, choisissez Souligné numérique. Le soulighement numérique et standard
n’affecte pas les caractéres de tabulation. Pour souligner I’espace de tabulation, formatez ce taquet
afin qu’il utilise un espace insécable comme caractére de conduite.

Mt. Everest is 25,028 .

Mt. Everest is29.025 i1

Figure 3:  Souligné numérique et standard

Barre de modification
Pour afficher une barre de modification a c6té du texte, sélectionnez Barre de modif.

Couleur

Pour afficher le texte dans une autre couleur, choisissez une couleur dans la liste déroulante
Couleur. Si vous définissez vos propres couleurs, elles s’affichent dans cette liste.

Approche

Pour ajouter ou retirer des espaces entre des caractéres, entrez un pourcentage dans le champ
Approche. Cette valeur est exprimée sous forme de pourcentage d’un espace cadratin. L'approche
normale est 0 %.

On Jooking towards
On looking towards
On looking towards

Figure 4: Approche de -10 % (haut), de 0 % (centre) et de 10 % (bas)

Etirement
Pour régler la largeur des caractéres, entrez un pourcentage dans le champ Etirement.

Casse

Pour afficher tous les caractéres en majuscules mais avec des lettres majuscules légerement plus
petites pour le texte en minuscules, sélectionnez Petites capitales.

L'utilisation d’une fenétre de configuration pour appliquer un style de casse au texte ne modifie
que I'aspect de ce dernier (ainsi par exemple, un texte en minuscules s’affiche en majuscules). Pour
modifier définitivement le texte lui-méme, utilisez la boite de dialogue Casse pour remplacer le
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texte sélectionné par I’équivalent en majuscules, en minuscules ou avec une majuscule en début
de mot.

REMARQUE : Vous pouvez afficher la boite de dialogue Casse a |'aide des raccourcis clavier Echap,e, Maj+c.

Langue

Pour modifier la langue associée au texte, utilisez la liste déroulante Langue. La langue choisie
affecte le texte dans les variables systéme, ainsi que la vérification orthographique et la césure.
Toutefois le fait de définir la langue sur Aucune empéche la vérification orthographique du texte
sélectionné.

Crénage par paire

Pour régler I'espace entre deux caracteres du méme mot, sélectionnez Crénage par paire. Les
crénages par paire qui ont été définis sont fonction de la police.

1y || Ty

Figure 5:  Crénage par paire activé et désactivé

Tsume

Pour rapprocher un caractéere japonais du caractere qui lui est contigu, sélectionnez Tsume.
L’espace que peut occuper un caractere de largeur variable, tel qu’une parenthese, est déterminé
par la valeur métrique de ce caractere.

Réglage de la mise en indice, en exposant et en petites capitales

Les réglages définis pour les caractéristiques d’un texte mis en exposant, en indice (références de note
de bas de page incluses) ou en petites capitales s’appliquent a tout texte de ce type dans un document.

1)  Dans la boite de dialogue Options de texte, spécifiez la taille, le décalage et le pourcentage d’étire-
ment.

Lors du calcul de la taille et du décalage, FrameMaker multiplie le pourcentage entré par la taille en
points des caractéres affectés. Par exemple, un décalage d’exposant de 40 % éléve de 4 points un
caracteére dont la taille est égale a 10 points.

Le pourcentage d’étirement correspond au degré de concentration ou d’étirement des caracteres.
2) Cliguez sur Appliquer.

Concentration et étirement des caractéres

Certains effets peuvent étre obtenus en étirant les caracteres.

On Jooking towards
On looking towards
On looking towards
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Figure 6: Texte condensé (en haut), normal (milieu) et étiré a 75 % (en bas)

1) Selon que vous souhaitez modifier I'intégralité du paragraphe ou une partie de celui-ci, choisissez
I"'une des méthodes suivantes :

- Police de la liste déroulante Caractéristiques de la fenétre Configuration des paragraphes.
- Configuration de caractéres.

2)  Entrez un pourcentage dans le champ Etirement. Une valeur de 100 % signifie que la largeur des
caracteres est égale a celle qui est définie pour la police. Une valeur inférieure a 100 % réduit la
largeur ; une valeur supérieure a 100 % I'augmente.

3) Cliquez sur Appliquer.

ConsElL : Dans les documents japonais, utilisez une valeur d’étirement supérieure a 100 pour
simuler la forme heitai (caractéres étirés horizontalement). Utilisez une valeur inférieure a 100 et
augmentez la taille en points du texte pour simuler la forme chotai (caractéeres étirés verticale-
ment).

Vous pouvez également modifier la largeur d’une ligne de texte en faisant glisser le texte afin de |étirer.

1) Sélectionnez la ligne de texte a modifier et faites glisser I'une de ses poignées afin d’étirer le texte
jusqu’a ce qu’il prenne la forme souhaitée. Si vous faites glisser une poignée d’angle, la taille en
points est modifiée ainsi que la largeur des caractéres. Vous pouvez également choisir un objet
groupé incluant une ligne de texte.

Création ou modification de polices de caractéres occidentaux et japonais

Outre le syllabaire japonais intégral, les polices japonaises incluent un jeu de caracteres occidentaux qui
facilite la saisie des caractéres et des nombres non japonais. Vous pouvez définir votre propre police
combinée : une police associant une police occidentale spécifiée et une police japonaise spécifiée.

Si votre systeme prend en charge le texte japonais et que des polices combinées sont incluses comme
éléments d’un modele, ces derniéres sont disponibles automatiquement (les polices spécifiées doivent
étre installées). S’il prend en charge la saisie de texte japonais dans les documents et les boites de
dialogue, les polices combinées s’affichent en haut de la liste des polices avec les polices occidentales et
japonaises standard.

FrameMaker prend également en charge les caracteres katakana a un octet (demi-largeur) dans les
polices combinées. Toute modification appliquée aux polices combinées s’applique a I'intégralité du
document.

1) Dans la boite de dialogue Polices combinées, effectuez I'une des opérations suivantes :

- Pour créer une nouvelle police combinée, entrez un nom dans le champ Nom de police
combinée.

- Pour modifier une police combinée, sélectionnez son nom dans la liste Polices combinées.

2)  Procédez comme suit :

- Pour spécifier la police japonaise, choisissez un nom dans la liste déroulante des familles de
polices de la zone Texte asiatique.

- Pour spécifier la police occidentale, choisissez un nom dans la liste déroulante des familles de
polices de la zone Texte occidental.

150



- Pour régler le décalage de la ligne de base et la taille relative du texte occidental, entrez des
valeurs dans les champs Taille et Décalage. La taille et le décalage du texte occidental sont
des pourcentages de la taille en points de la police asiatique. Utilisez un décalage négatif pour
déplacer le texte sous la ligne de base.

3) Cliquez sur Ajouter ou sur Modifier.
4) Cliquez sur Terminé.

REMARQUE : Vous pouvez désactiver le parametre Autoriser styles gras et oblique dans la zone Texte
asiatique de la boite de dialogue Editer les polices combinées pour éviter I'application des styles Gras ou
Italique au texte asiatique lorsque vous appliquez ces styles au texte occidental.

1)  Pour copier un jeu de polices combinées, choisissez Fichier > Importer > Formats, puis sélection-
nezPolices combinées.
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Couleur d’arriére-plan

Découvrez comment mettre en surbrillance les sections d’'un document Adobe FrameMaker en définis-
sant la couleur d’arriére-plan du texte ou du paragraphe entier.

Dans ce sujet

Introduction

Définir la couleur d’arriere-plan du texte dans un paragraphe

Définir la couleur d'arriére-plan pour un paragraphe entier
Définir la couleur d’arriere-plan d’une case de paragraphe

Introduction

Vous pouvez mettre en surbrillance des sections d’'un document en définissant la couleur d’arriére-plan
de parties du document dans les cas suivants :

Définir la couleur d’arriére-plan d’une partie de texte spécifique dans un paragraphe.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam
accumsan, urna nec gravida feugiat, nisl arcu egestas urna, id feugiat

lectus risus eget lectus.

Sed vehicula cursus interdum. Donec id turpis pellentesque, commodo
sem in, vestibulum leo. Sed purus ante, tincidunt eget diam id, ultrices
ornare elit. Praesent id sapien tristique risus finibus convallis. Sed et
nulla ante. Nulla pulvinar, lectus n on consectetur feugiat, nibh mauris

mollis odio, ut gravida dui libero et ligula.

Figure 1:  Couleur d’arriere-plan du texte

Définir la couleur d’arriére-plan du texte entier d’un paragraphe.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam
accumsan, urna nec gravida feugiat, nisl arcu egestas urna, id feugiat

lectus risus eget lectus.

Sed vehicula cursus interdum. Donec id turpis pellentesque, commodo
sem in, vestibulum leo. Sed purus ante, tincidunt eget diam id, ultrices
ornare elit. Praesent id sapien tristique risus finibus convallis. Sed et
nulla ante. Nulla pulvinar, lectus n on consectetur feugiat, nibh mauris

mollis odio, ut gravida dui libero et ligula.

Figure 2:  Couleur d’arriére-plan du paragraphe

Définir la couleur d’arriére-plan de la zone qui entoure le paragraphe.

152



Lorem ipsum dolor sit amet, consectetur adipiscing elit. Etiam
accumsan, urna nec gravida feugiat, nisl arcu egestas urna, id feugiat
lectus risus eget lectus.

Sed vehicula cursus interdum. Donec id turpis pellentesque, commodo
sem in, vestibulum leo. Sed purus ante, tincidunt eget diam id, ultrices
ornare elit. Pragsent id sapien tristique risus finibus convallis. Sed et
nulla ante. Nulla pulvinar, lectus n on consectetur feugiat, nibh mauris
mollis odio, ut gravida dui libero et ligula.

Figure 3:  Couleur de bordure de paragraphe

Définir la couleur d’arriére-plan du texte dans un paragraphe

Pour définir la couleur d’arriere-plan pour une partie du texte dans un paragraphe, procédez comme
suit :

1) Sélectionnez le texte dans un paragraphe.
2)  Ouvrez la fenétre Configuration de caracteres.
3) Danslaliste déroulante Couleur d’arriére-plan, sélectionnez une couleur et cliquez sur Appliquer.

La couleur d’arriere-plan est définie uniquement pour le texte sélectionné dans le paragraphe.

Définir la couleur d'arriére-plan pour un paragraphe entier

Pour définir la couleur d’arriere-plan d'un paragraphe entier, procédez comme suit :

1) Placez le curseur n‘importe ou dans le paragraphe.

2)  Ouvrez la fenétre Configuration de paragraphes et accédez a I’'onglet Police.

3) Danslaliste déroulante Couleur d’arriére-plan, sélectionnez une couleur et cliquez sur Appliquer.

La couleur d’arriere-plan est définie pour tout le texte du paragraphe.

Définir la couleur d’arriére-plan d’une case de paragraphe

Pour définir la couleur d’arriére-plan d’une case de paragraphe, procédez comme suit :

1)  Placez le curseur n‘importe ol dans le paragraphe.

2)  Ouvrez la fenétre Configuration de paragraphes et accédez a I'onglet Avancé.

3) Dans la liste déroulante Couleur, sélectionnez une couleur et cliquez sur Appliquer.

La couleur d’arriere-plan est définie pour la zone entiere qui entoure un paragraphe.

Lorsque vous définissez la couleur d’arriere-plan du texte dans le paragraphe, la couleur s’étend sur le
texte du paragraphe. Toutefois, dans le cas d’une case de paragraphe, le texte s’étend sur la totalité du
paragraphe, de la marge gauche a la marge droite.
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Retrait, alignhement et espacement

Découvrez I'indentation, I'alignement et I’'espacement dans Adobe FrameMaker. Découvrez les taquets
de tabulation et le placement dans les documents japonais.

Modification de I’alignement des paragraphes

La caractéristique d’alignement d’un paragraphe détermine la position du paragraphe entre les retraits
gauche et droit, non entre les bords de la colonne de texte.

Procédez de I'une des facons suivantes :
. Pour utiliser la regle, faites glisser le symbole de retrait vers son nouvel emplacement sur la régle.

UntitledLlim X

Figure 1:  A. Retrait de premiere ligne B. Retrait gauche C.Retrait droit

. Pour utiliser une valeur de retrait, affichez les caractéristiques élémentaires de la fenétre Configu-
ration de paragraphes. Entrez les retraits souhaités dans les champs 1ére ligne, Gauche et Droite,
puis cliquez sur Appliquer.

. Choisissez une option du menu déroulant Alignement dans la barre de formatage ou dans les
caractéristiques élémentaires de la fenétre Configuration de paragraphes.

REMARQUE : si vous utilisez les touches Maj+Entrée ou Maj+Retour pour insérer un retour forcé dans un
paragraphe justifié, la ligne contenant le retour forcé n’est pas justifiée.

CONSEIL : Pour aligner un retrait a I'aide d’un repere de la regle, activez la grille magnétique (a I'aide de la
commande Graphiques > Organiser > Magnétisme). Lorsque vous faites glisser un symbole de retrait, il
s’accroche aux emplacements correspondants de la grille magnétique.

Modification des taquets de tabulation

Dans ce sujet

. Introduction

. Modlification des tabulations dans la barre de formatage

J Modlification des tabulations dans la fenétre Configuration de paragraphes

J Définition d’un caractéere de tabulation décimale ou d’une chaine de conduite

Introduction

Si vous appuyez sur la touche Tab et que le point d’insertion ne se déplace pas, aucun taquet de tabula-
tion n’a été défini.

Quatre types de taquet de tabulation sont disponibles : gauche, centré, droit et décimal.
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A B C (]
| | |
Everest Everest Everest 2.6794

Lhotse Lhotse Lhotse 293,

K2 K2 K2 18.36

A. Tabulation gauche B. Tabulation centrale C. Tabulation droite D. Tabulation décimale

Vous pouvez également spécifier une chaine de caracteres (appelée chaine de conduite) pour combler

I’espace entre un taquet de tabulation et le caractére suivant. En regle générale, la chaine de conduite

est une suite de points. Les chaines de conduite sont particulierement utiles dans les tables des matiéres
ayant des colonnes de texte trés espacées.

Modification des tabulations dans la barre de formatage

1)

2)

Choisissez Afficher > Barres d'outils > Formatage de paragraphe. Seuls les taquets de tabulation

communs a tous les paragraphes sélectionnés s’affichent sur la regle supérieure.

Procédez de I'une des facons suivantes :

- Pour ajouter un taquet de tabulation, cliquez sur un symbole de taquet de tabulation dans la
barre d’outils Formatage de paragraphe, puis cliquez a la position souhaitée sous la regle.

- Pour déplacer un taquet de tabulation, faites-le glisser vers sa nouvelle position.

ConsEIL : Pour aligner des taquets de tabulation sur les marqueurs de la régle, activez la grille
magnétique (Graphiques > Organiser > Magnétisme). Lorsque vous faites glisser un symbole de
tabulation, il s’accroche aux emplacements correspondants de la grille magnétique.

- Pour ajouter plusieurs taquets de tabulation a des intervalles réguliers, cliquez deux fois sur
le taquet de tabulation que vous souhaitez dupliquer. La boite de dialogue Modifier les tabu-
lations s'affiche.

Edit Tab Stop X

Current Position 0,25"

New Position:

Alignment: Leader:
OLet O None
O Center ® ...

O....
O Right O .
(® Decimal O

Align On: |:| (O Custom: |:|
[[] Repeat Every:

Delete Delete All

Figure 2: Boite de dialogue Modifier les tabulations
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Entrez I'intervalle entre les tabulations dans le champ Répéter tous les, puis cliquez sur Mod-
ifier.

Pour modifier un taquet de tabulation, cliquez deux fois dessus, entrez une nouvelle position
de tabulation dans le champ Nouvelle position, puis choisissez un alignement différent. La
position correspond a la distance entre le bord gauche de la colonne et le taquet de tabula-
tion. Cliquez ensuite sur Modifier. Vous pouvez également faire glisser un nouveau taquet de
tabulation au-dessus d’un taquet existant sur la regle pour le remplacer.

Pour supprimer un taquet de tabulation, faites-le glisser vers le bas en dehors de la régle
supérieure.

Pour supprimer tous les taquets de tabulation, cliquez deux fois sur un taquet puis sélec-
tionnez Tout supprimer.

Modification des tabulations dans la fenétre Configuration de paragraphes

1)
2)

3)

Affichez les caractéristiques élémentaires de la fenétre Configuration de paragraphes.

Dans la zone Taquets de tabulation, créez, modifiez ou supprimez des éléments en sélectionnant
les parametres correspondants.

Cliquez sur Appliquer.

Définition d’un caractere de tabulation décimale ou d’une chaine de conduite

1)

Figure 3:

2)

Cliquez deux fois sur le taquet de tabulation sur la regle. La boite de dialogue Modifier les tabula-
tions s'affiche.

Edit Tab Stop X

Current Position 0,25"

New Position:

Alignment: Leader:
OLet O None
O Center ® ...

O....
Right
ORig O----
(® Decimal O

Align On: |:| (O Custom: |:|
[[] Repeat Every:

Delete Delete All

Boite de dialogue Modifier les tabulations

Procédez de I'une des facons suivantes :

Dans la zone Caractere de conduite de la boite de dialogue, cliquez sur I'un des caracteres de
conduite prédéfinis ou entrez votre propre caractere personnalisé, puis cliquez sur Modifier.
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- Pour spécifier un caractere décimal, par exemple une virgule lorsque vous travaillez sur un
systeme décimal européen, entrez le caractére décimal dans la zone de texte Aligner sur de
la zone Alignement, puis cliquez sur Modifier.

Modification de I’espacement entre les paragraphes et entre les caractéres

Dans ce sujet

. Introduction
o Réglage de I'’espacement vertical
. Réglage de I'’espacement horizontal

Introduction

L'espacement vertical est I'espace entre les paragraphes et les lignes. L'espacement horizontal est
I’espace entre les mots et les caracteres. Les caractéristiques d’espacement possédent des noms
différents selon les contextes. L’espace entre les caracteres est souvent appelé crénage par paire, le
réglage de I'espacement entre les lettres sur une ligne est appelé étirement ou approche, tandis que
I’espacement des lignes d’un paragraphe (mesuré depuis la ligne de base d’une ligne jusqu’a la ligne de
base de la suivante) inclut son interligne.

Réglage de I'espacement vertical

Lorsque vous réglez I'espacement vertical, tenez compte des points suivants :

. Si un paragraphe est situé en haut d’'une colonne, FrameMaker ignore le parametre Dessus.
S’il se trouve au bas d’une colonne, FrameMaker ignore le paramétre Dessous.

. Si un cadre ancré est positionné au-dessous de la ligne en cours et que son symbole d’ancrage
s’affiche sur la derniere ligne d’un paragraphe, I’espace au-dessous de ce dernier apparait

généralement entre le cadre et le paragraphe suivant. Si le cadre est ancré dans un paragraphe
fusionné, I'espace en dessous est ignoré.

Sile cadre est un cadre fusionné mais n’est pas ancré dans un paragraphe fusionné, I'espace en des-
sous apparait entre le symbole d’ancrage et le cadre.

. Dans une présentation en plusieurs colonnes, vous pouvez également régler la justification verti-
cale du texte au sein des colonnes.

Plusieurs caractéristiques affectent I'espacement vertical d’un paragraphe : I'espace au-dessus du para-
graphe, I'espace au-dessous et l'interligne.

1)  Affichez les caractéristiques élémentaires de la fenétre Configuration de paragraphes et procédez
comme suit :

- Entrez des valeurs dans les champs Dessus et Dessous de la rubrique Espace. L’espace entre
les paragraphes est déterminé par le plus élevé des deux paramétres Dessous du premier
paragraphe et Dessus du deuxieme paragraphe.

- Choisissez un type d’interligne dans la liste déroulante Interligne ou spécifiez une valeur dans
le champ.
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2)  Pour autoriser un espace supplémentaire entre les lignes afin de placer du texte en indice ou en
exposant, du texte Rubi ou des tailles de police plus élevées dans un paragraphe, désactivez
I'option Fixe.

3) Cliquez sur Appliquer.

Réglage de I'’espacement horizontal

Lorsque FrameMaker remplit une ligne de texte, il ajuste I'espace entre les caracteres selon les
caractéristiques de crénage et d’approche. L'espacement entre les mots est défini sur les valeurs suiva-
ntes, stockées dans le style de paragraphe :

. L’espacement minimum est le plus petit espacement autorisé entre les mots.

. L’espacement maximum est |'espacement maximum autorisé entre les mots avant que
FrameMaker ne tente de les couper par une césure ou n’ajoute un espace entre les lettres dans les
paragraphes justifiés.

. L’espacement optimum correspond a I'espacement que FrameMaker tente de créer.

Ces valeurs sont exprimées en pourcentage de I’espace standard de la police par défaut d’un paragraphe.
Les valeurs inférieures a 100 % créent un espacement plus serré entre les mots et conférent un aspect
plus justifié, alors que les valeurs supérieures a 100 % créent un espacement plus lache qui donne un
aspect plus irrégulier au bord droit.

1)  Pour régler I'approche entre les mots, sélectionnez le(s) paragraphe(s) dont vous souhaitez modi-
fier 'espacement.

2)  Affichez les caractéristiques avancées de la fenétre Configuration de paragraphes et spécifiez
I'espacement minimum, optimum et maximum a autoriser entre les mots.

3) Cliquez sur Appliquer.

REMARQUE : les lignes de texte d’un paragraphe justifié peuvent étre séparées par un espace plus
important que I'espace maximum autorisé lorsque FrameMaker ne parvient pas a faire tenir un
mot sur une ligne ou ne peut le couper par une césure. Pour éviter cet inconvénient, vous pouvez
ajouter un espace supplémentaire entre les caractéres d’un texte justifié en choisissant I'option
Activer I'interlettrage automatique de la zone Intermot.

4)  Pourappliquer un crénage par paire ou une approche, dans la fenétre Configuration de caractéres,
choisissez Crénage par paire ou définissez une valeur dans le champ Approche.

Réglage de I'espacement dans les documents japonais

Dans ce sujet

J Introduction
. Réglage de I’espace autour des caracteres et de la ponctuation
. Réglage de taille, de positionnement et d’espacement de texte Rubi

Introduction

Si le systeme prend en charge la saisie de texte japonais dans les documents et boites de dialogue, vous
pouvez ajuster les caractéristiques d’espacement suivantes :
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Groupe spécial de caractéristiques, dans la fenétre Configuration de paragraphes, qui controle
certains aspects de I'espacement entre les caractéres japonais

Taille, espacement et alignement du texte Rubi sur I'ensemble d’'un document

Espacement des caractéres japonais de largeur variable via la sélection de la caractéristique de
police Tsume.

Réglage de I'’espace autour des caractéres et de la ponctuation

Pour régler I'espace autour des caracteres et de la ponctuation pour les caractéres d'un contenu
japonais, ouvrez la fenétre Configuration de paragraphes et affichez les caractéristiques de I'onglet
Asiatique. Procédez comme suit :

Pour régler I'espace entre les caractéres japonais et les caractéres occidentaux, utilisez le groupe
supérieur de champs. Pour régler I’espace entre les caracteres japonais, utilisez le groupe inférieur
de champs. Entrez les pourcentages minimum, maximum et optimum.

Pour déterminer I'espace entre les caractéres et les caractéres spéciaux de ponctuation (yaku-
mono), choisissez une option dans la liste déroulante Ponctuation.

Comprimer autant que nécessaire signifie que I'espace autour de la ponctuation n’est réduit que
lorsque la gestion de la ponctuation spéciale (kinsoku shori) intervient.

Ne jamais comprimer signifie qu’aucun ajustement d’espace n’est effectué autour de la ponctua-
tion.

Toujours comprimer signifie que I'espace est toujours réduit autour de la ponctuation.

Pour obtenir I'aspect d’un espacement unique dans un texte japonais, choisissez Ne jamais
comprimer dans la liste déroulante Ponctuation et désactivez la caractéristique Tsume.

Réglage de taille, de positionnement et d’espacement de texte Rubi

Le texte Rubi est constitué de petits caracteres (généralement kana) qui s’affichent au-dessus d’un autre
texte, appelé oyamoji. Ces paramétres affectent le texte Rubi dans tout le document.

1)

3)

4)

Dans la boite de dialogue Format > Document > Caractéristiques Rubi, choisissez une valeur dans
la liste déroulante Taille ou entrez une valeur dans le champ. La valeur entrée peut étre un
pourcentage de la taille en points du texte oyamoji situé au-dessous, une taille en points ou toute
autre unité de mesure, y compris les unités Q.

Procédez comme suit :

- Pour permettre au texte Rubi d’étre placé au-dessus du texte non-oyamoji, sélectionnez
Caractéeres Rubi centrés au-dessus des caractéres Hiragana.

- Pour supprimer I’espace avant ou apreés lorsque du texte Rubi s’affiche au début ou a la fin
d’une ligne, cliquez sur Aligner tous les caractéres selon les lignes de contour.

Cliquez sur une option dans la zone Alignement Rubi pour les caractéres japonais Oyamoji ou sur
la zone Alignement Rubi pour d’autres caractéres Oyamoji. Les illustrations de la boite de dialogue
présentent 'espacement et I'alignement du texte Rubi lorsqu’il est situé au-dessus de caractéres
japonais ou non japonais et que sa longueur est inférieure ou supérieure au texte situé dessous.

Cliquez sur Définir-
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Listes et numérotation automatique

Découvrez comment créer des listes, marquer la numérotation automatique et utiliser des symboles
dans Adobe FrameMaker. Découvrez la numérotation des composants d'un livre, les options de numéro-
tation japonaises, les options de numérotation RTL.

Pour créer des listes numérotées et a puces, utilisez des styles de paragraphes qui possedent un format
de numérotation automatique défini. Lors de I'ajout de paragraphes numérotés automatiquement a un
document, FrameMaker les numérote correctement et recalcule la numérotation des autres para-
graphes, si nécessaire.

Les paragraphes numérotés automatiquement le sont de maniéere consécutive dans un enchainement de
texte. Si le document contient plusieurs enchainements de texte, les paragraphes numérotés automa-
tiguement dans chaque enchainement sont indépendants les uns des autres.

La numérotation automatique est définie a I'aide des caractéristiques de numérotation de la fenétre
Configuration de paragraphes. Un format de numérotation automatique ne doit pas nécessairement
spécifier la numérotation des paragraphes. Lorsqu’il est utilisé sans les composantes, il permet
d’effectuer facilement des insertions automatiques de texte ou de symbole. Un format de numérotation
automatique peut inclure un libellé de série, un compteur, des tabulations et du texte.

Libellé de série

Un libellé de série permet d’identifier les différents types de séries de numérotation automatique
dans un enchainement. Par exemple, pour numéroter des figures indépendamment des tableaux
et des intitulés, il suffit de spécifier une série différente pour chaque élément de formatage (intit-
ulés, figures et tableaux).

De plus, les numéros de tableaux et de figures doivent tous se trouver dans la méme série pour étre
basés sur les numéros de section.

Compteur

Un compteur constitue une marque de réservation (composante) que FrameMaker remplace par
un nombre ou une lettre dans la numérotation automatique. Par exemple, le compteur <n+> incré-
mente le numéro de paragraphe de 1. Si le paragraphe est le deuxiéme dans la série, FrameMaker
remplace <n+> par le numéro 2. Vous pouvez utiliser plusieurs compteurs dans un format.

Vous pouvez également ajouter des composantes de chapitre <$chapnum> et de volume
<$volnum> dans un format.
Tabulations, texte et ponctuation

Un format de numérotation automatique peut inclure également des tabulations, du texte, des
puces, des espaces ou des signes de ponctuation.
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Formatage de texte sous forme de liste numérotée

La création d’une liste numérotée implique parfois le formatage du premier élément de la liste avec un
style de paragraphe réinitialisant le compteur a 1, puis celui des éléments restants avec un style différent
gui incrémente le compteur. Par exemple, vous pouvez appliquer un format Etapel au premier élément
d’une liste, puis le format EtapeSuivante au reste. En outre, le modele définit parfois des formats qui
permettent d’appliquer un format unique a tous les éléments d’une liste numérotée.

1)

2)

3)

4)

5)
6)

Affichez les caractéristiques de Numérotation de la fenétre Configuration de paragraphes et
saisissez un libellé de série dans le champ Format si le document requiert plusieurs séries de
numeérotation automatique.

Un libellé de série consiste en un seul caractere imprimable suivi de deux points (S :, par exemple).
Si vous utilisez un libellé de série, il doit apparaitre au début du nom du style.

Entrez tout texte a afficher automatiquement avec le format de numérotation automatique. La liste
Composantes permet d’entrer des tabulations ou des compteurs. Lorsque vous sélectionnez un
élément, il s’affiche au point d’insertion dans le champ Format de numérotation automatique.

Sélectionnez un style de caractéere pour la numérotation automatique dans le menu local Style de
caractere. Si aucun format n’est spécifié, la numérotation automatique s’affiche avec la police par
défaut du paragraphe.

Choisissez un emplacement pour la numérotation automatique dans la liste déroulante Position.
Les numérotations automatiques en fin de paragraphe sont rares a I’exception des formats d’équa-
tion.

Cliquez sur Appliquer.

Sivous avez inséré une tabulation (t) dans I'étape 2, définissez un taquet de tabulation correspon-
dant pour le style de paragraphe dans I'onglet Elémentaire de la fenétre Configuration de para-
graphes.

Formatage de texte sous forme de liste a puces

Outre le symbole de puce standard () présent dans toutes les polices texte, vous pouvez utiliser

n’importe quel caractére de toute police installée, y compris une police dingbat telle que Zapf Dingbats®.

1)
2)

3)
4)

Cliquez sur un paragraphe ou sélectionnez un ensemble de paragraphes adjacents que vous
souhaitez intégrer a la liste a puces.

Affichez les caractéristiques de Numérotation de |la fenétre Configuration de paragraphes et cliquez
sur les symboles de puce et de tabulation (\b et \t) dans la liste de sélection Composantes.

Cliquez sur Appliquer.

Si vous avez inséré une tabulation (\t) a I’étape 2, définissez un taquet de tabulation correspon-
dant pour le style de paragraphe.
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Spécification d’un symbole de puce spécial

Avant de spécifier un symbole de puce spécial, créez un style de caractére comportant la police du
symbole de puce a utiliser. Par exemple, pour utiliser la police Zapf Dingbats 9 points, créez un style de
caractere utilisant cette police. Donnez au format un nom descriptif tel que PolicePuce.

1) Affichez les caractéristiques de numérotation de la fenétre Configuration de paragraphes et entrez
le caractere correspondant au symbole de puce souhaité dans le champ Format de numérotation
automatique.

Par exemple, pour utiliser une puce carrée Zapf Dingbats, entrez la lettre minuscule n, qui s’affiche
sous la forme ? dans cette police. Pour trouver le caractére correspondant au symbole de puce sou-
haité, consultez le jeu de caractéres de cette police.

2) Cliguez sur le symbole de tabulation (\ t) dans la liste de sélection Composantes ou entrez des
espaces.

REMARQUE : parfois, vous devez entrer des codes spéciaux pour saisir des caractéres tels que des
espaces insécables ou des espaces cadratins.

3) Dans laliste déroulante Style de caracteére, cliquez sur le style de caractere de puce que vous avez
créé.
4)  Cliquez sur Appliquer.

Suppression de la numérotation automatique ou d’une puce d’un paragraphe

1) Désactivez I'option Format de numérotation automatique dans les caractéristiques de Numérota-
tion de la fenétre Configuration de paragraphes. Cliquez deux fois sur I'option pour désactiver le
parametre, un seul clic lui attribuant la valeur Tel que.

2)  Cliguez sur Appliquer.

Compteurs dans les formats de numérotation automatique

Un compteur est constitué de chevrons (< >) qui encadrent un style d’affichage et une valeur d’incrémen-
tation. La fonctionnalité de numérotation automatique personnalisée prend en charge le format de
codage de texte Unicode.

A. Style d’affichage B. Valeur d’incrémentation

Pour indiquer le style d’affichage, utilisez un compteur avec I'une des lettres suivantes.

Pour ce style de numérotation Choisissez
Numérique (1, 2, 3, ...) n
Romain en minuscules (i, ii, iii, iv, ...) r
Romain en majuscules (I, II, 111, 1V, ...) R
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Pour ce style de numérotation Choisissez

Minuscules alphabétiques (a, b, ¢, ..., aa) a

Majuscules alphabétiques (A, B, C, ..., AA) A

Pour préciser I'incrémentation de la numérotation automatique, utilisez un compteur avec une valeur
d’incrémentation, comme illustré dans les exemples suivants.

Opération Choisissez
Conserver la méme valeur <n>
Définir la valeur sur 1 ou toute autre valeur entrée aprés le signe égal <n=1>
Augmenter la valeur du compteur de 1 <n+>
Conserver la méme valeur sans |'afficher < >
Ramener le compteur a zéro (ou a toute autre valeur) sans I’afficher < =0>

Par défaut, chaque compteur est initialement défini sur zéro. Le compteur peut conserver sa valeur actu-
elle, étre incrémenté de 1 ou étre redéfini sur une autre valeur. Par exemple, utilisez I'option <n=1> pour
reprendre la numérotation a partir de 1 au début d’une nouvelle série d’instructions numérotées.

Pour conserver la méme valeur sans I'afficher, placez un espace entre les chevrons. Dans ce cas, les chev-
rons s’affichent comme faisant partie du format de numérotation automatique.

Numérotation automatique en fonction des numéros de composants de livres

Vous pouvez insérer les composantes <Svolnum>, <Schapnum> <Ssectionnum> ou <Ssubsectionnum>
dans les styles de paragraphes. Les numéros de composants de livre sont définis par les parametres
sélectionnés dans la boite de dialogue Caractéristiques de numérotation.

Exemple Format de numérotation automatique
Volume 3 Volume <S$volnum>
Chapitre 3 Chapitre <$chapnum>

Le tableau suivant montre comment combiner la composante de chapitre avec d’autres composantes.

Exemple Format de numérotation automatique
Section 1.1 S:Section <S$chapnum>.<n+><=0>
Section 1.1.1 S:Section <Schapnums>.
Figure 1-1 <n>.<n+>
Tableau 1-1 F:Figure <$chapnum>-<n+>
T:Table <Schapnum>-<n+>
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Numérotation automatique en fonction des numéros de section

La numérotation automatique dans les sections requiert que les numéros de tableaux et de figures se
trouvent tous dans la méme série, comme indiqué dans le tableau ci-dessous.

Numéro de section Numéro de figure Numéro de tableau
Section 1 Figure 1-1 Tableau 1-1
1.1 Figure 1-2 Tableau 1-2
1.2
Section 2 Figure 2-1 Tableau 2-1
2.1 Figure 2-2 Tableau 2-2
2.2

Pour obtenir ce type de numérotation, vous devez inclure les formats de numérotation automatique
dans une seule série en utilisant le méme libellé de série pour chaque format. Le tableau suivant affiche
les formats de numérotation automatique possibles. Ces formats sont répertoriés dans un tableau afin
de présenter avec précision la position de chaque compteur dans la chaine. La position du compteur

détermine son type d’incrémentation.

Format de
Style de numeérotation
paragraphe automatique
TitreSection H:Section <$chapnum> =0> < =0> < =0>
Intitulél H: <$chapnum> <n+> < > < >
TitreFigure H:Figure <$chapnum> > -<n+> < >
TitreTableau H:Tableau <$chapnum> > < > -<n+>

Dés qu’un paragraphe avec le style TitreSection est détecté, le numéro de section est incrémenté de 1 et
les valeurs de compteur restantes sont remises a zéro. Comme chaque compteur <n+> fait référence a
un type d’élément distinct dans les autres formats, ils sont incrémentés indépendamment.

Les compteurs < > empéchent FrameMaker de remettre les valeurs a zéro.

Utilisation de plusieurs compteurs dans un format de numérotation automatique

Un format de numérotation automatique peut contenir plus d’un compteur. Par exemple, les numéros
d’une série de titres de sections et sous-sections peuvent contenir deux compteurs.

Ces compteurs

dans ce format

s’affichent ainsi

<$chapnum>.<n=0> Intitulél 1.0
<$chapnum>.<n+> Intitulé2 1.1
<$chapnum>.<n+> Intitulé2 1.2
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Ces compteurs dans ce format s’affichent ainsi

<$chapnum>.<n=0> Intitulél 2.0

Les compteurs de chaque format sont indépendants les uns des autres. La position d’'un compteur dans
une chaine détermine la fagon dont il est affiché et incrémenté. Lors de I'incrémentation d’'un compteur,
FrameMaker base sa valeur sur le compteur correspondant dans le paragraphe numéroté automatique-
ment précédent du méme enchainement.

L’exemple suivant utilise plusieurs compteurs dans des titres et des sous-titres de section. Les compteurs
situés de part et d’autre du point augmentent indépendamment I'un de 'autre.

Format de numérotation

Exemple automatique Etiquette
1.0 Prise en main <n+>.<n=0>\t Headl
1.1 Installation <n>.<n+>\t Head?2
1.2 Sauvegarde <n>.<n+>\t Head2
1.2.1 Erreurs <n>.<n>.<n+>\t Head3
1.3 Saisir des données <n>.<n+>\t Head?2
L’'exemple suivant utilise des formats de numérotation automatique en relief.

Format de numérotation

Exemple automatique Etiquette
1.0 Prise en main <R+>< =0>\t Head1l
1.1 Installation < ><A+>\t Head?2
1.2 Sauvegarde < ><A+>\t Head2
Il Saisir des données <R+>< =0>\t Headl
A Ouvrir un fichier < ><A+>\t Head?2
B Enregistrer un fichier < ><A+>\t Head2

La numérotation automatique de l'intitulé Ouverture d’un fichier est redéfinie sur la lettre A. Le deux-
ieme compteur du format du paragraphe précédent raméne la numérotation a zéro (sans |'afficher) et
<A+> incrémente le compteur pour définir sa valeur sur 1 ou sur A.

Le compteur < > dans le format Head2 garde la valeur du premier compteur mais ne I'affiche pas. Si le
compteur < > ne se trouve pas a cette position, le compteur <A+> du format Intitulé2 fait référence au
premier compteur (pas au second) et FrameMaker affiche le résultat suivant :

I Getting started
B Installing the product
C Backing up the files
IV  Entering data
E Opening a file
~ F  Saving afile

pae—— e
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Figure 1: Format incorrect de numérotation automatique en relief

Réinitialisation de séries de numérotation automatique

Certaines séries de numérotation (telle qu’une liste d’étapes numérotées) débutent a 1 chaque fois

gu’elles sont utilisées. Deux méthodes permettent de réinitialiser ce type de série.

Le premier exemple indigue comment reprendre la numérotation d’une série a I'aide de la composante

<n=1> pour la premiére étape de la série, puis en utilisant <n+> pour les étapes suivantes.

Exemple

Format de humérotation
automatique

Etiquette

Etape 1. Déballage.

Etape 2. Sauvegarde.

Etape 3. Exécution du
programme d’installation.
Etape 1. Enregistrement du
fichier.

S:Step <n=1>.\t
S:Step <n+>.

\t

S:Step <n+>.

\t

S:Step <n=1>.

\t

Stepl
StepNext
StepNext
Stepl

Le deuxieme exemple présente une autre méthode permettant de réinitialiser le compteur afin de pas
utiliser un format unique pour débuter une liste numérotée. A la place, un paragraphe introduisant la
liste utilise un format qui réinitialise le compteur.

Exemple

Format de numérotation
automatique

Etiquette

Pour installer le logiciel :
Etape 1. Déballage.

Etape 2. Sauvegarde.
Etape 3. Exécution du
programme d’installation.

S:< =0>
S:Step <n+>.\t
S:Step <n+>.
\t

S:Step <n+>.
\t

Steplntro
Step
Step
Step

Le compteur < =0> du format Etapelntro raméne la série S a zéro mais n’affiche pas la valeur.

Si un compteur est incrémenté, tout compteur omis dans la série placée a sa droite est remis a zéro. Par
exemple, les formats de numérotation automatique suivants sont équivalents :

S:<n+>< =0>\t

S:<n+>\t

A propos des options de numérotation japonaise

Les compteurs suivants de formats de numérotation automatique sont autorisés dans le texte japonais

et avec les polices japonaises.
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Composante

Signification

Caracteres, dans cet ordre

<zenkaku a>

Alphabet romain en
minuscules de largeur fixe.

<zenkaku A>

Alphabet romain en
majuscules de largeur fixe.

1= m

<zenkaku n>

Numérotation arabe de
largeur fixe.

<kanji kazu>

Numérotation kanji standard,
ou les nombres a deux
chiffres sont constitués des
caracteres kanji traditionnels
pour dix, cent, etc.

<kanji n>

Nombres utilisés pour les
adresses, numéros de
téléphone, codes postaux,
etc., ol les nombres a deux
chiffres sont constitués des
caracteres kanji pour zéro
jusqu’a neuf.

<daiji>

Nombres utilisés dans des
contextes financiers ou
bancaires et constitués de
chiffres kanji de style ancien.

R, Bl Sl

<hira

gojuon>

Caracteres Hiragana dans
I'ordre standard.

<kata

gojuon>

Caractéres Katakana dans
I’ordre standard.

<hira

iroha>

Caracteres Hiragana dans
I'ordre littéraire (rare).

&
o

w, A, L, BT, Oh,

|
= W
1

<kata

iroha>

Caractéres Katakana dans
I'ordre littéraire (rare).

WL |
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A propos des options de numérotation RTL

Les compteurs suivants de formats de numérotation automatique sont autorisés dans les langues lues de

droite a gauche telles que I'arabe, I’'hébreu.et le farsi. Pour plus d’informations sur les formats, voir
Compteurs dans les formats de numérotation automatique.

Pour le script de langue farsi

Pour le script de langue hébreu

<Farsi n>
<Farsi n=1>
<Farsi n+>
<Farsi a>
<Farsi a=1>
<Farsi a+>

<Hebrew n>

<Hebrew n=1>

<Hebrew n+>
<Hebrew a>

<Hebrew a=1>

<Hebrew a+>

Pour le script de langue Arabe

<Alif Ba Ta
<Alif Ba Ta
<Alif Ba Ta
<Abjad n>
<Abjad n=1>
<Abjad n+>
<Indic n>
<Indic n=1>
<Indic n+>

n>
n=1>
n+>
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PAGES COURANTES, MAQUETTES ET PAGES DE REFERENCE

Pages courantes, maquettes et pages de référence

Connaitre le corps, le maitre et les pages de référence dans Adobe FrameMaker et leur utilisation.
Comprendre le cadre de texte de modele, le cadre de texte de fond et le cadre de référence.

Les documents FrameMaker contiennent trois types de pages qui vous permettent de définir votre mise
en page:

SRR e— G HeE D €y o 1D
| CHAPTER I PIATE
BOUNDARIES
N B _ Sr s
bty "f‘%‘?j = mﬁtﬂ%-?.@ — <>
a5 e
—— = —
— = Toctr e
— e
A | :
E——— B e~ 1] c

A. Maquettes : page de couverture et page de droite B. Pages courantes : premiére page du chapitre et

page de droite C. Page de référence

. Les pages courantes affichent le texte et les graphiques d’arriére-plan de la maquette associée et
sont constituées du contenu du document.

J Les maquettes définissent la mise en page et le texte d’arriere-plan des pages du document
(en-tétes et pieds de pages, par exemple).

. Les pages de référence peuvent contenir des graphiques souvent utilisés, des informations de
formatage, des commandes hypertexte, des correspondances de conversion HTML et des éléments
standard.
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Maquettes

Découvrez les maquettes et leur utilisation dans Adobe FrameMaker. Découvrez les modeles de zone de
texte et la zone de texte d'arriere-plan.

FrameMaker assure le suivi de la mise en page d’'un document a I'aide de maquettes. Un document
recto-verso contient au minimum deux maquettes, une destinée aux pages de gauche et I'autre aux
pages de droite. Un document recto ne fait appel gu’a la seconde. Un document peut aussi contenir des
maquettes personnalisées, pouvant étre utilisées pour des types de pages spéciaux. Vous pouvez égale-
ment créer des mises en page directement sur les pages courantes pour une utilisation ponctuelle.

Sila mise en page est complexe ou si vous devez créer des éléments de conception, tels que des en-tétes
et pieds de pages, travaillez avec les éléments directement sur les maquettes. Vous pouvez dessiner ou
importer des graphiques (lignes, contours ou logos) n‘importe ou sur une maquette et y saisir du texte.
Les graphiques et le texte s’affichent sur les pages courantes correspondantes, exactement comme sur
la maquette, comme élément d’arriére-plan de la page courante.

CHAPTER

1 B General description

Figure 1: Maquette et page courante

Les maquettes peuvent contenir les types de zones de texte suivants :

. Un modeéle de zone de texte contient un enchainement de texte étiqueté (ou enchainement
portant un nom). Lorsque vous ajoutez une page courante, le modeéle de zone de texte est copié
sur la nouvelle page courante. Vous entrez ensuite le texte du document dans cette zone de texte
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sur la page courante. Vous pouvez saisir du texte dans un modeéle de zone de texte sur une
magquette, mais le texte ne s’affiche pas sur les pages courantes.

. Une zone de texte d’arriére-plan contient un enchainement de texte sans étiquette (ou enchaine-
ment sans nom). Son contenu s’affiche sur les pages courantes correspondantes mais vous ne
pouvez le modifier que sur les maquettes. Les zones de texte d’arriére-plan sont généralement util-
isées pour les en-tétes et pieds de pages.

A
I :
RUNNING H/F 1 4
B
Romnleg T T ___ A

Figure 2: Maquette
A. Zone de texte d’arriére-plan sans étiquette B. Modéle de zone de texte

Lors de I'ajout de texte ou d’illustrations sur les pages courantes du document, FrameMaker ajoute les
pages courantes requises et utilise automatiquement la mise en page de la maquette gauche ou droite.

™,

PLATE BOUNDARIES 13

H

Figure 3:  Sur les pages courantes, la zone de texte dans laquelle vous tapez est une copie de celle du modeéle.
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Création de maquettes personnalisées

Familiarisez-vous avec la création et I'ajout de maquettes personnalisées dans FrameMaker.

Dans ce sujet

] Introduction
J Création d’une maquette personnalisée vierge ou basée sur la mise en page d’une autre maquette
. Création d’'une maquette personnalisée basée sur la mise en page d’une page courante

Introduction

Un document peut nécessiter des pages courantes possédant une mise en page différente de celles des
magquettes gauche et droite. Par exemple, vous pouvez créer un aspect différent pour la premiére page
d’un document, comme vous pouvez inclure une page au format paysage dans un document de format
portrait. Dans ces deux cas, vous devez créer des maquettes personnalisées (un document peut contenir
jusqu’a 100 maquettes).

Une fois la maquette personnalisée créée, modifiez I'aspect des colonnes et ajoutez du texte et des
graphiques d’arriére-plan. Attribuez ensuite la maquette personnalisée a une ou plusieurs pages
courantes.

Création d’'une maquette personnalisée vierge ou basée sur la mise en page d’une autre maquette

1) Affichez la maquette a utiliser comme base de la nouvelle maquette.

2) Sélectionnez Insérer > Ajouter une maquette et saisissez un nom pour la nouvelle maquette dans
la zone de texte Nom.

3)  Procédez de I'une des facons suivantes :

- Pour créer une maquette dont la mise en page correspond a celle d’'une maquette existante,
choisissez la maquette dans la liste déroulante Copier depuis la maquette.

- Pour créer une maquette vide, cliquez sur Vide.

4)  Cliquez sur Ajouter.

Création d’'une maquette personnalisée basée sur la mise en page d’une page courante

1) Apportez les modifications voulues a I'aspect des colonnes.
2) La page courante étant affichée, choisissez Format > Mise en page > Nouvelle maquette.
3) Entrez un nom pour la maquette et cliquez sur Créer.

RELATED LINKS:
Attribution de maquettes a des pages courantes

Réorganisation des maquettes personnalisées

Découvrez comment réorganiser des maquettes dans Adobe FrameMaker.
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Lorsque vous réorganisez des maquettes personnalisées, les maquettes droite et gauche doivent
toujours étre placées en téte de liste.

1)  Ouvrez une maquette, puis choisissez Format > Mise en page > Réorganiser les maquettes person-
nalisées.

2) Sélectionnez une maquette dans la liste Maquettes personnalisées, puis cliquez sur Monter ou
Descendre pour mettre la maquette a la place que vous souhaitez dans la liste.

3)  Cliquez sur Définir- Si, avant de procéder a cette opération, vous aviez affiché une maquette a
I’écran, il se peut que la maquette affichée ne soit plus la méme.

Rotation d’une maquette

Découvrez comment faire pivoter des maquettes dans Adobe FrameMaker.

Vous pouvez créer une maquette personnalisée en modifiant I'orientation d’une page courante. Par
exemple, vous pouvez créer une orientation avec rotation pour une page courante comportant un
tableau tres large.

~
o
o~
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Plats Bourdaies. Piats Bourdarias.
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|
[

Figure 4: La page de droite utilise une maquette pivotée.

1) Surune nouvelle maquette, définissez les zones de texte, le texte et les graphiques d’arriere-plan
devant avoir la méme orientation (sans rotation) que les en-tétes et pieds de pages des autres
magquettes.

2)  Choisissez 'une des commandes Format > Personnaliser la mise en page > Rotation de la page.
Lorsque FrameMaker applique une rotation a la page, une partie de celle-ci sera probablement
invisible. Vous pouvez régler la taille de la fenétre pour afficher une plus grande partie de la page.

3) Créezles zones de texte ainsi que le texte et les graphiques d’arriere-plan a afficher avec une rota-
tion.

CoNSEIL : Vous pouvez saisir du texte dans des zones de texte avec rotation comme vous pouvez annuler
la rotation de la page pour une saisie plus rapide. Pour annuler la rotation d’une page, choisissez Format
> Personnalisation de la mise en page > Annuler rotation page. Lorsque vous avez terminé, vous pouvez
réappliquer la rotation a la page.

RELATED LINKS:
Création et modification de zones de texte d’arriére-plan

Suppression d’une maquette personnalisée

Découvrez comment supprimer une maquette personnalisée dans Adobe FrameMaker.
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Pour supprimer une maquette personnalisée, affichez la maquette et choisissez Format > Docuement >
Supprimer la page [nom de la maquette]>.

REMARQUE : il n’est pas possible de supprimer les maquettes gauche et droite ni toute autre maquette
attribuée a une page courante.

Attribution de maquettes a des pages courantes

Découvrez comment attribuer des maquettes a des pages courantes dans des documents FrameMaker
structurés et non structurés

Dans ce sujet

. Introduction

. Attribution d’une maquette différente

. Attribution d’une maquette a des pages contenant des styles de paragraphe
) Attribution d’une maquette a des pages courantes de documents structurés

Introduction

Vous pouvez attribuer a tout moment une maquette a une page courante. FrameMaker utilise le modéele
de zone de texte de la maquette et affiche le texte et les graphiques d’arriére-plan.

Vous pouvez également choisir de ne pas attribuer de maquette a une page courante. Dans ce cas, cette
derniére ne possede pas d’en-téte, de pied de page ni tout autre texte ou graphique d’arriére-plan (si la
page courante contient une zone de texte, cette derniere n’est pas affectée). Par exemple, si chaque
chapitre d’un livre doit contenir un nombre de pages pair et que la derniére page d’un chapitre ne
contient pas de texte courant, vous pouvez décider de ne pas attribuer de maquette a cette page afin
gu’elle reste totalement vierge.

Attribution d’une maquette différente

1) Une page courante étant affichée, choisissez Format > Mise en page > Usage de la maquette.
2) Dans la boite de dialogue Usage de la maquette, procédez comme suit :

- Pour attribuer la maquette gauche ou droite, cliquez sur Droite (pour un document recto) ou
Droite/Gauche (pour un document recto-verso).

- Pour attribuer une maquette personnalisée, choisissez le nom de la page dans la liste dérou-
lante Personnalisée.

- Pour n’attribuer aucune maquette, choisissez Aucun(e) dans la liste déroulante Personnal-
isée.
3) Dans la zone Appliquer a, procédez comme suit :
- Pour appliquer les modifications a la page courante actuelle, cliquez sur La page en cours.

- Pour appliquer les modifications a une plage de pages, entrez le numéro des pages de début
et de fin dans les zones de texte Pages.

- Pour appliquer les modifications uniquement aux pages paires ou impaires au sein d’une
plage, sélectionnez Paires ou Impaires.
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- Pour appliquer les modifications uniquement aux pages qui utilisent une maquette particu-
liere au sein d’une sélection de pages, choisissez une page dans la liste déroulante de la zone
Appliquer a.

4)  Cliquez sur Appliquer.

REMARQUE : si la maquette contient un modéle d’enchainement de texte introuvable sur la page
courante, FrameMaker ajoute des zones de texte contenant cet enchainement a la page courante. Si
c’est la page courante qui contient un enchainement introuvable sur la maquette, FrameMaker ne
modifie pas les zones de texte contenant cet enchainement. Cette action peut entrainer le chevauche-
ment de zones de texte.

Attribution d’une maquette a des pages contenant des styles de paragraphe

Vous pouvez attribuer des maquettes a des pages courantes contenant des styles de paragraphe. Par
exemple, vous souhaitez peut-étre que toutes les pages qui contiennent le style de paragraphe Titre
soient formatées sur la base d’une maquette personnalisée appelée Premiere.

Pour cela, associez les styles de paragraphe aux maquettes en utilisant la table de correspondance Pages
de référence. Si vous choisissez la commande Appliquer les maquettes, les maquettes sont appliquées
aux pages courantes contenant le style de paragraphe spécifiée.

UnstructMasterPageMaps
Book Update (Yes or No): Yes

Paragraph Tag WName | Right-Handed Mas- |Left-Handed Master |Range Indicator Comments
ter Page (or Single- |Page (Single, Span pages,
Sided Master Page) Until changed)
Title First Single Convert Title pages
to First Master
Figure 5: Dans cet exemple, la maquette Premiéere est appliquée aux pages courantes contenant des styles de

paragraphe Titre.
1) Sélectionnez Affichage > Pages de référence.

2)  Cliquez sur le bouton Page suivante jusqu’a ce que la table CorrespondanceMaquettesNonStruct,
qui contient cing colonnes, s’affiche.

ConNsElL : Si la table de correspondance n’apparait pas dans les pages de référence, choisissez
Format > Mise en page > Appliquer les maquettes.

3)  Pourle champ Mise a jour du livre (Oui ou Non), tapez Oui ou Non pour indiquer si la maquette
spécifiée doit étre appliquée dés que vous sélectionnez Format > Mise en page > Appliquer les
maquettes... a partir d’'un livre.

4)  Modifiez la table de correspondance en procédant comme suit :
- Dans la colonne intitulée Nom du style de paragraphe, saisissez le nom du style de paragraphe
sur la base de laquelle vous souhaitez appliquer la maquette. Cette colonne est obligatoire

pour I'application des maquettes. Veillez a orthographier correctement le nom du style de
paragraphe, en respectant la casse utilisée.
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5)
6)

7)

Dans la colonne Maquette page de droite, saisissez le nom de la maquette a appliquer. Cette
colonne est obligatoire pour I'application des maquettes. La maquette spécifiée est appliquée
a toutes les pages courantes (y compris les pages de gauche des documents recto verso)
contenant le style de paragraphe indiquée, sauf si vous spécifiez une maquette différente
dans la colonne Maquette page de gauche. Les noms de maquettes font la distinction entre
les minuscules et les majuscules.

Dans la colonne Maquette page de gauche, saisissez le nom de la maquette que vous
souhaitez appliguer aux pages courantes de gauche (documents recto verso) contenant le
style de paragraphe spécifié. Cette colonne est facultative.

Dans la colonne Indicateur de sélection, tapez Une seule page pour appliquer la maquette
uniquement a la page courante contenant chacune des étiquettes de paragraphe ; tapez Série
de pages pour appliquer la maquette a la série de pages contenant I'étiquette de paragraphe ;
ou tapez Avant modification pour appliquer la maquette a toutes les pages, jusqu’a la
prochaine page courante contenant un autre style de paragraphe répertorié dans la table de
correspondance. Si vous ne renseignez pas cette cellule, les maquettes sont appliquées a une
seule page.

Ajoutez des remarques dans la colonne Commentaires. Le texte saisi dans cette colonne ne
modifie en aucune facon le mode d’application des maquettes.

Pour associer d’autres maquettes a des styles de paragraphe, ajoutez des lignes a la table en
remplissant les colonnes comme indiqué ci-dessus.

Une fois que vous avez terminé, choisissez Affichage > Pages courantes.

Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

Sélectionnez Format > Mise en page > Appliquer les maquettes, puis cliquez sur Oui pour
remplacer les maquettes appliquées manuellement.

Adobe FrameMaker recherche la premiere page courante contenant la premiere occurrence du style de
paragraphe spécifié dans la table de correspondance des maquettes. Dés que la page contenant le style
de paragraphe défini est trouvée, FrameMaker lui applique la maquette spécifiée.

Attribution d’une maquette a des pages courantes de documents structurés

Pour attribuer des maquettes a des pages courantes contenant des éléments de documents structurés,
associez les éléments aux maquettes a I'aide de la table de correspondance Pages de référence. Lorsque
vous choisissez Format > Mise en page > Appliquer les maquettes..., la page principale est appliquée a
la page du corps sur laquelle I'élément référencé apparait.

1)
2)

Dans FrameMaker structuré, choisissez Affichage > Pages référence.

Cliquez sur le bouton Page suivante jusqu’a ce que la table CorrespondanceMaquettesStruct, qui
contient huit colonnes, s’affiche.

CoNsEIL : Si vous modifiez un document créé avec une version antérieure de FrameMaker,
choisissez Format > Mise en page > Appliquer les maquettes..., afin que la table de correspon-
dance s’affiche dans les pages de référence.
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3)

4)

6)

7)

A droite du champ Mise a jour du livre (Oui ou Non), saisissez Oui ou Non pour indiquer si la
magquette spécifiée doit étre appliquée dés que vous choisissez Appliquer les maquettes dans un

livre.

Modifiez la table de correspondance en procédant comme suit :

Dans la colonne Nom du style d’élément/de paragraphe, saisissez un préfixe valide (E : pour
les éléments, ou P : pour les paragraphes), suivi du nom de la balise d’élément ou de
I’étiquette de paragraphe a laquelle vous souhaiter appliquer la maquette. Si aucun préfixe
n’est appliqué, FrameMaker considere que vous avez défini un élément. Veillez a orthogra-
phier correctement le nom du style de paragraphe ou d’élément, en respectant la casse util-
isée. Cette colonne est obligatoire pour I'application des maquettes.

Dans la colonne Maquette page de droite, saisissez le nom de la maquette a appliquer. La
magquette spécifiée est appliquée a toutes les pages courantes (y compris les pages de gauche
des documents recto verso) contenant le style de paragraphe ou d’élément indiqué, sauf si
vous spécifiez une maquette différente dans la colonne Maquette page de gauche. Les noms
de maquettes font la distinction entre les minuscules et les majuscules. Cette colonne est
obligatoire pour I'application des maquettes.

Dans la colonne Maquette page de gauche, saisissez le nom de la maquette que vous
souhaitez appliquer aux pages courantes de gauche (documents recto verso) contenant le
style de paragraphe ou d’élément spécifié. Cette colonne est facultative.

Dans Nom d’attribut, saisissez un nom d’attribut valide pour préciser le contexte de corre-
spondance.

Dans Valeur d’attribut, saisissez une valeur d’attribut valide pour préciser le contexte de mise
en correspondance.

Dans Contexte, saisissez la valeur d’un label de contexte d’élément pour préciser le contexte
de correspondance.

Dans la colonne Indicateur de sélection, tapez Une seule page pour appliquer la maquette
uniguement a la page courante contenant chacune des étiquettes de paragraphe ou des
balises d’élément ; tapez Série de pages pour appliquer la maquette a la série de pages conte-
nant le style de paragraphe ou d’élément ; ou tapez Avant modification pour appliquer la
maquette a toutes les pages, jusqu’a la prochaine page courante contenant un autre style de
paragraphe ou d’élément répertorié dans la table de correspondance. Si vous ne renseignez
pas cette cellule, les maquettes sont appliquées a une seule page.

Ajoutez des remarques dans la colonne Commentaires. Le texte saisi dans cette colonne ne
modifie en aucune facon le mode d’application des maquettes.

Pour associer d’autres maquettes a des éléments ou a des styles de paragraphe, ajoutez des
lignes a la table en remplissant les colonnes comme indiqué ci-dessus.

Sélectionnez Affichage > Pages de corps.

Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

Sélectionnez Format > Mise en page > Appliquer les maquettes, puis cliquez sur Oui pour
remplacer les maquettes appliquées manuellement.
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FrameMaker recherche dans chaque page courante la premiére occurrence du style de paragraphe ou
d’élément spécifié dans la table de correspondance des maquettes. Dés que la page contenant le style
de paragraphe ou d’élément défini est trouvée, FrameMaker lui applique la maquette spécifiée.

Affichage des maquettes

Découvrez comment afficher des maquettes et revenir aux pages courantes a partir d'une maquette.

Dans ce sujet

. Introduction
. Affichage d’autres maquettes lorsqu’une maquette est visible
J Retour aux pages courantes lorsque les maquettes sont visibles

Introduction

Lorsque vous travaillez sur les maquettes, vous vous déplacez entre elles et les pages courantes. Si une
magquette est visible, son nom et le nombre de maquettes dans le document s’affichent dans la zone
d'état de page de la barre d’état.

1 b M| Rightilof2)® o ]| = womv +

Figure 6: Zone d’état de page de la barre d’état

Sélectionnez Affichage > Maquettes. La maquette utilisée par la page courante s’affiche et les bordures
de zones de texte et de colonnes sont visibles.

Affichage d’autres maquettes lorsqu’une maquette est visible

. Procédez de I'une des facons suivantes :
- Cliquez sur le bouton Page suivante ou Page précédente.
- Appuyez sur la touche fléchée Page précédente ou Page suivante.
- Utilisez la barre de défilement.

Retour aux pages courantes lorsque les maquettes sont visibles

Sélectionnez Affichage > Pages de corps. La derniére page courante affichée s’affiche. Si FrameMaker
détecte une mise en page personnalisée sur les pages courantes, un message d’alerte vous demande
comment vous souhaitez les gérer.

RELATED LINKS:
A propos des mises en page personnalisées
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Pages de référence

Vous pouvez stocker sur des pages de référence des graphiques fréquemment utilisés que vous voulez
placer de maniere homogeéne dans un document, puis utiliser ces graphiques sur les pages courantes
quand ils sont requis. Si vous placez un graphique dans un cadre de référence (cadre graphique non ancré
sur une page de référence), vous pouvez utiliser ce cadre comme une caractéristique de style de para-
graphe. Par exemple, pour créer un intitulé avec une ligne sous celui-ci, dessinez la ligne dans un cadre
de référence, puis incluez le cadre de référence dans le style de paragraphe de l'intitulé.

Note

Note de tableaux

Bloc danger

Bloc avertissement

CHAPTER

"iThe section provides general background information about the
wehicle and its fuel systems.
"History of flight” on page 5
"Overview" on page 7

"Vehicle structure” on page 9

Flight used to depend on an aircraft engine and propeller.
Today's modern Personal Spaceship is ready to go with a hydro-
‘gen and oxygen mix in an external tank and solid rockets for aux-
iliary takeoff power.

DANGER! Ceci est une note de type DANGER.‘

i Avertissement Ceci est une note de type Avertissement.

Figure 1:  Page de référence et page courante

Les pages de référence peuvent également contenir des éléments standard ou des composants
graphiques clip art que vous pouvez copier et coller sur les pages courantes ; il s’agit par exemple de
symboles d’avertissement ou de remarque. De plus, les pages de référence spécialisées peuvent
comporter des commandes hypertexte, des informations de formatage pour les index et les listes
générées, des définitions d’éléments mathématiques personnalisés et des correspondances de conver-
sion au format XML et HTML.
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Un document contient normalement au moins une page de référence. Vous pouvez ajouter vos propres
graphiques a une page de référence existante et vous pouvez créer des pages de référence supplémen-
taires (jusqu’a 100).

Affichage, création et suppression de pages de référence

Découvrez comment afficher, créer et supprimer des pages de référence.

Dans ce sujet

. Affichage de pages de référence

. Affichage d’autres pages de référence lorsqu’une page de référence est visible
J Création d’une page de référence

. Retour aux pages courantes

. Maodlification du nom ou suppression d’une page de référence

Affichage de pages de référence

Sélectionnez Affichage > Pages de référence. Le nom de la page de référence courante s’affiche dans la
zone d’état de page de la barre d’état.

Flow: MasterPageMaps .. | 4 4 P M| MasterPageMa... P = 100% ¥ o+

Figure 2: Zone d’état de page

Si le document ne contient aucune page de référence, la boite de dialogue Ajouter une page de référence
s’affiche. Créez la page de référence en entrant un nom de page et en cliquant sur Ajouter.

Affichage d’autres pages de référence lorsqu’une page de référence est visible

. Cliquez sur le bouton Page suivantej ou Page précédenteq.
. Appuyez sur la touche fléchée Page précédente ou Page suivante.
. Utilisez la barre de défilement.

Création d’une page de référence

1)  Affichez les pages de référence et choisissez Insérer > Ajouter une page de référence.
2)  Entrez un nom pour la page de référence et cliquez sur Ajouter.

Retour aux pages courantes

Sélectionnez Affichage > Pages de corps. La derniére page courante affichée s’affiche.

Modification du nom ou suppression d’une page de référence

Vous pouvez renommer une page de référence (par exemple, pour éviter d’écraser la page de référence
lors de I'importation de pages de référence depuis un modéle contenant une page portant le méme
nom).
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Toutefois, si elle contient un graphique utilisé dans un style de paragraphe, ce dernier n’apparait plus
dans les paragraphes faisant référence a ce style. Lorsque cela se produit, la liste déroulante Cadre du

dessus ou Cadre du dessous dans les propriétés Avancées[E de la fenétre Configuration de paragraphes
a pour valeur Tel quel pour les paragraphes.

. Affichez la page de référence, puis procédez de I'une des facons suivantes :

- Pour renommer la page, cliquez sur le nom de la page dans la barre d’état et saisissez le
nouveau nom. Cliquez sur Définir-

- Pour supprimer la page, choisissez Format > Document > Supprimer la page <nom de la page
de référence>.

Utilisation de cadres de référence sur les pages de référence

Découvrez comment créer et utiliser des cadres de référence sur les pages de référence et comment
configurer des graphiques standard sur les pages de référence.

Dans ce sujet

. Introduction

J Création d’un cadre de référence sur une page de référence

. Modification du nom d’un cadre de référence

. Modification d’autres caractéristiques d’un cadre de référence

. Définition de graphiques standard sur les pages de référence

Introduction

Un graphique peut étre considéré comme faisant partie d’un style de paragraphe si vous |'avez placé
dans un cadre de référence sur une page de référence.

181



Footnote

TableFootnote

DangerBlock

CautionBlock

The shapes to the left control the way that
buttons in the file look. To change ALL
appearances at once, select one of the
three shapes, then click Graphics >
Object Style Designer, change the Fill >
Color settings and lastly, click Update All
to change the appearances of buttons.

Figure 3:  Graphiques dans des cadres de référence

Lorsque vous sélectionnez un cadre de référence sur une page de référence, son nom s’affiche dans la
barre d’état aprés le mot Cadre.

Création d’un cadre de référence sur une page de référence

1)

2)

3)

4)

Cliquez sur 'outil Cadre graphique =8 sur le panneau Outils, puis faites faites-le glisser pour dess-
iner le cadre. Pour dessiner un carré, maintenez la touche Maj enfoncée pendant le déplacement
du pointeur.

Entrez un nom dans la zone de texte Nom et cliquez sur Définir. Utilisez un nom court et descriptif,
facilement reconnaissable lorsqu’il s’affichera dans les menus déroulants Cadre dessus et Cadre
dessous dans les propriétés Avancées/Ede la fenétre Configuration de paragraphes.

Placez un graphique dans le cadre. Vous pouvez dessiner le graphique, importer un fichier
graphique ou combiner des graphiques dessinés et importés.

Ajustez la taille et la forme du cadre, si nécessaire. Si vous utilisez un cadre de référence au-dessus
ou au-dessous d’un paragraphe sur une page courante, le cadre entier (et non uniguement le
graphique) s’affiche sur cette page. La hauteur du cadre affecte I'espacement du texte au-dessus
et au-dessous du cadre.
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5)  Utilisez I'outil Ligne de texte pour saisir le nom du cadre au-dessus de ce dernier. La saisie d’'un nom
vous aide a identifier le cadre lorsque vous visualisez la page de référence. Cela ne renomme pas le
cadre de référence.

Modification du nom d’un cadre de référence

1) Sélectionnez le cadre de référence et cliquez sur son nom dans la barre d’état.

2)  Entrezle nouveau nom, puis cliquez sur Définir. Vous pouvez également entrer ce nom sur la ligne
de texte au-dessus du cadre de référence. Si vous renommez un cadre de référence utilisé dans un
style de paragraphe, vous devrez mettre a jour le format afin qu’il utilise ce nouveau nom.

Modification d’autres caractéristiques d’un cadre de référence

Sélectionnez le cadre. Sélectionnez Graphiques > Caractéristiques de I'objet pour modifier les
caractéristiques de I'objet. Alternativement, utilisez les options du panneau Outils.

Définition de graphiques standard sur les pages de référence

Vous pouvez placer un graphique standard (tel gu’un symbole de marge) dans un cadre ancré sur une
page de référence. Vous avez ensuite la possibilité de copier ce cadre sur les pages courantes. Dans ce
cas, le graphique est correctement positionné dans son cadre ancré.

O

0 1Caution Symbeol

lesding
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Figure 4: Vous pouvez copier et coller des graphiques standard sur les pages courantes.

Vous pouvez également placer directement des graphiques sur les pages de référence puis les copier et
les coller sur les pages courantes.

1) Créez une page de référence avec le méme aspect de colonnes que la page courante sur laquelle
afficher le graphique. Cela garantit le bon positionnement du graphique lors de sa copie sur les
pages courantes. Pour définir I'aspect des colonnes, vous pouvez copier la zone de texte d’une page
courante et la coller sur la page de référence.

Sur la page de référence, définissez le cadre ancré tel qu’il doit s’afficher sur les pages courantes.
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2) Dessinez le graphique dans le cadre ancré ou collez-le ou importez-le dans le cadre. Vous pouvez
ajouter du texte a I’extérieur du cadre ancré pour identifier le graphique. Par exemple, dans l'illus-
tration, le symbole d’avertissement identifie le graphique.
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Mises en page

Découvrez comment créer et utiliser des cadres de référence sur les pages de référence et comment
configurer des graphiques standard sur les pages de référence dans Adobe FrameMaker.

Vous pouvez apporter des modifications a la mise en page de base d’un document directement depuis

une page courante. FrameMaker met alors automatiquement a jour les maquettes gauche et droite ainsi
gue la mise en page des pages courantes utilisant ces maquettes. Sil'une de ces pages courantes contient
une mise en page personnalisée, vous étes invité a confirmer I'application des mises a jour.

Si le document utilise une autre maquette (par exemple, pour sa premiéere page), vous devez effectuer
toute modification de mise en page sur cette maquette.

Modification du format de page

Découvrez comment modifier le format d'une page dans Adobe FrameMaker.

1) Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

2) Sélectionnez Format > Mise en page > Format de page.

3)  Procédez de I'une des fagons suivantes :

- Choisissez un format standard dans la liste déroulante Format de page. Les dimensions
correctes s’affichent dans les zones de texte Largeur et Hauteur.

- Entrez les dimensions dans les zones de texte Largeur et Hauteur. Personnalisé apparait dans
la liste déroulante. Le format personnalisé spécifié peut étre petit, en fonction des
parameétres de marge ou trés grand (216 x 216 pouces, soit 548 x 548 cm environ).

4)  Cliquez sur Définir-
REMARQUE : Lorsque vous générez un fichier PDF pour un document dont la taille est supérieur a A4,
il se peut qu’une partie du cotenu ne rentre pas dans la page et ne ressorte pas correctement. Pour
éviter de perdre du contenu, ajoutez I'indicateur UsePDFResolution=300 dans le fichier
maker.ini dansle dossier <$appdata%\Adobe\FrameMaker\16>.Pouren savoir plussurla
génération de PD, consultez Générer un PDF.

REMARQUE : si le document contient des maquettes personnalisées, FrameMaker ne vous permet pas de
lui attribuer un format de page ne pouvant recevoir les zones de texte sur ces maquettes.

Modification de la pagination

Découvrez comment modifier la pagination dans Adobe FrameMaker et comment modifier un document
recto en recto-verso ou inversement.

Vous pouvez modifier un document recto en recto-verso et inversement. Si vous définissez un document
recto-verso, vous devez indiquer si la premiére page est a gauche ou a droite.

1) Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

2)  Sélectionnez Format > Mise en page > Pagination.
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3) Sélectionnez une option de la zone Pagination. Pour un document recto-verso, précisez si la
premiere page est a gauche ou a droite. Si vous appliquez la pagination a un livre, vous pouvez
sélectionner I'option Lire depuis fichier pour utiliser le c6té défini dans le fichier. Sélectionnez Coté
suivant disponible pour éviter I'insertion de pages blanches.

Suivant I'option choisie, une page blanche peut étre ajoutée au document précédent du livre pour
permettre au présent document de commencer du cété indiqué.

4)  Cliquez sur Définir- Si le document contient des maquettes ou des mises en page personnalisées,
un message d’alerte vous demande comment procéder.

Ajout ou suppression de pages vides

Découvrez comment ajouter ou supprimer des pages vides dans Adobe FrameMaker et comment spéci-
fier un nombre pair ou impair de pages.

Vous pouvez spécifier que le nombre de pages d’un document doit étre pair ou impair. Le cas échéant,
FrameMaker ajoute une page vierge a la fin du document pour obtenir la pagination souhaitée.

Des pages vierges indésirables peuvent en outre apparaitre en fin de document suite a la suppression ou
a la modification du texte. Vous pouvez indiquer a FrameMaker de supprimer ces pages vides a I’enreg-
istrement ou a I'impression du document.

FrameMaker ne supprime une page vierge que si elle utilise la maquette gauche ou droite et qu’elle ne
contient pas le début d’'un enchainement ni de formats personnalisés, mais ne supprime pas une page si
elle contient un paragraphe vide.

Sivous changez la pagination d’un document faisant partie d’un livre a partir de la fenétre du document,
les parametres choisis peuvent étre remplacés lors de la mise a jour du livre. Pour vous assurer que la
pagination du livre est correcte, modifiez la configuration du document dans la fenétre du livre.

1) Activez la fenétre de document ou de livre qui vous intéresse. Dans le cas d’une fenétre de livre,
sélectionnez les documents concernés.

2)  Sélectionnez Format > Mise en page > Pagination.

3) Dans la liste déroulante Avant d’enregistrer et d’imprimer, choisissez une option puis cliquez sur
Définir.

Si aucune page blanche n’est ajoutée ou supprimée, vérifiez que toutes les pages du document sont

autoconnectées.

RELATED LINKS:
A propos des mises en page personnalisées

Modification des marges et du nombre de colonnes

Définissez des marges des pages et le nombre de colonnes, créez une mise en page a plusieurs colonnes
de différentes largeurs, définissez des marges gauche et droite asymétriques dans Adobe FrameMaker.

La marge est la distance entre le bord de la page et la zone de texte. Pour un document recto, vous
définissez les marges supérieure, inférieure, gauche et droite de la zone de texte. Pour un document
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recto-verso, vous définissez les marges supérieure, inférieure, intérieure et extérieure pour obtenir un
aspect symétrique.

Pour définir des marges gauche et droite asymétriques, modifiez directement les zones de texte sur les
maquettes. Vous pourriez, par exemple, afficher les zones de texte des pages recto comme verso du coté
droit de la page et laisser une zone d’espace blanc a gauche.

Vous pouvez diviser une zone de texte en deux (ou plusieurs) colonnes de gouttiére et de largeur égales.
Pour créer une mise en page a colonnes multiples de largeurs ou de gouttieres inégales, utilisez une zone
de texte pour chaque colonne de texte et positionnez les zones une par une. Dessinez les zones de texte
ou définissez une zone de texte selon votre choix et dupliquez-la.

1) Placezle point d’insertion dans I'enchainement de texte principal ou cliquez dans la marge. Dans le
cas d’une fenétre de livre, sélectionnez les documents concernés.

2)  Sélectionnez Format > Mise en page > Aspect des colonnes.

Si la mise en page est asymétrique (avec, par exemple, un nombre de colonnes différent ou une
marge inférieure ou supérieure différente sur les maquettes gauche et droite), vous étes invité a
confirmer que vous souhaitez poursuivre la procédure. Pour conserver I’asymétrie, modifiez la mise
en page directement sur les maquettes.

3)  Pour modifier les marges, entrez les valeurs voulues dans la zone Marges des colonnes. Les marges
et la gouttiére entre les colonnes déterminent la largeur de chaque colonne.

4)  Pour modifier le nombre de colonnes ou la gouttiére entre celles-ci, entrez de nouvelles valeurs dans
la zone Colonnes.

Toutes les colonnes ont la méme largeur et sont séparées par une gouttiére uniforme.

5) Cliquez sur Modifier tout I’enchainement. Si la nouvelle largeur de colonne est trop étroite pour
contenir certains cadres ancrés ou tableaux du document, vous étes invité a confirmer que vous
souhaitez poursuivre la procédure. Si vous cliquez sur OK, vous pouvez redimensionner manuelle-
ment les tableaux et les cadres.

RELATED LINKS:
Modification de la mise en page de pages spécifiques
Ajout d’un modéle de zone de texte sur une maquette

Ajout de zones de texte aux pages courantes

En-tétes, pieds de pages et autres textes d’arriére-plan

Définissez des en-tétes, des pieds de page et un texte d'arriere-plan. Créez et modifiez des zones de texte
d'arriere-plan, redimensionnez ou déplacez une zone de texte d’arriere-plan dans Adobe FrameMaker.
Dans ce sujet

. Introduction

. Création et modification de zones de texte d’arriere-plan

. Saisie des informations d’en-téte ou de pied de page
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Introduction

Pour définir des en-tétes et des pieds de pages, affichez les maquettes et saisissez du texte dans les zones
de texte d’arriére-plan. Le contenu de ces zones s’affiche sur les pages courantes mais ne peut étre
modifié que sur les maquettes. Les en-tétes et pieds de pages peuvent inclure le numéro de page, la date,
le numéro et la section de chapitre, le titre et le numéro de section, I'auteur, le numéro de révision et la
version (préliminaire ou finale, par exemple).

Running /T 1 6/13/20;

Figure 1:  Zones de texte d’en-téte et de pied de page sur la maquette

Créez et modifiez le texte des en-tétes ou des pieds de pages comme tout autre texte de paragraphe.
Vous pouvez appliquer des styles de paragraphes et de caracteres, ajouter et déplacer des taquets de
tabulation et ajouter des graphiques tels qu’une ligne au-dessus ou au-dessous du texte. De plus, vous
pouvez ajouter des variables systeme relatives a des informations telles que le numéro de page ou la
date. Vous pouvez également modifier la taille et la position des zones de texte d’en-téte et de pied de
page. Si vous modifiez celles-ci sur une maquette, FrameMaker met automatiquement a jour toute page
courante utilisant cette maquette.

Vous pouvez également ajouter tout autre texte d’arriére-plan sur les maquettes.

Création et modification de zones de texte d’arriére-plan

Lorsque vous créez un document vierge, FrameMaker définit des zones de texte d’arriére-plan pour les
en-tétes et pieds de pages sur les maquettes gauche et droite. Pour faciliter I'ajout d’informations

centrées ou alignées a droite dans les en-tétes et pieds de pages, FrameMaker ajoute automatiquement
des tabulations au centre de la zone de texte et sur la marge droite. Vous pouvez dessiner des zones de
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texte d’arriere-plan pour d’autres informations d’en-téte et de pied de page ou pour tout autre texte
d’arriere-plan.

REMARQUE : il est possible de créer des lignes de texte d’arriere-plan individuelles a I'aide de |'outil Ligne
de texte mais vous ne pouvez pas appliquer des styles de paragraphes au texte niy insérer des variables.
Pour ajouter une zone de texte d’arriere-plan sur une maquette, procédez comme suit :

1) Dessinez la zone de texte a I'aide de I'outil Zone de texte.

2) Dans la boite de dialogue Ajouter nouvelle zone de texte, sélectionnez Texte d’arriére-plan, puis
cliquez sur Ajouter. La nouvelle zone de texte, comme toutes les zones de texte d’arriere-plan des
maquettes, ne porte pas d’étiquette.

3) Cliguez deux fois dans la zone de texte pour placer le point d’insertion, puis insérez le texte
d’en-téte, de pied de page ou d’arriere-plan.

Pour redimensionner ou déplacer une zone de texte d’arriére-plan, procédez comme suit :

1) Cliquez sur la zone de texte tout en maintenant la touche Ctrl enfoncée.

2) Effectuez I'une des opérations suivantes :
- Pour redimensionner la zone de texte, faites glisser une poignée.
- Pour déplacer la zone de texte, faites glisser sa bordure (et non une poignée).

Saisie des informations d’en-téte ou de pied de page

Vous pouvez créer des en-tétes et des pieds de pages simples en saisissant du texte dans des zones de
texte d’en-téte et de pied de page sur les maquettes. De plus, vous pouvez spécifier des éléments tels
qgue le numéro du chapitre et de la page active, le nombre total de pages et la date. FrameMaker affiche
une variable systéme dans I’en-téte ou le pied de page de la maquette et la remplace par la valeur
correcte sur chaque page courante utilisant cette maquette.

Vous pouvez également créer des en-tétes et des pieds de pages courants dans lesquels le texte change
de page en page. Dans la figure suivante, I’en-téte courant contient I'intitulé de section courante. Le pied
de page contient le numéro de page et du texte saisi directement dans la zone de texte d’arriere-plan.
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[Running HF 1| [|General description |

We've moved from the basics of flight to space travel as it was
imagined in fiction and seen in movies in under 100 years. Just
think about where the next 100 years will take us!

Today the promise of space flight is closer than ever. With your
own Personal Spaceship you can travel to the stars!

K the fallowing image.

None of the work on the Personal Spaceship would have been
possible without the research and work done over the years by
the good folks at NASA. To learn more about the history of their
great achievements, what they are doing at present, and what the
future of NASA holds, visit these sites!

Table 1: More information about space travel

Sitelocation QR Code (Scan/go)

http://www.nasa.gov/

[y ]t s s S e i P

Figure 2: En-tétes et pieds de pages courants

Pour créer des en-tétes et pieds de pages courants, insérez des variables d’en-téte/pied de page courant
dans des zones de texte d’arriere-plan sur les maquettes.

Vous pouvez insérer les variables suivantes dans un en-téte et un pied de page sur la maquette :

Numérotation des composants de livre
Numeéro du volume, Numéro du chapitre, N° de section ou N° de sous-section.

Numéros de page
Numéro de page en cours ou Nombre de pages

Informations de date
Date en cours (Longue), Date en cours (Courte), Date de modif. (Longue), Date de modif. (Courte),
Date de création (Longue), Date de création (Courte).

Autres variables

Nom du titre de chapitre, Nom de fichier (Long), Nom de fichier (Court), Suite de tableau ou Page
de tableau.

Pour insérer une variables dans un en-téte et un pied de page sur une maquette, procédez comme suit :
1)  Sur une maquette, cliquez dans I'en-téte ou le pied de page ou ajouter les informations.
- Pour insérer un texte statique, tapez le texte.
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- Pour insérer des variables systéme, accédez au panneau Variables, puis cliquez deux fois sur
le nom de la variable dans la liste de sélection Variables. Vous pouvez insérer tout type de
variable systéme, par exemple :

- Pourinsérer des variables utilisateur, accédez au panneau Variables, puis cliquez deux fois sur
le nom de la variable (si celle-ci est déja définie) dans la liste de sélection Variables.

ConsEIL : Pour ajouter des informations centrées dans les en-tétes et pieds de pages, appuyez sur
la touche Tab pour placer le point d’insertion au niveau du taquet de tabulation centré. Pour
ajouter des informations alignées a droite, continuez d’appuyer sur la touche Tab pour placer le
point d’insertion au niveau du taquet de tabulation aligné a droite.

RELATED LINKS:
Saisie des informations d’en-téte ou de pied de page

Variables

Modification de la mise en page de pages spécifiques

Modifiez la mise en page de pages spécifiques, créez une mise en page asymétrique, des mises en page
personnalisées, un modele de zone de texte, mettez a jour des mises en page du corps et des maquettes.
Créez des mises en page uniques dans Adobe FrameMaker.

Vous pouvez créer une mise en page asymétrique en ajoutant ou en modifiant des zones de texte directe-
ment sur les maquettes. Par exemple, vous pouvez avoir une marge gauche plus large que la marge
droite sur les pages gauches et droites. Vous pouvez également avoir une mise en page a une colonne
sur la page de gauche et a deux colonnes sur la page de droite.

Vous pouvez méme créer une mise en page contenant des colonnes de largeur et de gouttiére inégales
en utilisant plusieurs zones de texte sur une page (une zone de texte par colonne).

A propos des mises en page personnalisées

Si vous modifiez une maquette, FrameMaker met automatiquement a jour toutes les pages courantes
utilisant cette maquette. Lorsque vous modifiez la mise en page d’une page courante (par exemple, en
modifiant le nombre de colonnes, la gouttiére entre les colonnes ou les marges), vous créez une mise en
page personnalisée de la maquette. Vous pouvez alors effectuer I'une des opérations suivantes :

J Mettre a jour la maquette et toutes les pages courantes correspondantes avec les modifications
. Créer une maquette basée sur les modifications de pages courantes
. Ne rien faire et garder cette personnalisation unique
RELATED LINKS:
Mise a jour des maquettes et pages courantes
Création de maquettes personnalisées

Création de mises en page uniques

Modification des marges et de I'aspect des colonnes sur des pages spécifiques

Les étapes suivantes créent toujours une mise en page a une colonne ou a plusieurs colonnes de méme
largeur.
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Pour créer une mise en page a plusieurs colonnes de largeurs ou de gouttieres inégales, utilisez une zone
de texte pour chaque colonne et positionnez les zones de texte une par une.

1)  Cliquez sur la zone de texte dont vous souhaitez modifier les marges tout en maintenant la touche
Ctrl enfoncée.

2)  Sélectionnez Format > Personnaliser la mise en page > Personnaliser la zone de texte.
3)  Procédez comme suit :

- Pour modifier les marges, spécifiez les nouvelles taille et position dans les zones Taille avant
rotation et Décalage a partir de. Les options de décalage a partir du haut et a partir de la
gauche définissent les marges supérieure et gauche. Les marges inférieure et droite sont alors
définies en fonction de la largeur et de la hauteur de la zone de texte.

- Pour modifier le nombre de colonnes ou la gouttiére entre les colonnes, modifiez les valeurs
de la zone Colonnes.

4)  Cliquez sur Définir-

ConsElL : Pour modifier les marges, vous pouvez également choisir une zone de texte et faire glisser une
poignée de redimensionnement. Lorsque la zone de texte est a plusieurs colonnes, la largeur de ces
dernieres change pour s’adapter a la zone de texte, mais la gouttiere reste la méme.

RELATED LINKS:
Ajout d’un modéle de zone de texte sur une maquette

Ajout de zones de texte aux pages courantes

Ajout d’'un modeéle de zone de texte sur une maquette

Pour qu’une maquette contienne des colonnes de texte de largeurs différentes ou pour définir la mise
en page d’un bulletin ou de tout autre document dans lequel les articles ne s’enchainent pas de maniere
continue de la premiére page a la derniere, utilisez plusieurs zones de texte (une pour chaque colonne).
Par exemple, pour une page avec deux colonnes de différentes largeurs, vous ajoutez un second modéle
de zone de texte.

Vous pouvez ajouter un modele de zone de texte en le dessinant ou en dupliquant un modele existant.

1) Pour dessiner la zone de texte, utilisez I'outil Placer une zone de texte de la barre d’outils
Graphiques. Pour dessiner plus d’'une zone de texte, dessinez-les dans I'ordre ou vous souhaitez les
connecter.

2) Dans la boite de dialogue Ajouter nouvelle zone de texte, cliquez sur Modéle de zone de texte de
la page courante et choisissez une étiquette dans la liste déroulante Etiquette. Choisissez
I’étiquette d’enchainement courante, a moins que vous ne configuriez une zone de texte pour un
enchainement différent dans un document a enchainements multiples.

3) Dans la zone Colonnes, spécifiez le nombre de colonnes dans la zone de texte et (s’il y en a plus
d’une) la gouttiére entre les colonnes adjacentes. Si vous créez une mise en page a colonnes multi-
ples de largeur inégale, définissez le nombre de colonnes sur 1, car vous utilisez une zone de texte
distincte pour chaque colonne.

4)  Cliquez sur Ajouter.

5) Déplacez la zone de texte selon vos besoins.
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CONSEIL : Pour copier une zone de texte existante, sélectionnez-la et choisissez Edition > Copier, puis
Edition > Coller. FrameMaker copie la zone de texte, son contenu et ses caractéristiques (y compris
I’étiquette d’enchainement).

Ajout de zones de texte aux pages courantes

Lorsque vous dessinez une zone de texte sur une page courante, vous étes invité a spécifier le nombre
de colonnes et la gouttiere les séparant. Cependant, FrameMaker n’attribue pas d’étiquette d’enchaine-
ment et ne connecte pas la zone de texte aux zones de texte existant sur la page.

Pour utiliser cette nouvelle zone de texte comme élément de I'’enchainement de texte du document,
connectez-la a '’enchatnement.

Si la nouvelle zone de texte est la premiére dans I’enchainement, sélectionnez aussi le parametre Auto-
connecter afin d’ajouter de nouvelles pages si nécessaire.

RELATED LINKS:
Connexion de zones de texte

Mise a jour des maquettes et pages courantes

Vous pouvez modifier le modéle de zone de texte sur plus d’'une maquette, puis mettre a jour toutes les
pages courantes correspondantes en une étape. Toutefois, si vous modifiez I'aspect des colonnes sur une
page courante, vous devez mettre a jour la maquette correspondante avant de pouvoir mettre a jour les
autres pages courantes qui utilisent cette maquette.

Avant de mettre a jour des pages courantes, FrameMaker détermine si I'aspect des colonnes de ces
pages est différent de leur maquette. Lorsque certaines pages contiennent des personnalisations, vous
devez spécifier si vous souhaiter les conserver.

Mise a jour des pages courantes avec les modifications de la maquette

1)  Apres avoir modifié les maquettes, affichez les pages courantes.

2) Siun message d’alerte s’affiche, indiquez si vous souhaitez conserver ou supprimer les formats
personnalisés, puis cliquez sur Continuer. Si vous conservez les formats personnalisés,
FrameMaker met a jour ces pages courantes avec les graphiques et le texte d’arriere-plan de la
maquette, mais ne met pas a jour les modeéles de zone de texte.

Mise a jour d’une maquette avec des pages courantes modifiées

1)  Choisissez Format > Mise en page > Mise a jour aspect des colonnes. Un message vous demande
de confirmer la maquette et les pages courantes a mettre a jour.

2) Cliquez sur Mettre a jour.
3)  Siun message d’alerte s’affiche, indiquez si vous souhaitez conserver ou supprimer les person-
nalisations de mise en page sur les pages a mettre a jour, puis cliquez sur Continuer.

RELATED LINKS:
A propos des mises en page personnalisées
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Création de mises en page uniques

Vous devrez peut-étre modifier la mise en page d’une seule page courante d’un document. Par exemple,
vous pouvez agrandir une zone de texte pour qu’elle contienne plus de lignes de texte sur la page ou
réduire une zone de texte pour permettre de placer directement un graphique sur la page courante.

Lorsque vous modifiez I'aspect des colonnes d’une page courante sans mettre a jour la maquette, vous
créez une mise en page personnalisée.

RELATED LINKS:
Modification des marges et de I"aspect des colonnes sur des pages spécifiques

Ajout de zones de texte aux pages courantes

Alignement de texte sur plusieurs colonnes

Découvrez comment équilibrer du texte sur plusieurs colonnes, justifier verticalement un texte en bas de
zones de texte, et synchroniser des lignes de base dans Adobe FrameMaker.

Equilibrage du texte sur plusieurs colonnes

Découvrez comment équilibrer du texte sur plusieurs colonnes dans une zone de texte dans Adobe
FrameMaker.

Dans ce sujet

. Introduction
. Equilibrage d’un texte sur des colonnes dans un enchainement de texte
. Equilibrage d’un texte sur des colonnes dans une seule zone de texte

Introduction

Dans une mise en page utilisant une zone de texte a plusieurs colonnes, vous pouvez équilibrer le texte
sur les colonnes n’étant pas entierement remplies (par exemple, des colonnes sur des pages partielle-
ment vides qui précédent des sauts de page forcés et des colonnes sur la derniére page d’'un document).
Vous pouvez équilibrer le texte sur les colonnes dans un enchainement de texte ou dans une zone de
texte individuelle.
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"enjoy the beverage of your
ichoice.

132 Wing

for the spaceship.

ized vehicle.

l 3.3 Thermal protection
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Figure 3:

Equilibrage inactif et actif

Equilibrage d’un texte sur des colonnes dans un enchainement de texte

1) Silafenétre activée est une fenétre de document, placez le point d’insertion dans I’enchainement
principal ou cliquez dans la marge de la page. Dans le cas d’une fenétre de livre, sélectionnez les

documents concernés.

2)  Sélectionnez Format > Mise en page > Aspect des colonnes.

3)  Sélectionnez Equilibrer les colonnes, puis cliquez sur Modifier tout I’enchainement.

Equilibrage d’un texte sur des colonnes dans une seule zone de texte

Cliquez dans la zone de texte et choisissez Format > Personnalisation de la mise en page > Personnali-

sation de la zone de texte.

Sélectionnez Equilibrer colonnes et cliquez sur Définir.

Justification verticale du texte en bas des zones de texte

Découvrez comment justifier verticalement (espacer) du texte sur plusieurs colonnes dans une zone de

texte dans Adobe FrameMaker.
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Lorsque FrameMaker justifie verticalement un texte, il ajoute d’abord un espace entre les paragraphes
jusqu’a la limite définie. Si un autre ajustement est requis, un espace est ajouté entre les lignes jusqu’a
la limite définie. Lorsque le texte d’'une zone de texte habille un graphique, FrameMaker ne justifie pas
ce texte verticalement.
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Figure 4:  Avant et apres la justification verticale

Dans une zone de texte a plusieurs colonnes contenant des fusions (paragraphes, tableaux ou cadres
ancrés), FrameMaker ajoute un espace vertical pour aligner les derniéres lignes de base de texte dans
des colonnes adjacentes au-dessus de chaque fusion.
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Figure 5:  Avant et apreés la justification verticale avec fusion

1) Silafenétre activée est une fenétre de document, placez le point d’insertion dans I’enchainement
principal. Dans le cas d’une fenétre de livre, sélectionnez les documents concernés.

2)  Sélectionnez Format > Mise en page > Aspect des lignes.

3)  Sélectionnez Justification verticale et entrez |I'espace maximum pouvant étre ajouté entre les
lignes (Espacement maxi. entre lignes) et entre les paragraphes (Espacement maxi. entre 1]).

FrameMaker ne dépasse pas les limites d’espacement spécifiées. S’il n’est pas possible de justifier
verticalement un texte d’une colonne sans dépasser les limites, FrameMaker n’effectue pas la justi-
fication dans cette colonne.
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4)  Cliquez sur Modifier I’enchainement.

REMARQUE : |a justification verticale permet de réserver de la place a la plus grande hampe descendante
dans la plus grande taille de police utilisée pour la ligne. Si la derniére ligne d’une colonne semble trop
haute, vérifiez que la colonne ne contient pas de caractére nonimprimable (tel qu’un symbole d’ancrage)
dans une police plus grande que celle du texte I'entourant.

Synchronisation des lignes de base de texte dans un flux de texte

Découvrez comment synchroniser et aligner la ligne de base de lignes de texte sur plusieurs colonnes et
zones de texte dans Adobe FrameMaker.

Dans ce sujet

J Introduction
J Synchronisation de lignes de base sur les colonnes
J Synchronisation des lignes de base dans des zones de texte adjacentes

Introduction

Lorsque vous synchronisez (alignez) un texte dans un enchainement, FrameMaker crée une grille invis-

ible dans chaque zone de texte et aligne sur la grille la ligne de base de la premiére ligne de chaque para-
graphe spécifié. FrameMaker aligne également la premiére ligne apres un cadre ancré et tente d’aligner
la premiére ligne de chaque colonne.

REMARQUE : si la justification verticale et la synchronisation sont toutes deux activées pour un enchaine-
ment, la justification verticale est prioritaire sur la synchronisation. Cependant, les premiéres lignes dans
les colonnes sont synchronisées les unes par rapport aux autres.
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Figure 6:  Avant et aprés la synchronisation du texte dans un flux

Les intitulés libellés dans de grandes polices s’affichant souvent en haut des colonnes, vous pouvez spéci-
fier la limite de la synchronisation de la premiere ligne. Cette limite contréle si la ligne de base d’un inti-
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tulé est placée sur la premiére ligne de la grille lorsque l'intitulé se trouve en haut d’'une colonne, méme
si la police par défaut de I'intitulé est supérieure a la limite. Pour placer la ligne de base d’un intitulé sur
la premiére ligne de la grille, FrameMaker laisse l'intitulé s’étendre au-dessus du haut de la colonne
comme dans l'illustration. FrameMaker ne synchronise pas les tailles de police supérieures a la limite
définie.

Synchronisation de lignes de base sur les colonnes

Pour synchroniser des lignes de base sur les colonnes, procédez comme suit :

1) Vérifiez le style des types de paragraphes a synchroniser pour vérifier qu’ils possédent les mémes
interligne et taille de police par défaut. Le parameétre d’interligne doit étre Fixe.

2) Cliguez dans|’enchainement a synchroniser (ou sélectionnez les documents dans le livre concerné)
et choisissez Format > Mise en page > Disposition des lignes.

3)  Sélectionnez Synchronisation ligne de base et désactivez I'option Justification verticale.

4)  Dans la zone de synchronisation, entrez I'interligne de la grille de la zone dans le champ Synchro-
niser 9 avec un interligne de. Utilisez le méme interligne que dans les paragraphes a synchroniser.
Dans le cas contraire, FrameMaker ne synchronise pas les paragraphes avec la grille de la zone de
texte.

5) Dans la zone de texte Limite de synchronisation 1ére ligne, entrez la taille de police la plus élevée
a aligner en haut d’une colonne. Ainsi, supposons que l'interligne des paragraphes courants est de
12 points, la grille de la colonne de 12 points et les intitulés de 18 points. Pour aligner les intitulés
s’ils s’affichent en haut d’une colonne, spécifiez 18 comme limite de premiére ligne.

6) Cliquez sur Modifier ’enchainement.

Aucune hampe descendante ne s’affichant au-dessus de la premiére ligne d’'une colonne, la premiere
ligne de la grille est décalée du haut de la colonne d’une distance égale aux deux-tiers de l'interligne
spécifié.

Synchronisation des lignes de base dans des zones de texte adjacentes

Si les zones de texte débutent a des positions différentes sur une page, vous devrez parfois ajuster les
parties supérieures sur leurs grilles.

Alignez les grilles en redimensionnant les zones de texte adjacentes afin que la distance entre leur partie
supérieure respective puisse étre divisée de facon réguliere par la grille. Par exemple, si la grille est de
12 points, vous pouvez débuter une zone de texte a 144 points (12 x 12 points) du haut d’une zone de
texte adjacente.
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Figure 7:  Synchronisation des lignes de base dans des zones de texte adjacentes

A. Espacement de grille B. Distance divisible régulierement par la grille

ConselL : Utilisez la grille magnétique pour placer correctement les zones de texte. Pour ce faire, spécifiez
une grille magnétique égale a la grille de la zone de texte. Redimensionnez ensuite les zones de texte
jusqu’a ce que leurs parties supérieures s’accrochent a la grille.
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Documents a enchainements multiples

Gérez des enchainements de texte distincts, chacun ayant ses propres connexions de zones de texte.
Créez des documents bilingues dans FrameMaker.

Un document peut comporter des enchainements de texte distincts, chacun ayant ses propres connex-
ions de zones de texte. Ainsi, un document bilingue peut contenir des traductions du méme texte cote a
cote.

Si une zone de texte remplit un document a enchainements multiples, vous pouvez indiquer a
FrameMaker de ne pas ajouter de nouvelle page. Vous pouvez ainsi ajouter des pages vous-méme et
contréler les connexions. La numérotation automatique de chaque enchainement étant indépendante
de celle des autres enchainements, vous pouvez conserver séparément des titres d’illustration, des inti-
tulés et des listes numérotées pour chague enchainement.

Définition d’un document a enchainements multiples

Découvrez les enchainements de texte et les étiquettes d'enchainements, définissez un enchainement
cOte a coOte, définissez les enchainements d'un bulletin ou d'un magazine dans FrameMaker.

A propos des enchainements de texte et de leurs étiquettes

Un enchainement de texte comporte une série de zones de texte connectées au travers desquelles
s’enchaine le texte d’'un document. La plupart des documents possédent un enchainement unique, de la
premiere page a la derniere, dans lequel FrameMaker gére automatiquement les connexions de zones
de texte. Vous ne créez ces connexions vous-méme que pour les documents dans lesquels vous liez
plusieurs enchainements (comme un bulletin dont I'article de premiére page continue sur la derniére
page, en ignorant les autres articles des pages intermédiaires).

L’étiquette d’enchainement de la zone de texte courante s’affiche dans la zone d’étiquette de la barre
d’état.

Flow: & 9): Body

Figure 1: Zone d’étiquette de la barre d’état

Définition d’un enchainement cote a cote

Un document a enchainements de texte cOte a cOte est défini en placant et en connectant les zones de
texte sur les maquettes. Les connexions de zone de texte étant les mémes dans tout le document, il n’est
généralement pas requis d’apporter d’autres modifications aux pages courantes.

1) Définissez les enchainements sur I'une des maquettes. Utilisez une zone de texte pour chaque
enchainement et attribuez une étiquette d’enchainement différente a chaque zone de texte.
Assurez-vous que le parametre Autoconnecter est activé pour chaque enchainement afin que
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FrameMaker ajoute une nouvelle page courante lorsque le texte atteint la fin de I'un des enchaine-
ments

Fenning HIF § Fainkeg HAF A

Figure 2: Maquettes gauche et droite pour un enchainement cote a cote

2) Répétez I'étape précédente pour les maquettes restantes. Toutes les maquettes doivent porter les
mémes étiquettes d’enchainement, sinon, FrameMaker ne peut pas alterner correctement les
maquettes gauche et droite lors de I'ajout de pages courantes.

IMPORTANT : pour créer correctement une page courante lorsque le texte atteint le bas d’une zone
de texte, la maquette gauche ou droite appropriée doit contenir toutes les étiquettes d’enchaine-
ment de la page courante active. S'il manque une étiquette d’enchainement, FrameMaker crée la
nouvelle page avec la maquette de la page courante active.

3) Mettez a jour les pages courantes avec les modifications de la maquette en affichant les pages
courantes.

RELATED LINKS:
Ajout d’un modéle de zone de texte sur une maquette

Modification d’une étiquette d’enchainement ou du paramétre Autoconnecter

Définition des enchainements d’un bulletin ou d’un magazine

Un bulletin ou un magazine requérant des enchainements multiples non paralléles est défini en établis-
sant I'aspect des colonnes sur les maquettes. Cependant, les maquettes n’agissent que comme la grille
de mise en page élémentaire. Redimensionnez, supprimez, connectez et déconnectez les zones de texte
sur les pages courantes jusqu’a ce que vous obteniez un aspect satisfaisant. Cette approche offre une
plus grande souplesse lors du choix du mode d’enchainement du texte dans le document.

REMARQUE : si vous créez un bulletin comportant des articles se suivant de la premiéere a la derniére page,
il n’est pas nécessaire d’utiliser les techniques décrites dans ce chapitre. Vous pouvez en effet utiliser un
seul et unique enchainement de texte. Vous avez la possibilité de créer des effets spéciaux en habillant
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les graphiques de texte et en fusionnant des paragraphes, tableaux et colonnes. Le modeéle de bulletin
fourni avec FrameMaker représente un exemple de cette technique.

1)  Choisissez le nombre de colonnes et placez ce nombre de zones de texte a une colonne sur chaque
maquette. Toutes les zones de texte doivent appartenir au méme enchainement. Utilisez ces zones
de texte comme une grille de mise en page qui contiendra I’enchainement de texte.

A A A
[T
Figure 3: Maquette de premiere page
A A A A A A
— S

Figure 4: Maquettes gauche et droite avec le méme enchainement

2) Désactivez le parametre Autoconnecter afin que FrameMaker n’ajoute pas automatiquement des
pages.

3) Mettez a jour les pages courantes avec les modifications de la maquette en affichant les pages
courantes.
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4)  Sur chaque page courante, redimensionnez, déconnectez et connectez les zones de texte suivant
vos besoins. Ne mettez pas a jour les maquettes lorsque vous modifiez les pages courantes.

5)  Poursynchroniser les lignes de base dans le bulletin, veillez a placer les zones de texte de maniére
appropriée. Si le document contient plusieurs enchainements de texte, synchronisez les lignes de
base pour chaque enchainement.

6) Sinécessaire, créez manuellement de nouvelles pages courantes non connectées.
7)  Connectez les zones de texte entre les pages selon vos besoins.

RELATED LINKS:
Ajout d’un modéle de zone de texte sur une maquette

Controle de I’enchainement du texte

Modifiez une étiquette d’enchainement ou le parametre Autoconnecter, modifiez des pages non
connectées ou des zones de texte dans FrameMaker.

Les caractéristiques de base d’un enchainement comprennent son étiquette d’enchainement et son
parametre Autoconnecter. Dans un document contenant un enchainement ou plusieurs enchainements
paralleles, le parametre Autoconnecter est généralement actif pour indiquer a FrameMaker d’ajouter
une nouvelle page si les zones de texte de I’'enchainement sont pleines. La nouvelle page adopte I'aspect
des colonnes de la maquette appropriée (gauche ou droite) et ses zones de texte sont automatiquement
connectées aux zones de texte des pages d’origine.

Lors d’un travail sur un document ayant plusieurs enchainements non paralléles, le parameétre Autocon-
necter est généralement désactivé. Cela vous permet d’ajouter une nouvelle page courante non
connectée selon votre choix et de contrdler les connexions entre celle-ci et les pages existantes. Si ce
parametre est désactivé et que I’'enchainement contient plus de texte que ne peuvent contenir ses zones
de texte, le texte déborde a la fin de la derniére zone de texte de I'’enchainement. La bordure inférieure
d’une zone de texte débordante s’affiche sous la forme d’une ligne continue si les bordures sont visibles.
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Figure 5: Débordement de zone de texte
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Si vous essayez de saisir du texte dans une zone de texte débordante, I'ordinateur émet un bip sonore.
Le débordement de texte n’est pas supprimé ; il est uniquement masqué. Des que vous connectez la zone
de texte débordante a une autre zone de texte, le texte masqué réapparait dans la zone suivante.

Si vous devez attribuer une étiquette (par exemple, lors de la création d’enchainements de texte cote a
cote), vous pouvez le faire a tout moment. Dans un nouveau document vierge, I'enchainement principal
porte I'étiquette A. Il suffit d’attribuer une étiquette a un enchainement une seule fois. La connexion
d’une zone de texte a I'’enchainement attribue ensuite I'étiquette a la zone de texte. Si vous modifiez
I’étiquette ou le parametre Autoconnecter dans une zone de texte d’'un enchainement, la modification
est apportée a tout I'enchainement.

Modification d’une étiquette d’enchainement ou du paramétre Autoconnecter

Les étiquettes d’enchainement et le paramétre Autoconnecter sont généralement modifiés sur les
magquettes. Si deux zones sont connectées, vous devez les déconnecter avant de pouvoir modifier I'une
des étiquettes d’enchainement.

1) Cliguez dans une zone de texte de I’enchainement.
2)  Sélectionnez Format > Personnaliser la mise en page > Personnaliser la zone de texte.

3)  Entrez une étiquette pour I’'enchainement dans la zone de texte Etiquette. Essayez de donner des
noms d’étiquettes d’enchainement aussi courts que possible afin de ne pas obstruer les autres
informations dans la zone d’étiquette de la barre d’état. Vous ne pouvez pas attribuer une
étiquette déja utilisée sur la page actuelle.

REMARQUE : pour que deux zones de texte sur une page portent la méme étiquette d’enchainement,
connectez les zones de texte.

4)  Pour que FrameMaker ajoute une nouvelle page lorsque la derniére colonne d’une page est pleine,
sélectionnez Autoconnecter.

5)  Cliquez sur Définir.
RELATED LINKS:
Connexion de zones de texte

Déconnexion de zones de texte

Ajout d’une nouvelle page non connectée

En général, dans un document comportant un enchainement principal ou deux enchainements
paralléles, il n’est pas nécessaire d’ajouter des pages courantes non connectées ; FrameMaker ajoute
automatiquement des pages connectées si besoin est. Dans un document a enchainements multiples
dans lequel le paramétre Auto-connecter est désactivé ou dans d’autres documents spécialisés, vous
pouvez ajouter de nouvelles pages courantes non connectées. Lorsque le texte atteint la fin d’une zone
de texte, ajoutez une nouvelle page et connectez les zones de texte.

1) Depuis une page courante, choisissez Insérer > Ajouter des pages non connectées.
2) Choisissez I’'emplacement et le nombre de pages a ajouter.
3) Choisissez une maquette dans la liste déroulante Utiliser la maquette et cliquez sur Ajouter.
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Suppression de pages non connectées

Lors de la suppression de pages non connectées dans un document a enchainements multiples,
FrameMaker supprime également leur contenu.

1)  Cliguez sur une page a supprimer et choisissez Formater > le document > Supprimer des pages.

2) Spécifiez les premiére et derniere pages non connectées a supprimer et cliquez sur Supprimer.
Pour ne supprimer qu’une seule page, entrez son numéro dans les deux zones de texte.

Connexion de zones de texte

Lorsque deux zones de texte sont connectées, le texte passe de la fin de la premiére zone de texte au
début de la seconde. Vous pouvez connecter une zone de texte d’'une maquette a toute autre zone de
texte de la méme maquette et vous pouvez connecter une zone de texte d’'une page courante a une autre
zone de texte d’une autre page courante. Vous pouvez également connecter une zone de texte au milieu
d’un enchainement.

Lorsque vous connectez deux zones de texte, FrameMaker attribue I'étiquette d’enchainement de Ia
premiére zone de texte a la deuxiéme. Si la premiére zone de texte ne porte pas d’étiquette, I'étiquette
de la deuxiéme zone est utilisée. Ainsi, toutes les zones de texte connectées appartiennent au méme
enchainement et possédent la méme étiquette. Si le texte de la premiére zone de texte déborde de
celle-ci, il passe a la deuxieme zone lorsque vous créez la connexion.

1) Sélectionnez les deux zones de texte dans I'ordre d’enchalnement souhaité. Pour ce faire, cliquez
sur chaque zone de texte tout en maintenant la touche Ctrl enfoncée.

Si les zones de texte se trouvent sur des pages différentes, la premiére zone est désélectionnée lor-
sque vous sélectionnez la seconde, mais FrameMaker assure le suivi de la premiére sélection.

REMARQUE : pour ajouter une zone de texte au milieu d’'un enchainement, sélectionnez la zone de
texte a ajouter, puis celle devant la suivre.

2)  Sélectionnez Format > Personnaliser la mise en page > Connecter des zones de texte. Si la
premiére zone de texte sélectionnée ne se trouve pas sur une page actuellement visible, un
message d’alerte vous invite a connecter cette zone.

Déconnexion de zones de texte

Pour créer des enchainements distincts (par exemple, pour placer un article a un emplacement
spécifique d’un bulletin ou pour créer une citation mise en évidence), vous pouvez déconnecter des
zones de texte. Si vous devez commencer un nouvel enchainement au milieu d’'une colonne, vous pouvez
diviser en deux la zone de texte contenant la colonne, puis déconnecter les deux zones de texte.

Vous pouvez déconnecter une zone de texte de la zone de texte précédente, de la suivante ou des deux.
Vous pouvez également supprimer une zone de texte au milieu d’'un enchainement.

La déconnexion n’affecte pas le texte existant dans les zones. Pour déplacer le texte vers une zone de
texte différente, coupez-le et collez-le apres la déconnexion des zones.

REMARQUE : lorsque vous déconnectez des zones de texte appartenant a la méme page courante,
FrameMaker crée des enchainements distincts sans étiquette. Si vous déconnectez des zones de texte
de pages courantes différentes, FrameMaker crée des enchainements distincts ayant la méme étiquette
d’enchainement. Dans les deux cas, si vous créez un document de style bulletin avec le parameétre Auto-
connecter désactivé pour chaque enchainement, les étiquettes d’enchainement ne sont pas prises en
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compte. FrameMaker ne crée pas automatiquement de nouvelles pages et, par conséquent, il n’est pas
nécessaire d’effectuer les connexions de la zone de texte.

1) Cliguez sur la zone de texte a déconnecter tout en maintenant la touche Ctrl enfoncée.

2)  Sélectionnez Format > Personnalisation de la mise en page, puis sélectionnez Déconnecter de la
zone précédente, Déconnecter de la zone suivante ou Déconnecter les deux.

Suppression d’une zone de texte au milieu d’'un enchainement

1) Sélectionnez la zone de texte précédant immédiatement celle a supprimer. Pour ce faire, cliquez
sur la zone de texte tout en maintenant la touche Ctrl enfoncée.

2) Sélectionnez la zone de texte suivant immédiatement celle a supprimer.

3)  Sélectionnez Format > Personnaliser la mise en page > Connecter des zones de texte. Si la
premiére zone de texte sélectionnée ne se trouve pas sur une page actuellement visible, un
message d’alerte vous invite a connecter cette zone.

Division ou annulation de la division de zones de texte

Vous pouvez diviser une zone de texte en deux, puis déconnecter les deux zones pour commencer un
nouvel enchainement. Vous pouvez souhaiter, par exemple, qu’un nouvel article avec son propre
enchalnement démarre au milieu d’une zone de texte.
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Figure 6: La deuxieme de trois zones de texte est divisée, déconnectée de la premiére et réétiquetée.

Division de zones de texte

1) Cliquez sur la ligne située au-dessus de I'endroit auquel vous voulez diviser la zone de texte et
choisissez Format > Personnaliser la mise en page > Diviser la zone de texte. FrameMaker divise
la zone de texte sous la ligne contenant le point d’insertion, créant deux zones de texte distinctes
mais connectées.

2)  Cliguez sur la zone de texte inférieure tout en maintenant la touche Ctrl enfoncée.
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3)

4)

Déconnectez la zone de texte de la précédente en choisissant Format > Personnaliser la mise en
page > Déconnecter de la zone précédente. Si 'enchainement portait une étiquette, FrameMaker
la supprime. Si le parameétre Autoconnecter était actif avant la déconnexion des zones de texte, il
est maintenant désactivé pour les deux zones.

Si besoin est, redimensionnez les zones de texte.

Annulation de la division de zones de texte

Sivous n'avez effectué aucune modification depuis la division de la zone de texte, choisissez Edition
> Annuler.

Sivous avez apporté des modifications mais n’avez pas encore déconnecté les deux zones de texte,
supprimez la zone inférieure et redimensionnez la zone de texte restante a la taille de la zone
d’origine non divisée.

Si vous avez déja déconnecté les deux zones, coupez le texte de la deuxiéme zone de texte et
collez-le alafin de la premiére. Supprimez ensuite la deuxieme zone et redimensionnez la premiere
a la taille de la zone d’origine non divisée. Si vous devez réactiver le parametre Autoconnecter ou
réattribuer une étiquette pour I’enchainement de texte, utilisez la commande Format > Personnal-
isation de la mise en page > Personnalisation de la zone de texte.

Etablissement d’une référence croisée vers une zone de texte déconnectée

Si un article d’un bulletin ou d’un magazine se termine sur une page et continue sur une autre, vous
pouvez utiliser une référence croisée pour indiquer au lecteur ou continuer sa lecture.
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Figure 7:  Indiquez ou I'enchainement doit continuer et d’ou il provient.

1)

2)

Redimensionnez les deux zones de texte afin qu’il y ait suffisamment de place pour les références
croisées. Faites glisser le bas de la premiéere zone vers le haut et le haut de la zone de texte suivante
vers le bas.

Dessinez une petite zone de texte en dessous de celle de la premiére page et une autre au-dessus
de celle la page suivante. Ne connectez aucune de ces zones de texte a une autre.
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3) Insérez une référence croisée dans la zone de texte vide de la premiére page, en établissant une
référence a la page de suite.

4) Insérez une référence croisée dans la zone de texte vide de la page de suite, en établissant une
référence a la premiére page.

Suivi d’un enchainement de texte

Dans un document a plusieurs enchainements, il est facile de perdre le fil des enchainements. Vous
pouvez effectuer un zoom arriere pour afficher plus de texte ou vous déplacer d’une zone de texte d’un
enchainement a la suivante.

1) Effectuez un zoom arriere a 25 % et définissez la taille de la fenétre afin d’afficher autant de pages
gue nécessaire.

2) Cliguez dans I’'enchainement a contréler et choisissez Modifier > Tout sélectionner dans
I'enchainement. L’enchainement est mis en surbrillance et indique son flux dans les pages du docu-
ment.

3)  Pour naviguer dans les zones de texte d’un enchainement procédez de I'une des fagons suivantes :

- Pour afficher la zone de texte connectée suivante, cliquez sur la derniére ligne d’'une zone de
texte et appuyez sur la touche fleche bas.

- Pour afficher la zone de texte connectée précédente, cliquez sur la premiére ligne d’'une zone
de texte et appuyez sur la touche fléche haut.

Définir la direction d’enchainement

Spécifiez la direction du texte dans une zone de texte (de gauche a droite ou de droite a gauche) dans
FrameMaker.

Vous pouvez spécifier la direction (LTR ou RTL) du texte dans une zone de texte. Cela signifie que vous
pouvez créer un document dans lequel la direction d’enchainement peut étre différente. Par exemple,
vous pouvez créer un document avec deux enchainements ol une langue lue de gauche a droite (telle
gue I'anglais ou I'allemand) est écrite dans I’enchainement de gauche et une langue lue de droite a
gauche (telle que I'arabe, I'hébreu ou le farsi) est écrite dans le cadre de droite.

1)  Sélectionnez la zone de texte.
2) Dans le menu Graphiques, sélectionnez Caractéristiques de I'objet.

3) Dansl'onglet Zone de texte, sélectionnez la direction souhaitée dans la liste déroulante Direction
et cliquez sur Appliquer.
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Modeles

Découvrez les modeéles ainsi que les modeéles structurés et non structurés dans FrameMaker.

Pour créer un modele, vous devez mettre en page les maquettes, définir et appliquer les formats et
définir le texte spécial tel que les variables et les formats de références croisées.

CoNsEIL : Définissez un dossier de modeéles qui contiendra tous les modeéles associés ainsi qu’un docu-
ment décrivant leur contenu et leur mode d’emploi.

Modeéles non structurés

Un modéle est un document qui stocke des caractéristiques utilisées a plusieurs endroits. Vous
pouvez soit créer un document a partir d’'un modele pour lui donner toutes les caractéristiques du
modele, soit y importer ultérieurement des caractéristiques spécifiques du modele. Les modeéles
permettent de donner a vos documents une mise en page et un formatage uniformes.

Les modeles peuvent contenir les caractéristiques suivantes :

Formats de paragraphes, de caractéres et de tableaux associés aux informations de formatage des
définitions d’éléments

Mises en page déterminant le nombre de colonnes et leur position et éléments d’arriére-plan tels
que les en-tétes courants

Pages de référence contenant les graphiques et les informations de formatage utilisés a plusieurs
reprises

Variables servant de marques de réservation pour le texte mis a jour par FrameMaker
Informations de formatage des références croisées, des équations et des balises conditionnelles
Définition des couleurs applicables au texte et aux objets

Parameétres appliqués a I'ensemble du document, a savoir les caractéristiques des notes de bas de
page, les types de marqueurs personnalisés et les options de justification verticale pour les inter-
lignes

Spécifications des polices combinées japonais/polices occidentales (sur les systéemes de langue
japonaise)

Modeéles structurés

Dans FrameMaker structuré, des modeles structurés sont fournis pour les lettres, les mémos, les
fax, les enveloppes, les rapports, les formats, les bulletins, les livres, les FAQ et les livres source
unique.

Les modeles structurés peuvent contenir les caractéristiques suivantes :

Définitions d’éléments indiquant les régles de contenu, d’attributs et de formatage qui leur sont
applicables

Paragraphes et caracteres associés aux informations de formatage des définitions d’éléments
Variables servant de marques de réservation pour le texte mis a jour par FrameMaker
Informations de formatage des références croisées et des balises conditionnelles

Définition des couleurs applicables au texte et aux objets
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REMARQUE : si vous travaillez sur des fichiers structurés, un développeur d’application peut avoir
configuré des documents spéciaux gérant les conversions a partir de I'application structurée et vers
celle-ci. Ces documents peuvent inclure un modeéle qui formate les fichiers structurés dans FrameMaker
et qui est automatiguement appliqué lorsque vous importez un document a partir de I'application struc-
turée.

Conception de la mise en page

Concevez la mise en page, des formats de texte, standardiser les formats, configurer la numérotation,
définir le texte spécial dans FrameMaker.

1)

2)

3)
4)

5)

Créer un document. Vous pouvez commencer par un nouveau document personnalisé ou par une
copie d’un document existant que vous envisagez de modifier.

CoNsEIL : En créant la mise en page, vous pouvez visualiser la présentation de pages en regard en
les affichant cOte a cbte. Choisissez Affichage > Options, puis sélectionnez Pages en regard dans la
liste déroulante Défilement. Agrandissez la fenétre et effectuez un léger zoom arriére, le cas
échéant, pour que les deux pages puissent s’afficher dans la fenétre.

Définissez I'aspect des colonnes. Si vous avez commencé avec un document personnalisé, vous
avez déja spécifié le nombre de colonnes et les marges de colonnes. Si vous modifiez un document
existant, vous serez peut-étre amené a modifier 'aspect des colonnes.

Ajoutez toutes les maquettes personnalisées dont vous aurez besoin et donnez-leur un nom.

Placez le texte et les graphiques (y compris les en-tétes et les pieds de pages) en arriére-plan sur
les maquettes.

Si un en-téte ou un pied de page indique le texte ou la numérotation automatique d’un paragraphe
de document tel qu’un titre de chapitre ou de section, il contient une variable E/P courante se rap-
portant au paragraphe. Pour la configurer, déterminez le style du paragraphe concerné.

Définissez les caractéristiques personnalisées du document, telles que la numérotation et les
options de texte, et spécifiez les options d’affichage.

Conception de styles de texte

Apres avoir concu la mise en page, vous devez définir le formatage du texte :

Si votre document doit étre ouvert ou imprimé sur des ordinateurs autres que le votre, utilisez des
polices d’utilisation courante.

Les styles de paragraphes servant de base au formatage de texte, vous devez les configurer avant
les styles de caracteres.

Lors de la création d’un style de caractéres, attribuez la valeur Tel que a tous les paramétres de la
fenétre Configuration de caracteres, puis ne spécifiez que les parametres que vous souhaitez modi-
fier. Ainsi, ce style fonctionnera avec n‘importe quel style de paragraphe.

Utilisez des étiquettes définissant le role du texte plutdt que son aspect. Par exemple, donnez un
nom tel que Relief a un format servant a mettre le texte en relief, plutét que le nom de son style
(Gras, par exemple). Si vous décidez ensuite de mettre le texte en relief en I'affichant en italique,
vous pourrez redéfinir le format Relief sans devoir modifier I'étiquette du texte.
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. Utilisez des noms faciles a reconnaitre. Par exemple, pour des styles de listes numérotées, utilisez
Etapel et EtapeSuiv plutbét que Et1 et EtS. Si vous souhaitez utiliser le clavier pour appliquer des
styles de paragraphes et de caractéres, pensez a nommer vos étiquettes Et1 Etapel et EtS EtapSuiv.
De cette facon, vous pouvez accéder rapidement aux étiquettes et a leur description a partir du
clavier.

. Si le modeéle utilise plusieurs jeux de numérotation automatique, ajoutez un libellé au format de
chacun d’entre eux. Par exemple, définissez les numéros automatiques avecS:<n+>, ou S: est le
libellé.

J Dans les styles de paragraphes, utilisez Espace Dessus ou Espace Dessous pour ajouter de maniére
homogene un espace au-dessus ou au-dessous d’un paragraphe. FrameMaker utilise uniguement
la plus élevée des deux valeurs pour déterminer I'espace entre les paragraphes.

Normalisation des graphiques, cadres et tableaux

Si les documents doivent contenir des graphiques, des cadres ou des tableaux, appliquez les recomman-
dations suivantes pour homogénéiser ces documents :

. Placez les éléments standard sur une page de référence. Vous pouvez inclure des graphiques dont
les utilisateurs auront souvent besoin (tels qu’un symbole pour attirer I’attention sur les remarques
et les avertissements ou un cadre ancré possédant une hauteur et une largeur standard). Les utili-
sateurs pourront copier et coller ces éléments selon leurs besoins.

. Créez un style de paragraphes pour les cadres ancrés pour qu'’il y ait suffisamment d’espace autour
des graphiques. Par exemple, un style de paragraphe nommé Cadre peut contenir un parametre
Espace Dessous de 20 points et un Interligne de zéro. Chaque cadre peut ensuite étre ancré a un
paragraphe vierge a I'aide du style Cadre. Vous pouvez également utiliser des tableaux a cellule
unique et leur titre pour placer des graphiques et leur légende.

. Si vous envisagez d’utiliser des zones de texte pour les légendes de graphique, créez un style de
paragraphes a cet effet. Si vous prévoyez d’utiliser des lignes de texte, créez un style de caracteres
(vous ne pouvez pas appliquer un style de paragraphes a une ligne de texte).

o Choisissez un modele de couleurs et redéfinissez les couleurs si cela s’avere nécessaire.

J Préparez des formats de tableaux standard. Seules certaines des caractéristiques définies pour les
tableaux peuvent étre importées dans un autre document. La largeur du texte dans les tableaux
réels variant considérablement, il en va de méme pour les autres caractéristiques. Ainsi, les utilisa-
teurs devront probablement rectifier ces caractéristiques eux-mémes, quelle que soit la facon dont
vous préparez les tableaux. Concevez vos tableaux comme des modeles de départ pour les utilisa-
teurs.

Définition de la numérotation

La numérotation des pages des nouveaux documents est définie sur Recommencer a 1.

Si vous créez un modele pour la numérotation continue des pages d’un livre, vous voudrez peut-étre
définir la numérotation des pages dans le modéle sur Continuer la numérotation a partir de la page
précédente du livre. Par ailleurs, il peut également étre nécessaire de définir la numérotation des
chapitres sur Continuer la numérotation a partir du fichier précédent du livre.
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Définition de texte spécial et de polices

Voici quelques conseils pour la définition des éléments du texte spécial :
. Sélectionnez un style et un format de numérotation, ainsi que d’autres caractéristiques de notes.

. Définissez les formats des références croisées. Normalisez autant que possible leur format. Par
exemple, si des références croisées doivent toujours étre introduites par le mot Voir, intégrez ce
mot dans la définition du format.

. Pensez a définir des variables utilisateur pour les noms de produits, les noms de documents et
autres éléments susceptibles d’étre modifiés au cours du projet.

] Définissez les étiquettes de condition, les indicateurs de condition et les paramétres de visualisa-
tion des balises conditionnelles.

J Définissez des types de marqueurs personnalisés si vous devez créer des index spécialisés.
. Définissez les dimensions et les polices des équations pour des documents qui en comporteront.

. Sivos documents doivent comporter du texte en langue japonaise, définissez les polices combinées
a utiliser ainsi que les caractéristiques du texte Rubi.

Définition des options HTML

Si des documents basés sur vos modeles doivent étre convertis au format HTML, il vous faut définir des
macros de mise en correspondance et de conversion qui définissent la méthode de conversion des docu-
ments.

] Définissez la correspondance entre des styles de paragraphes et de caractéeres FrameMaker vers
des balises HTML.

o Créez les macros de conversion devant convertir les formats de références croisées en un format
adapté aux documents électroniques.

. Créez les autres macros de conversion nécessaires (par exemple, pour placer un logo en haut de
chaque nouvelle page Web ou pour définir le titre du document HTML).

Création de modeles pour les fichiers générés

Créez des modeles pour les fichiers générés, mettez a jour les formats dans un fichier généré, importez
des formats, utilisez le formatage d’un fichier existant lors de la génération d'un nouveau fichier dans
FrameMaker.

Lorsque vous générez une table des matieres, un index ou toute sorte de fichier généré, si le dossier
contenant le document source ou le fichier livre comporte un fichier dont le nom correspond a celui du
fichier généré, FrameMaker utilise le formatage du fichier existant lors de la génération du nouveau
fichier. Le fichier existant sert de modele pour le nouveau fichier généré, comme si vous aviez importé
certains de ses formats. Utilisez cette fonction pour créer des modeles de fichier généré comportant des
mises en page, des styles de paragraphes et caractéres et les informations de formatage s’affichant sur
la page de référence.
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Vous pouvez également mettre a jour les formats dans un fichier généré en important des formats depuis
un modele. Cependant, vous devrez probablement a nouveau générer le fichier aprés I'importation des
formats pour visualiser tout le formatage.

1)  Ouvrezle document ou le fichier livre a partir duquel vous souhaitez générer la table des matieres,
I'index ou tout autre fichier.

2)  Générez le fichier.
3) Formatez le fichier généré. Ce fichier formaté devient votre modele.

4)  Enregistrez le fichier généré. Assurez-vous que ce modele se trouve dans le dossier contenant le
document ou le fichier livre que vous utiliserez pour créer un fichier généré.

RELATED LINKS:
Importation de formats a partir d’un modéle ou d’un document

Création de modeéles pour la modification de parameétres de balises conditionnelles

Découvrez comment créer des modeles pour modifier les paramétres des balises conditionnelles dans
FrameMaker.

Si vous modifiez souvent la vue de documents conditionnels dans un livre, vous trouverez sans doute
utile d’avoir un modele pour chaque vue. Vous pourrez ainsi modifier la vue de tous les fichiers du livre
simultanément en important les parameétres de balises conditionnelles de I'un des modeles dans le
fichier livre.

Si vous souhaitez modifier la vue d’un seul document contenant des balises conditionnelles, il est plus
pratique de modifier les parametres Afficher/Masquer du document.

1)  Définissez un modéle de base pour le document conditionnel en affichant toutes les conditions et
leurs indicateurs. Vous importerez les paramétres des balises conditionnelles depuis ce modeéle
avant de modifier un document.

2) Définissez un modele pour chaque combinaison de conditions que vous souhaitez visualiser.
Utilisez ces modeéles pour visualiser ou imprimer une version du document a la fois. Vous pouvez
également utiliser le modéle pour modifier les définitions de variables exclusives a une vue.

Modification des modeles pour documents types et fichiers texte

Modifiez des modeles pour documents types et fichiers texte, mettez a jour la mise en page dans
FrameMaker.

Vous pouvez modifier le modeéle personnalisé du document type afin qu’il contienne les formats de votre
choix. Le modéle peut contenir les mémes formats comme tout autre modeéle, a I'exception de la mise

en page. La mise en page de la maquette, le nombre de colonnes et les marges sont spécifiés lors de la

création des documents types.

Vous pouvez également modifier le modele personnalisé utilisé par FrameMaker lorsque vous ouvrez des
fichiers texte.

REMARQUE : vous pouvez modifier le nom de fichier a rechercher lors de la création d’un document type
ou de I'ouverture d’un fichier texte.
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Modification du modéle de documents types

1)

2)

3)

Modifiez un document afin qu’il contienne les formats et parameétres souhaités. Laissez les
maquettes vides et ne créez pas de maquettes personnalisées.

Supprimez toutes les zones de texte des maquettes gauche et droite (méme si un document est
défini au format recto uniquement). Si le document est uniquement recto, choisissez Format >
Mise en page > Pagination, sélectionnez Recto-verso, puis cliquez sur Définir. Sélectionnez ensuite
les zones de texte sur la maquette et supprimez-les.

Sélectionnez Format > Document > Supprimer des pages et supprimer toutes les pages de corps.

Enregistrez le document a I'aide du fichier personnalisé se trouvant dans le dossier fminit de
FrameMaker. (Lorsque vous choisissez Nouveau > Document Adobe FrameMaker dans le menu
contextuel d’un dossier ou sur le bureau, fichier Shellnew.fm est utilisé.)

Modification du modele de fichiers texte

1)

2)
3)

4)

Modifiez un document afin qu’il contienne les formats et paramétres souhaités. Par exemple, vous
pouvez placer des en-tétes et pieds de pages, un Catalogue de paragraphes et des graphiques de
magquette dans le document modéle.

Supprimez tout le texte sur les pages courantes.

Cliquez dans la zone de texte vide de la page 1 et attribuez-lui I'étiquette du style de paragraphe a
utiliser pour tout le texte du document. Le modele par défaut utilise le style de paragraphe
« Body ».

Enregistrez le document a l'aide du fichier txttmplt se trouvant dans le dossier fminit de
FrameMaker.

Importation de formats a partir d’'un modeéle ou d’un document

Découvrez comment importer des formats a partir d’'un modeéle ou d’'un document et les parametres
d’importation et de mise a jour dans FrameMaker.

Vous pouvez importer des styles de paragraphes, des styles de tableaux, des définitions de variables ainsi
gue d’autres caractéristiques d’un autre document.

Vous pouvez également conserver ou supprimer tout format personnalisé du document (par exemple,
les modifications apportées au paragraphe mais non enregistrées dans le Catalogue de paragraphes.

Importation de styles

1)
2)

3)
4)

Ouvrez le document contenant les formats que vous souhaitez importer.

Activez la fenétre de document ou de livre qui vous intéresse. Si la fenétre de livre est active, sélec-
tionnez les documents que vous voulez mettre a jour.

Dans le document ou le livre que vous mettez a jour, sélectionnez Fichier > Importer > Formats.
Procédez de I'une des facons suivantes :

- Pour importer des formats d’'un document, choisissez celui-ci dans la liste déroulante
Importer du document. Cette liste déroulante répertorie tous les documents enregistrés
ouverts.
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- Pour réappliquer des formats du document courant, choisissez En cours dans la liste dérou-
lante Importer du document.

5) Sélectionnez les parametres Importer et mettre a jour que vous souhaitez appliquer au document
actuel. Par défaut, toutes les options sont sélectionnées. Pour sélectionner ou désélectionner
toutes les options simultanément, cliquez sur Tout sélectionner ou Tout désélectionner. Si vous
mettez a jour des définitions de variables, des formats de références croisées ou des définitions
mathématiques, alors que certains de ces éléments utilisent des styles de caracteres, sélectionnez
Styles de caractéres afin qu’ils soient ajoutés au document.

6) Pour supprimer des modifications apportées a des formats individuels et non enregistrées dans un
catalogue, procédez comme suit :

- Pour supprimer les sauts de page n’appartenant pas a un format du Catalogue de para-
graphes, sélectionnez Sauts de page manuels.

- Pour supprimer les formats personnalisés de paragraphes, de caractéres, de mise en page et
de tableaux, sélectionnez Autres formats de page pers.

7)  Cliquez sur Importer.

RELATED LINKS:
A propos des mises en page personnalisées

A propos des parameétres d’importation et de mise a jour

Lors de I'importation des informations de formatage depuis un modeéle, FrameMaker fusionne les infor-
mations dans le document au lieu de les remplacer entierement. Par exemple, lorsque vous importez des
styles de paragraphes, FrameMaker les ajoute au Catalogue de paragraphes du document. Si des styles
portent le méme nom dans les deux documents, le style importé écrase le style d’origine. Tout style non
écrasé est conservé dans le document.

REMARQUE : Les différences de casse étant prises en compte dans FrameMaker, le nom Courant est
différent du nom courant.

Styles de paragraphes

Le Catalogue de paragraphes du modele est fusionné dans le document et tous les styles du cata-
logue sont appliqués de nouveau au document. Les parametres de signets PDF du modele sont
également copiés dans le document.

Styles de caractéres

Le Catalogue de caracteres du modéle est fusionné dans le document et tous les styles du catalogue
sont appliqués de nouveau au document.

Mises en page

Les maquettes du modéle sont fusionnées dans le document et les pages courantes sont mises a
jour avec les modifications de maquette. Si le modeéle et le document possedent une maquette
portant le méme nom, la maquette du modéle remplace celle du document. FrameMaker copie les
caractéristiques de la barre de modification, I'’ensemble des réglages des boites de dialogue Format
de page et Pagination, ainsi que la plupart des parameétres de la boite de dialogue Options d’affi-
chage.
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Formats de tableaux

Le Catalogue de tableaux et les styles de trait du modéle sont fusionnés dans le document et tous
les formats du catalogue sont appliqués de nouveau au document.

Définitions des couleurs
Les définitions de couleurs et les vues du modele sont fusionnées dans le document.

Caractéristiques de document

Les caractéristiques de types de marqueurs personnalisés et de notes, les styles de numérotation
de la boite de dialogue Caractéristiques de numérotation (volumes, pages, paragraphes, notes et
notes de table), les caractéres du parametre Autoriser rupture de lignes aprés de la boite de
dialogue Options de texte et le parameétre Justification verticale de la boite de dialogue Alignement
vertical des paragraphes du modéle sont fusionnés dans le document. Les paramétres de Configu-
ration PDF (autres que les parameétres de signets) sont également fusionnés dans le document. Sur
les systémes de langue japonaise, les caractéristiques de texte Rubi et les régles kumihan (regles de
composition en langue japonaise) fusionnent également dans le document.

Pages de référence

Toutes les pages de référence du modeéle (exceptées les pages de référence FrameMath) sont
fusionnées dans le document. Si le modeéle et le document possédent une page de référence
portant le méme nom, la page de référence du modele remplace celle du document. Pour importer
des pages de référence FrameMath, sélectionnez Définitions mathématiques.

Définitions de variables
Les définitions de variables du modeéle sont fusionnées dans le document.

Formats de références croisées

Les formats de références croisées du modeéle sont fusionnés dans le document et les références
croisées internes sont mises a jour.

Parameétres de balises conditionnelles

Les étiquettes de condition et les parameétres Afficher/Masquer du modele sont fusionnés dans le
document et appliqués aux balises conditionnelles.

Définitions mathématiques

Les parameétres de format et de police d’équation, les définitions des éléments mathématiques
personnalisés et les pages de référence FrameMath du modéle sont copiés dans le document. Si un
élément mathématique personnalisé du document est supprimé lors de la fusion des pages de
référence, FrameMaker remplace cet élément dans les équations par le nom de I'élément placé
entre les points d’interrogation.

Polices combinées

Sur les systémes en langue japonaise, les spécifications des polices japonaises et occidentales
combinées sont fusionnées dans le document et appliquées au texte utilisant les polices
combinées.
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IMPORTATION DE CARACTERISTIQUES DE FORMATAGE

Importation de caractéristiques de formatage

Découvrez I'importation de caractéristiques de formatage dans Adobe FrameMaker.

Dans ce sujet

. Introduction

. Paramétres de formatage

J Importation de caractéristiques a partir d'un modele

Introduction

Vous pouvez importer un grand nombre d’informations de formatage, notamment les mises en pages,
les formats de paragraphe et de tableau, la définition des variables et des couleurs, les propriétés d’objet
comme un style et les parametres de balises conditionnelles. Si des expressions conditionnelles sont
créées dans votre document source, elles sont, de méme que leur état Afficher par expression,
importées dans les documents cibles. De la méme maniére, dans les documents structurés, tous les
parameétres Filtrer par attribut que vous avez définis sont également importés.

1)  Ouvrez le modéle contenant les formats. Le modele doit étre nommeé et enregistré.

2)  Ouvrezle document ou le livre que vous souhaitez mettre a jour. Si la fenétre de livre est active,
sélectionnez les documents que vous voulez mettre a jour.

3) Dans le document ou le livre que vous mettez a jour, sélectionnez Fichier > Importer > Formats.

4)  Choisissez le modele approprié dans la liste déroulante Importer du document. Ce menu répertorie
I’ensemble des documents nommés et ouverts.
Vous pouvez également choisir le document en cours afin d’appliquer de nouveau les formats que
le document posséde déja. Cette fonctionnalité permet notamment de supprimer les modifications
de formatage, comme décrit a I'étape 6.

5) Sélectionnez les paramétres Importer et mettre a jour que vous souhaitez appliquer au document
actuel.

- Si vous mettez a jour des formats de références croisées, des définitions mathématiques ou
des définitions de variables et que certains de ces éléments utilisent des styles de caracteres,
sélectionnez également Styles de caractéres afin que tous les nouveaux styles soient ajoutés
au document.

- Si les mises en correspondance HTML ont été modifiées, sélectionnez Pages de référence.

6) Sivoussouhaitez supprimer des modifications de formatages qui ne sont pas enregistrées dans des
styles de catalogue, procédez comme suit :

- Pour supprimer les sauts de page qui ne font pas partie d’un style de paragraphe, sélectionnez
Sauts de page manuels.

- Pour supprimer les formats personnalisés de paragraphes, de caractéres, de mises en page et
de tableaux, sélectionnez Autres formats/mises en page pers..

IMPORTANT : Dans la plupart des cas, ne sélectionnez pas Autres formats/mises en page pers. dans
un document structuré, car les définitions des éléments utilisent parfois des formats personnalisés.

7)  Cliquez sur Importer.
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IMPORTATION DE CARACTERISTIQUES DE FORMATAGE

Parametres de formatage

Lorsque vous importez des styles, FrameMaker fusionne les nouvelles informations de formatage dans
le document.

Par exemple, si vous importez des styles de tableaux, les styles sont ajoutés au Catalogue de tableaux. Si
un style se trouvant déja dans le catalogue a le méme nom qu'un style importé, le style importé remplace
le style d'origine. Tous les styles qui ne sont pas écrasés restent dans le catalogue.

Styles de paragraphes

Le Catalogue de paragraphes du modéle est fusionné dans le document et tous les styles du cata-
logue sont appliqués de nouveau au document.

Styles de caractéres

Le Catalogue de caractéres du modele est fusionné dans le document et tous les styles du catalogue
sont appliqués de nouveau au document.

Mises en page
Les maquettes du modeéle sont fusionnées dans le document et les pages courantes sont mises a
jour avec les modifications de maquette. Si le modéle et le document contiennent une maquette
de méme nom, la maquette du modele remplace celle du document. FrameMaker copie les
caractéristiques de la barre de modification, I'ensemble des réglages des boites de dialogue Format
de la page et Pagination, ainsi que la plupart des parametres de la boite de dialogue Options d’affi-
chage.

Formats de tableaux

Le Catalogue de tableaux et les styles de trait du modele sont fusionnés dans le document et tous
les formats du catalogue sont appliqués de nouveau au document.

Définitions des couleurs

Les définitions de couleurs et les vues du modele sont fusionnées dans le document.

Caractéristiques de document

Les caractéristiques de types de marqueurs personnalisés et de notes, les styles de numérotation
de la boite de dialogue Caractéristiques de numérotation (volumes, pages, paragraphes, notes et
notes de table), les caractéres du parametre Autoriser rupture de lignes apres de la boite de
dialogue Options de texte et le parametre Justification verticale de la boite de dialogue Alignement
vertical des paragraphes du modéle sont fusionnés dans le document. Les parameétres de Configu-
ration PDF (autres que les parametres de signets) sont également fusionnés dans le document. Sur
les systémes de langue japonaise, les caractéristiques de texte Rubi et les régles kumihan (régles de
composition en langue japonaise) fusionnent également dans le document.

Pages de référence

Les pages de référence du modele (sauf pour les pages de référence FrameMath™) fusionnent dans
le document. S’il existe une page de référence portant le méme nom dans le modéle et le docu-
ment, c’est |la page de référence du modele qui remplace celle du document. Pour importer les
pages de référence FrameMath, sélectionnez Définitions mathématiques.
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IMPORTATION DE CARACTERISTIQUES DE FORMATAGE

Définitions de variables
Les définitions de variables du modeéle sont fusionnées dans le document.

Formats de références croisées
Les formats de références croisées du modele sont fusionnés dans le document et les références
croisées internes sont mises a jour.

Parameétres de balises conditionnelles
Les balises conditionnelles du modéle et les paramétres Afficher/masquer fusionnent dans le
document.

Définitions mathématiques

Les parameétres de format et de police d’équation, les définitions des éléments mathématiques
personnalisés et les pages de référence FrameMath du modeéle sont copiés dans le document. En
cas de suppression d’éléments mathématiques personnalisés du document lors de la fusion des
pages de référence, FrameMaker remplace les éléments mathématiques dans les équations par le
nom de I'élément mathématique encadré par des points d’interrogation.

REMARQUE : dans les équations FrameMaker, le terme « élément mathématique » désigne une partie
d’une expression. Un élément mathématique n’est pas un élément de structure.
Polices combinées

Sur les systémes en langues asiatiques, les polices combinées sont fusionnées dans le document.

Styles d’objet

Les propriétés des objets tels que les images, les cadres ancrés, les graphiques, les équations etc.
disponibles dans le modeéle sont fusionnées dans le document.

Importation de caractéristiques a partir d'un modele

Vous pouvez importer des définitions d’éléments et autres caractéristiques dans votre document a partir
de tout document FrameMaker. Ce second document est généralement un modeéle que vous n’avez pas
utilisé pour créer votre document.

Si vous avez fait utilisé le modéle approprié, I'importation de caractéristiques n’est pas nécessaire
puisque le document possede déja les caractéristiques requises.

Sile modele de votre document a été révisé, vous devez de nouveau importer les caractéristiques a partir
du modele pour mettre votre document a jour.

Vous pouvez également importer des caractéristiques dans tous les fichiers d’un livre simultanément.

RELATED LINKS:
Importation de styles dans un livre

Formatages personnalisés
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MODIFICATION DE CONTENU

Modification de contenu

Découvrez comment modifier le contenu d’Adobe FrameMaker.
FrameMaker propose de nombreux outils et options permettant de créer un contenu.

Outre le texte, vous pouvez ajouter des graphiques, des images, des tableaux et des liens a vos docu-
ments.

Vous pouvez également inclure des équations mathématiques complexes et codes QR.
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TEXTE ET CARACTERES SPECIAUX

Texte et caracteéres spéciaux

Découvrez comment ajouter du texte et des caracteres spéciaux au document dans Adobe FrameMaker.

En tant qu'environnement de création, Adobe FrameMaker offre des outils qui permettent d'ajouter
facilement du texte (y compris des caracteres spéciaux) a un document.

Bien que le texte contienne des caracteres standards comme des lettres et des chiffres, vous pouvez
également saisir des caractéres comme une tabulation, des symboles de puce, des symboles mathéma-
tiques.

Ajout de texte et de caractéres spéciaux

Découvrez comment ajouter du texte, des personnages spéciaux, des onglets, des espaces spéciaux et
des guillemets intelligents dans FrameMaker.

Le point d’insertion marque I'emplacement de saisie ou d’édition du texte. L'emplacement du point
d’insertion détermine le paragraphe auquel les commandes de format de paragraphes sont appliquées.

Le menu Spécial permet également d’insérer des éléments de texte spéciaux, tels que des références
croisées, des notes, des variables et des marqueurs. Lorsque vous cliquez sur un élément de texte spécial,
tel qu’une référence croisée, une variable ou un encart de texte, vous sélectionnez I'objet entier.

Si vous ne pouvez pas placer le point d’insertion dans le texte ou prés de celui-ci, les raisons possibles
sont les suivantes :

. Le texte d’arriére-plan a été saisi sur une maquette. Affichez la maquette contenant le texte et
placez le point d’insertion dans le texte sur cette page.

. Le texte a été généré automatiquement, comme les numéros automatiques de paragraphes, les
références croisées ou les en-tétes et les pieds de page.
RELATED LINKS:

Modification des taquets de tabulation

Texte et caracteéres spéciaux

Caracteres spéciaux

Dans ce sujet

. Introduction

] Tabulateurs

. Caracteres d'espacement

. Guillemets ouvrants/fermants

Introduction

En plus des caractéres standard, vous pouvez entrer des puces, des tirets, des espaces a largeur fixe, des
symboles mathématiques, des caractéres internationaux ainsi que d’autres caractéres spéciaux.
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REMARQUE : Dans FrameMaker, les séquences de caractéres (alt) ne sont pas implémentées pour les
polices Dingbats et Symbol car, pour ces polices, des équivalents Unicode de la page de code 1252 sont
fournis par défaut. Les séquences de caracteres (alt) ne sont implémentées que pour la famille de polices
de caracteres MakerRoman.

Pour obtenir la liste des caractéres des polices Symbol et Zapf Dingbats, la liste des caracteres accentués
dans le jeu de caractéres standard ainsi que des informations sur I'insertion du symbole monétaire de
I’euro, consultez le manuel en ligne Jeux de caractéres FrameMaker.

certains caracteres spéciaux sont entrés ou affichés différemment dans les boites de dialogue. Sous
Windows, vous devez entrer une séquence de caractéres en commencant par une barre oblique inverse
(\). Ces séquences sont répertoriées dans la section Boites de dialogue.

Tabulateurs

Chaque fois que vous appuyez sur la touche tab ?, un symbole de tabulation j est incorporé au texte. Ce
symbole ne s’affiche pas sur le document imprimé mais est visible a I’écran si les symboles de texte sont
activés.

Si le paragraphe en cours posséde des taquets de tabulation définis, FrameMaker déplace le point
d’insertion et le texte d’'un taquet a chaque fois que vous appuyez sur la touche tab ?. Si aucun taquet
n’est défini et que vous appuyez sur la touche tab ?, le point d’insertion et le texte ne se déplacent pas.
Sivous appuyez sur la touche tab ? plus de fois qu’il n’y a de taquets, les symboles de tabulation se super-
posent. Si vous ajoutez par la suite des taquets de tabulation au paragraphe, FrameMaker positionne
correctement le texte en fonction de ces taquets.

FrameMaker utilise des taquets de tabulation absolus et non relatifs. Avec une tabulation relative, le
point d’insertion est envoyé au taquet de tabulation disponible suivant chaque fois que vous appuyez sur
la touche Tab. Avec la tabulation absolue, lanieme tabulation d’une ligne envoie le point d’insertion au
niéme taquet. Si ce taquet se trouve a gauche du point d’insertion, ce dernier ne bouge pas.

Caracteéres d'espacement

Lorsque vous appuyez sur la barre d’espacement, vous insérez un espace proportionnel (dont la largeur
dépend des caractéres qui I’entourent). Vous pouvez également insérer des espaces spéciaux a largeur
fixe (pour augmenter I’espace entre deux mots, par exemple). Lorsque vous entrez un espace spécial
entre deux mots, ces derniers restent toujours ensemble sur une ligne.

Les types d’espaces spéciaux suivants sont disponibles :

. Un espace cadratin a la méme largeur que la taille en points de la police utilisée. Par exemple, si
vous utilisez une police de 10 points, la largeur de I’espace cadratin est de 10 points.

. Un espace demi-cadratin a une largeur inférieure de moitié a celle d’un espace cadratin.

. Un espace numérique a la méme largeur que le caractére 0 (zéro) de la police. Tous les chiffres ont
généralement la méme largeur. Cet espace est utile pour aligner des nombres dans une colonne
sans devoir utiliser des tabulations.

J Un espace fin a une largeur égale au douzieme de celle d’'un espace cadratin. Un tel espace est
utilisé pour séparer un nombre et 'unité de mesure qui le suit ou des caracteres s’affichant trop
pres 'un de I'autre, comme « /) ».

. Un espace insécable a la méme largeur qu’un espace par défaut de la police.
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Lorsque la fonction Réduction espaces est activée, vous ne pouvez pas entrer plusieurs espaces propor-
tionnels sur une ligne. Vous pouvez cependant entrer plusieurs espaces a largeur fixe

Guillemets ouvrants/fermants

Lorsque la fonction Guillemets ouvrants/fermants est activée, FrameMaker insére des guillemets gauche
et droit courbés, ou les guillemets que vous avez définis dans la boite de dialogue Préférences. Chaque
fois que vous appuyez sur la touche des guillemets simples ou doubles(y, . ou 1), les guillemets configurés
sont entrés en fonction de vos préférences. Comme la fonction Guillemets ouvrants/fermants dépend de
la langue, la langue définie pour le style du paragraphe détermine les guillemets a utiliser.

REMARQUE : Si vous préférez des guillemets droits, désactivez cette fonction.
La fonction Guillemets ouvrants/fermants ne s’applique pas au texte des zones de dialogue. Pour plus

d’informations sur la saisie des guillemets et des apostrophes dans les boites de dialogue, voir Jeux de
caracteres.

1)  Pour définir des caractéres spéciaux ouvrants/fermants, dans une fenétre de livre, sélectionnez les
documents concernés.

2)  Sélectionnez Format > Document > Options de texte.
3)  Modifiez I'option Réduction espaces ou Guillemets ouvrants/fermants, puis cliquez sur Appliquer.
CONSEIL : Lorsque vous sélectionnez Réduction espaces, FrameMaker ne modifie pas les guillemets déja

présents dans le document. Pour rechercher les apostrophes et guillemets droits et les modifier en apos-
trophes et guillemets courbés, utilisez la commande Orthographe ou la commande Chercher/Remplacer.
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Importation et liaison de fichiers

Savoir importer et lier des fichiers dans FrameMaker.
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Méthodes de liaison et d'importation

Comprendre les méthodes d’importation et de lien, I'importation de fichiers texte, graphiques, audio,
vidéo et d'objets. Utilisez les commandes Presse-papier, Importer et Objet dans FrameMaker.

Dans ce sujet

. Introduction

J Importation a partir du presse-papiers

. Utilisation du glisser-déposer

. Importation par référence

J Copier dans le document

. Utilisation de la commande Fichier > Importer > Objet

Introduction

Vous pouvez importer d’autres documents Adobe FrameMaker, des documents créés dans d’autres
applications, des fichiers texte, audio, vidéo (y compris des vidéos YouTube) et graphiques. Vous pouvez
aussi importer des objets 3D dans les documents FrameMaker.

Un objet importé peut étre simplement collé dans le document. Vous pouvez aussi le lier (importation
par référence) pour gqu’il reste associé a la source et ainsi faciliter la mise a jour.

Importation a partir du presse-papiers

Le moyen le plus simple pour importer du texte et des graphiques est de copier et de coller a I'aide du
presse-papiers. Lorsque vous appliquez cette méthode, tenez compte des points suivants :

1)  Sélectionnez I'objet ou le texte que vous souhaitez copier, puis choisissez Edition > Copier. Le
contenu est copié dans le presse-papiers.

2)  Placez le point d'insertion a I'endroit du document ou vous voulez coller le contenu, puis sélec-
tionnez Edition > Coller.

Lorsque vous appliquez cette méthode, tenez compte des points suivants :

. Vous pouvez convertir du texte séparé par des marques de tabulation en tableau avec la
commande Tableau > Convertir en tableau.

. Le formatage de texte est perdu, sauf si vous le collez dans un autre document FrameMaker.

. Si vous sélectionnez Edition > Coller (spécial), cela vous offre plus d’options. Par exemple, vous
pouvez coller le texte au format RTF ou en tant que document Microsoft Word incorporé. Pour
appliquer des formats FrameMaker, copiez ensuite le contenu du Presse-papiers en tant que texte.
Pour les graphiques, vous pouvez coller le contenu du presse-papiers sous forme d'image bitmap
incorporée, d'image bitmap indépendante du périphérique ou en tant que métafichier.

. Lorsque vous copiez et collez du texte d’une direction spécifique (LTR ou RTL) dans un document
FrameMaker, vous devez vous assurer que le sens du texte de I'emplacement de destination (docu-
ment, tableau, ou un paragraphe) est placé dans le méme sens.
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Utilisation du glisser-déposer

L'importation et I'exportation sont beaucoup plus faciles lorsque vous pouvez faire glisser un objet vers
son nouvel emplacement.
Dans FrameMaker, vous pouvez effectuer les opérations de glisser-déposer suivantes :

. Déplacer un graphique depuis une fenétre de document FrameMaker ouverte vers une autre en
faisant glisser le graphique. Vous pouvez également le copier en le déplacant tout en maintenant
la touche Ctrl enfoncée ou cliquer dessus avec le bouton droit de la souris au moment ol vous le
déposez afin d’afficher un menu contextuel.

] Déplacer un graphique depuis une fenétre de document FrameMaker vers une autre application
prenant en charge les opérations de glisser-déposer.

J Faire glisser un fichier graphique depuis un dossier ou depuis le bureau vers une fenétre de docu-
ment ouverte.

. Déplacer un ou plusieurs fichiers de document vers la fenétre de I'application pour ouvrir les fich-
iers ou faire glisser un fichier vers une fenétre de document pour lI'incorporer.

Importation par référence

Si vous effectuez une importation par référence, le texte ou les graphiques importés restent liés au
fichier source. FrameMaker conserve le chemin du fichier source dans le document. A chaque ouverture
du document, FrameMaker repére le fichier sur le disque et I'affiche.

Si le fichier source a été modifié, FrameMaker met a jour le document avec la derniéere version. L'impor-
tation par référence peut réduire la taille totale du fichier, car elle permet d'utiliser les mémes données
a plusieurs endroits sans stocker le contenu des images ou du texte importés dans le document
FrameMaker. Le texte importé par référence est appelé un encart de texte.

1)  Sélectionnez Fichier > Importer > Fichier. La boite de dialogue Importer s’ouvre.
2)  Sélectionnez le fichier que vous souhaitez importer, puis sélectionnez Importation par référence.
3) Cliquez sur Importer.

Pour plus de détails sur I’'enregistrement du Chemin lors de I'importation par référence, reportez-vous a
la section Utilisation des chemins d’acceés lors de I'importation par référence.

Copier dans le document

L'importation par copie facilite le transfert des données importées d’'un emplacement a un autre mais
elle augmente la taille du document. De plus, si vous modifiez la source, vous devez réimporter les
données afin de mettre a jour le document avec la derniére version.

1)  Sélectionnez Fichier > Importer > Fichier. La boite de dialogue Importer s’ouvre.

2) Sélectionnez le fichier que vous souhaitez copier dans le document. Sélectionnez Copier dans le
document.

3) Cliquez sur Importer.
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Utilisation de la commande Fichier > Importer > Objet

L’utilisation de la fonction OLE (liaison et incorporation d’objet) a comme principal avantage de
permettre I'affichage de visualisations de données créées dans des applications autres que FrameMaker.
L'option Fichier > Importer > Objet associe I'objet importé au programme utilisé pour le créer, ce qui
permet de le modifier dans son programme d'origine. Par exemple, vous pouvez insérer un diagramme
circulaire créé a l'aide de Microsoft Excel dans un document FrameMaker. A chaque fois que vous cliquez
deux fois sur I'objet inséré, FrameMaker I'ouvre dans Microsoft Excel ou vous pouvez le modifier.

REMARQUE : vous ne pouvez pas incorporer ou lier un objet dont le logiciel d’origine n’est pas installé sur
votre ordinateur. Par exemple, si vous ouvrez un document avec une image Photoshop intégrée
viaFichier > Importer > Objet, vous devez avoir installé Photoshop sur votre ordinateur pour pouvoir
modifier cette image.

Considérez les facteurs suivants lorsque vous décidez d’importer du texte et des graphiques par
référence ou en utilisant la fonction OLE pour les incorporer ou les lier :

. Si I'élément a inclure provient d’un autre document FrameMaker, utilisez I'importation par
référence. Le choix d’options d’importation est alors plus important.

o Si vous souhaitez réduire le fichier lié a la taille d’'une icone au lieu d’afficher son contenu dans le
document, utilisez une liaison OLE.

. Si I’élément a inclure est d’'un format que FrameMaker ne peut ouvrir, utilisez la fonction OLE.

. Si vous modifiez ou affichez le document sur plusieurs plates-formes, utilisez I'importation par
référence. La fonction OLE ne fonctionne que sous Windows.

. Si le texte ou le graphique a inclure provient d’une application ne prenant pas en charge la fonction
OLE, utilisez I'importation par référence.

RELATED LINKS:
Importation de texte
Importation de graphiques

Incorporation d’objets
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Utilisation des chemins d’acces lors de I'importation par référence

Découvrez les chemins lors de I'importation par référence, chemin relatif et chemin absolu dans Adobe
FrameMaker.

Lorsque vous importez par référence avec la commande Fichier > Importer > Fichier, le chemin d’acces
au texte ou graphique peut étre absolu ou relatif. Un chemin d’accés relatif commence au dossier en
cours ou au dossier supérieur dans la hiérarchie et spécifie I'emplacement du fichier depuis ce point. Un
chemin d’acces absolu commence a la racine du systéme de fichiers (le dossier le plus élevé) et spécifie
entierement I'’emplacement du fichier depuis ce point. Les deux exemples suivants correspondent a des
chemins d’accés absolus.

o D:\Graphics\Mountain.gif

o ServeurDoc\images\Montagne.gif

Si possible, FrameMaker enregistre les noms de chemin d’accés relatifs afin de pouvoir trouver un fichier
importé méme si vous avez déplacé le document et le fichier source (tant que vous conservez les fichiers
aux mémes emplacements relatifs). Si vous enregistrez le document dans un dossier différent,
FrameMaker ajuste les chemins d’acces aux fichiers importés en conséquence. Cependant, si le chemin
d’acces au fichier importé passe par la racine (le dossier le plus élevé) du systéme de fichiers,
FrameMaker utilise un chemin absolu qui commence a la racine.

Pour vous assurer que FrameMaker utilise des chemins d’acces relatifs, vérifiez qu’il ne doit pas passer
par la racine pour trouver le fichier.
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Importation de graphiques

Utilisez la commande Importer un fichier pour importer des graphiques, en apprendre davantage sur le
format graphique, localiser les graphiques manquants, ajouter des graphiques a des documents struc-
turés et des cadres ancrés dans FrameMaker.

Dans ce sujet

Introduction

Importation d’un graphique

Importation de fichiers JPEG 2000

Importation d’images SVG

Importation de fichiers Adobe Photoshop

Importation de fichiers Adobe Illustrator

Recherche d’un graphique que FrameMaker ne trouve pas
Affichage du nom de fichier d’un graphique importé

Introduction

Vous pouvez importer de nombreux formats graphiques/images dans un document FrameMaker. La liste
suivante répertorie certains des formats de fichiers image les plus couramment utilisés que vous pouvez
importer dans FrameMaker :

Adobe lllustrator (Al)

Adobe Photoshop (PSD)

Adobe PDF

Bitmap (BMP)

Device-Independent Bitmap (DIB)

Drawing Interchange Format/Drawing Exchange Format (DXF)
Computer Graphics Metafile (CGM)

Enhanced Metafile (EMF)

Encapsulated Postscript (EPS)

Graphic Interchange Format (GIF)

Joint Photographic Experts Group Graphics (JPEG, JPEG2000)
Portable Network Graphics (PNG)

Scalable Vector Graphics (SVG)

Tagged Image File Format (TIFF)

Universal 3D (U3D)

WebP

Windows Metafile (WMF)

Icon (ico)

FrameVector

Framelmage
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Tenez compte des aspects suivants lors de I'importation ou de I'utilisation de fichiers image dans
FrameMaker :

. Utilisez Fichier > Importer > Fichier ou Insérer > Image pour importer des graphiques.

o Vous pouvez importer un graphique dans un cadre graphique ancré ou non, dans un rectangle
utilisé comme cadre de contour ou directement sur une page. Si vous souhaitez que le graphique
se déplace avec le texte lors de la modification du document (par exemple, un graphique dans de
longs documents ou des documents destinés a une conversion HTML), importez-le dans un cadre
ancré. Pour que le graphique reste au méme endroit (comme un logo ou un en-téte), importez-le
sur la page et placez-le a I'endroit souhaité.

. Lorsque vous importez un graphique, vous pouvez spécifier un filtre d’'importation basé sur le
format du graphique. Lors de I'importation d’un bitmap, vous spécifiez également son échelle en
points par pouce (ppp). Plus la valeur (en ppp) est élevée, plus la taille du graphique sur la page est
petite.

. Lors de I'importation d’une image avec un arriére-plan transparent, FrameMaker conserve la trans-
parence de I'image lors de la création et lors de la publication au format PDF.

J Lorsque vous copiez une image, que ce soit par copie ou référence, dans un document, vous pouvez
spécifier un chemin HTTP a partir duquel importer le graphique. Le chemin HTTP est conservé lors
de la conversion XML bidirectionnelle.

. Par défaut, FrameMaker importe des images par référence. Si vous souhaitez copier des images
dans le document par défaut, désélectionnez I'option Importer I'image par référence dans la boite
de dialogue Préférences de la section Global, Général.

. Vous pouvez également importer des graphiques en déplacant le fichier graphique par
glisser-déposer a partir de I'explorateur Windows dans votre document. L'image est ajoutée dans
un cadre ancré. Dans le cas d’un document structuré, I’élément d’image approprié est appliqué a
I'image a insérée.

Importation d’un graphique

1)  Spécifiez la position du graphique en procédant de la facon suivante :

- Pour placer le graphique importé dans un cadre graphique, sélectionnez un cadre existant ou
placez un point d’insertion dans une zone de texte.

- Pour placer directement le graphique importé sur une page, cliquez dans la marge de la page.

- Pour utiliser un rectangle dessiné pour définir la taille du graphique en mode point importé,
sélectionnez un rectangle existant ou dessinez-en un (ne sélectionnez pas un cadre ancré ou
non ancré). Le graphique importé remplace le rectangle, si I'option Cadrer dans le rectangle
sélectionné est sélectionnée lors de I'importation, mais garde son rapport hauteur-largeur.

- Pour remplacer un graphique existant, sélectionnez-le.

2)  Sélectionnez Fichier > Importer > Fichier pour ouvrir la boite de dialogue Importer du fichier.
Ou,
Sélectionnez Insérer > Image pour ouvrir la boite de dialogue Insérer une image.

3) Dans la boite de dialogue Importer un fichier, sélectionnez le fichier graphique a importer ou
indiquez son chemin HTTP, ainsi que la méthode d’importation. Une fois que vous avez sélectionné
une image ou fourni I'URL, cliquez sur Importer.
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4) Dans la boite de dialogue Insérer une image, sélectionnez le fichier graphique a importer, puis
cliquez sur Ouvrir.

5) Sila boite de dialogue Type de fichier indéterminé apparait, sélectionnez un type de fichier dans la
liste de sélection et cliquez sur Convertir.

6) Sila boite de dialogue Redimensionner les graphiques importés s’affiche, sélectionnez une option
de mise a I'échelle ou Cadrer dans le rectangle sélectionné, puis cliquez sur Définir.

CONSEIL : Pour obtenir une impression optimale, choisissez comme valeur ppp un quotient exact (ou tres
proche) de la résolution de I'imprimante. Pour une présentation optimale a I’écran, choisissez une
valeur ppp qui divise de maniere égale la résolution d’écran (sous Windows, la résolution d’écran est
généralement de 96 ppp).

Importation de fichiers JPEG 2000

FrameMaker prend en charge le format JPEG2000, version du format trés connu de compression d’'image
JPEG.

Lors de I'importation de fichiers JPEG 2000, le filtre convertit les modes de couleurs pris en charge tels

que RVB, CMJN, Grayscale et LAB, mais ignore les modes non pris en charge tels qu’Index par exemple.
Les images 16 bits par canal ne sont pas prises en charge par le filtre. Lors de I'importation, si la boite de
dialogue Type de fichier indéterminé s’affiche, sélectionnez JPC, J2C, JPX, JPF, J2K ou JP2, puis cliquez sur
Convertir.

La procédure d’importation de fichiers est identique a celle décrite dans la Importation d’un graphique-
section.

Importation d’images SVG

Vous pouvez importer Scalable Vector Graphics (SVG) dans votre document.

FrameMaker imprime des images SVG (Scalable Vector Graphic) sur des imprimantes PostScript en
convertissant les images en graphiques vectoriels a I’aide du format EPS (Encapsulated PostScript). Pour
les imprimantes autres que PostScript, le format Framelmage est utilisé.

Par ailleurs, lorsque vous créez un fichier PDF a partir d’'un document contenant une image SVG, cette
image s’affiche sous forme de vecteurs, ce qui améliore son aspect dans Acrobat et vous permet
d’effectuer un zoom avant sans aucun phénomene de pixellisation.

REMARQUE : Les animations contenant des images SVG incorporées ne sont pas prises en charge dans
FrameMaker.

Importation de fichiers Adobe Photoshop

FrameMaker prend en charge I'importation de fichiers Adobe Photoshop (PSD). Les fichiers PSD y sont
convertis au format Framelmage natif et les couleurs (RVB, CMIN, LAB, Indexed, Grayscale ou Bitmap
Photoshop) sont converties en RVB.

Nouveau dans FrameMaker (version 2019) : lors de la création d’un PDF avec le nouveau moteur PDF de
FrameMaker (version 2019), FrameMaker conserve I'espace couleur de PSD (par exemple, RVB ou CMJN)
dans le PDF publié. Si un profil de couleur est attaché au fichier Photoshop (par exemple, sRGB
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IEC61966-2.1, Adobe RGB, image P3, Euroscale Uncoated v2 etc.), le profil de couleur est attaché a
I'image dans la sortie PDF.

L'importation de fichiers PSD se déroule de la méme maniéere que I'importation d’autres types de
graphiques.

Importation de fichiers Adobe Illustrator

Lorsque vous importez un fichier Adobe Illustrator dans FrameMaker, ce fichier est traité comme un
objet graphique et une seule page peut étre importée a la fois. L'importation peut se faire par copie ou
par référence. |l est possible d’afficher et d’'imprimer les couleurs quadri et les tons directs.

REMARQUE : il se peut que les graphiques utilisant la transparence ne s’impriment pas correctement sur
les imprimantes PostScript de niveau 1 ou non PostScript. Si vous exécutez FrameMaker en utilisant
I'option —noapi (./maker.exe -noapi), vous ne pourrez pasimporter de fichiers PDF.

1) Dans FrameMaker, sélectionnez Fichier > Importer > Fichier ou Insérer > Image, et spécifiez le
fichier lllustrator a importer.

2) Dans la boite de dialogue Importer un fichier, sélectionnez le fichier graphique a importer ou
indiquez son chemin HTTP, ainsi que la méthode d’importation. Une fois que vous avez sélectionné
une image ou fourni I'URL, cliquez sur Importer.

3) Dans la boite de dialogue Insérer une image, sélectionnez le fichier graphique a importer, puis
cliquez sur Ouvrir.

4) Sile fichier comporte plusieurs pages, indiquez le numéro de la page souhaitée dans la zone de
texte prévue a cet effet.

5) Cliquez sur Sélectionner.

Les fichiers Illustrator sont importés a la taille de page du fichier. Redimensionnez le cadre ancré afin de
rogner les espaces blancs provenant de I'image.

Recherche d’un graphique que FrameMaker ne trouve pas

A l'ouverture d’un document contenant des fichiers graphiques importés par référence, FrameMaker
recherche les fichiers référencés. Si FrameMaker ne trouve pas de fichier graphique référencé, il affiche
une boite de dialogue.

1)  Si FrameMaker affiche la boite de dialogue Fichier manquant, procédez de I'une des facons
suivantes :

- pour trouver et afficher le graphique, utilisez la liste de sélection pour le sélectionner, puis
cliquez sur Utiliser nouveau chemin d'acces. FrameMaker utilise le nouveau chemin d’acces
pour rechercher les autres fichiers manquants a I'ouverture du document. Ainsi, si vous
déplacez tous les fichiers graphiques a un autre emplacement, vous ne spécifiez le nouveau
chemin gu’une seule fois.

- Pourignorer le fichier graphique, cliquez sur Ignorer ce fichier. Le fichier ignoré s’affiche sous
la forme d’un rectangle gris dans le document. A la prochaine ouverture du document,
FrameMaker tente a nouveau de trouver le fichier.

- Pour ignorer d'autres fichiers graphiques introuvables, cliquez sur Ignorer les fichiers
manquants.
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2) Cliguez sur Continuer.

Affichage du nom de fichier d’un graphique importé

Sélectionnez le graphique importé par référence et choisissez Graphiques > Caractéristiques de I'objet.
Le nom du graphique et le chemin d’acces s’affichent dans le panneau Caractéristiques de I'objet.

RELATED LINKS:
Utilisation des chemins d’acces lors de I'importation par référence
Méthodes de liaison et d’importation
Redimensionnement de graphiques importés

Incorporation d’objets
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Insertion d’éléments graphiques importés dans des documents structurés

Utilisez la commande Importer un fichier pour importer des graphiques, en apprendre davantage sur le
format graphique, localiser les graphiques manquants, ajouter des graphiques a des documents struc-
turés et des cadres ancrés dans FrameMaker.

Dans ce sujet

. Introduction

. Insertion d’un élément graphique importé

. Utilisation d’un élément graphique importé non valide

] Ajout d’un graphique importé dans un cadre ancré existant

Introduction

Certains éléments graphiques sont définis de sorte que vous puissiez importer un graphique en méme
temps que I'élément. Lorsque vous insérez I'élément, FrameMaker affiche une boite de dialogue
d’importation. Le graphique importé s’affiche dans un cadre ancré inséré sous la ligne comportant le
symbole d’ancrage et la taille du cadre est automatiquement ajustée au graphique.

REMARQUE : Par défaut, I'attribut @placement de I'élement <image> est défini sur Saut de page.
Vous pouvez changer ce comportement par défaut pour insérer des images en ligne en définissant
OverrideDefaultImageRenderingToBreak=0 dans le fichierditafm.ini.

Figure 1: Graphique importé dans un cadre ancré
Apres avoir inséré I’élément, vous pouvez modifier le cadre en le déplagant, le redimensionnant, etc.

Vous serez peut-étre amené a importer un graphique dans un cadre ancré existant, notamment si vous
avez utilisé un élément graphique qui a inséré un cadre vide dans le document.

Lorsque vous importez un élément graphique, vous pouvez I'intégrer a votre document (importation par
copie) ou maintenir un lien avec I'application ou le document source (importation par référence).

Vous pouvez également importer un graphique en déplagant le fichier graphique par glisser-déposer a
partir de I'explorateur Windows dans votre document. L'image est ajoutée dans un cadre ancré.

Pour plus de détails sur I'insertion d’un graphique importé qui n’est pas un élément (ce qui est possible
uniquement dans un enchainement non structuré), voir Importation de graphiques.
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Insertion d’un élément graphique importé

1)
2)

3)

4)
5)

6)

Cliquez a I'’endroit auquel vous souhaitez ancrer le cadre.

Sélectionnez un élément graphique importé dans le Catalogue d’éléments, et cliquez sur Insérer.
Vous pouvez également utiliser Fichier > Importer > Fichier ou Insérer > Image pour insérer un élé-
ment. Sélectionnez un fichier et cliquez sur Importer. Si plusieurs éléments graphiques importés sont
disponibles, faites votre choix dans la liste déroulante Balise d’élément de la boite de dialogue qui
s’affiche alors.

Sélectionnez le fichier graphique a importer et précisez s'il doit étre importé par copie ou par
référence.

Cliquez sur Importer.

Si la bofite de dialogue Type de fichier indéterminé apparait, sélectionnez un type de fichier dans la
liste de sélection et cliquez sur Convertir.

Si la boite de dialogue Redimensionner les graphiques importés apparait, choisissez une option de
mise a I’échelle ou Cadrer dans le rectangle sélectionné, puis cliquez sur Définir. Plus la valeur en
ppp (points par pouce) est élevée, plus la taille du graphique affiché sur la page sera petite.

Un cadre ancré contenant le graphique importé apparait dans la fenétre de document et un symbole
d’ancrage () apparait | au point d’insertion. Une bulle avec le fragment de texte <GRAPHIC> apparait
dans la Vue de la structure.

Siaucun élément graphique importé n’est disponible dans I'emplacement souhaité, vous pouvez utiliser
un élément non valide. Apres I'avoir inséré, consultez votre développeur pour savoir comment le rendre
valide pour cet emplacement.

Utilisation d’un élément graphique importé non valide

Procédez de I'une des facons suivantes :

Pour utiliser un élément valide dans une autre partie du document, insérez I’élément dans un
emplacement valide puis déplacez-le ou bien utilisez le parameétre Tous les éléments pour rendre
I’élément disponible partout, puis insérez-le a I'’endroit souhaité.

Pour insérer un élément non valide avec I'élément par défaut <GRAPHIQUE>, utilisez Fichier >
Importer > Fichier ou Insérer > Image pour importer un graphique. L'élément est celui par défaut
si aucun élément graphique importé défini n’est disponible.

Ajout d’un graphique importé dans un cadre ancré existant

Sélectionnez le cadre et utilisez Fichier > Importer > Fichier ou Insérer > Image pour importer le
graphique

RELATED LINKS:

Remplissage et modification des cadres ancrés
Meéthodes de liaison et d’importation
Copier dans le document

Modification de la sélection d’éléments disponibles dans un document structuré
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Importation d'objets audio, vidéo et 3D

Découvrez comment importer des objets vidéos (notamment des vidéos YouTube), audio et 3D. Gérez
les documents avec des objets 3D, définissez des vues et des schémas d’éclairage, des fichiers d’affiches
dans FrameMaker.

Il est tres facile d'insérer des fichiers multimédias dans votre document. FrameMaker vous permet
d’insérer ou d’importer des fichiers audio (.mp3), des fichiers vidéos (* .mp4) et méme des vidéos
YouTube dans vos documents.

Vous pouvez également importer des objets 3D (format U3D) dans les documents par copie ou par
référence. Vous avez également la possibilité de définir des parametres d’objet 3D tels que la vue par
défaut, le mode de rendu, la couleur d’arriere-plan et le schéma d’éclairage. Pour le rendu de I'objet 3D,
vous pouvez également choisir entre un cadre ancré ou non.

Pour consulter divers didacticiels et démonstrations sur I'utilisation de la fonctionnalité rich media dans
la création FrameMaker, regardez les programmes correspondants sur le canal Technical Communica-
tions d’Adobe TV.

Formats de fichiers audio et vidéo pris en charge

Découvrez les formats audio et vidéo pris en charge, comment importer des vidéos et comment définir
une image d’affiche pour un objet audio ou une vidéo dans Adobe FrameMaker.

Vous pouvez ajouter des objets audio ou vidéo a des documents en incorporant des fichiers multimédias.
FrameMaker prend en charge les formats multimédias suivants :
. AIF/AIFF (format de fichier Audio Interchange) WMV
. ASF (fichier Advanced Systems Format)

. AU (fichier audio)

J AVI (fichier Audio Video Interleave)

. FLV (fichier Flash Video)

J IVF (fichier Indeo Video Format)

. KAR (fichier MIDI Karaoke)

. M1V (fichier MPEG-1 Video)

. M3U (fichier de liste de lecture multimédia)

e MID (fichier MIDI)

. MOV (séquence Apple QuickTime)

. MP2 (fichier audio compressé MPEG couche Il)

. MP3 (fichier audio MP3)

] MP4 (fichier vidéo MPEG-4)

. MPA (fichier audio MPEG-2)

. MPE (fichier de séquence MPEG)

J MPEG (séquence MPEG)

. MPG (fichier vidéo MPEG)

. QT (séquence Apple QuickTime)
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e WAV (fichier DTS-WAV)
. WMV (fichier vidéo Windows Media)
. Vidéos YouTube

Pour plus d’informations, voir Incorporation d’objets.

Lors de I'impression d’'un document contenant une animation QuickTime, seul le titre du film s’affiche.

REMARQUE : ne supprimez pas ou ne déplacez pas le fichier original de I'animation QuickTime, méme si
vous avez utilisé I'option Copier dans le document lors de son importation. En effet, cette derniére ne
copie pas entierement I'animation QuickTime dans le document.

Importation de fichiers audio et vidéo

Découvrez comment importer ou insérer des fichiers audio et vidéo dans vos documents FrameMaker
structurés et non structurés.

FrameMaker prend en charge I'importation de fichiers audio (* . mp3) et vidéo (* .mp4) dans votre docu-
ment. Lorsque vous publiez votre document, ces fichiers sont également intégrés dans la sortie publiée.
1)  Placez le point d’insertion a I'endroit de votre document ou le fichier multimédia doit apparaitre.
2)  Selon le type de fichier que vous souhaitez insérer ou importer, effectuez la tache suivante :

- Sélectionnez Insérer > Multimédia > Audio pour insérer ou importer un fichier audio.

La capture d’écran suivante affiche la boite de dialogue d’insertion de fichiers audio pour un
document non structuré :

Insert X
&« v 4 « temp » Fm-2020 > sample-docs v U Search sample-docs r
Organize ~ New folder = T @
Reading Material ~ [ Name De
Research LwDITA-samples 24
RoboHelp TravelDITA 2
RoboHelp Server Unstructured-UserGuide 14
Tags-optimization M & sample_audio.mp3 06
TCS
TCS_CSAT
temp
2017
Fm-2020
sample-docs
. v < >
File name: |sample_audio.mp3 ~ ‘ All Audios (*.mp3) »

Figure 1: Boite de dialogue d’insertion de fichiers audio pour un document non structuré
- Sélectionnez Insérer > Multimédia > Vidéo pour insérer ou importer un fichier vidéo.

La capture d’écran suivante affiche la boite de dialogue d’insertion de fichiers vidéo pour un
document DITA structuré :
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Insert Video X
Element: |obiect h
Key Name:
Reference:
Href: :\lemp\Fm-2020\sample-docs\sample_video.mp4|| Browse...
Keyref. | v | Keyspace...
Path:
OK Cancel

Figure 2: Boite de dialogue d’insertion de fichiers vidéo pour un document structuré

3)  Accédez au fichier a insérer et sélectionnez-le.
4)  Cliquez sur Ouvrir.

Le fichier sélectionné est inséré dans votre document. La capture d’écran suivante montre les fich-
iers vidéo et audio insérés dans un document.

Congratulations on your purchase of a Personal Spaceship and:
welcome to the documentation designed to help you get the
most out of your vehicle. 5

Video file (*.mp4):

Audio file (*

Figure 3:  Fichier vidéo et audio inséré dans un document
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Insertion de vidéos Youtube

Découvrez comment insérer des vidéos YouTube dans vos documents DITA structurés ou FrameMaker

non structurés.

De méme que vous insérez un fichier audio ou vidéo, vous pouvez insérer une vidéo YouTube dans votre

document.

1)  Placez le point d’insertion a I’endroit de votre document ou la vidéo YouTube doit étre insérée.
2)  Sélectionnez Insérer > Multimédia > Vidéo en ligne.
3) Selon le type de document sur lequel vous travaillez, vous verrez I'une des boites de dialogues

suivantes :

- Document non structuré : si vous travaillez dans un document non structuré, la boite de

dialogue Vidéo en ligne apparait :

B ' Online Video

URL or Embed HTML.:

https://www.youtube.com/watch?v=6QvGCz_EAsU

Insert

Cancel

Figure 4: Insertion d'une vidéo Youtube dans un document non structuré
Entrez I’'URL courte ou complete de la vidéo ou le code HTML d’intégration de la vidéo dans la

boite de dialogue.

REMARQUE : Pour plus d’informations sur I'obtention de I'URL courte ou complete d’une vidéo
YouTube, consultez I'aide YouTube.

- Document DITA ou LWDITA structuré : si vous travaillez dans un document structuré DITA 1.3
ou LWDITA, la boite de dialogue Insérer vidéo en ligne suivante apparait :

IMPORTANT : Ce processus d’insertion de vidéos YouTube n’est actuellement pas pris en charge
pour les applications XML spécialisées ou personnalisées.
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Insert Online Video X

Element: |objeci

Key Name:
Reference:
Href: https:Hyoutu.belEstSOBmUSIVI| Browse...
Keyref: M Keyspace...
Path:

Figure 5: Insertion d'une vidéo Youtube dans un document structuré
Entrez ’'URL courte ou complete de la vidéo dans la boite de dialogue.

REMARQUE : L'intégration du code HTML d’une vidéo YouTube n’est actuellement pas prise en
charge pour les documents structurés.

4)  Cliquez sur Insérer.
La vidéo YouTube est insérée dans votre document.

Remarques supplémentaires relatives a l'insertion d'objets audio, vidéo et vidéo YouTube dans des docu-
ments DITA structurés

. Lorsque vous insérez un fichier vidéo ou audio hors ligne ou bien une vidéo YouTube en ligne dans
un document DIT, FrameMaker utilise I'élément <object> pour stocker le lien du fichier.
L’élément <object> contient I'élément <param> avec les attributs @name et @value, qui
définissent la source et le chemin du fichier inséré. Dans la cas d’une vidéo YouTube, I'attribut
@valeur contient 'URL ou le code HTML de la vidéo YouTube.

La capture d’écran suivante montre la vue XML d’un document DITA avec une vidéo YouTube, un
fichier vidéo local et un fichier audio inséré :
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<p>Video file (*.mp4)</p>

<p>
<object data="../sample_video.mp4" height="30.856pt" width="38.856pt">
<{param name="src" value="../sample_videoc.mp4"/>
</object>
</p>

<p>Audio File (*.mp3)</p>

<p>
<object data="../sample_audio.mp3">
<param name="src" value="../sample_audio.mp3"/>
</object>
</p>

<p>YouTube video</p>
<p>
<object data="https://youtu.be/ExHs80BmUSM"></object>

</p>

Figure 6: Vue XML des fichiers vidéo YouTube, vidéo et audio insérés dans le document DITA

J Lorsque vous travaillez dans un document DITA léger (LwDITA), la vidéo YouTube et un fichier vidéo
local sont insérés dans un élément <video> et le fichier audio est inséré dans un élément
<audio>. Les éléments <vidéo> et <audio> contiennent I'emplacement du fichier inséré dans
I'attribut de @valeur de I'élément <media-source>. L'attribut <media-source>@value
contient I'URL ou le code HTML de la vidéo YouTube.
La capture d’écran suivante montre la vue XML d’un document LwDITA avec une vidéo YouTube, un
fichier vidéo local et un fichier audio inséré :

<p>YouTube video:</p>
<video height="72.000pt" width="72.8@ept">
<media-source value="https://www.youtube.com/watch?v=6QvGCz_EAsU"/>

</video>

<p>Video File (*.mp4)</p>
<video height="30.856pt" width="38.856pt">

<media-source
value="../../../../../Kuldip/Data/Work/temp/Fm-2020/sample-docs/sample_video.mp4"/>

</video>

<p>Audio File (*.mp3)</p>
<audio>

<media-source
value="../../../../../Kuldip/Data/Work/temp/Fm-2020/sample-docs/sample_audio.mp3"/>

</audio>

Figure 7:  Vue XML des fichiers vidéo YouTube, vidéo et audio insérés dans le document LwDITA

Fichier d’affiche pour un fichier multimédia

Découvrez comment définir une image d’affiche pour un fichier multimédia dans FrameMaker.

241



Dans ce sujet

. Introduction

. Définition d’une image affiche

J Réinitialisation de I'image affiche

Introduction

Vous pouvez définir un fichier d’affiche pour un fichier multimédia importé. FrameMaker affiche I'image
de marque de réservation correspdante.

Dans les documents structurés, si un attribut est défini dans la DTD avec le nom posterfile pour un
objet graphique, I'attribut est automatiquement mappé a la propriété affiche du cadre ancré. Vous
pouvez également mapper n‘importe quel attribut a une affiche a I'aide d’une réegle dans le fichier de
lecture/écriture. Le fichier référencé dans I'attribut devient I’affiche.

Définition d’une image affiche

FrameMaker définit I'image sélectionnée comme affiche. Si I'image qui a été définie comme affiche est
manquante, FrameMaker définit une image spéciale comme affiche.

1) Cligquez avec le bouton droit sur le fichier multimédia inséré.

2)  Sélectionnez Définir I’affiche.

3)  Sélectionnez le fichier d'image (JPEG, .PNG, .BMP ou .GIF), puis cliquez sur OK.

Réinitialisation de I'image affiche

1) Cliguez avec le bouton droit sur le fichier multimédia inséré.
2)  Sélectionnez Définir I'affiche par défaut.
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Utilisation d'objets 3D dans Adobe FrameMaker

Découvrez comment importer des objets 3D, gérer des documents avec des objets 3D, définir des vues
et des schémas d’éclairage et définir une image d’affiche pour un objet 3D dans Adobe FrameMaker.
Dans ce sujet

J Importation d’un objet 3D

J Enregistrement d’un document contenant des objets 3D aux formats PDF et XML

. Enregistrement au format XML de documents contenant des objets 3D

. Impression d’un fichier FrameMaker contenant des objets 3D

J Définition de la couleur d’arriére-plan d’un objet 3D

. Définition des schémas d’éclairage d’un objet 3D

o Définition des vues des objets 3D dans FrameMaker

J Définition du mode de rendu pour un objet 3D dans FrameMaker

Importation d’un objet 3D

1) Placez le point d’insertion ol vous souhaitez faire apparaitre I'objet 3D dans votre document.
2)  Sélectionnez Fichier > Importer > Fichier ou Insérer > Image.

3) Recherchez le fichier U3D a importer, puis sélectionnez-le.

4)  Sélectionnez I'option Copier dans le document ou Importer par référence.

5) Cliguez sur Importer.

6) Le cas échéant, sélectionnez la valeur PPP souhaitée et cliquez sur Définir.

Lorsque vous cliquez sur Définir, I'image bitmap de I'objet 3D s’affiche dans le document. Si I'objet 3D a
été importé par copie, le fichier U3D est incorporé en tant qu’image bitmap indépendante du
périphérique (DIB) dans le document. En cas d’importation par référence, une image bitmap liée au
fichier U3D source est insérée dans le document. Quelle que soit la méthode d’importation du fichier 3D,
le rendu du fichier s’effectue dans la facette DIB du document.

Lorsque vous importez un objet 3D dans un document et que vous I'enregistrez au format PDF ou XML,
toutes les informations relatives a I'objet 3D sont conservées.

Enregistrement d’'un document contenant des objets 3D aux formats PDF et XML

Les documents contenant des objets 3D peuvent étre enregistrés au format XML et PDF.

1)  Sélectionnez Fichier > Ouvrir, puis ouvrez le livre ou le fichier FrameMaker contenant les objets 3D.

2)  Sélectionnez Fichier > Enregistrer au format PDF.

3) Sivousle souhaitez, vous pouvez modifier le dossier d'enregistrement et le nom du fichier avant de
cliquer sur Enregistrer.

4)  Cliquez sur Définir dans la boite de dialogue Configuration PDF pour générer un fichier PDF avec les
parametres par défaut. Autrement, définissez les options supplémentaires de votre choix, puis
cliquez sur Définir. Le fichier U3D importé dans le livre ou le fichier est enregistré ainsi que toutes
ses vues. Lorsque vous ouvrez le fichier PDF, la derniere vue de 'objet 3D sélectionnée dans le
document s’affiche dans le PDF.
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REMARQUE : par défaut, FrameMaker est configuré pour incorporer les objets 3D dans les fichiers PDF.
Cette option peut toutefois étre désactivée.

Dans le fichier PDF, cliquez sur I'objet 3D pour afficher la barre d’outils 3D et activer les fonctions inter-
actives de |'objet 3D. La barre d’outils Adobe Acrobat 3D s’affiche au-dessus de tous les objets 3D du
fichier PDF et vous permet d’analyser les conceptions 3D et de leur appliquer facilement un zoom, un
panoramique ou une rotation.

Enregistrement au format XML de documents contenant des objets 3D

Vous pouvez enregistrer un fichier FrameMaker contenant un objet 3D au format XML. Lorsque vous
ouvrez le fichier XML dans FrameMaker, I'objet 3D est conservé au cours de la conversion XML bidirec-
tionnelle. Il est extrait et enregistré sous forme de fichier U3D indépendant, en méme temps que le
fichier XML. Dés que le fichier est rouvert dans FrameMaker, I’objet 3D s’affiche a I'emplacement d’inser-
tion d’origine.

Pour préserver les modifications apportées a un objet 3D lors de la conversion bidirectionnelle d’'un
fichier XML, ajoutez un nouvel attribut appelé insetdata aux caractéristiques suivantes figurant dans
la section Graphique du fichier DTD, aux cOtés des attributs Of fset et DPI :

insetdata CDATA #IMPLIED

Ajoutez les lignes suivantes au fichier XSD de la méme facon :

<xsd:attribute name="insetdata" type="xsd:string" use="optional"/>
REMARQUE : I'attribut @insetdata ne prend pas en charge les regles de lecture et d’écriture.
Si les fichiers DTD et XSD n’ont pas été modifiés, les fichiers U3D sont toujours exportables au format

XML. Toutefois, les modifications qui leur ont été apportées dans FrameMaker ne sont pas préservées
lors de la conversion bidirectionnelle.

1) Sélectionnez Fichier > Ouvrir, et ouvrez le fichier FrameMaker contenant les objets 3D.
2)  Sélectionnez Fichier > Enregistrer au format XML ou appuyez sur Echap+f+w+x.

3)  Vous pouvez aussi modifier le dossier d’enregistrement et le nom du fichier avant de cliquer sur
Enregistrer.

REMARQUE : lorsque vous ouvrez le fichier XML dans un éditeur XML compatible 3D, I'élément graphique
correspondant contient une référence au fichier U3D, avec le nom et I'emplacement du fichier U3D.
Lorsque vous ouvrez le fichier XML dans FrameMaker, I'objet 3D apparait sous la forme d’une image
bitmap.

Impression d’un fichier FrameMaker contenant des objets 3D

Il est possible d’imprimer des documents contenant des objets 3D. Les objets 3D sont alors imprimés en
tan